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Overview of AFT
xStream
Welcome to AFT xStream™ - a visual
platform for modeling compressible
fluid transients in pipe networks!
AFT xStream brings increased productivity to the pipe flow engineer by
combining traditional analysis with an
intuitive graphical user interface. By
implementing a drag-and-drop
method of pipe flow modeling, AFT
xStream simplifies the pipe network
modeling process.
AFT xStream can show both input
data and analysis results in visual
form, allowing rapid analysis of a
model's validity. Identifying poor
assumptions, catching typographical
or modeling errors, and rerunning models are all accelerated because of AFT
xStream's graphical environment.
Whether your pipe system model will
be used to evaluate and improve an
existing system or to design a new
one, AFT xStream increases your productivity in the modeling process.

What Can AFT xStream Do?
AFT xStream can be used to model a
wide variety of compressible flow systems, including:

number of loops
l

Systems with valve transients

l

Systems with compressor transients

l

Systems with pressure or flow
control valve transients

l

Multiple design cases in a
single model file (Scenario Manager)

AFT xStream's steady-state solution
engine is based on standard techniques used for many years in
industry. A modified Newton-Raphson
method is used to solve the fundamental equations of pipe flow that
govern mass, momentum and energy
balance. Solutions are obtained by iteration, and matrix methods optimized
for speed are employed to obtain convergence. Once a steady-state solution is obtained, AFT xStream
simulates the transient using the
Method of Characteristics, the most
widely used method for solving fluid
transient problems.

Where to Start
The best place to start learning about
AFT xStream is to work through our
example problems found in the
xStream Learning Resources.

l

Open and closed (recirculating)
systems

Add-on Module Capabilities

l

Network systems that branch
or loop, with no limit on the

AFT xStream has one add-on module
that extends modeling capabilities, the
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Pulsation Frequency Analysis module.
Pulsation Frequency Analysis (PFA)
allows the engineer to predict resonant frequencies in the system and
graphically show the frequency
response of a system

conduction are considered inside the
pipe when a convective heat transfer
model is used.

Who Can Use AFT xStream
AFT xStream assumes that the user
possesses a good general knowledge
of compressible flow theory and has at
least a basic understanding of fluid
transients. Even the most advanced
and easy-to-use software package
cannot make up for a lack of fundamental knowledge on the part of the
user.

Related Topics
l

xStream Learning Resources

l

Primary Window Overview

l

Overview of Fluid Transients

Related Blogs
What Is Transient Analysis?

New in Version 2
Convective Heat Transfer
Pipe heat transfer calculation options
for convective heat transfer are available for use. Radial and axial

Libraries
The database feature interface was
completely overhauled to improve
workability. The new system is called
the Library Manager and significantly
improves the ease and workability for
users to browse and connect input
information, now called libraries, into
their model. For a list of differences
between the Database and Libraries
interfaces, see Interface Improvements for xStream 2.
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More Improvements
l

l

Improved Organization of the
Warnings in the Output
An improved display of the warnings
and design alerts makes it easier to
review and understand information in
the following ways:
l

Critical Warnings, Warnings,
and Cautions are color-coded
and grouped by type in collapsible sections

l

Design Alerts are now shown
on a separate tab in the General Section

l

Double-clicking messages will
take user to the related
pipe/junction in the Workspace

l

Pipes/Junctions
l

Several new junctions
have been added including the Bend, Screen,
and Venturi junctions

l

Valve transients can be
defined as open percent
vs time

Workspace and Interface
l

Pipes and Junctions can
be set the Same as Parent directly from the
Workspace

l

Custom Unit names can
be defined in the Unit
System section of the
User Options window

l

Pipe/Junction notes can
be searched in Select
Special

l

Special Conditions can
be directly changed from
the toolbar for junctions
that have multiple special condition options

Output and Reporting
l

Show the number of
warnings and design
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alerts in the batch run
window

l

l

Design alerts are
grouped together in the
General Output section

l

New output parameters
are available for the
Relief Valve junction

l

API 618 analysis added
for the Pulsation Frequency Analysis add-on
module

Miscellaneous
l

SRK and Peng-Robinson equations of state
are now available for
AFT Standard fluids

l

Saturation line data has
been added for the
AFT Standard fluids

l

List Junctions that have
Special Conditions
change in Solution Progress window

l

Silent Batch runs can be
enabled to prevent notifications from appearing
over other active windows

Interface Improvements
for xStream 2
There were many improvements
made to the interface in xStream 2.
These changes primarily involve consolidating inputs with the new Analysis

Setup window, and updating the functionality of databases, which have
been renamed as libraries.

Analysis Setup Sources in
xStream 1
l

Simulation Mode: The simulation mode settings were
moved to the Simulation
Mode/Duration panel in the
Transient Control group.

l

AFT Arrow Steady Solution
Control: The Steady Solution
Control parameters have
primarily moved to the AFT
Arrow Steady Solution Control group. The Special Controls have moved to the
Advanced Parameters panel
under the Miscellaneous group.

l

MOC Steady Solution: The
MOC Steady Solution panel
was renamed to the Transient
Solver Initialization panel
and moved to the Transient
Control group.

l

Sectioning: The Sectioning
panel has been renamed to the
Pipe Sectioning and Output
panel in the Pipe Sectioning
and Output group.

l

MOC Transient: The Start/stop
time inputs from this panel
were moved to the Simulation
Mode/Duration panel. The
options to save pipe stations
were moved to the Pipe Sectioning and Output panel.
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l

List Undefined Objects: The
undefined objects list has been
moved to the Pipes and Junctions group. The undefined
objects list can also still be
viewed next to the Workspace
by opening it from the View
menu.

l

Add-on Modules Activation:
The activation window for addon modules has moved to the
Modules panel

l

Pulsation (PFA module only):
Settings have moved to the
Pulsation Setup group.

navigate solely through the
Library menu

Database Improvements
l

Databases have been renamed
as libraries throughout the interface to better reflect their functionality

l

Connecting, creating, and transferring content between libraries
can all be done from the Library
Browser, rather than switching
between tabs in the Database
Manager to do this

l

l

Viewing the contents of libraries
can also be done directly in the
Library Browser, rather than opening a separate Browse Database
Content window
Windows to edit and add components to libraries can all be
accessed directly from the Library
Manager rather than having to

xStream Learning
Resources
Online Resources
Additional resources can be found in
the Learning Center on our website.
Resources found there include:
l

Training Seminar information

l

Free Webinars
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l

Flow Expert Package information

l

Case Studies

l

Video Tutorials

l

Tips & Tricks Blogs

l

Quick Start Guides

Beginner: Tank Blowdown
Problem

assumptions:
l

l

One dimensional flow

l

No chemical reactions

l

The pipes are rigid

l

The Method of Characteristics
(MOC) solution used here has
several significant assumptions
that impact accuracy - see the
Method of Characteristics topic
for more info

l

Additional assumptions
exist for particular modeling
components and features,
discussed where relevant

Walk Through Examples

Module Walk Though
Examples

Startup Window
The Startup Window is displayed
when AFT xStream is opened. This
window allows the user to quickly
access files and resources, as well as
define a basic starting point for a new
model.
l

An example using the PFA add-on
module of AFT xStream to perform frequency analysis is provided: Module
Walk Through Examples

Engineering Assumptions
AFT xStream is based on the following
fundamental fluid mechanics

AFT xStream is not
meant for analysis of
two-phase flow

l

This is a simple example model which
is recommended as a starting point for
brand new AFT product users: Beginner: Tank Blowdown Problem

This links to a variety of example problems for beginning to advanced users
which showcase different features and
applications of AFT xStream: Walk
Though Examples

Gas-phase flow only

Open a Model
l

My Files - AFT xStream
keeps a list of recently
opened model files. The
most recent files can be
opened with a single
click here.

l

Other Files - Browse to
any other model file, or
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open the built-in
Examples folder.
l

model and to update the
default settings for the
application.

Start a New Model
l

Activate Modules - Any
licensed Module can be
activated immediately.
Checking these boxes
will search for an available license.

l

Select Working Fluid
l

l

l

I Will Select
Fluid Later - No
fluid will be
defined, one will
need to be
defined in Fluid
Panel before running the model.
Select A
Recently Used
Fluid - Applies a
fluid used in a
recent model to
the current one.

Modeling Preferences
- Displays various settings for the application,
such as specifying the
units to use or which grid
to use. These options
can be modified later.
Click the Modify button
to reveal the following
settings, as shown in Figure 2. Click the Remember My Preferences
and Hide button to
update the modeling
preferences for the

l

l

Units - US, Metric, or both sets of
units with one as
default can be displayed. Additionally, the
displayed units
can further be
reduced to only
show common
units and those
used by a certain
industries.

l

Language Select a language to display
Output in.

l

Interface - Set up
the grid to enable
either 2D or isometric drawing
modes.

l

Default Pipe
Material - Set the
pipe material that
is initially selected for new pipes.

Resources
l

User Setup - Open the
AFT website to view the
latest AFT xStream
release, or sign up for
notifications of new
releases via email.

l

Help Files - Open our
detailed help file (you
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are here!) or the collection of worked
Example problems.
l

Video Tutorials - Open
the AFT website to our
library of instructional
videos.

Figure 2: Startup Window showing Modeling Preferences

Figure 1: Startup Window in AFT xStream
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Overview of Fluid Transients
A system is steady-state if its properties - pressure, velocity, etc - do not
change with time. Any disturbance to
a steady-state system will cause these
properties to change - this change is a
fluid transient. All fluid transients
cause disturbances which propagate
throughout the fluid as pressure, velocity and density waves.
Slow acting system changes - such as
a tank pressure that changes over the
course of a day - can be accurately
approximated with a series of steadystate simulations. There are still rapidly-propagating transient pressures in
the system, but their magnitude is generally small enough to be considered
negligible.
Rapid changes can cause large transient pressures that propagate
through the piping network. In extreme
cases this causes catastrophic failure
of piping and associated equipment.
AFT xStream is focused on analyzing
rapid changes to the state of a fluid piping system and the resulting transient
behaviors via the Method of Characteristics.

Wave Velocity and Communication Time
Wave Velocity
The wave velocity (sometimes
referred to as characteristic speed) for
gas transients is the velocity at which
the pressure waves will propagate
through the gas, as is calculated by
the Method of Characteristics. For gas
flow the wave velocity is equivalent to
the sonic velocity of the gas (a) plus
the velocity of the gas (V). The sonic
velocity and velocity will vary with pressure and density.

Communication Time
An important consideration in fluid transient studies is how long it takes a
wave to propagate through the system.
The time it takes for a wave to travel
from one end of a system to the other
is the distance (L) divided by the wave
velocity. Note that the wave velocity is
not constant since the sonic velocity
and velocity will vary with pressure
and density. However, a minimum
communication time can be estimated
using the maximum sonic velocity (i.e.
sonic velocity at the maximum temperature) and maximum velocity (i.e.
sonic velocity), as is discussed in Pipe
Sectioning - Introduction to Method of
Characteristics.
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When a transient event occurs at one
end of a pipe, the wave travels at the
wave velocity to the other end of the
pipe. However, this is not sufficient
time to analyze the problem. While the
disturbance has propagated through
the entire system, the point of transient initiation has not yet seen the result of the reflected wave. For the wave
to both travel to the end of the pipe
and back requires double the above
time. This time is known as the Pipe
Period or Communication Time.

Related Blogs
A Story About Fluid Communication

Pipe Sectioning - Introduction to Method of
Characteristics
To run any transient simulation in AFT
xStream, the pipes in the model must

first be sectioned - required for the
Method of Characteristics (MOC) solution approach utilized. A brief overview of the impact the Method of
Characteristics has on the model is
covered here - for a detailed discussion on the mathematics behind
the method see: Method of Characteristics.

What is Sectioning?
The Method of Characteristics
requires the entire system to be
solved every time step. To accomplish
this, every section must use a common time step. If the time steps were
allowed to vary throughout the model,
some portions of the system would be
solved "ahead" of others, resulting in a
time-distorted solution.
Furthermore, the Method of Characteristics requires that any information propagated from a given
calculation point arrives at the neighboring calculation points after one
time step. The method cannot allow
information to be "lost" between time
steps or calculation stations - the distance between calculation points is
locked to the duration of a time step.
The time Δt it takes to travel from one
point to another is determined by the
linear distance Δx , and wave velocity
a + V between those points:
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performed. Ideally the points R, P, and
L will fall between points 1 and 3 on
the grid for a stable solution.

For systems with liquid flow the velocity is relatively small and can be neglected, which results in a constant
characteristic line slope:

However, for gas flow the velocity cannot be neglected, which means that
the characteristic line slope will
change throughout the transient. This
complicates the choice of a characteristic grid size, since the AFT
xStream MOC solution requires a
fixed grid. For a fixed time step, the distance the wave travels will vary based
on the wave velocity at that time step.
Interpolation must be performed
between the known grid points to
determine the unknown pressure, velocity and temperature at time step t in
order to calculate the pressure, velocity, and density at time step t + Δt at
the grid intersection.
For example, consider Figure 1 below
where the parameters at point 4 are
being determined. At time step t,
points 1, 2, and 3 are known from the
previous MOC calculation. However,
based on the wave velocity at time
step t the characteristic lines will be
unlikely to fall on the known grid
points, so interpolation must be

Figure 1: Characteristic grid. Point 4 sees
effects from points R, P, and L after some
time dt, which has equal magnitude of
dx/a. Points R, P, and L must be interpolated from know points 1, 2, and 3

To ensure that grid points 1 and 3 are
not exceeded the minimum time step
can be approximated using the maximum value of a + V. Recall that the
maximum velocity for gas flow in a
pipe is limited to the sonic velocity,
and that the maximum sonic velocity
will occur at the maximum temperature (T,max). Therefore, the minimum time step can be calculated as
follows.
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less than the maximum pipe Mach
number will result in an unstable solution and may prevent the MOC from
converging.

Note: The maximum temperature
during the transient will likely
be unknown when the model
is first run. It is best practice
to choose a conservatively
large temperature when first
running the model. The maximum temperature can be
decreased for subsequent
runs to increase the accuracy
of the results as necessary.
Note that the multiplier of 2 for the maximum sonic velocity, known as the
courant factor, was derived assuming
that the velocity reaches the sonic
velocity (Mach number reaches 1). If
the Mach number does not reach 1
during the transient simulation, then
using two times the maximum sonic
velocity will be an overestimate for the
maximum velocity. This large maximum velocity allows for a stable solution, but also reduces the accuracy of
the solution since points R and L are
farther away from the grid points 1 and
3.
For simulations where the Mach number in the pipes remains significantly
below one for the whole duration the
accuracy can be increased by decreasing the courant factor, which should be
equivalent to one plus the maximum
pipe Mach number. Calculating the
courant factor using a mach number

Note: In xStream the courant factor
is adjusted based on the
Estimated Maximum Pipe
Mach Number During Transient defined in the Sectioning panel of Analysis
Setup. By default the estimated maximum pipe mach
number is fixed at 1, and can
only be changed if advanced
options are enabled.

Sectioning Effect on Accuracy
One of the largest sources of error in
xStream results from the interpolations performed to determine the
properties at points R, P, and L. To
increase the accuracy of calculations
the width between the grid points, Δx,
can be reduced by increasing the minimum number of sections. For a
detailed discussion on determining result accuracy, see the Transient Results Accuracy topic.

Sectioning Effect on Run
Time
As is discussed above, the accuracy
of the results in xStream will be closely
tied to the number of calculation sections. However, the more calculation
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stations there are, the longer the
required run time will be. xStream simulation times may require hours or
days to run, depending on the size of
the model and the computational
speed of the computer. For information on reducing run times see the
Minimizing Run Time topic.

Related Topics
Method of Characteristics
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number of sections used in
longer pipes in the model, therefore decreasing run time.
l

Set the Minimum Number of
Sections Per Pipe to 1 in the
Sectioning Panel.

l

Use the AFT Standard fluid library for fluid properties. Results
obtained using the AFT Standard library should always be
compared to results using one
of the higher accuracy fluid libraries.

Minimizing Run Time
Related Topics
Models built in AFT xStream can
experience long run times, sometimes
requiring hours or day to complete.
Ultimately, the best method to reduce
model run times is to work on a computer with a more powerful processor
and with higher read/write speeds.
There are modeling methods which
can be used to decrease the run time,
though these methods will typically result in some decrease in result accuracy. When using any of the following
methods the engineer should always
perform a sensitivity analysis to
determine what impact these changes
have on the accuracy of results.
l

Include losses from static components in the pipe Fittings &
Losses tab. This can be done
using the feature to combine
pipes.

l

Artificially increase the length
of the shortest pipe in the
model. This will decrease the

Transient Result Accuracy 45
Transient Sensitivity Analysis Tutorial
48
Reducing Run Time
485

Index 30
software designed for force
analysis.

Transient Forces
This section focuses on imbalanced
force calculations in xStream. Topics
included discuss how xStream calculates forces, what types of force
sets can be defined, and how to configure force calculations in xStream.

Contents
Defining Forces
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Exporting Force Data

34

Force Theory
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Defining Forces
AFT xStream includes the ability to calculate dynamic, unbalanced pneumatic forces. These unbalanced
forces occur when a transient pressure wave passes through a portion of
the system.
Note: As AFT xStream is only a
hydraulic solver, only
hydraulic forces are accounted for. AFT xStream is not a
pipe stress analyzer and as
such does not have the ability
to directly model piping supports or similar objects.
Hydraulic force files can be
generated for import into

Defining Force Sets
In order to process force data, the locations where the forces are to be calculated must be defined. Force Sets
can be defined either from the Workspace or from the Forces panel of the
Analysis Setup window.
Note: Force calculation accuracy in
AFT xStream is dependent
not only on accurately defining the force sets, but can
also be highly dependent on
the Sectioning and Fluid
panel settings. This is discussed further in the High
Pressure Steam - Forces
example.
Defining from Analysis Setup
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l

Generate Force Names - Automatically changes the names
for the selected force sets to
"upstream junction name downstream junction name"
using the names from the connected junctions on the workspace.

l

Point Force Ambient Pressure - If using a Point force set,
the ambient pressure is
required to calculate the force
balance. This defaults to the
Environmental Properties
value, but can be changed
here.

Figure 1: Force set data is defined on the
Force Definitions panel in the Analysis
Setup window

l

New - Add a new force set to
the table

l

Duplicate - Copy an existing
force set

l

Delete/Delete All - Remove
force sets

l

Swap Nodes - The calculation
will be the same, but the sign of
the force will be reversed. This
may be important for proper
interpretation of results or for
exporting data to other applications.

l

Import from CSV - If force sets
are defined in another application or by hand they can easily
be imported with a comma separated value file. Click the
Import from CSV button for an
explanation on the required
format.

Each individual force set has a number of required parameters:
l

Apply - Whether to include the
force set calculation. This
allows disabling force sets
without deleting them.

l

Force Type - There are several force set types available.
They are described in detail in
Force Set Types.

l

Force Set Name - A unique
name for the force set.

l

Start Pipe - Where the first
node is located.

l

Start Location - Force Sets in
xStream must have their endpoints at either the inlet or outlet of a pipe.

l

End Pipe - The second (for difference types) node. Note that
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the selection must be valid for
the specified force type. See
Force Set Types.
l

End Location - Force Sets in
xStream must have their endpoints at either the inlet or outlet of a pipe.

l

Pipe Group - For force sets
across 3+ pipes, a group is
required and is selected here.

l

Exit Area - For Exit type
forces, an exit area is required.

l

Force Unit Vector Coordinates - Define unit vectors for
your linear pipe to give the resulting forces a three-dimensional direction. xStream is still
only a one-dimensional fluid
modeling software, and specifying a unit vector will not
change the force calculations.
However, by defining the XYZ
vector for a given force set, that
data can be brought into other
software for further analysis
using the Export Force Data
tool. These unit vectors should
be defined based on the
coordinate system in the force
stress analyzing software that
the force sets will be exported
to.

Create Force Set window, shown
below in Figure 2. If multiple pipes are
selected, an individual Difference
Force Set will be created for each pipe
applying the specified settings for
each.

Figure 2: Create Force Set window in the
Workspace

Each force has several required and
optional parameters:
l

Pipe Name - If the pipe has a
name entered other than 'Pipe',
the user can choose whether to
include that pipe name or not in
the Force Set name.

l

Force Set Name - Users can
add a name for the Force Set to
better organize and manage
Force Sets in the model.

Defining from the Workspace
Force Sets for individual pipes can be
defined directly from the workspace by
right-clicking on a selected pipe.
Choose the Create Force Set With
Selected Pipe... option to launch the
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l

l

Force Unit Vectors or Length
- Define unit vectors for your linear pipe to give the resulting
forces a three-dimensional direction. xStream is still only a
one-dimensional fluid modeling
software, and specifying a unit
vector will not change the force
calculations. However, by defining the XYZ vector for a given
force set, that data can be
brought into other software for
further analysis using the
Export Force Data tool. These
unit vectors should be defined
based on the coordinate system in the force stress analyzing software that the force
sets will be exported to.
Show Analysis Setup Force
Panel after Creation - If
checked the user will be
brought to the Force panel of
the Analysis Setup window to
view all Force Set information
defined for that scenario.

Related Topics
Force Definitions Panel

xStream:
l

Point - Point forces are simply
the difference in pressure
between the fluid and ambient
multiplied by the pipe area.
This can be useful for places
where the fluid is leaving the
system, such as a relief valve
or exit valve.

l

Difference - Difference forces
are defined as the unbalanced
force between two nodes, or
computation stations along two
sequential pipes. An example
of this is the pneumatic loading
between two elbows along the
length of a pipe. See Figure 1
below.

l

Difference Exit - Similar to the
difference force set in that two
nodes are required. However,
the user defined exit area will
be used for calculating the
force across the section. This is
useful for modeling forces on
something such as a nozzle.

l

Difference (3+ Pipes) - The
same as difference forces, but
spans across more than two
pipes. A pipe group must be
defined that contains the pipes
between the two locations. The
Difference (3+ Pipes) force set
type must still include only
sequential pipes.

l

Difference Exit (3+ Pipes) The same as difference exit,
but spans across more than
two pipes, requiring a group.
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High Pressure Steam Forces Example
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Force Set Types
There are several types of forces that
can be defined for analysis with AFT
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may only be set to lbf or N as these
are the only units accepted by
CAESAR II.
Note: Force Set unit vectors can
only be exported to CAESAR
II (v12 and higher) and
AutoPIPE. To export any
Force Sets to AutoPIPE,
users must have defined
force unit vectors for each
Force Set.
Figure 1: Difference force type schematic.
For Difference Exit, the area used at End
Node is user defined

Related Topics
Force Definitions Panel

94

Related Examples
High Pressure Steam Forces Example

588

Exporting Force Data
The transient force data can be exported by selecting the Export Force File
from the File menu while viewing the
Output window.
CAESAR II, TRIFLEX, ROHR2, and
AutoPIPE Force Files can be selected.
The time frame of interest, quantity of
data points, force balance components, and units can be customized.
Note that the units for CAESAR II files

Figure 1: Exporting force results to a
Caesar II Force File

Related Topics
Force Definitions Panel
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l

All piping and components are
assumed to be completely
rigid. No deflections or deformations are considered.

l

The force due to fluid and piping weight is neglected.

l

The volume of any junctions
(bends, valves, etc.) is considered negligible. This is consistent with how junctions are
modeled throughout AFT
xStream.

l

All Difference Force sets comprise a pipe or set of pipes that
are axially aligned between the
beginning or ending nodes.

l

Both beginning and ending
nodes for a Difference force set
type are assumed to be 90
degree elbows.

l

The total force acting on the piping is assumed to be equal and
opposite to the forces acting on
the fluid.

Related Examples
High Pressure Steam Forces Example
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Force Theory
The force solution methods in AFT
xStream are intended to calculate the
unbalanced pneumatic loading on a
series of axial aligned pipes rather
than the total forces on those same
pipes. Thus, most systems will see
steady-state forces calculated as
zero. However, systems such as an
exit nozzle will see a non-zero steady
state force, since there is a hydraulic
force imbalance across that valve
even at a steady flow rate.
It is important to keep in mind that AFT
xStream is not a tool built for the analysis of pipe stress. In real systems,
the configuration and location of supports, the deflection of pipes and components, and other effects of dynamic
loading should be considered. All piping and components in AFT xStream
are considered to be perfectly fixed in
time and space, unless directed to
change in a specified way, such as a
valve closure. The forces that can be
calculated by a hydraulic solver such
as AFT xStream are only unbalanced
hydraulic forces - not forces or
stresses in pipe walls or supports.
Considering the above, the calculations for forces proceed under the
following assumptions:

Note: Forces calculated in
xStream are always referenced as defined by the
force set inlet and outlet. The
reference direction for each
pipe does not affect the
forces calculated.
A complementary resource to this discussion is an AFT whitepaper titled
Evaluating Dynamic Loads in Piping
Systems Caused by Waterhammer,
available on our website.

Index 36

Difference Force Set Calculations
A Difference Force Set effectively represents the force between two elbows
along a pipe. An example case for a
difference force set can be considered
for a stretch of pipe at constant elevation with a valve in the middle, as
depicted in Figure 1 below.

using the equation F=m*a. xStream
uses this equation to determine the
overall reaction force from the change
in fluid velocity at each time step.
Equation 1 below shows how xStream
determines the force from the fluid
acceleration.

(1)

Using Equation 1 above, xStream
takes the change in mass flow rate
between the previous time step and
the current time step to determine the
change in velocity (and thus acceleration) of the fluid in each section to
give the unbalanced force in each section. The total force for each pipe is
then given by the sum of forces for all
sections in a pipe.
Figure 1: Simplified force diagram for
fluid flow in a pipe

With flow through such a pipe, multiple
forces act on the fluid, including friction, pressure, gravity (which AFT
xStream neglects for force set calculations), normal forces from the pipe
to the fluid, and forces due to changes
in fluid momentum as flow is redirected through the elbows. Only forces
which are axially aligned with the pipe
will be considered.
Newton's second law relates these
forces to the acceleration of the fluid,

In the steady state system, the total
unbalanced hydraulic forces sum to
zero, as the fluid has no acceleration,
and thus no net forces acting on it.

Point Force Set Calculations
Point and Exit Force Sets in xStream
represent the force caused by the pressure differential between the fluid and
the ambient conditions. The Point
force uses Equation 2 below. Note
that this force is assumed to be
applied over the flow area of the pipe.
This assumption may not always be
valid. For example, a blind flange
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would see the entire Point force, but a
smaller tap on the side wall of a pipe
would not.
(2)

true, xStream uses the
approaches described above
instead. If the approach implemented in xStream is used
on an incompressible fluid in
Impulse, the resulting forces
are the same as those calculated using the component-based approach in
Impulse.

Exit Force Set Calculations
The Exit force captures the same fluid
acceleration as the Difference Force
Set, but also captures the force due to
fluid exiting the system at the end of
the force set. To do so, xStream
accounts for the momentum change
through the exit, as shown in Equation
3 below. Here, N is the final pipe section of the force set, connected to the
exit.

(3)

Note: Users of AFT Impulse may
be familiar with the component-based approach
Impulse uses to determine
the total unbalanced
hydraulic forces acting on a
system. That approach has
an implied assumption of constant density. Since the
assumption of constant density in xStream does not hold

Related Topics
Force Definitions Panel

94

Related Examples
High Pressure Steam Forces Example
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also be created for Multiple Scenarios.

Interpreting Transient
Results

Creating an Animated Graph
This section discusses how to begin
understanding complex transient results. Topics included discuss how to
use the output animation features in
the Graph Results and Visual Report
windows, and how to interpret transient results accuracy.

Since animations display information
along a flow path, only Profile type
graphs may be animated.

Contents
Animating Graph Results
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Animating Visual Report Results 40
Transient Result Accuracy

45

Transient Sensitivity Analysis
Tutorial

48

Animating Graph Results
Animating the results of a transient
simulation is a powerful way to understand how a system is behaving. Plots
of fluid parameters at a given location
over time are valuable and easy to
interpret, but they cannot directly convey the most important aspect of a
fluid transient event: how the pressure
and flow waves propagate through a
system and interact with one another.
Animating the results of a transient
simulation allows these effects to be
observed directly. Animations can

Figure 1: Options for animation under Profile type graphs in the Graph Results window

Profile graphs are animated using the
output saved for each computation station in the model. By default, output is
saved for all stations in an xStream
model. Profile graphs cannot be animated if the Inlet/Outlet stations for each
pipe are the only computation stations
where output is saved. To allow animation, the user must have the "Pipe
Stations To Include In Transient Out-
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put File" set to All on the Pipe Sectioning and Output panel.

l

Record - Begin playing the
animation from the current
step, and when the playback is
stopped, prompt the user to
save an .mp4 video recording
of the animation to file.

l

Stop - Halt the animation and
reset the time to zero.

l

Pause - Pause the animation
at the current time.

l

Time - The actual simulation
time of the currently displayed
data.

l

Step - The simulation step of
the currently displayed data.

l

Time/Step slider - Seek for a
certain point in the animation.

l

Speed slider - Change the
speed of the playback.

l

Default - Reset the speed to
default.

Using an Animated Graph
Once the animated graph is created, it
will look much like a normal Profile
graph, but a few components have
been added.

Figure 2: Components added to the
Graph Results window when animating a
Profile graph

The animation toolbar has several controls:
l

Play - Start the animation from
the current time.

By default, the graph will display the
current values for the time step as well
as the maximum and minimum profiles. These can be hidden or displayed in the graph Parameter
selection area, like any other Profile
graph. The Steady-State solution can
be displayed, as well as applicable
Design Alerts.
The Current Time box can be moved
anywhere within the Graph area.
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Using Animations to Interpret Behavior
There are many ways that animations
are helpful in interpreting behavior.
Below, we consider the case of an
instantaneous valve opening.
Like normal Profile graphs, multiple
parameters can be displayed and
animated as a single Graph List Item.
The images below show the relationship between pressure and flow
(velocity) for this case at the beginning
and partway through the animation.

Figure 4: The movement of the wave
within the pipe can be directly visualized

Animating Visual Report
Results

Figure 3: Animation showing steady-state
(time step zero) results

Animating the results of a transient run
is an extremely powerful way to understand how a complex system is behaving. While transient plots of fluid
parameters over time at a given location are valuable and easy to interpret, they do not directly convey the
most important aspect of a fluid transient event - how the pressure and
flow waves propagate through a system and interact with one another.
Animating the results of a transient
simulation allows you to observe
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pipes being animated.
xStream will then automatically generate
evenly spaced values in
between the absolute
minimum and maximum
which will be displayed
on the color scale.

these effects directly.
Unlike the Graph Results Animation
feature, Visual Report Animation
provides the added benefit of being
able to observe how waves propagate
through branching paths and similar
situations which are not restricted to
one continuous flow path.
l

Relative Changes This option displays the
changes in the transient
results relative to the
steady state values in
order to animate the
delta throughout the run.
xStream will determine
the maximum and minimum changes from the
steady state, then automatically generate
evenly spaced intervals
between these values to
display on the color
scale.

l

Maximum Values - This
option does not animate
the data, but instead colors the pipes based on
the maximum values during the transient for each
of the pipe stations.

l

Minimum Values - This
option does not animate
the data, but instead colors the pipes based on
the minimum values during the transient for each
of the pipe stations.

Saving Output for Animation
The Visual Report Animation feature
works by referencing the output for
each computational pipe section in the
animated pipes. In order to accomplish this, data for each pipe station
being animated must be saved to the
output file. xStream will save the data
for all pipe stations by default. The
pipe station output settings can be
changed on the Pipe Sectioning and
Output panel if needed.

Creating an Animation
To enable animation in the Visual
Report, the Display Mode will need to
be set to "Animate" in the Visual
Report Control window.
When Animate is selected, the following Animation Settings become
available.
l

Data Type
l

Absolute Values - This
option directly uses the
transient values for the

l

Parameter to Animate - The
parameter and units for the
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animation can be selected
l

l

Auto Scale - If this box is
checked, xStream will automatically choose the maximum
and minimum values for the
selected parameter to assign
the color scale for animation.
This box is checked by default.
Maximum - The maximum
value for the color scale can be
changed here if the Auto Scale
box is unchecked

l

Minimum - The minimum value
for the color scale can be
changed here if the Auto Scale
box is unchecked

l

Smooth colors between pipe
sections - This choice sets the
color gradient on the Visual
Report to be displayed as a
smooth transition, rather than
an abrupt transition in color.

l

Borders between pipe sections - This choice displays
lines on the pipes to explicitly
delineate the sections. This can
only be enabled if the smooth
colors option is disabled.

l

Pipe Thickness - This option
adjusts the thickness of the
colored animation pipes. The
thickness of the original pipes
can be adjusted in the Pipe
Properties window on the
Optional tab.

l

Junction Size - This option
allows the size of the junctions
in the Visual Report window to
be adjusted for the animated

model. The junctions can also
be set to 0% to automatically
hide all junctions. This sizing
will only be applied on the
Visual Report window.
l

Use Lines for Junctions This option allows the junctions
to be represented as bold lines
instead of symbols as an alternate method of displaying the
junction locations.

l

Defaults - This button allows
the user to reset the Visual
Report Animation settings to
the defaults.

It should be noted that once the animation settings have been changed for
a scenario, those settings will be
retained even if the scenario is re-run.
Each scenario can retain different
Visual Report Settings if desired; however, there is no way to save multiple
Visual Report configurations within the
same scenario.
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Figure 2: Components added to the
Visual Report window when using the
animation display mode
Figure 1: Options for the Animate display
mode in Visual Report Control

Viewing Animation
Once the Visual Report Control Settings have been configured and the
visual report has been shown, several
animation-specific components will
appear, including the animation toolbar and Visual Report Animation tab,
as shown below.

The Visual Report Animation tab in the
Quick Access Panel provides quick
access to the Animation Settings from
the Visual Report Control window, as
well as allowing the user to select
which pipes will be enabled for animation. When disabled, the pipe will
simply be shown using the workspace
settings. Pipes that are not being animated can be hidden in the Visual
Report Control window on the Show
Selected Pipes/Junctions tab.

The animation toolbar has several controls:
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l

Play - Start the animation from
the current time.

l

Record - Begin playing the
animation from the current
step, and when the playback is
stopped, prompt the user to
save an .mp4 video recording
of the animation to file.

l

Stop - Halt the animation and
reset the time to zero.

l

Pause - Pause the animation
at the current time.

l

Time - The actual simulation
time of the currently displayed
data.

l

Step - The simulation step of
the currently displayed data.

l

Time/Step slider - Seek for a
certain point in the animation.

l

Speed slider - Change the
speed of the playback.

l

Default - Reset the speed to
default.

The Current Time box and Scale can
be moved anywhere within the Graph
area.

Using Animations to Interpret Behavior
There are many ways that animations
are helpful in interpreting behavior.
Below, we consider the simple case of
a valve closure.

Figure 3: Animation showing steady-state
(time step zero) results
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Figure 4: Velocity slows at the valve as
the valve rapidly closes, and increases
elsewhere

Figure 5: The movement of the wave
within the pipe can be directly visualized

Transient Result Accuracy
Modeling transient, compressible flow
in a pipe network is an inherently
imprecise endeavor. Individually modeling transient flow, compressible
flow, or transient compressible flow in
a single pipe can be done to a high
degree of precision, but the practical
application of all three factors forces
limiting assumptions to be made. AFT
xStream is no exception. The methods
it employs start from three fundamental equations: conservation of
mass, momentum, and energy.
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However, solving those equations on
a practical scale requires several limiting assumptions that introduce some
amount of error into the results. The
derivation process and these assumptions are discussed in detail in the
Transient Theory section.

system such as an AFT xStream
model, these assumptions introduce a
potentially significant amount of error
as the compressible nature of a gas
means flow parameters and fluid properties are changing continuously in
time and space.

As the user analyzes and interprets
their transient results, it is important
they keep in mind how the assumptions behind the MOC solution introduce error, how to gauge that error,
and how to reduce that error.

Users of AFT Arrow may be familiar
with how Arrow captures the continuously changing nature of compressible flow. Arrow calculates
results at intervals along a pipe which
are adjusted based on the change in
Mach number, thus the compressible
flow effects along a whole pipe are
accurately captured even though properties between computation stations
are assumed to change linearly.

Sources of Error
The MOC solution process includes
multiple assumptions, with two
primary assumptions being made.
First, flow parameters are assumed to
vary linearly between computation stations, allowing linear interpolation to
be performed. Second, fluid properties
are assumed to be constant while
integrating along characteristic lines,
allowing those integrals to be solved
directly. In effect, this means that fluid
properties are only updated once per
time step, with their change over time
assumed to be linear.
The nature of the MOC solution forces
both assumptions to be made. The
MOC solution requires that the time
step at each location in the system be
uniform, meaning the section length
must also be held constant. In an
incompressible fluid system such as
an AFT Impulse model, these assumptions introduce a minimal amount of
error. However, in a compressible fluid

xStream however, does not have the
ability to adjust the locations at which
properties are calculated to be specific
for an individual pipe. Section lengths
must be held constant across all pipes
in a system. Adjusting the location of
computation stations along a single
pipe would require the time step to
change across the simulation, which
in turn could cause time to run faster in
some parts of the system than in others.

Gauging Error
These assumptions have the major
implication that mass and energy may
not be perfectly conserved along the
length of a pipe. The error introduced
by these assumptions increases as
the compressible flow effects become
more pronounced. At low Mach
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numbers, mass and energy can be
almost perfectly conserved, while near
the sonic velocity, potentially significant amounts of mass and energy
may escape the system.
Users can gauge this error in their system via two means. The first is more
quantitative and is performed for the
user by xStream. Prior to implementing the MOC transient solver,
xStream solves the system once using
the same computational methods as
used by Arrow, and once by running
the MOC solution without any transient events to determine the MOC
Steady Solution.
The mass and energy loss along a
pipe in the MOC Steady Solution can
then be quantified. The mass and
energy flow out of each pipe are subtracted from the mass and energy flow
into each pipe. In a nominally steadystate system, the difference should be
zero. However, the assumptions
behind the MOC solution mean this difference may not be zero. The steadystate error is reported in the Solution
Progress window, and the simulation
process will be halted if the steadystate error exceeds the allowable set
points. Figure 1 below, shows what
that reported error and halted solution
looks like. It is important to note that
this quantitative approach to gauging
error is only valid for a steady-state
system. A transient system will inherently see differences in inlet and outlet
mass and energy flows as waves
travel along each pipe.

Figure 1: Solution Progress window showing an example model with high mass and
energy conservation error

The second approach users can
employ to gauge the error in their systems is more qualitative and must be
performed by the user. Flow parameters and fluid properties change
more rapidly in time and space at
higher Mach numbers than they do at
lower Mach numbers. Thus, in a system which sees high velocity or sonic
choking either in steady state or during the transient simulation, users can
expect to see relatively large mass
and energy losses compared to systems with low velocities throughout.
While users cannot directly quantify
those losses, they can expect to be
more confident in the results determined by xStream at lower velocities.

Reducing Error
The best way to minimize the error
associated with the assumptions by
the MOC solution process is to
increase the number of sections in
each pipe, which also decreases the
time step in the simulation. This
approach is similar to how Arrow captures compressible flow effects in
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steady-state systems. By calculating
system parameters more frequently,
the assumptions the MOC solution process makes are violated to a lesser
degree.
In the Sectioning panel of the Analysis
Setup window, users define the minimum number of sections a pipe can
have. Setting a minimum section number of 5 means the shortest pipe must
have at least 5 sections. Increasing
that number forces xStream to use
smaller section lengths throughout the
entire system.

Related Topics
Transient Flow Equations 406
Method of Characteristics 411
Transient Solver Initialization Panel
91
Minimizing Run Time
29
Transient Sensitivity Analysis Tutorial
48
Reducing Run Time
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model used, and the estimated Maximum Mach Number in Pipe value.
We will use the model shown below in
Figure 1 of a system with an abrupt
stoppage of flow at a Turbine Shutoff
Valve (TSV) to indicate how a user
might analyze results and refine these
inputs over subsequent runs. To help
quantify how these parameters impact
the transient simulation results, we will
look at transient forces in the system,
using a Difference Force Set applied
to each pipe. Please note that this
tutorial is not meant to be an exact
step-by-step procedure to follow, but
is instead meant to be a general
guideline to help the user better understand how to evaluate xStream results.

Transient Sensitivity
Analysis Tutorial
AFT xStream requires a large number
of inputs to be defined in order to run a
transient simulation. Many of those
inputs directly affect the transient simulation results, and it is important for
users to carefully evaluate that effect.
This tutorial will focus specifically on
three parameters: the Minimum Number of Sections per Pipe defined in the
Sectioning Panel, the Fluid Property

Figure 1: Layout of Tutorial Example
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Baseline Results
We must start our sensitivity analysis
by determining some baseline results
for the system. The first run of the
model uses standard settings for all
inputs: AFT Standard Steam using the
Three-Parameter method, the default
Maximum Pipe Mach Number During
Transient of 1, and a Minimum Number of Sections per Pipe of 10. Force
results from this run for Pipes 2,3,8,
and 9 are shown below in Figure 2.
Pipes P2 and P9 see the largest transient forces in this model, mostly
because P2 and P9 are 120 ft long
with the other pipes in the system are
40 ft long. Transient forces are caused
by the presence of transient waves
with some pressure differential across
them traveling through the system. A
longer pipe which is long enough to
contain the entire wavefront will see a
larger pressure differential across it
than a shorter pipe which only ever
sees a portion of the wavefront. Thus,
longer pipes tend to see larger transient forces, with the maximum transient force seen when the entire
wavefront is shorter than the pipe
length.
We can also see that P2 experiences
a significantly higher maximum transient force than P9 even though they
have the same length. This difference
is due to wave coalescence (or wave
steepening). A wave moving through a
gas raises the local temperature, in
turn raising the local sonic velocity.
The temperature and sonic velocity
behind the wavefront is thus higher
than that ahead of the wavefront,

meaning the back of the wavefront
can have a higher wave velocity (V+a)
than the front of the wavefront. As the
wave travels, the back of the wavefront will catch up to the front of the
wavefront, steepening the wave until a
shock wave is formed.
In this example, P9 is closer to the transient event at J11, and the wavefront
is still relatively dispersed. However,
the wavefront has steepened by the
time it reaches P2, meaning more of
the wavefront can fit in P2 and a larger
transient force is seen.
This tutorial will focus on the transient
force results from P2, as they are the
largest magnitude forces in the model.
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Figure 2: Force Results for AFT Standard,
10 Minimum Sections, Standard Maximum
Mach Number in Pipe

Minimum Number of Sections Per
Pipe
The first parameter for our sensitivity
analysis is the Minimum Number of
Sections Per Pipe. The baseline scenario used a minimum of 10 sections,
and we will also run scenarios with a
minimum of 50 and 100 sections. All
other inputs are held constant, and results for the P2 Force Set are shown in
Figure 3 below.
Comparing the 10 section and 50 section scenarios, the 50 section scenario
gives a force that is 1,013 lbf higher
than the 10 section run (or approximately a 5.6% difference). This difference indicates that using a
minimum of 10 sections was too low,
since using a finer grid has a noticeable effect. However, the 50 section
and 100 section scenarios have minimal differences in the force results.
This similarity indicates that the error
inherent to applying the Method of
Characteristics (MOC) to a compressible fluid may have been
reduced when using a minimum of 50
sections, and using a finer grid will not
reduce that error further.
We now know that 50 sections is a
good point to balance accuracy with
run-time concerns.

Figure 3: Effect of Sectioning on Forces

Fluid Property Model
The next parameter for our sensitivity
analysis is the Fluid Property Model.
The baseline scenario used
AFT Standard Steam with the ThreeParameter equation of state, and we
will also run scenarios using AFT
Standard Steam with the RedlichKwong equation of state, Chempak
Steam, NIST REFPROP Steam, and
ASME Steam. All other inputs are held
constant, and results for the P2 Force
Set are shown in Figure 4 below.
The results shown in Figure 4 below
show that the Fluid Property Model
can have a substantial impact on
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results. The largest difference in results is between the Chempak and Redlich-Kwong results, with an absolute
difference of 3,327lbf, or a relative difference of 18%.
The observed difference in transient
force magnitude for various Fluid Property models forces us to evaluate
which model is best suited for this system.The Redlich-Kwong and ThreeParameter equations of state were
developed for light, non-polar
molecules - hydrocarbons in particular. Water (or steam, in xStream) is
a relatively light molecule which is
highly polar, meaning the accuracy of
those Fluid Property models may be
reduced when evaluating the steam in
this system. Chempak has an
increased accuracy from the AFT
Standard Steam models, and gives
force results which are substantially
higher. It is difficult to say how reliable
the Chempak results are until we compare them against other models.
Finally, the scenarios using
NIST REFPROP Steam and
ASME Steam give effectively identical
results, and the source for each model
(NIST and ASME, respectively) is
highly reliable. We can thus say that
these results are the most reliable results, and they should be used for subsequent runs of our model. The only
distinguishing factor between these
two Fluid Property Models is the
model run time, where the
NIST REFPROP model will run significantly faster than the ASME Steam
model. See the Fluid Property Model
example for more information on this
topic.

To learn more about the strengths and
weaknesses of each fluid property library, visit the Fluid panel topic. Note
that while the NIST REFPROP and
ASME Steam models may offer
improved accuracy, the AFT Standard
fluid models run significantly faster.
Users should always use the
AFT Standard fluid models for initial
runs as the xStream model is gradually refined.

Figure 4: Effect of library on Forces (minimum 50 sections used in each pipe,
ASME Steam has indistinguishable differences from NIST REFPROP and thus
cannot be seen in this figure)
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Effect of Maximum Pipe Mach Number During Transient
The last parameter for our sensitivity
analysis is the Maximum Pipe Mach
Number During Transient, defined in
the Pipe Sectioning and Output panel.
The MOC grid size is determined by
the wave velocity (V+a), using the
maximum estimated sonic velocity.
This maximum sonic velocity is in turn
a function of the Estimated Maximum
Pipe Mach Number During Transient
and the Estimated Maximum Pipe
Temperature During Transient input
parameters. Refining the estimated
maximum sonic velocity can improve
the accuracy of our results by reducing the amount of interpolation necessary while performing the MOC
calculations.
The results for our model when using
a minimum of 10 sections and ASME
Steam show a Maximum Mach Number of 0.06, seen in Figure 5 below.
Reducing the Estimated Maximum
Pipe Mach Number During Transient
from the default value of 1 to a value
closer to 0.06 may improve our results.
Figure 6 below compares transient
force results with Estimated Max
Mach Numbers of 1, 0.5, and 0.1. A
scenario with 50 sections is included
as a reference for what the expected
results are, based on our previous analysis of how sectioning affects results.
We can see that better estimates of
the Max Mach Number for the transient simulation bring the results with
10 sections closer towards the 50 section reference results. However, better

estimates for the Max Mach Number
are unable to make the 10 section results match the 50 section results, indicating that the user should use the
Estimated Max Mach Number parameter to compliment adding additional
sections rather than to replace adding
additional sections.
Caution: Never define the Estimated Maximum Pipe Mach
Number During Transient
lower than the value
observed in the system! An
estimate lower than the
actual value will force the
MOC calculations to extrapolate, which can add significant instability and
uncertainty to the results. Output which shows that the specified maximum Mach
number was exceeded
should be disregarded, and a
better Estimated maximum
Pipe Mach Number During
Transient should be defined.

Figure 5: Maximum Mach Number
obtained from 10 Sections, ASME Steam,
Maximum Mach Number of 1
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waves, a different shape of the wavefront, and a difference in the maximum
force magnitude of 2,512lbf.
These differences help show the
importance of gradually refining the
model input parameters. Initial runs
should be performed with default or
more simple options which have faster
run times as the user starts to understand the system. Then, the user
should refine the inputs for more
advanced parameters to reduce the
uncertainty in their results.
Note that some systems may be more
sensitive or less sensitive to the three
parameters considered in this tutorial.
The user should follow these steps on
their own system and use their engineering judgment to determine the best
model inputs.

Figure 6: Effect of Maximum Pipe Mach
Number During Transient on Forces

Comparing Initial and Optimized
Inputs
Our sensitivity analysis on Minimum
Number of Sections Per Pipe, Fluid
Property Model, and Estimated Maximum Mach Number in Pipe showed
what inputs to use for this model. Figure 7 below compares the initial results (10 minimum sections, AFT
Standard Steam with the Three-Parameter equation of state, and a Max
Mach Number of 1) against the final
results (50 minimum sections, ASME
Steam, and a Max Mach Number of
0.1). These transient force results
show a different timing of the transient
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Reducing Run Time
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Related Examples
High Pressure Steam Forces Example

Figure 7: Initial Run vs Modified Run
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Fundamental Modeling
Concepts
This section focuses on the critical concepts and theories that comprise the
model building process in
AFT xStream. Topics include discussions on the role of pipe and junction objects, descriptions of how
boundary conditions and flow direction
are specified, and instructions on how
to model closed systems.
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Pipes and Junctions
AFT xStream employs two fundamental pipe system constructs:
pipes and junctions.
Pipes are conduits for one-dimensional gas flow. Pressure drop due to
friction occurs in pipes.
Junctions are connector points for
pipes and are elements at which flow
balances are made and where transients are initiated. Some junction
types can only connect to one pipe;
others can connect with up to twentyfive.
In addition to balancing flow, junctions
also influence the flow or pressure
behavior of the system. For example,
an infinite tank junction applies a constant pressure at a location, and the
flow there is free to adjust in whatever
manner is consistent with the governing equations. In contrast, an
assigned flow junction applies a
known flow rate at its location, allowing the pressure to adjust to that level
dictated by the governing equations.
The various junction types allow you
to specify special kinds of transient
behavior, irrecoverable pressure
losses, or fluid behavior.
Junctions communicate with each
other through the pipes connecting
them. Each pipe must be connected to
two junctions. There are no exceptions to this rule.
A pipe differs from a junction in that it
has a reference positive flow direction.
To say a pipe has a flow rate of 1
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lbm/sec is meaningless unless the
flow direction is specified.
In general, you do not need to specify
the actual flow direction in a pipe,
because AFT xStream sorts out the
true physical flow directions of the system you define. For example, if you
specify the reference positive flow direction from left to right, and the solution is in fact the opposite direction,
then that information will be presented
in the output as a negative flow rate.
Inlet and outlet conditions correspond
to the reference positive flow direction,
not the actual flow direction. However,
for easier analysis of results, it can be
helpful to ensure all pipes are configured so that they have positive flow
in the steady state system.
It is important to specify the proper
flow direction for pipes which connect
to junctions such as compressors/fans
or control valves. AFT xStream uses
the flow direction of the pipes to
determine in which direction to
increase or reduce pressure.

Features for Modeling
Irrecoverable Losses
AFT xStream works almost exclusively with the concept of the loss
factor, also known as K factor or resistance factor. In some Properties windows, other popular methods for
specifying loss information are
provided where they are consistent
with the loss factor method. For
example, you will find Cv (flow coefficients) for valves. No provision has

been made for the equivalent length
approach to solving pressure drop
problems. See the Junction Loss
Models section for more information.

Related Topics
Conventions for Specifying
Base Area
187
Pressure Drop in Pipes Detailed Discussion
180

Convention for Positive
Flow Direction
Reference Positive Flow Direction
Next to each pipe's ID number is an
arrow that indicates the reference positive flow direction for the pipe. AFT
xStream assigns a flow direction corresponding to the direction in which
the pipe is drawn. You can reverse the
reference positive flow direction by
choosing Reverse Direction from the
Edit menu or selecting the reverse direction button on the Toolbar.
The reference positive flow direction is
used for reference purposes only and
need not be the actual flow direction. If
the reference positive direction is the
opposite of that obtained by the
Solver, the output will show the flow
rate as a negative number.

Index 57

Convention for Flow Entering
and Exiting
Many of the junction types permit fluid
flow to come into or pass out of the system in a prescribed manner. The most
obvious of these is the tank junction.
Tanks maintain a constant pressure at
a node, and the flow adjusts according
to the governing equations. While in
principle the gas is stored or removed
from the tank, AFT xStream considers
the gas as coming into or going out of
the system. The stored tank fluid is not
part of the system.
The convention for defining inward or
outward flow for the system or any
AFT xStream object is that flow in is
positive (that is, the object gains the
flow) and flow out is negative (the
object loses the flow).

should never be used as a "black box".
Your model input and output should
always be carefully reviewed.
To make the most effective use of AFT
xStream, you should follow these
guidelines:
l

Be aware of what AFT xStream
can and cannot do and the
assumptions it makes.

l

Learn and use the tools in AFT
xStream that are appropriate
for the specific analysis you
want to perform. Detailed and
accurate answers demand
detailed and accurate input.
Quick and dirty answers
require less detailed input.

l

Learn and use the tools in AFT
xStream that allow you to process information in the formats
that mean the most to you.
Because pipe flow applications
vary so much within different
industries, AFT xStream is customizable for the way you want
to do your pipe flow work.
Understanding the tools will
help you gain greater conceptual control over your pipe
flow analysis and reduce modeling errors.

l

Check your input data. Use the
features available in AFT
xStream to review your results
for input errors. Pay attention to
the information in the output
report. Don't neglect warnings
in the output. Perform hand analysis checks of results.

Philosophy of Computer
Modeling
Some might say that a "good" computer model is one that accurately predicts the response of a system; but
this is only partly true. The practicing
engineer generally must weigh the
accuracy of the model against the risk,
schedule, and/or budget involved.
Through experience an engineer
learns where to focus resources and
when an answer is good enough to
base important decisions on.
Although AFT xStream is designed to
speed up the modeling process, it
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l

l

Bound your problem. Instead of
trying to calculate the exact resistance in a network, or the
right loss factor for an orifice,
use your judgment, guided by
data, on how much variation
might occur. By running your
model at the upper and lower
limits, you can obtain answers,
for example, on the maximum
and minimum possible pressure drops in the system. If the
results at the maximum and
minimum are acceptable, your
analysis is probably finished. If
they are not acceptable, you
can further refine the input
model.
Recognize whether your problem is one of maximization or
minimization. That is, recognize whether the design goal is
to minimize the flow rate, for
example, or maximize the flow
rate. Then make your assumptions conservative enough to
provide high confidence that
your design requirements are
being satisfied.

Related Topics
Overview of AFT xStream 17
xStream Learning Resources 21
Primary Window Overview 261
Overview of Fluid Transients 25
Related Examples

Tank Blowdown Example
(English Units)
510

Role of Pressure Junctions and How They
Work
Role of Pressure Junctions
In modeling a generalized pipe network, it is possible to construct models
that do not have a unique solution. A
common occurrence of this is when a
model contains one or more sections
which are completely bounded by
known flow rates. The simplest
example is the system shown in Figure 1. In AFT xStream terms, the system has two assigned flow junctions.

Figure 1: Model with two assigned flows.
This model does not have a unique solution

Obviously, the flow in the pipe is
known. But what is the pressure at the
inlet? At the outlet? It cannot be
determined because there is no reference pressure. The reference pressure is that pressure from which other
pressures in the system are derived.
There can be more than one reference
pressure, but there always has to be
at least one.
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The model in Figure 1 can be built with
AFT xStream and if you try and run
this model, AFT xStream will inform
you that it cannot run it because of the
lack of a reference pressure (Figure
2). In AFT xStream there are several
junctions that can act as a reference
pressure: the tank, assigned pressure,
valve (with the exit valve option), and
pressure control valves.
When you try and run a model that has
one or more sections completely
bounded by known flows (or Flow Control Valves or Compressors/fans operating in assigned flow mode), the
Need Reference Pressure window
(shown below) is displayed. This window informs you which junctions
bound the sections where a reference
pressure is needed to obtain a unique
solution.
In multi-pipe systems there are a host
of other possibilities that present themselves. All other configuration possibilities which lack a reference
pressure ultimately boil down to the
same problem that exists in Figure 1.
See Role of Pressure Junctions Detailed Discussion (Long) for more
information.

Figure 2: AFT xStream message when
you try to run a model without sufficient
reference pressures

How Pressure Junctions
Work
Pressure junctions (e.g., Tanks or
Assigned Pressures) in AFT xStream
are an infinite source or sink of fluid.
This means that they can draw or discharge as much fluid as is necessary
to maintain the specified pressure.
Some engineers have difficulty grasping this concept, and misuse pressure
junctions in AFT xStream. This section
offers a physical example of how pressure junctions work to clarify for those
having difficulty with the concept.
Consider the physical system shown
in Figure 1. This system compresses
air from a low pressure supply tank to
a high pressure discharge tank.
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Figure 1: Physical compressor system to
transfer air from low pressure tank (J1) to
high pressure discharge tank (J2)

An engineer is tasked with sizing the
compressor for this system. The engineer has an idea of the discharge pressure needed for the compressor, and
builds an AFT xStream model as
shown in Figure 2. The Figure 2 model
is attempting to represent the physical
system in Figure 1, but it in fact represents the physical system in Figure
3.

Figure 2: Model to size compressor
attempting to represent system in Figure
1, but actually represents the system in
Figure 3

Figure 3: Physical system represented by
model in Figure 2

Why? Because the tank junction (J4),
which is an infinite source of fluid, has
been located between the compressor
(J3) and the discharge tank (J2). The
J4 tank isolates the supply tank and
compressor (J1 and J3) from the discharge tank (J2). The J4 tank is very
much like placing the atmosphere
between the supply and discharge piping.
If the engineer changes the pressure
in J4, it is like changing the atmospheric pressure. It will change the
flow rate in the pipes, but no matter
how high the pressure of J4, it does
not change the fact that the compression system is isolated from the
discharge tank. The flow rate in the piping from J4 to J2 is entirely dependent
on the difference in pressures
between J2 and J4, and is not influenced by the J3 compressor in any
way.
How then should the physical system
in Figure 1 be modeled? It should be
modeled as shown in Figure 4.

Index 61
then whatever is delivered by the Tank
junction to the system will also be
received from the other pipes, thus
achieving a net zero outflow rate for
the system.
Figure 4: Proper model of physical system shown in Figure 1

If the goal is to size the compressor at
J3, the model is Figure 4 can be used
with the compressor modeled as a
fixed flow compressor.

Related Topics
Role of Pressure Junctions Detailed Discussion (Long) 453
Assigned Pressure
209
Tank
241

Open vs. Closed Systems
Model a Closed Loop System
A closed circulating system can easily
be modeled with AFT xStream by locating a Tank junction anywhere in the
system and setting the pressure to the
known pressure at that point. Inflow
and outflow pipes will then need to be
connected. The Tank junction merely
acts as a reference pressure against
which all other pressures in the system are compared. Because there are
no other inlets or outlets to the system,

Balancing Mass
In order to model a closed system,
only one pressure junction is used in
the model. Typically this would be a
Tank junction. Pressure type junctions
are an infinite source of fluid and do
not balance flow. How then can one
be used to flow in a closed system?
To answer this question, it is worth
considering how AFT xStream views a
closed system model. AFT xStream
does not directly model closed systems, and in fact does not even realize
a closed system is being modeled.
Consider the system shown in Figure
1. This is an open system. Fluid is
taken from J1 and delivered to J4 and
J5. Because the AFT Arrow Steady
solution engine in xStream solves for
a mass balance in the system, all flow
out of J1 must be delivered to J4 and
J5. Because the flow is steady-state,
no fluid can be stored in the system;
what goes in must go out.
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Figure 1: Open system - Flow out of J1
equals the sum of J4 and J5

Now consider the systems in Figure 2.
The first system appears to be closed,
while the second appears to be open.
If the same boundary condition (i.e.,
pressure, temperature and surface
elevation) is used for J1, J11 and J12
in the second system, to AFT
xStream it will appear as an identical
system to the first system. The reason
is that AFT xStream takes the first system and applies the J1 tank pressure
as a boundary condition to pipes P4,
P9 and P10. The second system uses
three tanks to apply boundary conditions to P4, P9 and P10. But if the
tanks all have the same pressure, temperature and elevation, the boundary
conditions are the same as J1 in the
first system. Thus the same boundary
condition is used for P4, P9 and P10 in
both models, and they appear
identical to AFT xStream.
But how is the flow balanced at J1 in
the first system? Looking at the first
system, one sees that to obtain a

system mass balance, whatever flows
into P10 must come back through P4
and P9. Because there is overall system mass balance by the solver, it will
give the appearance of a balanced
flow at the pressure junction J1. If
there is only one boundary (i.e., junction) where flow can enter or leave the
pipe system, then no flow will enter or
leave because there isn’t anywhere
for it to go. Thus the net flow rate will
be zero at J1 (i.e., it will be balanced).
But recognize that AFT xStream is not
applying a mass balance to J1 directly. It is merely the result of an overall system mass balance.

Figure 2: The first system is closed, and
the second open. In both systems the
flow into P10 is the same as sum of P4
and P9. If the second system has the
same conditions at J1, J11 and J12, the
two system will appear identical to AFT
xStream

Balancing Energy
Consider the system shown in Figure
1. We know that the flows are balanced at J1, but how can the energy
be balanced? For example, assume
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the user sets an initial temperature of
100° F at J1. This temperature will be
the inlet pipe stagnation temperature
for all pipes that flow out of J1 in the
steady state. In this case, the 100° F
will apply only to pipe P10.
The pipes flowing into the tank (P4
and P9) will have their own temperatures that are obtained by balancing energy along their individual
flow paths. This will include heat
exchanger input and heat transfer to
or from pipes, as well as any heat of
compression effects in the compressor.
The only way to obtain an overall system energy balance is for the J1 tank
temperature to adjust to the mixture
temperature (mixture stagnation
enthalpy, to be more precise) of all
inflowing pipes. This can be enforced
using the Finite tank option with an
Adiabatic Thermodynamic Process.
There is a unique “mixture temperature” (or mixture stagnation
enthalpy) that will yield an energy balance at J1. This will be the temperature/enthalpy from Equation 49.

Figure 1: Example of balancing energy in
a closed system

Curve Fitting
There are many places in AFT
xStream where the user is asked to
define how a property changes in relation to another. Some examples are:
l

Compressor/Fan Curves

l

Junction Resistance Curves

l

Custom Fluids

l

Pipe Physical Properties

These properties are entered in a
table format, relating one particular
property to several others. For
example, see the below definition of a
custom fluid:
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0,1,2,3, or 4. Note that a 0th
order polynomial is a constant
value, and a 1st order is a linear fit.
l

Figure 1: Custom Fluid Definition

There are several parameters that control the behavior of the fluid and they
are entered as they relate to temperature.
However, it is important to recognize
that these values in particular are not
directly used in the solution. Instead,
the data is used to create a best-fit
curve. This curve is then used in the
solution process. This is an important
step to take because there must be a
continuous relationship between the
independent variable (e.g. temperature) and the dependent variable
(e.g. density). Even if the final solution
was close to one of the defined points,
the solver needs continuous data to
proceed.
There are some options for how the
data is curve fit. First, there are two
Curve Fit Types:
l

Polynomial - The data is best
fit to a polynomial of order

Interpolated X-Y Data - The
data has a linear interpolation
drawn between every data
point.

One of the critical items to note with
any curve fit is that you may not be
operating close to one of your defined
points if the data does not conform
well to a polynomial relationship. For
example, the below fluid has a rapidly
decaying viscosity that does not follow
a polynomial relationship. Fitting the
data to the standard 2nd order polynomial results in the following:

Figure 2: Using a Polynomial Curve Fit on
Non-Polynomial Data

The viscosity relationship in the model
will use the blue curve, and not the
user-defined black points. Depending
on the operating range of the system,
this may significantly impact the
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results! For this data in particular,
using the Interpolated X-Y Data option
may be a better choice.
After data has been curve fit, the constants for the resulting curve are displayed in the lower right of the
associated window. For example, in
Figure 1 above there are a, b, and c
constants shown for the Density (Rho)
curve fit. These values use a base
unit, which is not necessarily the unit
the user has defined for that parameter.

Stagnation vs. Static
Pressure Boundaries
With two exceptions (to be discussed),
all pressure-type boundary conditions
in AFT xStream are stagnation. This
works very well for things such as
large storage tanks or atmospheric
boundaries, where the volume associated with a pressure is large and will
not change (significantly) with time.
These boundaries have no velocity
associated with them, and using stagnation pressure is thus appropriate.
These boundary conditions are most
clearly rendered in AFT xStream by
use of a Tank junction.
For simplicity, we will discuss this in
terms of an incompressible flow
example. Consider the tank and connected pipe in Figure 1. When the fluid
in a tank flows into connecting pipes,
the static pressure immediately drops
due to the increase in velocity.
It is tempting to say that because there
is no velocity in the tank, then it does
not matter whether the tank boundary

pressure is considered as a static or
stagnation pressure because they are
equal. This is a misconception. The
pressure boundary condition in an
AFT xStream model is applied at the
exit of the junction, not within the junction itself. Inside the tank, the static
and stagnation pressures are the
same, but they are not the same at the
exit - they differ by the amount of the
dynamic pressure.
Note: An incompressible liquid flow
example is given because it
is easier to discuss, but the
principles apply similarly to
compressible flow.

Figure 1: Pressure profile along horizontal pipe shown in Figure 1 (incompressible flow)

The appropriateness of either stagnation or static pressure as a boundary condition depends on whether
there is a velocity associated with the
pressure that is specified. Is the pressure in a vessel or large (lower velocity) header, or is it in a pipe
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somewhere in the middle of a system?
If the first, stagnation is more appropriate; if the second, static.
Pressure boundary conditions with no
velocity are more common across all
piping industries, and are usually
appropriate. However, this is not
always the case.

When to use Static Pressure
Now let's consider the application of a
true static pressure boundary condition. A static boundary condition has
a unique velocity associated with it.
The Bernoulli equation, which in this
integrated form applies only to incompressible flow, is given by:

From this equation it can be seen that
application of the static pressure is not
sufficient to specify location 1. The
velocity and elevation is also required.
Note that though the equation above
is only applicable for incompressible
flow, the general concept is applicable
for compressible flow.
In AFT xStream, elevation data is
entered for junctions. The pipes adopt
the elevation of the junction to which
they are connected.
But where does the velocity information in the Bernoulli equation come
from? One might respond that it can
be obtained from the flow rate. But this

raises another question: what if the
flow rate isn’t known? Put another
way, what if the flow rate is what we
are solving for?
Because the stagnation pressure combines the static pressure with the velocity information (in the form of Mach
number, see Stagnation Pressure
definition), when the user supplies a
stagnation pressure boundary condition AFT xStream can avoid the
need for an associated velocity condition at location 1. A stagnation pressure boundary can thus be supplied to
multiple pipes that might have different velocities. That is why the same
Tank junction can connect with multiple pipes.
However, if the user specifies a static
pressure as the boundary condition, a
unique velocity (or Mach number)
must be supplied. Thus it is only possible to connect a static pressure to a
single pipe with a unique velocity.
Important: A static pressure boundary has a unique velocity
(and Mach number) associated with it, and can thus
connect to only one pipe.
Where would one find a static pressure boundary? The best example is
when the boundary condition is inside
a pipe. A pipe system model can start
and end anywhere it is convenient for
the user. It may be convenient to not
start the model at the physical boundary (such as a tank) but at a particular
location in the pipe system. This could
be, for example, at the location of a
pressure measurement. Or it could be
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at the boundary of the pipe system for
which your company is responsible,
with another company responsible for
what is on the other side of that boundary.
If one needs to model such a situation,
the Assigned Pressure junction allows
one to model either a static or stagnation pressure. The default stagnation pressure allows connection of
up to 25 pipes. If static pressure is
chosen, only one connecting pipe is
allowed.

Static Pressure at Pressure
Control Valves
Another example of static pressure is
at pressure control valves. For pressure control valves (i.e., PRV’s and
PSV’s) the default control pressure is
static pressure. The reason is that the
measured pressure that provides feedback to the controller will typically be a
static pressure measurement. You
have the option of modeling pressure
control valves as either static or stagnation pressure.

Related Topics
Review of Compressible
Flow Theory
Stagnation Properties
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Analysis Setup Overview
The Analysis Setup window contains
all of the settings which the user must
define to run the model, including fluid
properties, steady state and transient
solution controls, pipe sectioning settings, and other related options. The
Analysis Setup window can be
launched from either the toolbar or the
Analysis menu.
The controls in Analysis Setup are
divided into different groups in the navigation pane on the left of the window
(Figure 1). Each group has one or multiple items. Clicking on an item opens
the panel for that item.
A group is not fully defined until each
item in that group is defined. Each
group will have either a green check
mark, indicating that all required items
have been defined, or a red exclamation point, indicating that some or all
of the required inputs are missing.
Note that some groups will have a
green checkmark by default, indicating that the required inputs have
default settings already applied, or all
inputs for that group are optional.
Groups that are undefined will change
to a green check mark when the
required inputs for that group are
entered, and the user navigates to a
different panel. Note that none of the
changes will be applied to the model
until OK is selected. Clicking Cancel
will discard all changes made in the
window.
The groups in Analysis Setup are

l

Modules Group

l

Fluid Properties Group

l

Pipes and Junctions Group

l

Pulsation Setup Group

l

Pipe Sectioning and Output
Group

l

Transient Control Group

l

Forces Group

l

AFT ArrowTM Steady Solution
Group

l

Environmental Properties
Group

l

Miscellaneous Group

Figure 1: Default state of the Analysis
Setup window in a new blank model
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Modules Group
AFT xStream has one optional add-on
module which extends its modeling
capabilities into other areas. The modules allow pulsation frequency modeling. The Modules panel in the
Modules group in Analysis Setup
allows you to activate and enable the
add-on modules. An additional license
to the base AFT xStream license is
required to use a module. These modules include:
l

PFA (Pulsation Frequency Analysis) - Helps identify and avoid
resonant frequencies in systems, especially in those
caused by positive displacement compressors.

Modules Panel
The Modules Panel allows users to
activate and enable the optional addon modules and/or cost calculations.
Activating a module checks out a
license seat for the module.
Enabling a module turns on all functionality for the module. By default
activating a module will also automatically enable the module for use.
Disabling a module keeps the license
seat checked out but the module calculations are not applied to the model.
Disabling a module may be desired for
various reasons, as is discussed further for each module below.

Note: A module specific license is
required to activate the PFA
add-on module.

Figure 1: The default state of the Modules
panel

PFA (Pulsation Frequency
Analysis)
Activate the Pulsation Frequency Analysis (PFA)module by checking the
box next to Activate PFA. Once activated, enable it by selecting Use or disable it by selecting Ignore. When the
PFA module is activated, the Pulsation Setup group appears in the Analysis Setup. The Pulsation Setup
group has one item, Pulse Setup.
The PFA module can be enabled
before or after a model is built. Preexisting models built with the base
AFT xStream application can have the
PFA module activated.
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Setting the PFA module to Ignore
causes the PFA module to function
like the base AFT xStream application. One difference is that users are
still able to enter pulsation data and it
be retained in the model. If a model
with PFA input is opened in the base
AFT xStream application that cannot
access a license to PFA, this data will
be lost. Table 1 relates the differences
between using AFT xStream without
the PFA module activated, using it
with the PFA module activated but disabled (Ignore mode), and using it with
the PFA module activated and
enabled.
The PFA module can also be toggled
between Use and Ignore from the Analysis menu in the Pulsation Frequency
Analysis option as shown in Figure 2.
Use this feature to quickly toggle the
PFA module between Use and Ignore
without opening the Modules panel in
Analysis Setup.

Table 1: AFT xStream feature accessibility based on PFA activation and
enablement

PFA Activated
PFA NFeaturot
PFA
PFA Enae
ActivDisbled
ated
abled
Pulsation
Setup Not VisVisible
group
ible
in Analysis

Visible

PFA Activated
PFA NFeaturot
PFA
PFA Enae
ActivDisbled
ated
abled
Setup
Pulsation Frequency
Ana- Not VisVisible
lysis in
ible
Analysis
menu

Visible

Pulsation
Setup Not VisVisible
in Analible
ysis
menu

Visible

Steady-State
Pulsation Tol- Not Vis- Not
erance
ible
Visible
on Tolerance
panel

Visible

Frequency
tab in
Graph
Not Vis- Not
Conible
Visible
trol,
Graph
Results
window

Visible
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selected - one must be defined to run
any simulation.
The first selection that must be made
is what Fluids library to use.
The available Fluid libraries are:
l

AFT Standard - An included library that offers 30 common fluids to the user. Saturation line
data was added for AFT Standard fluids in xStream 2.

l

ASME Steam/Water- Data
from the 1997 ASME Steam
Tables.

l

NIST REFPROP - Data compiled by the National Institute of
Standards and Technology
(NIST) using thermophysical
property models for a wide variety of fluids. User defined mixtures of these fluids can be
defined.

l

Chempak Fluid - A large library of fluids with detailed property information. User defined
mixtures of these fluids can be
defined. See the Chempak
Detailed Discussion for more
information.

Figure 2: Select Use from the Pulsation
Frequency Analysis in the Analysis menu
to perform pulsation analysis

Fluid Properties Group
The Fluid Properties group in Analysis
Setup gives you control over the fluid
properties that influence your pipe system analysis. There is one item in the
Fluid Properties Group, the Fluid
panel.

Related Topics
References

435

Related Blogs
Get More Flexible With Your Fluids

Fluid Panel
The Fluid panel in the Analysis Setup
window gives you control over the fluid
properties that influence your pipe system analysis. A default fluid is not

After selecting a library, the Fluids
Available in Library list is populated.
One of the fluids can be selected and
used with the Add To Model button.
When determining which fluid package is most appropriate, it is recommended that you consult the table
below to ensure your selection suits
your needs.
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Table 1: Compatibility Chart for Fluid library Selection

Model Requirements
FUsCoFluier
Sysmpid
ConnSpMitem
lex
Libdensal
ecixtuTroub- Syraration
Rfieres
lesho- stey
Data
ud
oting
mnFlus*
s
ids
AFT
StaP**
P
P P
ndard
NIST
REP
P
P P P
FPROP
Chem- P
P
P P P
pak
ASME
P
P
Steam
* Evaluating the complexity of a system is most easily done in early runs
of the model. It is suggested that all
early runs should be run with an
AFT Standard fluid (even if the real
system fluid is a mixture), and the run-

time recorded. This runtime should
inform your decision on which fluid library is needed to run the more polished runs when high accuracy results
are needed. Run times can vary significantly between the 4 libraries, so
make sure you evaluate your time constraints and accuracy needs when
weighing this decision. Factors that
can impact the run time include the
ratio in the length of the smallest pipe
to the largest pipe, presence of mixtures, usage of Junctions containing
graphs, and the presence of sonic
choking.
** It is strongly recommended that all
runs used to troubleshoot the design
of the system model are run using
AFT Standard.

AFT Standard Fluid Library
The AFT Standard fluid library offers
multiple fluids for easy use in AFT
xStream models. Density and
enthalpy can be evaluated for these
fluids using any of six equation of state
models and three enthalpy models to
account for both temperature and pressure dependence.
Transport properties for the AFT
Standard fluids (specific heat,
dynamic viscosity and thermal conductivity) and Saturation Pressure are
assumed to be functions of temperature only using polynomial curve
fits. This assumption is generally reasonable below the fluid's critical point,
although systems at very high pres-
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sure usually start to show some pressure dependence.
To add a fluid into your model, select it
from the Fluids Available in Library list
and click the Add to Model button. The
fluid will appear in the Fluids in Current Model area. Once the fluid is
added, specify the temperature in the
Fluid Properties area on the right to
calculate values of density, dynamic
viscosity, and vapor pressure, as
shown in Figure 1.

steam properties obtained from the
IAPWS Industrial Formulation 1997
for the Thermodynamic Properties
Steam (see ASME Press in References).
After selecting ASME Steam/Water,
"ASME '97 Steam" is automatically
added to in the Fluids in Current
Model area as shown in Figure 2.
Detailed fluid properties information
from SteamCalc can be calculated
using the AFT SteamCalc Viewer,
which can be accessed from Tools >
Fluid Property Viewers > SteamCalc.
The SteamCalc Viewer will be
launched as a separate application,
which can then be used to calculate
fluid properties at various conditions.
For more information on AFT
SteamCalc Viewer see the SteamCalc
Help file.

Figure 1: The Fluid panel in the Analysis
Setup window with AFT Standard library
selected

ASME Steam Tables
The ASME Steam Tables Library
offers users access to water and
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Information on the theory and calculation methods used in Chempak is
given in the Chempak technical information topic.
Detailed fluid properties information
from Chempak can be calculated
using the AFT Chempak Viewer,
which can be accessed from Tools >
Fluid Property Viewers > Chempak.
The Chempak Viewer will be launched
as a separate application, which can
then be used to calculate fluid properties at various conditions. A
Chempak Data license is required to
use the Chempak viewer.
For more information on AFT
Chempak Viewer see the Chempak
Viewer Help File.
Figure 2: Fluid Panel in Analysis Setup
with ASME Steam library selected

Chempak Library
The optional add-on Chempak Data
offers approximately 700 fluids to the
user. In addition, it offers non-reacting
mixture calculations.
A Chempak fluid is added the same
way as an AFT Standard fluid is
added. To add a Chempak fluid, select
Chempak Fluid from the Fluid panel in
the Analysis Setup window. From
here, select the appropriate fluid from
the library and click the Add to Model
button. After a fluid is added to the
model, it will appear in the lower list
under Fluids in Current Model.

Figure 3: Fluid Panel in Analysis Setup
with Chempak library selected
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NIST Refprop Library
The NIST REFPROP Library offers
users access to fluid properties from
Version 10 of the NIST Reference
Fluid Thermodynamic and Transport
Properties Library.
Add a fluid from the Fluids Available in
Library list by selecting it and clicking
Add to Model, as shown in Figure 3.
Fluids from the NIST REFPROP library support fluid mixtures.

High Pressure Steam - Fluid
Property Models Example 572
Related Topics
References
435
Use an AFT Standard Fluid 500
Related Blogs
Get the Most Out of AFT's Fluid Property Viewers
Get More Flexible With Your Fluids

Creating Mixtures
Users have the option of creating a
mixture of fluids with NIST REFPROP
and Chempak.

Figure 3: Fluid Panel in Analysis Setup
with NIST Refprop selected

Related Examples

To create a mixture, first select the
Chempak or NIST REFPROP Fluid
Libraries in the Fluid panel. Once this
has been selected, the option to
Create New Mixture and Add... button
becomes available. Select this button,
then locate and highlight the first fluid
in the mixture you wish to specify.
Enter the mass or mole fraction of the
fluid in the mixture, and click Add Fluid
to Mixture. Repeat this process for all
fluids in the mixture as shown in Figure 1.
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Note: The fraction basis of all mixtures is either mass or mole,
and it is specified on the Fluid
panel itself. If you would like
to change the fraction basis
for the mixture (from mass to
mole or from mole to mass),
click on the desired fraction
basis located on the right of
the Fluid panel. Note that this
option is only available after
the model fluid is set as a Mixture.

most mixtures containing
steam.

To add a mixture to the Fluid panel,
the Total Fraction for the table must
equal 100%. To help achieve this, the
Set as Remainder button can be used
to add the remaining percentage to
the selected component in the table so
that the fractions in the table will add
up to 100%. Alternatively, the Ratio
Fractions to Total button will scale up
the fractions in the table so that they
will add to 100%.
Components can be deleted from the
table by using the Remove Component or Clear All Components buttons.
Mixture data can be exported to a file
which can then be imported into other
AFT applications, or shared with other
AFT application users by using the
Export Mixture to File... and Import
Mixture from File... buttons in this window.
Note: The NIST REFPROP fluid library is not able to calculate
the mixing parameters for

Figure 1: The Create Mixture window
(opened from the Fluid panel) allows you
to create predefined mixtures for the
model.

Related Blogs
Get More Flexible With Your Fluids
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Equation of State
Models
AFT xStream uses the Ideal Gas
model with a corrected compressibility
factor, Z, to model AFT Standard fluids. The Z-factor can be calculated by
numerous correlations. xStream offers
6 options: Constant Z, Ideal Gas,
Peng-Robinson, Redlich-Kwong,
Soave Redlich-Kwong, and ThreeParameter.
The Ideal Gas option leaves the Zfactor defined at 1, meaning the fluid is
modeled as an Ideal Gas. The Constant Z option allows the user to specify a value for Z which xStream then
uses for all property calculations. The
other Equation of State options are discussed in turn below.

Equations of State Nomenclature

is the definition of the reduced pressure. The reduced temperature could
be written similarly.
ω is the acentric factor, for which values can be found in chemical engineering data books. It is a correction
factor that can be set to zero if you cannot find data for the fluid. However,
accuracy will be reduced.

Redlich-Kwong
The Redlich-Kwong Equation of State
is given by the following cubic equation.

where

There are a few characterizing fluid
properties that are common to all of
the Equations of state below.
The reduced temperature (Tr) and
reduced pressure (Pr) are the ratios
of the thermodynamic properties to
the critical properties. For example,

And Pc and Tc are the critical pressure
and temperature, respectively. V is the
molar volume.
An alternative form of the RedlichKwong equation can be obtained by
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multiplying the Redlich-Kwong equation by V/RT.

where
where

Elimination of the "a" and "b" terms
gives
where Tr is the reduced temperature,
and ω is the acentric factor.
The SRK equation can also be written
as in terms of Z as

where

where Tr and Pr are the reduced temperature and reduced pressure.

Soave-Redlich-Kwong (SRK)
Soave proposed a modified version of
the Redlich-Kwong method as follows

The largest root of Z for the cubic equation is the compressibility factor for the
vapor form of the fluid.

79

Quick Start Guide
where

Peng-Robinson
The Peng-Robinson Equation of State
uses a similar form to the RedlichKwong equation of state cubic equation. The Peng-Robinson cubic equation is given as follows

where

The largest root of Z for the above
equation is the compressibility factor
of the vapor form of the fluid.

Three-parameter
xStream implements a Three-Parameter Equation of State derived by
Pitzer for the second coefficient in the
Virial Equation of State. The ThreeParameter model as used by xStream
is taken from page 102 of Smith, van
Ness, and Abbott and shown below.

And Pc and Tc are the critical pressure
and temperature, respectively, V is the
molar volume, Tr is the reduced temperature and ω is the acentric factor.
The above equation for pressure can
be rewritten as

where Z is the compressibility factor,
and Pr and Tr are the reduced pressure and temperature, respectively.
The constants B0 and B1 are given by
the following
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constant pressure, the above approximation starts to lose accuracy.
AFT xStream offers three ways to calculate the enthalpy for the AFT Standard Fluid Library. Below is a
description of each.

Reference Enthalpy
The Reference Enthalpy Method uses
the following equation to calculate
enthalpy

whereω is the acentric factor.

Related Topics
Nomenclature
References

391
435

Enthalpy Models
For superheated gases, enthalpy is a
function of both temperature and pressure:

The reference enthalpy and temperature is entered in the fluid library,
and should be for a state that is as
near as possible to the operating conditions of your model. As seen from
the equation, the pressure dependence of enthalpy is ignored. In many
cases, this assumption is acceptable.

Generalized Enthalpy
However, enthalpy is more strongly a
function of temperature, and thus you
will frequently see the approximation
as follows:

where the specific heat at constant
pressure is used as a proportionality
constant. For processes that are not at

The Generalized Enthalpy Method is
an extension of the Reference
Enthalpy Method. The Generalized
Enthalpy, similar to the Three-Parameter Method, uses critical property
data to calculate a Residual Enthalpy.
The method is shown below.
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where:

B0 and B1 are as given previously,
and:

With this method, enthalpies would be
obtained by interpolating the polynomials between 25 and 50 psia at a
given temperature. Up to 10 pressure
table entries can be used. If the pressure is outside the table range, the
enthalpy is extrapolated.

Related Topics
Nomenclature

391

Fluid Accuracy Settings
Table Lookup Enthalpy
The third method of obtaining enthalpy
data is by using AFT xStream’s twodimensional table. In this method, a
sequence of polynomial curve fits as a
function of temperature are used.
Each step in the sequence is for a different pressure.

Several advanced settings are available to fine-tune the accuracy of the
fluid properties for the xStream simulation. These options can be enabled
from Tools -> User Options by going to
the Show options under General
(global).
Once enabled the Fluid Accuracy settings are located on the Fluid panel
below the Fluids Available in Library
area (Figure 1).
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This option is applicable to both the
AFT Standard as well as Chempak fluids.

State Properties
The State Properties option influences
the number of elements used in curve
fits for calculating property data. You
will usually want to start with standard
accuracy, and use high accuracy for
final runs, depending on the importance and run time for the model. The
high accuracy option will increase run
time by about a factor of two.

Figure 1: Fluid panel in Analysis Setup
with the Fluid Accuracy Settings enabled

Specific Heat Ratio
There is a choice of standard or high
accuracy for the specific heat ratio.
The standard accuracy uses Equation
80 for gamma(γ). The high accuracy
uses Equation 81. The standard accuracy will usually be suitable, but for
completeness you may want to use
the high accuracy in your final runs
and see if the results change.
The high accuracy option should not
have a significant affect on run time (at
most 10%). However, it can result in
convergence problems.

When performing interpolations for
properties, a 4 point or 16 point interpolation scheme can be used. The 4
point scheme implemented in AFT
xStream is the Standard Accuracy
option. The 16 point scheme is the
high accuracy option. Use of the High
accuracy option will roughly double
the run times for models.
This option is applicable to only to
Chempak fluids.

Sonic Velocity
The standard accuracy sonic velocity
option will usually be acceptable. The
standard option uses Equation 87 for
all sonic velocity calculations. The
high accuracy option uses Equation
84, calculating the derivative using a
numerical difference (also called perturbation derivative) along the isentropes. This is time consuming, and
can cause models to run ten times as
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long. You should not use this option
unless you have reason to believe
Equation 87 has unacceptable accuracy as evidenced from the output values of sonic velocity.
This option is applicable to only to
Chempak fluids.

Pipes and Junctions
Group
The Pipes and Junctions Group in Analysis Setup has one item: the Pipes
and Junctions panel. When the Pipes
and Junctions group has a green
checkmark next to its name, all pipes
and junctions are fully defined. When
a red exclamation point is next to its
name, there is at least one pipe or junction that is undefined. The model cannot run until all pipes and junctions are
defined.

Pipes and Junctions
Panel
The Pipes and Junctions panel within
Analysis Setup displays the status of
pipes and junctions within the model.

Figure 1: Default state of the Pipes and
Junctions panel

This panel is made up of three sections:
l

Undefined Pipes

l

Undefined Junctions

l

Undefined Properties

The Undefined Pipes and Undefined
Junctions sections displays the number and name of all pipes and junctions, respectively, that are not fully
defined. If all pipes and junctions in
the model are fully defined, the messages "All Pipes Are Defined" and "All
Junctions Are Defined" will be displayed. Clicking on the undefined pipe
or junction will display the undefined
properties in the list below, as shown
in Figure 2. All undefined data for all
objects can be saved to the file or
copied to the clipboard. Any undefined
object's Properties window can be
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launched by double-clicking the
object's name in the list to finish defining the object.

Pulse Setup Panel
The Pulse Setup panel (Figure 1)
allows you to specify required input for
the PFA module, including the junction
at which the pulse will be applied, as
well as the pulse properties. This
panel will not be visible unless the
PFA module has been activated from
the Modules panel.

Figure 2: Pipes and Junctions panel with
one pipe undefined and undefined properties displayed

Pulsation Setup Group
(PFA module only) The Pulsation
Setup group in Analysis Setup allows
you to define the pulsation analysis
parameters.
The Pulsation Setup group has one
panel, the Pulse Setup panel. The
Pulse Setup panel allows the user to
define properties of the pulse including the source, cutoff frequency, lowpass filtering, and magnitude.

Figure 1: Pulse Setup panel in the Analysis Setup window
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Pulse Properties
At the top of the window the Pulse
Properties can be specified, including
the junction that will act as the source
of the pulse and the magnitude of the
pulse. By default, the magnitude of the
pulse is twice the steady-state flow,
but you have the option to define this
magnitude as “User Specified”. This
pulse will be assumed to last for two
time steps and then return to steadystate flow. The pulse can only be
applied to an assigned flow junction.

Cutoff Frequency
The cutoff frequency in xStream is the
maximum frequency for displayed output. The defined cutoff frequency must
be less than or equal to the detectable
frequency for the analysis, which is calculated using the equation for maximum frequency as follows

where dt is the time step. The time
step for the model is not known until
run-time; However, the time step can
be estimated based on the inputs on
the Pipe Sectioning panel. The Pulsation Summary at the bottom of the
Pulse Setup panel shows the Detectable Frequency based on the current
settings on the Pipe Sectioning panel,

as well as the minimum number of sections required to capture the specified
cutoff frequency. If the current Cutoff
Frequency and sectioning are not
valid for the analysis, then either the
Cutoff Frequency should be
decreased, or the minimum number of
sections should be increased.
When the Analysis is run it is possible
to account for all frequencies up to the
Detectable Frequency calculated
based on the time step. However, the
results in the output will only display
frequencies up to the user defined
Cutoff Frequency. Therefore it is
important to define a large enough
Cutoff Frequency to be able to analyze all relevant frequency responses.

Minimum Number of Frequency Samples
The minimum number of frequency
samples used to generate the forcing
function is specified in the Frequency
Analysis section of the Pulse Setup
panel. The default of 1000 should be
sufficient for most cases. The Minimum Number of Frequency Samples
will impact the required simulation duration - a larger number of samples will
require a longer simulation duration.
The required simulation duration can
be calculated by dividing the minimum
number of frequency samples by the
detectable frequency. If the current
simulation duration is not long enough
to accommodate the minimum number of frequency samples, then the
simulation duration should be
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lengthened on the Simulation
Mode/Duration panel, or the minimum
number of frequency samples should
be decreased.

Evaluate with API-618
The Evaluate with API-618 feature
can be used to determine if the pressure response at any of the acoustic
natural frequencies of the system
exceeds the limits defined in API-618
for reciprocating compressors. To evaluate API-618 the model should be first
be run with PFA enabled and the API618 feature disabled to determine the
acoustic frequencies. Once the excitation frequencies are known, child
scenarios can be created by the user
to evaluate the pressure results when
the compressor operates at the excitation frequencies, as is demonstrated
in the last step of the Frequency Analysis Example. The API-618 evaluation should be enabled in the
excitation frequency child scenarios to
check if the pressure results exceed
the limits in API-618.
The required inputs to check API-618
are as follows:
l

Speed - The speed the reciprocating compressor is operating at.

l

Number of Heads - The number of pistons in the reciprocating compressor.

l

Time Until Steady State
Pulsation - The time required

for the dissipation of artificial
transients caused by the introduction of a flow rate wave to
the system. This time should be
determined by running the scenario with the "Time Until Steady
State Pulsation" set to 0, then
plotting the pressure results at
the outlet of the compressor.
The Time Until Steady State
Pulsation should be set as the
time at which the pressure
waves have consistent amplitudes. For example, in Figure
2 below the waves begin to
reach constant amplitude at
about 0.25 seconds. It is best to
choose a slightly longer time
interval than the estimated time
interval for increased accuracy
when checking API-618.
Note the Time Until Steady
State Pulsation input only
changes which pressure results are included in the API-618
evaluation, the transient results
are not impacted by this time.
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update the Minimum Number of Sections and/or the Stop Time for the simulation if they are not sufficient based
on the user-specified Cutoff Frequency and Minimum Number of Frequency Samples.
A short description of each of the
Pulsation Summary items is given
here.
l

Minimum Sections
l

Current Count - Displays the "Minimum
Number of Sections Per
Pipe" defined on the
Pipe Sectioning panel

l

Detectable Frequency
- Displays the Max Frequency calculated as discussed above in the
Cutoff Frequency section

l

Required for Cutoff Displays the required
Minimum Number of
Sections Per Pipe which
allow the Detectable Frequency to be greater
than or equal to the
Cutoff Frequency

Figure 2: Example pressure results at the
outlet of the reciprocating compressor
with an oscillating flow transient specified.

Pulsation Summary
The Pulsation Summary section at the
bottom of the Pulse Setup panel
provides information on the current
transient settings in the model to
check that the sectioning and simulation duration are sufficient based
on the user-specified Cutoff Frequency and Minimum Number of Frequency Samples. Therefore the
Pulsation Summary will only be able to
display results if the Pipe Sectioning
panel and Simulation Mode/Duration
panel have already been fully defined.
The Update For Me button under the
Pulsation Summary can be used to

l

Minimum Simulation Duration
l

Current Duration - Displays the current simulation duration defined
on the Simulation
Mode/Duration panel
(Stop Time minus Start
Time)
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l

l

Actual Samples - Displays the Actual
Samples used for the frequency analysis, calculated by multiplying
the Current Duration by
the Detectable Frequency
Required For Min.
Samples - Displays the
minimum required simulation duration based
on the user-specified
Minimum Number of Frequency Samples and
the calculated Detectable Frequency

Pipe Sectioning and Output Group
The Pipe Sectioning and Output
Group in Analysis Setup has one
item: the Pipe Sectioning and Output
panel. The Sectioning panel contains
settings related to setting up the
Method of Characteristics grid used
for the transient solution method.

Related Topics
Method of Characteristics

411

Pipe Sectioning and Output Panel
Before running a transient simulation,
there are several pipe sectioning

options that must be defined to section
the pipes as described in Pipe Sectioning - Introduction to Method of
Characteristics.
The user is required to specify the Sectioning item when the Transient Simulation Mode is selected. How the
pipes are sectioned is controlled in the
Pipe Sectioning and Output panel of
Analysis Setup.
When the system has been defined,
the Pipe Sectioning and Output panel
will also show a Sectioning Summary
which contains details of the sectioning including the estimated maximum sonic velocity, the estimated
time step, and the estimated total
steps. These numbers are only estimated values, as the actual values are
determined after xStream gets results
from the AFT Arrow Steady Solution.
However, these estimates can help
the user understand how many sections the system will have, and thus
how long a run might take.
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compared to other pipes in the
model, and the speed of transients in the model.
l

Estimated Maximum Pipe
Fluid Temperature During
Transient - Temperature used
to determine the maximum
sonic velocity for sectioning calculations. If the actual maximum temperature is not
known, a higher temperature
than expected should be used.

Transient Output Options

Figure 1: The Sectioning panel in the Analysis Setup window

Sectioning Options
l

Minimum Number of Sections Per Pipe - Defines the
minimum number of calculation
sections that will be used in
each pipe in the model. Some
pipes may use more than the
minimum number of sections
depending on the time step and
maximum sonic velocity in the
pipe. The ideal number of sections will vary based on the relative length of the shortest pipe

The Pipe Stations To Include In
Transient Output File option controls how much data is saved to the
file. By default all time steps for all
pipe stations will be saved to file.
The user may also set only the pipe
inlet/outlet station data to be saved
to file. Saving only the inlet and outlet stations to file will decrease the
run time for the model, but also
means that the user will not be able
to plot the results at interior calculation stations for the pipes.
Numbering Convention for
Pipe Sectioning
Once a pipe is broken into sections,
computation takes place where the
sections join together. These are
called pipe stations. The total number
of stations in a pipe is equal to the
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are encountered during simulation, the results will not be
valid, and the simulation can
become unstable or fail to converge. This can only be edited if
advanced options are enabled.

number of sections plus 1. The station
at the beginning of the pipe is
numbered zero.

l

Figure 2: Computing Stations (blue) exist
at the boundary of every section (green)

To observe parameters at the inlet or
outlet of a junction, view the station
adjoining the junction. In the above
example, the inlet to the valve is P1,
Station 3 and the outlet is P2, Station
0.

Advanced Sectioning Controls
l

Estimated Maximum Pipe
Mach Number During Transient - Adjusts the MOC grid
time step. An input value of 1
will ensure stability. For simulations with lower maximum
Mach Numbers, reducing this
input value can improve accuracy and runtime. If Mach Numbers higher than the Estimated
Maximum Pipe Mach Number

Number of Radial Thermal
Nodes per Wall or Insulation
Layer - Defines the number of
calculation nodes that will be
used in the pipe wall and in
each of the insulation layers
when calculating radial conduction. The default setting of 3
calculation nodes per layer
should be sufficient for most
applications; However, changing the number of radial nodes
may improve calculation stability if the heat rate changes
rapidly across the pipe wall and
insulation. See the topic on
Transient Heat Transfer for
more information on how the
transient heat transfer calculations are performed.

Related Examples
Gas Turbine Fuel System
Example
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Transient Control Group
The Transient Control Group in Analysis Setup has two items: the Simulation Mode/Duration panel and the
Transient Solver Initialization panel.
The Simulation Duration panel contains settings to define if the model will
be run in steady-state or transient and
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when the simulation start and stop
times are. The Transient Solver Initialization panel has settings related to
eliminating artificial transients.

Simulation Mode/Duration Panel
The Simulation Mode/Duration panel
allows the user to define settings that
will affect the transient results.
The Time Simulation options control
what calculations will be performed by
xStream. There are two time simulation options:
l

AFT Arrow Steady - This simulation mode runs the network
solution methodology found in
AFT Arrow to give steady-state
results for the model.

l

Transient - This simulation
mode runs the MOC solution
methodology for the transient
simulation as defined by the
user. This option is the default
selection.

The Start Time and Stop Time refer
to the beginning and end times for the
simulation. The units can be specified
using the drop-down box.

Transient Solver Initialization Panel
Artificial Transient Resolution
AFT xStream employs two separate
solvers in its solution method: the
AFT Arrow Steady Solver is used to
calculate the steady state solution to
initialize the transient solution, and the
Transient Solver is used to run the
Method of Characteristics (MOC) transient solution. The AFT Arrow Steady
solver and the Transient solver use different sectioning methods, which
causes small discrepancies between
the converged Arrow solution and the
first time step of the transient solution.
If xStream were to proceed directly
from the AFT Arrow Steady solution to
the Transient simulation, artificial transient waves would be introduced into
the system as is shown in Figure 1.
Checking the option to Delay start of
transient simulation until artificial
transients are resolved ensures that
the artificial transient waves are
allowed to die out before the transient
simulation begins, as is depicted in Figure 2. It is strongly recommended to
allow the artificial transients to resolve
before the transient simulation begins
for higher result accuracy.
Once xStream determines the artificial
transients have been resolved,
xStream checks the resolved solution
against the AFT Arrow Steady solution. If the velocity results have a
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larger relative velocity change than
the specified Allowed Mismatch
Between AFT Arrow Steady and
Resolved Solutions in the Transient
Solver Initialization panel, a warning is
given. By default "Do not proceed to
the transient simulation..." is enabled
to stop the transient run if the mismatch exceeds the allowed mismatch.
The user can disable the option that
prevents the transient solution from
proceeding; however, note that large
changes between the AFT Arrow
Steady solution and Resolved Solution can introduce error into the transient results.

Figure 1: Illustration of the Transient
Solver Initialization process without artificial transient resolution

Figure 2: Illustration of the Transient
Solver Initialization process with artificial
transient resolution

The artificial transients are resolved
by running the Method of Characteristics in a series of Blocks. Each
Block consists of 100 time steps. After
each Block is run xStream compares
the velocity results at the beginning
and end of the block for every calculation station. If the velocity change
from the beginning to the end of the
block at any point is larger than the
allowable tolerance defined in the
Transient Solver Initialization panel,
then the process is repeated until the
Maximum Number of Blocks is
reached, or the velocity tolerance is
met for two consecutive blocks.
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guesses to initialize the period
of resolving artificial transients
instead of using the AFT Arrow
Steady solution. The resolved
solution should still be the
same regardless of the whether
the AFT Arrow Steady solution
is used or just initial guesses;
however, the artificial transient
resolution will likely take more
time when fixed guesses are
used.

Figure 3: Example of blocks used during
artificial transient resolution period

l

Allowed mismatch between
AFT Arrow Steady and
resolved solution - The
allowed velocity mismatch criteria can be modified here.
Additional pressure and temperature criteria can also be
applied by checking the corresponding boxes.

l

A series of time steps (a
block) is considered
resolved when every station
meets these tolerances from
beginning to end of the
block - The tolerances in this
section are used to determine if
the artificial transients are
resolved by comparing the tolerance values to the velocity
change at the beginning and
end of each block as described
in the Artificial Transient Resolution section above. Additional pressure and
temperature criteria can also
be applied by checking the corresponding boxes.

l

Iteration Limits

Advanced Settings
The advanced settings should generally be used for troubleshooting purposes only. There are a number of
settings that can be customized.
l

Disable transient junction
behavior for the entire simulation - This option sets all
junction transient events to be
ignored, and fixes the pressure/temperature at all finite
tanks for the duration of the
transient. By disabling the junction transient behavior in this
way the user can directly view
the artificial transients in the
model for troubleshooting purposes.

l

Bypass AFT Arrow Steady
and start the transient with
fixed values for all stations This option uses arbitrary
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l

l

l

Maximum number of
blocks - The maximum
number of blocks that
xStream will run to
attempt to resolve the
artificial transients.
Time steps per block The number of time
steps that will be run in
each block. If there are
too few time steps the
blocks may falsely converge.
Successive blocks
required - The number
of successive blocks
that must meet the tolerances for the artificial
transients to be considered resolved.

Related Topics
Transient Result Accuracy 45
Method of Characteristics 411

Related Examples
High Pressure Steam Forces Example
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Force Definitions Panel
AFT xStream includes the ability to calculate dynamic, unbalanced pneumatic forces. These unbalanced
forces occur when a transient pressure wave passes through a portion of
the system.
Note: As AFT xStream is only a
hydraulic solver, only
hydraulic forces are accounted for. AFT xStream is not a
pipe stress analyzer and as
such does not have the ability
to directly model piping supports or similar objects.
Hydraulic force files can be
generated for import into software designed for force analysis.

Forces Group
Defining Force Sets

The Forces group in Analysis Setup
has one item: the Forces panel. By
default, the Forces group is fully
defined and will have a green checkmark next to its name.

In order to process force data, the locations where the forces are to be calculated must be defined. Force Sets
can be defined either from the Workspace or from the Forces panel of the
Analysis Setup window.

Related Topics
Transient Forces

30
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Note: Force calculation accuracy in
AFT xStream is dependent
not only on accurately defining the force sets, but can
also be highly dependent on
the Sectioning and Fluid
panel settings. This is discussed further in the High
Pressure Steam - Forces
example.

may be important for proper
interpretation of results or for
exporting data to other applications.
l

Import from CSV - If force sets
are defined in another application or by hand they can easily
be imported with a comma separated value file. Click the
Import from CSV button for an
explanation on the required
format.

l

Generate Force Names - Automatically changes the names
for the selected force sets to
"upstream junction name downstream junction name"
using the names from the connected junctions on the workspace.

l

Point Force Ambient Pressure - If using a Point force set,
the ambient pressure is
required to calculate the force
balance. This defaults to the
Environmental Properties
value, but can be changed
here.

Defining from Analysis Setup

Figure 1: Force set data is defined on the
Force Definitions panel in the Analysis
Setup window

l

New - Add a new force set to
the table

l

Duplicate - Copy an existing
force set

l

Delete/Delete All - Remove
force sets

l

Swap Nodes - The calculation
will be the same, but the sign of
the force will be reversed. This

Each individual force set has a number of required parameters:
l

Apply - Whether to include the
force set calculation. This
allows disabling force sets
without deleting them.

l

Force Type - There are several force set types available.
They are described in detail in
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Force Set Types.
l

Force Set Name - A unique
name for the force set.

l

Start Pipe - Where the first
node is located.

l

Start Location - Force Sets in
xStream must have their endpoints at either the inlet or outlet of a pipe.

l

End Pipe - The second (for difference types) node. Note that
the selection must be valid for
the specified force type. See
Force Set Types.

l

End Location - Force Sets in
xStream must have their endpoints at either the inlet or outlet of a pipe.

l

Pipe Group - For force sets
across 3+ pipes, a group is
required and is selected here.

l

Exit Area - For Exit type
forces, an exit area is required.

l

Force Unit Vector Coordinates - Define unit vectors for
your linear pipe to give the resulting forces a three-dimensional direction. xStream is still
only a one-dimensional fluid
modeling software, and specifying a unit vector will not
change the force calculations.
However, by defining the XYZ
vector for a given force set, that
data can be brought into other
software for further analysis
using the Export Force Data
tool. These unit vectors should
be defined based on the

coordinate system in the force
stress analyzing software that
the force sets will be exported
to.

Defining from the Workspace
Force Sets for individual pipes can be
defined directly from the workspace by
right-clicking on a selected pipe.
Choose the Create Force Set With
Selected Pipe... option to launch the
Create Force Set window, shown
below in Figure 2. If multiple pipes are
selected, an individual Difference
Force Set will be created for each pipe
applying the specified settings for
each.

Figure 2: Create Force Set window in the
Workspace
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Transient Forces

Each force has several required and
optional parameters:
l

Pipe Name - If the pipe has a
name entered other than 'Pipe',
the user can choose whether to
include that pipe name or not in
the Force Set name.

l

Force Set Name - Users can
add a name for the Force Set to
better organize and manage
Force Sets in the model.

l

Force Unit Vectors or Length
- Define unit vectors for your linear pipe to give the resulting
forces a three-dimensional direction. xStream is still only a
one-dimensional fluid modeling
software, and specifying a unit
vector will not change the force
calculations. However, by defining the XYZ vector for a given
force set, that data can be
brought into other software for
further analysis using the
Export Force Data tool. These
unit vectors should be defined
based on the coordinate system in the force stress analyzing software that the force
sets will be exported to.

l

Show Analysis Setup Force
Panel after Creation - If
checked the user will be
brought to the Force panel of
the Analysis Setup window to
view all Force Set information
defined for that scenario.

Related Topics

30

Related Examples
High Pressure Steam Forces Example
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AFT Arrow Steady Solution Group
The user has control over a number of
parameters that influence global convergence for the AFT ArrowTM Steady
Solution.
Note: These values should only be
changed by experienced
users or under advisement
by AFT Support. Poorly
defined Solution Control
settings can cause the
model to converge on an
incorrect solution without
warning messages.
l

Solution Method panel - The
calculation method can be
defined on this panel.

l

Tolerance panel - The iterative
tolerances that define convergence can be defined on
this panel.

l

Iterations panel - Additional iteration controls that can affect
whether or not a model converges, or how quickly it will
converge, can be defined here.
Most settings on this panel will
not affect the final result.
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l

Pressure and Temperature Limits panel - Options to limit the
pressure and/or temperature
results in the solver.

Related Topics
References

435

Solution Method Panel

method types except the Lumped
methods. This option solves the entire
system with the Lumped Adiabatic
method, and applies the results of that
solution as a starting point to the
marching method selected. This can
help with convergence for some models. The results will be the same as
using only the marching method. See
the Lumped Methods section below
for more information on Lumped Adiabatic.

The Solution Method panel defines
the calculation method and relevant
parameters for the AFT ArrowTM
Steady Solution (Figure 1). This panel
is defined by default and typically
should not be changed unless problems are encountered when running
the model.
The Method Type can be set as
Recommended or User Specified. The
Recommended option (Length March
With March Number Limits) is sufficient for most models. If desired the
User Specified option can be selected
to choose a different Method Type as
are described below in the Solution
Method Overview section below.
Choosing User Specified also allows
the march method increments to be
changed.
A few other settings are defined by
default for the user including the
Length March Increment and Mach
Number Increment settings. See the
Marching Methods discussion below
for more information on these parameters.
Lastly the "First Use Lumped Adiabatic..." option is available for all

Figure 1: Default settings on the Solution
Method panel

Solution Method Overview
xStream has six solution methods it
can employ to find the AFT Arrow
Steady Solution. Each method has certain advantages, and applicability to
certain types of systems. While each
option should theoretically come to a
similar solution, there will be
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Number March method, switching to Length March if the distance between axial points is
too large. This helps ensure
accuracy when the changes in
Mach Number are small.

differences in the results between the
methods. The magnitude of this difference depends heavily on the particular system being analyzed. All of
the methods apply the same fundamental equations in differing ways.
l

Length March - All of the fundamental equations are applied
at fixed length increments axial points - down a pipe. This
method provides good accuracy if changes in Mach Number
are small. It is the least sensitive to initial conditions.

l

Length March with Mach
Number Limits - This hybrid
method starts with the Length
March method, and dynamically switches to the Mach
Number March method if the
change in Mach Number
between steps is large. This
ensures excessive changes in
Mach Number across computing sections are avoided.

l

l

Mach Number March - The
fundamental equations are still
applied at axial points down the
pipe, but in this case the distance between the points is
fixed by a Mach Number increment. This method is more
accurate when there are large
changes in Mach Number,
often occurring when the Mach
Number is high and when the
flow is sonically choked.
Mach Number March with
Length Limits - This hybrid
method begins with the Mach

l

Lumped Adiabatic - This
method ignores all heat transfer and elevation changes.
These effects are minimal in
xStream as the pipes will be
treated as adiabatic regardless,
and simplifying the calculations
this way greatly reduces the
required solution time and likelihood of convergence.

l

Lumped Isothermal - This
method further simplifies the
fundamental equations by
assuming pipes are a fixed temperature throughout and again
ignoring elevation.

Marching Methods
The marching methods provide the
most accurate solutions. AFT Arrow
"marches" down a pipe in the model,
solving the fundamental equations
along the way.
Dividing the pipe into smaller segments is important for compressible
flow because the fluid properties
change throughout the pipe. Each segment considers the flow properties
constant and applies the fundamental
equations. This represents a discretization of the continuously changing flow parameters - necessary for
an iterative Solver such as AFT Arrow.
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This discretization introduces a certain
amount of error into the solution,
which is closely related to how many
segments are present, as well as how
much the flow properties change over
a single segment.
When dividing the pipes into segments, axial points are created along
the pipe, at the ends of every segment. The results at each axial point
can be viewed in the output.
l

l

Length March - This method
divides pipes into segments
based on length. The segment
length can be defined in two
ways - either by dividing every
pipe into a certain number of
segments (Initial Number of
Segments per Pipe setting),
or dividing all pipes into equallength segments (Segment
Length setting). This method
has the advantages that it is
conceptually easier to understand and ensures some minimum number of segments in
every pipe. Axial points are
also often located at convenient locations. However, at
high Mach Numbers, the large
change in flow properties over
a segment makes this method
less accurate. For a detailed
mathematical description of
this method see Length March
Method - Detailed Discussion.
Mach Number March - Unlike
the Length March, Mach Number March determines the locations of the axial points

dynamically based on the flow
solution. There is no easy way
to tell where the axial points will
be without completing the solution. This method is superior
when analyzing high Mach
Number flows, as the flow properties tend to change dramatically over short distances.
Effectively, this method adds
axial points as necessary
where the flow properties are
changing rapidly. The disadvantage of this method is
that the minimum number of
sections cannot be enforced - if
the Mach Number in a single
pipe changes less than the
increment specified, the entire
pipe will be represented with a
single segment. This is not
necessarily inaccurate, but it is
generally preferable to have
more than one segment per
pipe. For a detailed mathematical description of this
method see Mach Number
March Method - Detailed Discussion.

Hybrid Marching Methods
AFT Arrow offers hybrid marching
methods to get the best of both marching methods in one solution. These
methods dynamically switch from
Length to Mach Number March or
vice-versa during the solution.
This dynamic switch allows the user to
ensure that a certain minimum
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number of segments is present in
each pipe, and that the flow properties
do not change significantly over the
segment.
l

l

Length March With Mach
Number Limits (AFT Arrow
default) - The default solution
method begins the march down
the pipe with equal length segments. If the Mach Number
over any certain segment is
detected to increase more than
the specified limit, the march
continues over the rest of the
pipe at equal Mach Number
increments. It is often the case
that flow velocity in a pipe is relatively low and constant in the
first few segments of the pipe,
but increases dramatically
towards the exit. This method
captures this behavior.
Mach Number March With
Length Limits - Very similar to
the default method, this hybrid
method begins with a Mach
Number march, but if it is detected that the length to the next
axial point is too far due to relatively constant velocity, additional axial points are forced
into the pipe via the length limit.
This helps ensure all pipes
have some minimum number of
sections.

violate the Mach Number limit of 0.01.
Therefore, the march was adjusted
(starting at point 6) to increment in
Mach Number steps of 0.01.

Figure 1: Length March dynamically
switching to Mach Number March

Lumped Methods
For faster - but less accurate - computation, AFT Arrow offers two of the
traditional lumped methods. These
methods divide all pipes into 10 segments, but the method solves the
entire pipe in a single computation.
Certain assumptions simplify the fundamental equations allowing a much
faster solution at the cost of accuracy.
l

The figure below shows an example of
a pipe solved with Length March With
Mach Number Limits. During the solution, the solver determined that taking
an additional 10 foot step from point 6
(60 feet) to point 7 (70 feet) would

Lumped Adiabatic - This
method treats every pipe as
adiabatic, disallowing heat
transfer into or out of the pipe. If
heat transfer is defined in the
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model, the definition is retained
for convenience but is not
applied during the solution. In
addition, this model cannot
accurately model body forces
so therefore does not account
for elevation changes or rotating systems. In many gas systems these assumptions are
reasonable and the results
from Lumped Adiabatic acceptable. For a detailed mathematical description of this
method see Lumped Adiabatic
Method - Detailed Discussion.
l

Lumped Isothermal - Similarly, this method treats all
pipes as a constant temperature. Again, elevations are
ignored. Note that heat transfer
is applied to pipes (heat in or
out) to meet the isothermal conditions. For a detailed mathematical description of this
method see Lumped Isothermal Method - Detailed Discussion.
l

Use Pipe Isothermal
Temperatures When
Available Instead of
This Value - If Isothermal models have
been defined for individual pipes, that temperature will be applied
to that pipe instead of
the global temperature
defined in the Solution
Method panel.

Comparing Marching Methods to Traditional Methods
There exist in industry practice a number of traditional methods and equations for calculating compressible flow
in pipes.
A common equation is the Crane isothermal equation (see Crane, 1988,
pp. 1-8). AFT Arrow and equations
such as the Crane isothermal equation differ in several respects. First is
that the Crane equation assumes isothermal flow, while AFT Arrow can
model isothermal flow or other, more
general, boundary conditions. Second
is that the Crane equation solves the
entire pipe as one segment. This can
be called a lumped method. It is thus
roughly analogous to using AFT Arrow
with a single computing section per
pipe. Third, the Crane equation
assumes a constant diameter run,
whereas AFT Arrow allows you to
change diameters. Fourth, it is not
apparent how to apply the Crane equation to multi-pipe systems, including
pipe networks.
The Crane equation solves the governing mass and momentum equations by making some assumptions.
AFT Arrow is solving the same equations, but is not making any assumptions. It marches down each pipe,
taking into account physical property
changes and non-linear acceleration
effects as it progresses. Thus, AFT
Arrow is in general much broader and
more accurate than the Crane
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equation. When the pipe flow conditions are within the assumptions of
the Crane equation, then the Crane
equation and AFT Arrow should agree
closely.
Other equations on page 1-8 of Crane,
1988, compare similarly to AFT Arrow.
They are all lumped methods with certain assumptions about thermal conditions in the pipe and properties of
the gas.

(23)

Now take Equation 23 and use it to
replace the pressure term in Equation
10 to obtain:

These traditional equations can be
used successfully in many engineering applications. They all represent
a subset of AFT Arrow’s marching
methods, which solve the fundamental
equations without limiting assumptions.

(24)

The first two terms on the right hand
side of Equation 24 relate to the stagnation temperature (Equation 15) as
follows:

Length March Method Detailed Discussion
The Length March solution method for
the AFT Arrow Steady Solution
Method is described in detail below.
The stagnation pressure is given by
the following:

Making this substitution, and also
using Equation 14
(22)

By differentiating Equation 22 the following is obtained:

(25)
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known, and at location 2 are being solved
using one of the marching equations.

Integrating Equation 25 yields:

(26)

And with algebra the Length March
equation (Equation 27) is obtained:

(27)

Both of these methods are referred to
as marching methods. What does this
mean? Figure 1 shows a representation of a computing section in a
pipe. In this example, all parameters
at Location 1 are known, and it is
desired to calculate conditions at location 2 which is always downstream of
location 1.
Whether we are applying the Length
March or the Mach Number March
(Equation 21, 37 or 41), at location 1
we know these primary parameters:

Because we know the parameters
above, we also know:

Example
Some examples are given here to clarify how the Mach Number March and
Length March methods solve the governing equations.

Let's consider the Length March
method first because it is easier to
grasp. Using the Length March equation, we know three things about location 2. First, we know the length step,
as this is specified by the user. We
also know that the mass flow rate is
constant. Lastly, we know the heat
transfer relationship specified by the
user and can use this to determine a
thermodynamic parameter.

Figure 1: Marching equations are applied
at successive computing sections along
the pipe. Conditions at location 1 are

For instance, if the pipe is modeled as
adiabatic (q = 0), we can determine
the stagnation enthalpy at location 2
using the following assumptions.
If there is no elevation change, then:
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and according to the Energy equation:

Even if there is elevation change, we
know what it is and can just add that
into the energy equation and calculate
ho,2 explicitly.
If the pipe is isothermal, then:

If there is convective heat transfer or
known heat flux, we can solve Equation 36 or 40 for To,2 which allows us
to calculate ho,2 and we are at the
same point as with adiabatic.
Thus, if any boundary condition other
than isothermal is specified, the following is known at location 2:

or, if isothermal, the following is known
at location 2:

With one thermodynamic parameter
known at location 2, we guess at the
stagnation pressure solution to the
Length March equation. This in effect
gives us two known thermodynamic
parameters, from which all the other
parameters can be determined
through state relationships. This
requires significant iteration for each
computing step.
For each pipe in the system, the
marching is initiated at the pipe inlet
where conditions are known. The
known inlet conditions reflect the current solution state at the junction
upstream of the pipe. This is location
1. Based on the user specified length
step, the distance to location 2 is specified. The method just described is
used to converge on the conditions at
location 2. Once this convergence
occurs, the previous location 2
becomes location 1 and a new location 2 is determined based on the
step size. The marching continues to
the end of the pipe.
If the user specifies an absolute length
size (say 10 foot sections), a step may
go past the end of the pipe. This will
occur for any pipe that is shorter than
10 feet. For a longer pipe of say 12
feet, the first computing length will be
10 feet, while the second will be 2 feet.
It should be understood that in the
Length March method, computing sections are equidistant along a pipe,
aside from possible roundoff at the
end.
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Note: The process of converging
on location 2 while marching
down a pipe is referred to as
a local iteration. It is local in
that it does relate to what is
happening in any other part
of the model. AFT xStream
also has global iterations,
which relates to iterations
made on the entire system in
trying to obtain complete system convergence. You can
specify iteration limits for
each type of convergence in
the Iterations panel.

Example Application

of the gas as it expands with pressure
drop.
Fourth, notice that the stagnation
enthalpy is constant in accordance
with adiabatic flow.
Fifth, notice how the static enthalpy
drops along the pipe length. This
shows that the flow is not isenthalpic.
Finally, notice how the stagnation temperature drops slightly. This is a result
of real gas effects. A perfect gas will
have constant stagnation temperature
and enthalpy in adiabatic flow with constant elevation.
These results can be viewed graphically by changing to the Graph Results window and selecting to graph a
profile along a flow path.

Consider the model in Figure 2. This
model is of an air system modeled as
a real gas using Redlich-Kwong and
Generalized enthalpy. The Solution
Method panel specifies Length March
method with 10 segments per pipe.
Results using the Length March
method are shown in Figure 3.
There are several items worth noting
in Figure 3. First, note that the second
column shows the x location for each
computation step. Point 1 will be
identical to the pipe's inlet values. For
this model, there were 10 steps along
a 100 foot pipe, thus each step is
equally 10 feet long.
Second, notice how the velocity and
Mach number increase along the pipe
length.
Third, notice how the static temperature drops. This is due to cooling

Figure 2: Model of an air system dropping
from 40 to 30 psia.
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Figure 3: Axial Points (available in the
Output window) for model in Figure 2
using Length March method

Length March Method Verification
The axial points shown Figure 3 can
be used to verify that the fundamental
equations are being solved accurately. Figure 4 shows the relevant verification parameters for a pipe carrying
air from a tank at 40 psia and 100 deg.
F to another tank at 30 psia. The pipe
is vertical, 100 feet long, and 4 inches
in diameter with a roughness of 0.001
inches, and is adiabatic. The high pressure tank is the top tank.

Figure 4: Axial Points for AFT xStream
model Verify_Governing_Equations.xtr
using the Length March method.

The model, Verify_Governing_Equations.xtr, is shown in Figure 5 can be
obtained from AFT upon request (support@aft.com). Also included is an
Output Control data configuration file
called Verify_Governing_Equations_
1.dat that can be used to configure
any model to that shown in Figure 1.
The Figure 4 results were obtained
using the Length March method with
10 pipe segments. The results can be
copied to the clipboard and pasted
into a spreadsheet as shown in Table
1. Once in the spreadsheet, additional
calculations can be performed. Table
1 shows these calculations and a balance verification using all terms in the
momentum equation (Equation 2), continuity equation (Equation 1), and
energy equation (Equation 30). Along
with the previous files, this spreadsheet is included upon request and is
named Verify_Governing_Equations_
Length.xls.
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There are several terms in Table 1
that require clarification. Using coordinates as shown previously in Figures 1
of Fundamental Equations and Figure
1, density and velocity can be represented as follows:

Figure 5: AFT xStream model solved in
Figure 1 and verified in Table 1. Fluid is
air. File is Verify_Governing_Equations.xtr.

And using these terms, the four
momentum equation terms from Table
1 are defined as:
dP
Total:

dP
Fric.
(Friction):
dP
Accel
(Acceleration):
dP
Grav.
(Gravity):

(53)
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Table 1: Verification showing how AFT
xStream Length March method predictions satisfy momentum, mass and
energy balance equations. Taken from
spreadsheet Verify_Governing_Equations_Length.xls.

small number). They do, as shown in
Table 1 in the column titled Balance
(psi).
Note that AFT xStream does not solve
Equation 49. Rather, when using the
Length March method, AFT xStream
solves Equation 27, which contains
(more accurate) logarithmic terms.
Equation 27 is a more complex form of
the momentum equation. The arithmetically averaged terms in Equations
49 and Table 1 are approximations
which show that the momentum equation is being satisfied.
Table 1 has another column titled Balance (lbm/sec) which shows that the
continuity equation (Equation 1) is
also satisfied. This is calculated in
Table 1 as follows:

There is another term that is not relevant in this model and is thus not
shown in Table 1. This term accounts
for additional minor losses in the form
of K factors, and is a modified form of
the dP Acceleration term:

The momentum equation terms in
Table 1 are added together for each
computing section. If the momentum
equation is being satisfied, the four
terms should sum to zero (or a very

While not shown here, it was shown
earlier in Figure 3 how AFT xStream
maintains constant stagnation
enthalpy for adiabatic flow with zero
elevation change. According to the
energy equation (Equation 30), when
the elevation changes, the stagnation
enthalpy is not constant in adiabatic
flow. The energy balance is calculated
as follows:
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In the Energy Balance column, Table
1 shows how this equation is satisfied.
If heat transfer is applied, it is a simple
matter to extend the spreadsheet
behind Table 1 to verify that energy is
balanced.
The individual terms in Equations 49
are also available for output in AFT
xStream. The contributions to pressure drop can be reviewed individually, and can also be used for
further verification. Figure 6 shows the
axial points again for Verify_Governing_Equations.xtr, but now these pressure drop contributions are shown.
The Output Control data configuration
file used to obtain the Figure 6 format
is Verify_Governing_Equations_2.dat.

Figure 7: Pipe Results table shows total
pressure drop contributions as defined in
Equation 49.

Related Topics
Nomenclature
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Mach Number March
Method - Detailed Discussion

Figure 6: Axial Points for Verify_Governing_Equations.xtr showing the individual
pressure drop contributions.

The Pipe Results table shows the total
pressure drop contributions for each
pipe when appropriate parameters are
selected for display. See Figure 7.

The Mach Number March Solution
Method for the AFT Arrow Steady
Solution Method is described in detail
below.
Modify Equation 2 by substituting
Equations 3 and 5 and eliminating
density,

(6)

By definition of Mach number for a real
gas
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Replace velocity by Mach number by
substituting Equation 9 into Equation
11 to obtain

(7)

and from basic calculus the following
relationship holds:

(12)

(8)

Eliminate pressure from Equation 10
using Equation 12 to obtain:

Differentiating Equation 7 (and using
Equation 8) results in,

(9)

(13)

From the definition of stagnation temperature

Now, substitute Equation 7 and 9 into
Equation 6 and eliminate the velocity
(14)
(10)

Differentiating the preceding yields

(15)

Differentiating the equation of state,
Equation 5 yields

(11)

Replace static temperature in Equation 13 with stagnation by using Equation 14 and Equation 15 to obtain:
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Collecting terms and simplifying
yields:

(16)

Rearrange Equation 16 to obtain
(18)

(17)

Four useful parameters that simplify
notation are:

Using the four new parameters in
Equation 18 simplifies to
(19)
Integrating Equation 19 yields
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(20)

(28)

The definition of stagnation enthalpy is
Equation 20 can be solved for x2:
(29)
(21)

which, when substituted into Equation
28, yields:

(30)
where the bars over certain parameters indicate that the average value
over the computing section is used.
Equation 21 is the Mach Number
March equation. The Mach Number
March is a variable step size method.
As shown in Equation 21, the distance
is the parameter being calculated.

Modifications for Heat Transfer
In order to model heat transfer effects
it is convenient in some cases to
modify the previous equations.
The energy equation has the form:

In most applications, the elevation
term, gz, is very small and is neglected. This term will only become significant over pipes that have large
elevation changes such as pipelines
that go over mountains or down
mineshafts, or in rapidly rotating systems.
With elevation neglected, it is not
uncommon for engineers to conclude
that adiabatic flow is isenthalpic (constant static enthalpy). It’s not. Rather,
the stagnation enthalpy is constant in
adiabatic flow.

Convective Heat Transfer
In pipe convective heat transfer, it is
convenient to use the change in stagnation temperature rather than
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stagnation enthalpy by introducing the
following approximation
(34)
(31)
Rearranging Equation 34 yields:
When heat transfer occurs, the effect
of elevation change on the energy balance is small and is neglected. Substituting Equation 31 into Equation 30
yields

(32)

(35)

Integrating Equation 35 yields

The heat transfer due to convection is
given by the following:

(36)

(33)
where:
U = Overall heat transfer coefficient

This relationship for stagnation temperature can be substituted into Equation 20 to obtain:

Ph = Heated perimeter
The heated perimeter will frequently
equal the wetted perimeter, which is
the internal pipe circumference. It can
change if part of the pipe is insulated
(it will be less than the wetted perimeter) or there are fins on the pipe (it
will be greater than the wetted perimeter).
Equating Equation 32 and 33 yields

(37)

In convective applications which use
the Mach Number March method, the
advantage of Equation 37 over Equation 21 is that the stagnation temperature change is proportional to the
distance step dx (as shown in

115

Quick Start Guide

Equation 35), for which we are solving. Equation 37 couples the effects of
friction and heat transfer, and provides
more reliable convergence, especially
in convection heating.

(41)

Constant Heat Flux
The constant heat flux boundary condition on a pipe results in a modified
form of Equation 32

(38)

The stagnation temperature change is
thus:

Example
Some examples are given here to clarify how the Mach Number March and
Length March methods solve the governing equations.

(39)

Figure 1: Marching equations are applied
at successive computing sections along
the pipe. Conditions at location 1 are
known, and at location 2 are being solved
using one of the marching equations

Integrating Equation 39 yields:

(40)

Substituting this into Equation 20
yields:

Both of these methods are referred to
as marching methods. What does this
mean? Figure 1 shows a representation of a computing section in a
pipe. In this example, all parameters
at Location 1 are known, and it is
desired to calculate conditions at location 2 which is always downstream of
location 1.
Whether we are applying the Length
March or the Mach Number March
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(Equation 21, 37 or 41), at location 1
we know these primary parameters:

with the other derived knowns easily
obtainable:
Because we know the parameters
above, we also know:

Let’s turn our attention to the Mach
Number March method. Depending on
the heat transfer model, AFT xStream
will solve either Equation 21, 37 or 41.
The most general of these is Equation
21, so in the following discussion it will
be referred to as the Mach Number
March equation, with the understanding that Equation 21 encompasses Equations 37 and 41.
Similar to the Length March method, it
is desired to solve for conditions at location 2 based on known conditions at
location 1 (see Figure 2). However,
here the length step itself is not
known. In fact, as shown in Equation
21 it is the computing length (i.e., Δx)
for which we are solving. What is the
reason for trying to solve for Dx rather
just specifying it? This question will be
answered shortly. Before that, let’s
understand better what is happening
when Equation 21 is applied.
The knowns at location 1 are the same
as before, namely:

In the Mach Number March method,
our step size is dictated by increments
of Mach number. We thus take the
Mach number at location 1 (M1) and
add to it an increment. Since the maximum Mach number in the pipe systems modeled in AFT xStream is 1,
the step size should be far smaller.
The default step size is 0.01. Using
the default, we know the Mach number at location 2:

where ΔM is the Mach number increment. As before, we know the mass
flow rate at location 2 (it's the same
the same as location 1), and we also
have similar heat transfer relationships as discussed in the Length
March method example previously.
Specifically, if the pipe is adiabatic, we
know the following at location 2:
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or, if isothermal, the following is known
at location 2:

and if the pipe has a convective or
heat flux boundary condition,

less than ΔM. It will always occur for
the final computing section of each
pipe that does not reach choking. In
such a case, the method reverts to the
Length March method to compute conditions at the pipe exit.
It should be clearly understood that in
the Mach Number March method, computing sections are not equidistant
along a pipe. In fact, as the gas accelerates along the pipe, the Mach number increases more and more rapidly.
This results in shorter and shorter computing section lengths as shown in the
following application.

Example Application

However, in the convective and heat
flux cases, we cannot definitely say
what ho,2, is because the amount of
stagnation enthalpy change depends
on the length step, for which we are
solving. This requires additional iteration.
Similar to the Length March method,
the Mach Number March method
requires significant iteration for each
computing step. Again, known inlet
conditions become the first location 1,
and once location 2 is solved, it
becomes location 1 and the marching
continues to the end of the pipe.
Since we are solving for Δx, it is
entirely possible that the distance step
will extend beyond the pipe length.
This will occur for any pipe that has an
end-to-end Mach number change of

Consider once again the model in Figure 2. All conditions are the same as in
the previous Length March method
application, except for the solution
method. If we solve this model using
the Mach Number March method, with
a Mach number increment of 0.01, the
results in Figure 3 are obtained.
There are several items to note about
Figure 3. First, note how the Mach
number increases down the length of
the pipe. At the inlet, the Mach number
is 0.2604 (this is not specified, but
determined as part of the solution for
flow rate). Each computing point
increases the Mach number by DM ,
which is 0.01. This is what the Mach
Number March method is, a method
which marches in Mach number increments. With the step size dependent
on the Mach number change, the number of calculation points in a pipe
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cannot be controlled. The 10 points
shown in Figure 3 were chosen by
AFT xStream, not the user.

example is given in the Mach Number
March Verification section below.

Second, note the x locations of computing points. These numbers are not
whole numbers, and as the end of the
pipe is approached the distance
between each computing section and
the previous one becomes smaller
and smaller. This is a result of the gas
acceleration. At higher Mach numbers
this becomes even more pronounced.
Figure 4 shows how the Mach number
increases along the pipe length. The
curve's upward curvature shows the
acceleration effect. Figure 5 shows
the relative computing section distances.

Figure 2: Model of an air system dropping
from 40 to 30 psia.

Third, notice this adiabatic flow case
has constant stagnation enthalpy, but
not constant static enthalpy. This is
similar to the Length March method.
Last, notice how the mass flow rate is
(in this case) the same as the Length
March method results shown in Figure
3 of Length March Method Example
(4.884 lbm/sec). Since both methods
solve the same governing equations,
one would expect the results to be
comparable. However, the two methods will not always agree. Each
method has strengths and weaknesses, and results can differ somewhat when the flow conditions favor
one of the methods.
Is there any way to check that the results offer valid solutions of mass balance (Equation 1), momentum
balance (Equation 2) and energy balance (Equation 30)? There is. An

Figure 3: Axial Points (available in the
Output window) for model in Figure 2
using Mach Number March method.
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Figure 5 of the Length March Verification to the Mach Number March
method, the verification process
described in the previous section for
the Length March method can be
repeated. This is shown in Figure 6
and Table 1.

Figure 4: The Mach number increases
with length in this plot of the Figure 3 results

Figure 5: Relative pipe section locations
for Figure 3 results. Notice how computing sections get closer as a result of
gas acceleration as the end of the pipe is
approached

Mach Number March Method
Verification
By changing the solution method for
Verify_Governing_Equations.xtr in

Figure 6: Axial Points for AFT xStream
model Verify_Governing_Equations.xtr
using the Mach Number March method.
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approximation.
Table 1: Verification showing how AFT
xStream Mach Number March method predictions satisfy momentum, mass and
energy balance equations. Taken from
spreadsheet Verify_Governing_Equations_Mach.xls

An analytical solution to Equations 1,
2 and 5 for adiabatic flow neglecting
elevation changes is given by the following (e.g., see Saad, 1993, page
209):

(42)

This equation is valid for real gases as
long as the following approximation is
accepted:

using a suitably averaged value of cp.
Integrating from 0 to L obtains:

Related Topics
Nomenclature

(43)
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Lumped Adiabatic
Method - Detailed Discussion
When this AFT Arrow Steady Solution
Method is used elevation data is
ignored by the Solver. The output will
still show the elevation as entered by
the user. Since elevation effects are
usually not very important in gas systems, neglecting elevation changes is
frequently an acceptable

Equation 43 is then solved for each
pipe, using an average value of friction
factor and g for each pipe. The solution of Equation 43 typically is iterative
where the unknown is M2.

Related Topics
References
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Lumped Isothermal
Method - Detailed Discussion
When this AFT Arrow Steady Solution
Method is used elevation data is
ignored by the AFT Arrow Steady
solver. The output will still show the
elevation as entered by the user.
Since elevation effects are usually not
very important in gas systems, neglecting elevation changes is frequently
an acceptable approximation.
Another special case of flow in pipes is
that of isothermal flow. In isothermal
flow, the gas static temperature
remains constant. The tendency is for
gas to cool as it flows along a pipe. For
the temperature to remain constant,
an inflow of heat is required.
When the temperature remains constant, it removes one of the unknowns
from Equations 1, 2 and 5. From Equation 5, the density becomes directly
proportional to pressure, and an analytical solution can be obtained if elevation changes are neglected (e.g., see
Saad, 1993, pp. 264-269):

(44)

where the T subscript on L emphasizes isothermal. Integrating from point
0 to L,

(45)

Isothermal flow behavior results in a
different relationship for sonic choking
as compared to adiabatic flow. In fact,
to truly maintain isothermal flow up to
the sonic point requires an infinite
amount of heat transfer. This results in
the strange but mathematically correct
conclusion that sonic choking occurs
at a Mach number less than 1 for isothermal flow. Sonic choking will occur
at 1/sqrt(gamma) for isothermal flow,
where gamma is the isentropic expansion coefficient (Saad, 1993, pp. 267).
Practically speaking, isothermal flow
will not remain isothermal at high velocities.
Similar to the Lumped Adiabatic
method, Equation 45 is solved for
each pipe, using an average value of
friction factor and g for each pipe. The
solution of Equation 45 typically is iterative where the unknown is M2.
When the user chooses the Lumped
Isothermal method, an isothermal temperature is required in the AFT Arrow
Steady Solution panel. This temperature is used for all pipes.

Related Topics
References
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Tolerance Panel
The iterative tolerances that define
convergence are defined on the Tolerance panel in Analysis Setup,
shown in Figure 1. These values can
be modified for Pressure Tolerance,
Flow Rate Tolerance, and Enthalpy
Tolerance.

A solution is to use iterative tolerance.
This tolerance is related to the change
between iterations. When this change
is smaller than the iterative tolerance,
the solution is said to be converged.
These settings are specified in the
Solution Method panel.

Tolerance and Solution
Accuracy
Iterative tolerance does not have any
relationship to an engineering tolerance.
An engineering tolerance is a familiar
term to most engineers - it is a permissible limit in variation of a parameter. A simple example is the length
of a steel bar - an engineer might specify that this length must be 3 ± 0.01
meters. A steel bar manufactured by
this specification is known to be within
the engineering tolerance of the "true"
or desired length. In other words,
engineering tolerance describes an
accuracy.
Figure 1: Tolerance panel in Analysis
Setup

An iterative approach is used to obtain
pipe flow solutions. When approaching any analysis iteratively, a stopping
point must be defined. The simplest
approach is to stop after a certain number of iterations. However, this either
results in uncertain results because
the result is still changing, or wasted
processing time because there are too
many iterations.

Iterative tolerances do not directly
describe an accuracy. Convergence
only means that the change between
iterations was within the specified
limit.
With sound iterative methods, and an
appropriately specified iterative tolerance, the iterative solution will be
close to the true solution. However,
even with good settings, the iterative
tolerance does not define how close
the results are to the true solution.
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If there is concern that the results may
not be close enough to the true
answer, the tolerances could be
lowered and the results compared. If
the results do not change appreciably,
an appropriate tolerance was likely
selected.

Avoiding False Convergence
It is important to keep the tolerance at
least one order of magnitude smaller
(two orders or more is recommended)
than the relaxation. A false convergence can occur when the change
from the old value to the new value is
small enough to be within the tolerance because it is restricted by the
relaxation.

Absolute Tolerance
Absolute tolerance looks at the absolute change in quantity of a given parameter. If the change is smaller than
the directly specified value, the parameter is considered converged.
This approach works equally well for
both small and very large values, making iterative solvers more likely to find
convergence. However, specifying an
appropriate absolute tolerance
requires some knowledge of the true
solution. The tolerance should be set
3 or 4 orders of magnitude below the
solution, if there are near zero flows in
the system this will require a very low
tolerance.

Relative Tolerance
Relative tolerance checks the relative
change of a given parameter. Each
change is divided by the number itself,
giving a change proportional to the
magnitude.
This approach does not require any
knowledge about the true solution,
and for that reason is the default
method.
Table 1 shows the difference between
relative and absolute change while iterating. Notice that the absolute change
has units, while relative change does
not.
Convergence criteria can also be
based on either (or both) absolute or
relative change. Table 1 shows how
this is applied.
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Table 1: Example of four tolerance methods for a mass flow rate example. Absolute tolerance = 0.0005 lbm/s, Relative
tolerance = 0.0001

Iteration
#

Mass
Flow
Rate
(lbm/sec)

Relative
Change

1

20.0000

2

0.6126.060060
67

3

-

Absolute
Change
(lbm/sec)

-

Meets
Abs.
Tolerance?

-

Meets
Rel.
Tolerance?

-

Meets
Abs.
ORRel.
Tolerance?

-

8.00- N00- O
00

NO

NO

0.142.1.000- N40000- O
20
00
8-

NO

NO

MeetsAbs.
ANDRel.
Tolerance?

-

Iteration
#

Relative
Change

Meets
Abs.
Tolerance?

Meets
Rel.
Tolerance?

Meets
Abs.
ORRel.
Tolerance?

MeetsAbs.
ANDRel.
Tolerance?

57

4

0.0133.570000
37

0.50- N00- O
00

NO

NO

NO

5

0.0130.670030
53

0.10- N00- O
00

NO

NO

NO

6

13.5900

0.000-

0.01- N00- O
00

NO

NO

NO

NO

NO

Mass
Flow
Rate
(lbm/sec)

Absolute
Change
(lbm/sec)
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Mass
Flow
Rate
(lbm/sec)

Relative
Change

Absolute
Change
(lbm/sec)

Meets
Abs.
Tolerance?

Meets
Rel.
Tolerance?

Meets
Abs.
ORRel.
Tolerance?

MeetsAbs.
ANDRel.
Tolerance?

736
0.0130.509103
96

0.00- N01- O
30

8

0.0130.509007
44

0.00- N06- O
00

9

13- 0.- 0.YE- YE- YE- YE.5- 0- 00S
S
S
S
90- 0- 02-

7

YE- YENO
S
S

Iteration
#

Absolute
Change
(lbm/sec)

Mass
Flow
Rate
(lbm/sec)

Relative
Change

9

0000
15

Meets
Abs.
Tolerance?

Meets
Rel.
Tolerance?

Meets
Abs.
ORRel.
Tolerance?

MeetsAbs.
ANDRel.
Tolerance?

Exhaustive Tolerance
AFT xStream finds a solution for all
junction pressures when Exhaustive
Tolerance is enabled.

YE- YENO
S
S

Disabling this option will only check
junction pressures that are in the solution matrix. Only junctions that contain
a split in flow are included in the matrix. Both options should come to a
reasonably similar converged result,
but the more rigorous approach of
checking all junctions is selected by
default.
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Related Blogs

destabilizing effect of non-linear systems.
l

Automatic - Implements an
adaptive relaxation scheme
that reduces the relaxation
dynamically in response to
highly non-linear features of the
problem.

l

Fixed - Allows for user specified Flow Rate and Pressure
Relaxation

Having model convergence problems? Start here!

Iterations Panel
Relaxation, iteration limits, and matrix
method settings are defined on the Iterations panel in Analysis Setup. Most
settings on this panel will not affect the
final result. The default state of the Iterations panel is shown in Figure 1.

When applied to the flow solution,
relaxation r is used as follows:

A relaxation of 1 is the same as no
relaxation. Each iteration's prediction
is used directly in the next iteration.
A relaxation of 0 is not allowed, as this
would prevent the parameter from
changing.
l

Figure 1: Iterations panel in Analysis
Setup

Relaxation
Relaxation slows iterative progress
toward a solution reducing the

Flow Rate Relaxation - For
highly non-linear systems, a
flow rate relaxation of 0.1 is
advised. Experience shows
that using flow rate relaxation
factors between 0.5 and 1 has
limited usefulness. If a flow rate
relaxation of 1 does not work,
you should generally try flow
rate relaxation parameters
between 0.1 and 0.5. In more
extreme cases, a flow rate
relaxation factor smaller than
0.1 may be required.
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l

Pressure Relaxation Because of the nature of the
matrix solver, experience indicates that if pressure relaxation
is used, it should always be set
to 0.5 or 1 to maintain stability.

l

Resistance Relaxation - Typically should be left at 1. In
some cases with very long
pipelines, reducing the value as
low as 0.1 can improve convergence.

Iteration History shows a history of
which pipe or junction is most out of tolerance, which is helpful for
troubleshooting. After enabling Iteration History on the Iterations panel in
Analysis Setup, the Iteration History
can be viewed from the Solution Progress window by pausing the calculation and selecting the Other
Actions button.

Matrix Method
Iteration Limit
l

Maximum Iterations - 50000
by default, sufficient for the vast
majority of models. Most models converge in a relatively
small number of iterations. This
limit does not directly affect the
solution.

l

Iteration Span for
AutoDetect - If the AFT Arrow
Steady Solver detects that no
meaningful progress has been
made to convergence within
this many iterations, relaxation
is automatically lowered. This
also automatically adjusts tolerance.

l

Local Iterations - The maximum number of local iterations
allowed before allowing the
Solver to continue without local
convergence. See Local Iteration Control below for details.

Iteration History

Network analysis requires solving complex matrices potentially thousands of
times. Different methods may solve
faster or slower, but have no bearing
on results. The default method of
Gaussian Elimination is very robust
and usually provides the fastest convergence. The available Matrix Methods are:
l

Gaussian Elimination

l

Gaussian Elimination With
Pivoting

l

LU Decomposition

Local Iteration Control
In the AFT Arrow Steady Solver, properties such as density, specific heat,
and viscosity will vary over an interval.
Calculations done on such an interval
should use average values for the
interval. However, the average values
cannot be directly calculated without
knowing the values at both the beginning and ending of the interval.
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Because the parameters at the end of
the interval are not known initially, the
local properties must be solved for iteratively.
In certain models, these local iterations may not converge. The Local
Iterations limit provides a means to
allow the Solver to continue if this
occurs.
If the Local Iteration limit is reached,
the Solver will continue with the global
solution using the non-converged
local solution. This does not affect the
final results unless it occurs on the
final global pass through the Solver. If
a local iteration problem does occur
on the final pass, the solution is
retried. A Max Number of Retires
After Incomplete Local Convergence will be carried out to
attempt to solve the problem. If the
retries are not successful, the results
will be presented as converged along
with a warning including information
on the amount out of tolerance.
A default Factor on Allowable Tolerance Violation of 50 is specified
here. Local iterations within this factor
of the built-in tolerance values are
deemed adequately acceptable. Setting this value to 1 will show a warning
for any tolerance violation.

Related Blogs
Having model convergence problems? Start here!

Pressure and Temperature Limits Panel
If the maximum and minimum temperatures or pressures in a system are
known, these can be entered here. If
limits are present, the AFT Arrow
Steady Solver will not allow solutions
outside of these bounds.
This is most useful when operating
near the edge of available physical
property data. During iteration, the
Solver may attempt to extrapolate
past the available data, returning an
error. Limiting the allowable range can
keep the search within the proper
bounds.
Note: This setting can affect results. It is critical that the limits
are appropriately selected to
not artificially constrict the
solution.

Environmental Properties Group
The Environmental Properties Group
in Analysis Setup has one item: Environmental Properties panel. By default,
the Environmental Properties Group is
fully defined and will have a green
checkmark next to its name.
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Environmental Properties Panel
The Environmental Properties panel,
shown in Figure 1, controls the atmospheric pressure, acceleration properties, standard conditions, and
transition Reynolds number used to
model the system.

spheric pressure as a project at 8500
feet.

Standard Conditions (STP)
The standard temperature and pressure (STP) are used for defining common usage flow rate units including
standard cubic feet per minute (scfm).
AFT xStream uses a default standard
pressure of 14.696 psia. This value is
used consistently across industry, and
the user likely will not need to change
it. AFT xStream uses a default standard temperature of 60° F. This value
changes across industries, and the
user may wish to change it.
Another common usage flow rate is
normal flow rate units. The definition
of normal uses the same standard
pressure as above, but 32° F (0° C) for
temperature. The normal pressure
and temperature cannot be changed
by the user.

Figure 1: Environmental Properties panel
in the Analysis Setup window

Transition Reynolds Numbers
Atmospheric Pressure
AFT xStream uses a default atmospheric pressure of 1 standard earth
atmosphere, or 14.696 psia. This pressure is also used to convert absolute
pressures to gauge pressures. Keep
in mind that atmospheric pressure varies with altitude. A project at Sea Level
should not have the same atmo-

AFT xStream allows you to modify the
transition Reynolds numbers. The
default values are Reynolds number
less than 2300 is laminar and greater
than 4000 is turbulent. In the transition
zone a linear interpolation is assumed.
This applies for friction factors as well.
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Miscellaneous Group
The Miscellaneous Group in Analysis
Setup has two items: the Advanced
Parameters panel and Advanced Transient Parameters panel. Both panels
contain advanced parameters intended for troubleshooting only and
should be used with caution.

information and guidance on other
options please contact AFT.
l

Create Transient Debug File Disabled by default. When
enabled, xStream will write relevant diagnostic information to
a text file, including information
on tolerance and convergence
settings, records of when/if saturation conditions were
reached, etc. The transient
debug file will be created in the
same location as the model file,
and follows the naming structure "Model Name_#_
GasTranDebug.txt", where
Model Name is the user specified model name, and # represents a number assigned to
differentiate between the transient debug files generated for
different scenarios. It is recommended to send this file to AFT
when requesting support on a
model file.

l

Limit Properties to Saturation Conditions - Disabled
by default. If enabled, xStream
will attempt to limit the temperature and pressure to saturation conditions to allow the
transient solution to continue.
This will not produce accurate
results as xStream cannot
account for two-phase flow.
However, this may be useful for
troubleshooting purposes to be
able to analyze the transient
results up to the point that saturation conditions were

Advanced Parameters
The Advanced Parameters panel
offers various advanced options to
adjust the AFT Arrow Steady Solver.
These parameters should not be
changed under normal circumstances
and will seriously impact results. They
can be useful for troubleshooting certain models. Contact AFT for more
information.

Advanced Transient
Parameters Panel
The Advanced Transient Parameters
panel is only visible when Show
Advanced Options is checked.
The options on this panel are intended
for troubleshooting use and should
only be changed with caution. In
almost every model, the default values
for these parameters is appropriate.
There are rare circumstances where
the user may wish to change them.
A description of some of the most commonly used advanced parameter
options is provided here. For
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reached.
l

Halt Solver When Saturation
Conditions Encountered Disabled by default. If enabled,
xStream will halt the solver if
the temperature and/or pressure conditions exceed the saturation line. This is useful to
provide the user the chance to
immediately stop the transient
and troubleshoot the model, as
any transient results calculated
after the time that saturation
conditions were reached will be
invalid.
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Working with Pipe and
Junction Objects
This section focuses on interactions
with the Pipe and Junction objects in
the AFT xStream workspace. Topics
include how to create pipes and junction objects, how to alter junctions
already on the workspace, and how to
ensure the inputs for objects are both
correct and complete.

l

Workspace Find

l

Workspace Search

l

Find from Model Data or
Output

l

Jump Feature

l

Bookmarks

Related Topics
Selecting Objects
Moving Objects
Editing Objects
Defining Objects

Contents
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Selecting and Finding
Objects
AFT xStream has a number of methods to assist in selecting multiple
objects at once as well as finding
objects for recall later. The contents of
this section can be broken down into
the two categories shown
below. Follow the links to learn more.
l

l

A single left click on any object will
select that object.
Selecting multiple objects can be
accomplished by:
l

Holding the shift or control key
and left clicking on objects

l

Dragging the cursor over the
objects, creating a selection
area
l

Dragging left-to-right creates a selection area
that will only select
objects entirely bounded
by the area

l

Dragging right-to-left creates a selection area
that selects any objects
completely or partially
inside the area

Methods for selecting objects
l

Select Flow Path

l

Select Special

l

Groups

Methods for finding objects
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l

Using Select All from the Edit
Menu, right-clicking on Workspace to open context menu, or
keyboard shortcut (Ctrl+A)

l

Using Select Last Selection
from the Edit Menu or with F12
to reselect the previously selected objects

l

Using Select Flow Path

l

Using Select Special

l

By selecting a Group

Select Flow Path
A flow path is a sequence of pipes and
junctions where there is no branching
or flow sources or sinks.
The pipes and/or junctions in a flow
path may all be easily selected by
selecting a pipe on the Workspace
then clicking the Select Flow Path item
on the Edit menu, Toolbar, or the rightclick context menu.
This feature is very useful in duplicating or deleting sequences of pipes
and junctions. It can also be used to
quickly define groups for graphing or
for selected Output or Model Data listings.

Select Special
Select Special is a tool for selecting or
deselecting objects based on certain
criteria. It can be opened from all windows/menus that give you the option
to choose what pipes and/or junctions

are selected. These windows/menus
include the Output Control window,
the Model Data window, the Visual
Report Control window, the Select
Graph Data window, the Edit menu,
right clicking on the Workspace, or
pressing F6 on the keyboard.
Once Select Special is open, all pipe
names and numbers and junction
names and numbers are shown in
numerical order under Pipe Selections
and Junction Selections, respectively.
At the top of the Select Special window is the Selection Type option. This
option allows you to choose what criteria you would like to use to select certain pipes and junctions. You can
choose from the following criteria to
select certain pipes and/or junctions.
l

Selected on Workspace

l

Closed in Model

l

Special Conditions Set

l

Number Range

l

Junction Type

l

Pipe Input Properties

l

Notes

l

Undefined Objects

l

User-Colored Pipes

l

Transient Data Exists

l

Groups

l

Pipe Output Properties (Only
available when output is available)

l

Junction Output Properties
(Only available when output is
available)
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Choosing certain Selection Types will
prompt a second or sometimes third
option below the Selection Type to
allow you to further specify the type of
pipe or junction you want. For
example, selecting Junction Type in
the Selection Type box will prompt the
Junction Type box to appear. The
Junction Type box will allow you to
specify what type of junctions you
would like to select.
By default, the Selection Type is Selected on Workspace and any pipes or
junctions selected on the Workspace
are selected in the Select Special window with a black check mark next to
the box corresponding to the pipe or
junction.
Once you have fully specified the
Selection Type, you must click Select
Pipes and/or Select Junctions to automatically select the corresponding
objects.
The selected pipes and junctions
under Pipe Selections and Junction
Selections do not automatically
become unselected when you switch
from one Selection Type to another.
Therefore, you must first choose
Deselect Pipes and/or Deselect Junctions located above the Pipe Selections and Junction Selections boxes,
respectively. For example, if you
select all of the pipes on the Workspace prior to opening the Select Special window, all of the pipes will be
selected in the Select Special window
when you open it. If you then choose
Junction Type as the Selection Type
and then specify All Junctions as the
Junction Type, all junctions will be

selected under Junction Selections,
but all pipes previously selected will
also remain selected. In this example,
if you would like only junctions to be
selected with none of the selected
pipes on the Workspace to be selected in the Select Special window, first
click the Deselect Pipes button, which
is located above the Pipe Selections
list.
Options to select all pipes/junctions, to
deselect all pipes/junctions, and to
invert the selected pipes/junctions are
located below both Pipe Selections
and Junction Selections boxes. Inverting the pipes/junctions deselects all
currently selected pipes/junctions and
selects all currently deselected
pipes/junctions. This feature is helpful
if you want to select all pipes/junctions
that do not fit a certain criteria. For
example, if you want to select all open
objects in the model, you could specify
Closed in Model in the Selection Type
box, then click Select Pipes and
Select Junctions. All pipes and junctions that are closed in the model will
be selected. Because you want to
select all open pipes and junctions in
the model but only the closed pipes
and junctions are selected, you would
simply click Invert below both the Pipe
Selections and Junction Selections
lists to deselect all closed pipes and
junctions and select all open pipes
and junctions.

Related Topics
Selecting and Finding
Objects

132
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Moving Objects
Editing Objects
Defining Objects
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Finding Workspace
Objects
Workspace Find
The Find window utility helps you find
a particular pipe or junction by its ID
number and name. The Find utility
becomes more useful for models that
expand over multiple Workspace
pages.
You can access the Find utility by
selecting Find on the View menu, by
clicking the button on the Toolbar, or
by using the keyboard shortcut
"Ctrl+F". After you double click on the
pipe or junction you are searching for
in the Find utility or when you click the
Find button, the Workspace is moved
so that the pipe or junction is located
near the center of the screen. Additionally, the pipe or junction you are
searching for is selected in the Selected Items color specified in the User
Options window in the Tools menu. By
default, this color is red.

Workspace Search
The Search window utility helps you
search for a particular pipe or junction
by its ID number, name, or notes you
have inputted in the properties window. The Search utility becomes more

useful for models that expand over
multiple Workspace pages.
You can access the Search on the
Common Toolbar. The search feature
will list all objects related to your
search term beneath itself in a list of
search results. You can hover over
each search results to see a preview
of input and output (if the model has
been run). Clicking on or pressing
enter while the object is highlighted in
the search results will select the object
in the workspace and center the focus
of the workspace on the object.

Find From Model Data or Output
Objects can be quickly located on the
Workspace by right-clicking on a cell
in Model Data or row header in Output
and selecting "Find on Workspace..."
the view will change to show the Workspace, with the object of interest selected.

Jump Feature
By clicking the Jump button in a Properties window, you can move directly
to another Properties Window of
another a pipe or junction that you specify.
The Jump button is located in the
upper right corner of the Properties
Window.
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Bookmarks
Use the Bookmark tools on the View
menu to set Bookmarks and to display
different bookmarked pipes or junctions.
Bookmarks can be added on the Workspace in relation to individual pipes or
junctions. You can quickly navigate
around the Workspace by moving
from Bookmark to Bookmark.

Groups
Groups of pipes and junctions can be
named for later recall. This is done
using the Group tools on the Edit
menu. The easiest way to create a
named Group is as follows:
1.

First select the pipes and junctions you want in the group

2.

Choose Groups -> Create from
the Edit menu or Toolbar.

3.

You will be prompted for a
name for the group. Enter a
meaningful name and click OK.

4.

The Group Manager then
opens. The selection of pipes
and junctions in the Group will
match those currently selected
on the Workspace. If you want
to modify the selections once
more, you can do it here.

You can include Subgroups inside of
your Groups. Subgroups are existing
Groups. If a Group contains one or

more Subgroups and the Group is
selected on the Workspace, then all
pipes and junctions in the Group and
Subgroup(s) will be selected. Additionally, if you include a Subgroup in
your Group and then later change the
contents of the Subgroup, the Group
that contains the Subgroup will also be
changed.
After you have created a Group, you
can then quickly reselect that Group of
pipes or junctions on the Workspace
by choosing Group -> Select from the
Edit menu or Toolbar and choosing
the name of the Group.
The Group Manager can be opened
by choosing Group -> Manager from
the Edit menu or Toolbar. The Group
Manager allows you to modify, create,
delete or rename Groups.
Another place that Groups can be
selected from is in the Select Special
window.

Related Topics
Graph Results Window
Global Pipe Editing
Global Junction Editing
Force Set Types
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Pipe Drawing Modes
AFT xStream has 3 different pipe drawing modes. These pipe drawing
modes are
l

2D Freeform

l

2D Orthogonal
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l

Isometric

This section will discuss the features
of each drawing mode as well as how
to adjust the pipe presentation in each
including Snap to Grid.

Related Blogs
Iso love the new Pipe Drawing Mode!

Snap to Grid
Toggled from Arrange > Snap to Grid.
All junctions, pipe endpoints, and pipe
vertices will be snapped to the grid
intersection points when Snap to Grid
is on. Turning Snap to Grid on in an
existing model will optionally attempt
to move all existing junctions to the
grid points.

Figure 1: 2D Freeform with Snap to Grid
off

2D Freeform Grid
The standard grid, enabled by default
in the Arrange -> Pipe Drawing Mode
menu.
This Pipe Drawing Mode allows placing pipes or junctions anywhere on
the Workspace, with pipes at any
angle.

Figure 2: 2D Freeform with Snap to Grid
on
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l

ments button
vertices

2D Orthogonal
The 2D Orthogonal Pipe Drawing
Mode forces all pipes drawn in the
model to be either horizontal or vertical. This is enabled in the Arrange ->
Pipe Drawing Mode menu.
In 2D Orthogonal mode, segments are
automatically inserted into pipes to
enforce drawing only along the horizontal and vertical.

Use the Add/Remove Segto add new

l

Use a fine grid and Snap to
Grid features

l

If you have a junction with several connecting pipes that interfere, enlarge the junction to
150% or 200% of normal size

Isometric
AFT xStream allows the user to place
pipe or junction objects anywhere in
the Workspace.
In order to make building clean looking
models easier, objects are snapped to
the 2D Freeform grid by default.
However, it may be convenient or
desired to demonstrate the three
dimensional nature of a system. A typical 2D grid has two sets of gridlines
representing the x and y axes. An isometric grid has three sets of gridlines
that are offset by 60°, representing the
x, y, and z axes.

Figure 1: Model in 2D Orthogonal mode
with Snap to Grid on

Tips for Using the Orthogonal Drawing Feature
Orthogonal drawing can create some
confusion for the user because segments from different pipes may overlap each other and hence become
indistinguishable.

Enable the isometric grid by selecting
Pipe Drawing Mode -> Isometric from
the Arrange menu. There will be a
prompt about converting non-isometric pipes - this is a required step,
but may result in some unintended
object placement. It is best practice to
set the grid type before building a
model and retain that type of grid if
possible. It is also very helpful to show
the Grid (Arrange -> Show Grid) when
building an isometric model.
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pressing the arrow keys or by scrolling
the mouse scroll wheel.
Holding the alt key while dragging a
pipe endpoint will retain the existing
vertex and automatically add a new
segment to the pipe - the placement of
the line can be controlled with the
arrow keys or scroll wheel as before.

Figure 1: 2D (left) and isometric (right)
grids

When drawing on the isometric grid,
pipes are automatically segmented to
lie on the gridlines as shown below.
Dragging one of the handles on the
pipe shows a preview line of where the
pipe will be placed if adjustment needs
to be made.
The placement of the preview line can
be cycled through all possibilities by
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Figure 2: Automatic layout of isometric
pipes

The default action is for pipes in the
workspace to snap to the isometric
gridlines. However, if desired, a given
pipe can be set to not snap to the grid
by clicking Edit -> No Snapping for
Pipe or by right-clicking a selected
pipe and clicking the No Snapping for
Pipe option.

Placing Junctions
Placing junctions onto the Workspace
follows the usual rules - however, the
visual appearance of the icon is more
complex than in an orthogonal grid.

141

Quick Start Guide

When icons are added after pipes are
placed, AFT xStream will rotate the
icon automatically following the workspace arrangement. When pipes are
connected to icons already placed in
the workspace, right-click and select
Auto-rotate Icon to adjust the icon. For
manual control of icon appearance,
right-click and select Customize Icon
to choose the desired appearance.
Note: It may be easiest to make
use of the Rotate button in
the Customize Icon window
to find the appropriate icon.
With many possibilities to
choose from, finding the
proper rotation can be difficult.

Figure 3: Icon rotations in isometric
space
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Related Examples
High Pressure Steam - Fluid
Property Models Example 572
Related Blogs
Iso love the new Pipe Drawing Mode!
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which you can enter the data
you want to change on each of
the selected pipes. Alternatively, if you want to copy the
data from an existing pipe, you
can choose "Existing Pipe",
then select the desired pipe
number and skip to step 5.

Global Edit
AFTxStream has the powerful capability to apply input parameters
across a wide range of objects. This
can be done for pipes by using the
Global Pipe Edit or across junctions of
the same type by using the Global
Junction Edit.

4.

Enter the pipe data you want to
change and click the OK button
in the Pipe Properties window.

5.

The Global Pipe Edit window
now lists the parameters to
change in a list on the right.
Select the parameters you
want to change.

6.

Click the Apply Selections button.

Related Blogs
Mass Modify your Model with Global
Edit

Global Pipe Editing
The Global Pipe Edit window allows
you to edit data for multiple pipes at
the same time. A Guide is available at
the top of the Global Edit window to
walk you through the global edit process.
Here is how you use it:
1.

Open the Global Pipe Edit window from the Edit menu, or
from the right-click menu on the
Workspace.

2.

Select the pipes you want to
edit from the Pipe list on the left
(if pipes were selected in the
Workspace, they will be automatically selected here)

3.

Click the Select Pipe Data button. This will open a template
Pipe Properties Window in

Note: You cannot change some
data, like the pipe ID number,
using this global method.
Note: There is no undo for global
pipe editing. Therefore, you
cannot revert your changes
once you have exited the
Global Edit window.
However, hitting Cancel on
the Global Edit window will
undo any changes that were
just applied.

Related Examples
Gas Turbine Fuel System
Example

554
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Related Blogs
Mass Modify your Model with Global
Edit

Global Junction Editing
The Global Junction Edit window
allows you to edit data for multiple junctions at the same time. A Guide is
available at the top of the Global Edit
window to walk you through the global
edit process, or the instructions are
provided below in this topic.
Junction data falls into the following
two broad categories:
l

Common Data- data that
applies to all junctions regardless of junction type; examples
include elevation and initial
pressure data.

l

Junction Specific Data- data
that applies only to certain junctions; examples include compressor curves and control
valve setpoints.

To open the Global Junction Edit window, browse to the Global Junction
Edit option on the Edit menu. From
there, choose the category of junction
you want to edit. The available categories include those junctions selected on the Workspace, any junction
type used in the model, and common
junction data. Global Junction Edit can
also be launched by right-clicking on
the Workspace.

Note: There is no undo for global
junction editing. Therefore,
you cannot revert your
changes once you have
exited the Global Edit window. However, hitting Cancel
on the Global Edit window
will undo any changes that
were just applied.

Editing Common Junction
Data
You can open the Global Junction Edit
window for common data editing in
two ways. First, you can choose Common Data from the Global Junction
Edit menu selection on the Edit menu,
or you can choose one of the other
specific junction types on the menu
and then choose the Common option
for the Junction Template in the upper
left.
Here is how to globally edit junction
common data:
1.

Open the Global Junction Edit
window.

2.

Select the Common option for
Junction Template in the upper
left.

3.

Select the junctions you want to
edit from the Junction list on the
left. Note that all junctions in
the model are shown, no matter
what the junction type.

4.

Click the Select Common Junction Data button. This will open
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the Common Junction Data
Edit window in which you can
enter the data you want to
change on each of the selected
junctions.
5.

6.

7.

2.

Enter the junction data you
want to change and click the
OK button in the Junction Properties Window.

Select the Junction Template
option in the upper left. Alternatively, if you want to copy the
data from an existing junction,
you can choose "Existing Junction", then select the desired
junction number and skip to
step 6.

3.

The Global Junction Edit window now lists the parameters to
change in a list on the right.
Select the parameters you
want to change.

Select the type of junction you
want to edit in the dropdown list
in the upper left. For example,
you could choose an Assigned
Pressure junction.

4.

Click the Select Assigned Pressure Data button (the button
name will change based on the
type of junction selected). This
will open the appropriate junction Properties Window, in this
case the Assigned Pressure
Properties Window.

5.

Enter the junction data you
want to change and click the
OK button in the Assigned Pressure Properties Window (or
whatever window type is displayed).

6.

The Global Junction Edit window now lists the parameters to
change in a list on the right.
Select the parameters you
want to change.

7.

Select the junctions you want to
edit from the Junction list on the
left. Note that only junctions of
type selected in the upper left
are shown (Assigned Pressure
junctions in this case).

8.

Click the Apply Selections button.

Click the Apply Selections button.

Note: You cannot change some
data, like the junction ID number, using this global method.

Editing Specific Junction
Data
You can open the Global Junction Edit
window for specific data editing in two
ways. First, you can choose the junction type from the Global Junction Edit
menu selection on the Edit menu, or
you can choose Common Data on the
menu and then choose the desired
junction template, or Existing Junction
data for the desired junction type.
Here is how to globally edit specific
types of junctions:
1.

Open the Global Junction Edit
window.
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Related Blogs
Mass Modify your Model with Global
Edit

Toolbox
The bundle of tools at the left of the
Workspace window that allows you to
create pipes and junctions. The toolbox can be docked to the left, right, or
floated within the workspace by clicking on the arrows on the top of the toolbox.

Creating Pipes - the Pipe
Drawing Tool
The tool in the upper left corner of the
Toolbox is the Pipe Drawing tool. With
this tool you can draw new pipes on
the Workspace, starting and ending at
any desired location.
To draw a pipe, click the Pipe Drawing
tool. The mouse pointer will change to
a crosshair when you move it over the
Workspace. Position the cursor at the
pipe’s starting point, hold down the left
mouse button while dragging the
cursor to the pipe end point, then
release the mouse button.
To draw multiple pipes, double click
the Pipe Drawing tool. This will keep
the tool engaged until you click the
Pipe Drawing tool again or press the
escape key.
The length of the line on the Workspace has no relationship to the physical length of the pipe. The Workspace
pipe is merely an abstract representation of a pipe, however, each
pipe drawn must have a visible length
on the Workspace. If the pipe drawn
does not have a visible length, AFT
xStream eliminates the line immediately after you release the mouse.

Figure 1: Toolbox items

When a single pipe is selected, two
black squares (or more if the pipe is
segmented), called handles, appear.
When the cursor is placed over a pipe
handle it changes to a crosshair and
the pipe handle can be moved or
stretched by dragging with the left
mouse button.
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Another way to create new pipes is to
duplicate existing pipes with the
Duplicate or the Copy and Paste features found on the Edit menu. When a
new pipe is derived from a previous
pipe, the new pipe retains the input
associated with the original pipe.
Each pipe must be connected to two
junctions. There are no exceptions to
this rule.

Pipe ID Numbers
When a new pipe is created, it is
assigned a default ID number. When
the pipe is displayed on the Workspace, the ID number is preceded by
the letter "P" to indicate that it is for a
pipe. From the Pipe Properties Window, you can change the ID number to
any desired number greater than zero
and up to 99,999, but the number
must be unique to the pipe and cannot
be replicated in any other pipes on the
Workspace. The pipe number remains
with the pipe in descendant scenarios
in the Scenario Manager. An arrow
near the ID number indicates the reference flow direction for the pipe. The
reference positive flow direction can
be reversed by choosing Reverse Direction from the Edit menu or by selecting the reverse direction button on the
Toolbar.
Tip: The pipe or junction ID number text can be dragged to a
new location to improve visibility. The new location is
saved with the model. If you

want the text of one or more
pipes and/or junctions
returned to the default location, select those pipes/junctions on the Workspace and
choose Reset Label Locations from the Arrange menu.
From this box, click the Reset
Labels For Currently Selected Pipes and Junctions. If
you want all pipe and junction
text returned to the default
locations, choose Reset
Label Locations from the
Reset Label Locations box
on the Arrange menu.

Pipe Segments
A pipe can be segmented or "bent"
into numerous sections. This only
affects the visual representation and
does not affect the calculated results.
It does not add an "elbow" to the
model or the resulting pressure drop
effects of an elbow. This feature is useful in graphically bending the pipe
around another part of the model or
graphically showing that there are
embedded elbows as fittings & losses.
You can add a segment to a pipe in
several ways. The easiest way to add
a pipe segment is to first select the
pipe, then click on the Add/Remove
Segment icon
from the Toolbar.
A segment will automatically be
added. One or more segments can be
added by clicking on the down-facing
arrow on the Add/Remove Segment
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icon from the Toolbar, and then choosing the number of segments to be
added. Alternatively, you can first
select the pipe, then select Pipe Segments in the Arrange menu. A dropdown list will appear that allows you to
choose Add a Segment or Add Multiple Segments.
The easiest way to remove a segment
is to first select the pipe, then click on
the down-facing arrow on the Add/Remove Segment icon from the Toolbar.
A drop down list will appear that will
allow you to choose Remove Segment. If you wish to remove all segments, click Remove All Segments.
Alternatively, you can first select the
pipe from which you want to delete
one or more segments, then select
Pipe Segments in the Arrange menu.
A dropdown list will appear that allows
you to remove one or all segments by
clicking on either Remove Segment if
you want to remove one segment, or
by clicking on Remove All Segments if
you want to delete all segments.

Keyboard Shortcuts
See the Keyboard Shortcuts for Workspace topic for more information on
additional Pipe Drawing Tool shortcuts.

Combining and Splitting
Pipes
When pipes are present in the Workspace, users can both combine and
split up pipes. This can be done either
to clean up the model visually or to further manipulate the model.

Combining Pipes
When multiple pipes are placed in the
workspace separated by junctions
without having other flowpaths splitting off, those pipes and intermediate
junctions can be combined into a
single pipe.
This can be done by selecting the
desired pipes and intermediate junctions, and clicking Edit -> Join Selected Pipes/Jcts.
The new pipe will have any losses
associated with the intermediate junctions entered as additional Fittings &
Losses.
Note: The pipes being combined
must have the same diameter, friction model and
material.

Splitting Pipes
Related Topics
Keyboard Shortcuts for
Workspace

273

An existing pipe in the workspace can
be split into multiple pipes by holding
the Shift key while placing a junction
on the pipe. This will split the pipe in
two and insert the selected junction at
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the specified length. Any fittings and
losses defined in the pipe can be
placed in either of the split pipe segments.

Related Topics
Keyboard Shortcuts for
Workspace

273

Creating Junctions
Below the pipe drawing and the
annotation tools on the Toolbox are
junctions, which allow you to model a
large variety of pipe system components. To add a junction to a model,
drag the desired icon from the Toolbox
and drop it anywhere on the Workspace.
As you move the mouse pointer over
the Toolbox, a tooltip identifies the
type of junction under the mouse
pointer.
When you duplicate a junction using
the Duplicate, Copy, or Paste features
on the Edit menu, the new junction
retains the input associated with the
original junction.

Junction ID Numbers
Junctions are shown on the Workspace with default ID numbers, which
you can change in the Junction Properties Window. The letter "J" precedes
the ID number to signify that it is for a
junction. From the junction’s Properties window, you can change the ID

number to any desired number greater
than zero and up to 99,999, but the
number must be unique to the junction
and cannot be replicated in any other
junctions on the Workspace. The junction number remains with the junction
in descendant scenarios as long as
the junction type is not changed.
Identical ID numbers can be assigned
to both a pipe and a junction because
the "P" or "J" will distinguish the two.
Unlike pipes, junctions do not have reference positive flow directions. Junctions for which the flow direction is
important (such as control valves)
derive the flow direction from the flow
direction of the connecting pipes.

Related Topics
Keyboard Shortcuts for
Workspace

273

Connecting Objects
During construction of a new model,
objects can be placed anywhere on
the Workspace. In order to assemble
a model that is ready for analysis, you
must connect the objects properly.
Remember that connectivity only
exists between junctions and pipes.
There are no junctions that connect to
junctions, and no pipes that connect to
pipes.
AFT xStream will attempt to automatically connect pipes and junctions
when they are moved. This eliminates
unnecessary opening of the pipe and
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junction Properties windows. If
xStream cannot make the connection
automatically, then the following three
steps may be required to establish a
connection between a junction and a
pipe:
1.

Graphically connect the objects
on the Workspace. The pipe
endpoint must terminate within
the boundaries of a junction
icon.

2.

After the pipe is graphically connected to two junctions,
double-click the pipe to open its
Properties window, then click
OK to accept the connected
junctions as determined by
AFT xStream. It is most efficient to do this when you are
entering the pipe's data in its
Properties window.

3.

Open the Properties window of
the corresponding junction and
accept the pipe connectivity
determination. In most junctions, this pipe connectivity
determination will be located in
the upper right hand corner of
the Properties Window. In a
few junctions, such as the
Assigned Pressure Junction
and Tank Junction, the pipe
connectivity will be shown
under the tab containing Loss
Coefficients. You can do this as
you enter the junction's data in
its Properties Window.

If the model seems to not be connected properly, you can also use the
Extended Model Check feature on the
View menu.

When you accept AFT xStream's connectivity interpretation, the connection
advances from a graphical connection
to a model connection.
The model connectivity you establish
on the Workspace is retained only as
long as you maintain the graphical
objects in their current visual relationship to each other. If you move a
pipe or a junction and break the graphical connection, AFT xStream disconnects the two objects. However, if
you move a group of connected
objects, their model connectivity is
maintained.

Moving Objects
Objects on the Workspace can be
moved individually or as groups. Clicking a Workspace object selects it. Pipe
objects change color when selected.
Junction objects are outlined in red
when selected. These colors are configurable in the Workspace section of
User Options (Tools menu) .
To move an object, select it, drag it
within the Workspace, and drop it in
the desired location. When an object
is dragged beyond the existing Workspace area, the Workspace is expanded accordingly.
A pipe object can be stretched by
grabbing the handles (small red
squares) at the pipe endpoints and
moving an endpoint to a new location.
To make these handles visible, select
the pipe you want to move.
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There are numerous ways to select a
group of objects for movement or
other operations.
To prevent accidental movement on
the Workspace, lock the objects. A
lock symbol appears next to locked
pipes or junctions when an attempt is
made to move the pipe or junction.
The Lock feature is accessed from the
Arrange Menu or the lock button
on the Toolbar. To lock an object on
the Workspace, select it and then activate the Lock feature either from the
Arrange menu or from the lock button
on the Toolbar. If you would like to
lock multiple objects at the same time,
ensure that all of the objects are selected prior to activating the Lock feature.

Keyboard Modifiers
If you hold down the CTRL key when
dragging a junction, the endpoints of
any connected pipes are not moved
with the junction, thus breaking the
graphical connection.

Related Topics
Keyboard Shortcuts for
Workspace
Selecting and Finding
Objects
Selecting Objects
Editing Objects
Defining Objects
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Editing Objects
The pipes and junctions you place on
the Workspace can be edited with the
editing commands from the Edit menu
or the Toolbar. Objects can be cut,
copied, pasted, duplicated, and
deleted. These operations can be performed on individual objects or on
groups. The Edit menu provides the
option to undo each editing operation
in the Workspace, but will not undo
any changes made in the pipe/junction
properties windows. Alternately you
can use the Undo button
Toolbar.

on the

The Copy Graphics feature on the Edit
menu will copy the specified Workspace objects to the Windows clipboard. This image can then be pasted
into other Windows applications.

Related Topics
Keyboard Shortcuts for
Workspace
Selecting and Finding
Objects
Selecting Objects
Moving Objects
Defining Objects
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Morphing Junctions
Occasionally you may want to change
a junction’s type in your model. You
can do this by morphing the old junction into a new one.
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If you hold down CTRL key and select
a junction from the Toolbox and drop it
onto an existing Workspace junction,
the old junction will morph into the new
one. The junction type will change to
the new junction type, and data that
can be kept will be copied into the new
junction.

Related Topics
Keyboard Shortcuts for
Workspace

The highlight feature shows the
required input in pipes and junctions.

Undefined Objects Window
273

Defining Objects
To specify the required property data
for an object, open its Properties window. This can be done in six ways:
1.

Double-click the object on the
Workspace

2.

Select the object (by clicking on
it once, or using the Selection
Box) and press ENTER

3.

Select the object and click the
Open Pipe/Jct Window icon on
the Toolbar

4.

Properties window. Some parameters
in the Properties windows are required
and others are optional. The optional
parameters offer you added control
over your model and the ability to
obtain specialized information.

Double-click the left column of
the appropriate table in the
Model Data window (where the
object ID number is shown)

5.

Jump from another Properties
window

6.

Double-click the connected
pipe or junction number in a
Properties window

Parameters that functionally describe
the pipe or junction are entered in the

You can open the Undefined Objects
window to view all undefined objects
and the undefined properties. This is
available on the View menu.

Use Status Feature
Each pipe and junction Properties window has a Status tab. The Status tab
shows what required information for
the pipe or junction is missing.

Satisfying Connectivity
Requirements
In addition to entering the required
information for each object in the
model, you must satisfy these connectivity requirements:
l

You must accept the connectivity information shown in
each object's Properties window
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l

l

Each junction must have the
appropriate number of pipes
connected to it. For example,
an area change junction must
have exactly two connecting
pipes, whereas a tank may
have one to twenty-five connecting pipes.
Pipes must always be connected to two junctions, one at
each pipe endpoint.

Should you ever delete any of the
required information in the Properties
window or move a connected object
from its connection, the object's status
reverts to undefined.
For example, say you place a check
valve on the Workspace. A check
valve requires inlet and outlet piping.
AFT xStream reflects this by requiring
each check valve to be assigned an
upstream pipe and a downstream
pipe. Entering only the Valve model
details and setting an elevation is
necessary but not sufficient information to define the check valve according to AFT xStream's requirements.
Once you have entered the check
valve data and properly connected it,
the check valve is defined.

by clicking the floodlight button
the Toolbar.

Turning Show Object Status on displays the undefined junction and pipe
ID numbers in the Undefined Color,
which is red by default. The color can
be changed through the User Options
window on the Tools menu. Show
Object Status helps you rapidly
assess where your model requires
additional information.
Leaving Show Object Status always
toggled on is not recommended for
large models, as it will slow the Workspace graphics response. When this
feature is on, every Workspace graphical operation you perform must be
accompanied by a check of all pipe
and junction connections. This check
takes time, and could degrade your
graphics performance.

Highlight Required Input
The highlight feature functions to
identify required input data for the
Properties Window for each pipe and
junction. You can toggle the highlight
feature on and off in the following
ways:
l

Show Object Status
The Show Object Status feature helps
you identify which objects on the Workspace are defined and which are not.
This feature can be toggled on and off
by selecting it from the View menu or

on

l

From the Properties Window
l

Double-click anywhere in
the Properties Window

l

Press the F2 function key

From the View Menu
l

Toggle the Highlight in Pipe
and Jct Windows to Off
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The highlighting feature may be especially useful when you are first learning to use AFT xStream or when you
are having difficulty obtaining a
defined object status.

If output data exists it will also be displayed.

Inspecting Objects
The Inspection feature is a time saving
feature for reviewing the data associated with a Workspace object.
Inspection displays the data for an
object in read-only format (see Figure
1).
To inspect an object, position the
mouse pointer on the object and hold
down the right mouse button. Inspecting is quicker than opening the Properties Window if you want to look at an
object's input data but not edit it.
The Inspection feature is also available in each Properties Window. This
is useful if you want to check the input
data of objects connected to the one
you are working on.
For example, when working in a Valve
Properties window, you may wish to
quickly check the upstream and downstream pipe diameters previously
defined. Holding down the right mouse
button on each connected pipe ID
number will show you that pipe's
primary input parameters.
The Inspection feature works similarly
in Pipe Properties windows when you
inspect connected junctions. Judicious inspecting can save you time
when assembling or debugging a
model.

Figure 1: Inspecting from the Workspace
with right mouse button

Related Blogs
AFT Responds to 2020 Customer Survey Feedback

Notes
Each object can have notes associated with it. This is useful for listing
assumptions, reference documents,
drawings, measurements, etc.

Related Topics

Index 155

Pipe Properties Window
158
Junction Window Overview 182

Status
The status tab lists all undefined parameters that are required to define the
pipe or junction.

Related Topics
Pipe Properties Window
158
Junction Window Overview 182

Workspace Pan
The user can use Workspace Pan
mode to move around, or pan, the
model. If the Workspace has been
enlarged beyond the default one
screen size (Workspace scrollbars will
be visible), then the Workspace can
be panned by activating Workspace
Pan mode. There are several ways to
activate Workspace Pan Mode:
l

Click the Workspace Pan button

To switch off the pan mode, click the
mouse scroll wheel or the Workspace
Pan button on the toolbar a second
time. If Workspace Pan mode is maintained using the mouse scroll wheel, it
will automatically turn off once you
release the mouse scroll bar.

Related Topics
Keyboard Shortcuts for
Workspace

273

Related Blogs

on the toolbar

l

Select the Workspace Pan
option in the View menu

l

If your mouse has a center button (a scroll wheel), hold the
scroll wheel button down

l

panned by holding down the left
mouse button (if the Workspace Pan
mode has been activated using the
Workspace Pan button on the toolbar
or the Workspace Pan option has
been selected in the View menu) and
moving the mouse in the desired direction, or by holding down the mouse
scroll wheel (if using the scroll wheel
to keep Workspace Pan mode activated) and moving the mouse in the
desired direction.

Hold CTRL and use the arrow
keys

Once in pan mode, the cursor will
change to an open hand that can be
used to grab and move a point in the
Workspace. The Workspace can be

AFT Responds to 2020 Customer Survey Feedback

Moving Pipe and Junction Labels
Each pipe and junction on the Workspace also displays text (or label) referring to the number and/or name of the
object. This label can be dragged to
improve model aesthetics. AFT
xStream keeps track of the relative
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location of the label to the object so
that if the object is moved, the label
moves with it.

Returning Label to Default
Location
To return the label to its default location, you can:
l

Right-click the label for an individual object and choose Reset
Label Location

l

Use Arrange -> Reset Label
Locations and respond to the
dialog

Special Conditions
Some junctions have Special Conditions which alter the normal state of
the junction. For example, a valve can
be closed, a compressor turned off, or
a relief valve opened.
The special conditions are set in one
of three ways:
l

By selecting the junction(s) on
the Workspace and choosing
Special Conditions from the
Edit Menu

l

By selecting the junction(s) on
the Workspace and clicking the
Special Condition icon
the Toolbar

l

on

By opening the junction’s Properties window and clicking the

appropriate condition on the
Optional tab
The junctions which have special conditions set are shown using a special
symbol before the ID number (an X by
default). This symbol can be customized in the Tools/User Options window.
When the special condition results in a
section of the model being closed or
"turned off", the pipes which will have
zero flow are display as dotted lines.
This indicates visually that they are cut
off from flow; the junctions are outlined
with a dotted line. The default dotted
line can be changed in the Tools/User
Options window.
The user can specify Special Conditions for Control Valves to be either
closed or fully open. Similarly, compressors/fans can be turned off and
either allow flow through or stop the
flow.

Special Condition: Ignore
The Relief Valve junction has a unique
kind of Special Condition called
Ignore. This makes the steady-state
and transient solvers ignore the presence of the junction. Thus not only is
the data ignored, the junction itself is
ignored. This is convenient when locating a relief valve by trial and error.
Rather than having to delete the junction, it can be ignored.
As an example, assume that one is trying to find the best location for a relief
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valve. If one does this with a single
relief valve junction, it will be required
to run a case, view the results, then
relocate the junction by changing the
pipe lengths and rerunning. If one
uses the Special Condition Ignore,
one can place multiple relief valve junctions in the model and then set all of
them except one to Ignore so that only
one of the junctions is used at a time.
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Pipe Properties Window

Pipes
This section focuses on specifying
and modifying the Pipe object in the
Workspace. Topics include an overview of the Pipe Properties window,
how to input pipe specification data, a
description of the methodology used
for heat exchange within pipes, and
how to insert fittings and losses within
the pipes.

Contents
Pipe Properties Window

158

Each pipe on the Workspace has
engineering information associated
with it. Each pipe must have an ID
number, a length, a diameter, a roughness specification, and two connecting junctions. If the pipe is not
purely cylindrical, additional geometry
information is also required.
The Pipe Properties Window allows
the user to define all data for a pipe on
the Workspace. An example on a fully
defined Pipe Properties Window is
shown below in Figure 1. The various
Pipe inputs are discussed in the
respective pipe pages listed in the
Related Topics section below.

Common Pipe Input Parameters 159
Pipe Model

159

Fittings & Losses

161

Heat Transfer in Pipes Overview 162
Insulation for Pipes

178

Optional Input for Pipes

178

Add/Remove Pipe Segment

179

Reverse Direction

179

Pressure Drop in Pipes Detailed Discussion

180
Figure 1: Fully Defined Pipe Properties
Window
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Related Topics
Notes
Status
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Common Pipe Input Parameters
The common input parameters are located above the tabs in the Pipe Properties Window.

Number
Every pipe must have a unique ID
number. When new pipes are created,
a pipe number is automatically allocated.
The pipe number can be changed by
the user to any unique value greater
than zero and less than 100,000. Pipe
numbers are only identifiers and have
no affect on the model behavior.

The Copy Data From Pipe drop-down
list allows you to copy all or some of
an existing pipe’s properties to the current pipe. Selecting an existing pipe
will prompt the user on what parameters should be changed. The Copy
Previous button functions similarly,
copying parameters from the previously edited pipe.
In a child scenario, Copy Data From
Pipe lists "Parent Pipe Data," allowing
the user to copy all or some parameters from the parent pipe.

Connected Junctions
All pipe objects have a reference positive direction, as indicated on the
Workspace by an arrow in the center
of the pipe. The upstream and downstream junctions are identified with
this direction. The connected junctions
area displays these junctions. Every
pipe must be connected to two junctions in order to be completely
defined.

Name

Pipe Model
A name can be assigned to each pipe
for reference purposes. The default
name is simply “Pipe.” Names do not
need to be unique. The name can be
shown on the Workspace, in the
Visual Report and in the Output window.

Copy Data From Pipe...

Size
The size section of the Pipe Model tab
specifies the pipe geometry.
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l

Pipe Material
l

l

l

l

l

User Specified - If
selected, the geometry
of the pipe must be directly specified.
Library Material - Many
common pipe materials
are included in the standard Pipe Material library.
These and any other
accessible library materials can be selected.
When a library material
is selected, the parameters defining the geometry cannot be
modified.

Size - Select from a list of
defined nominal sizes for the
selected Pipe Material. Only
available for library materials.
Type - Select from a list of
defined types (classes/schedules) for the selected Pipe
Material. Only available for library materials.
ID Reduction (Scaling) Reduction in hydraulic diameter due to scaling can be
accounted for by entering a percent reduction in this field. Zero
represents no reduction.

Length
The Length of the pipe between the
two connecting junctions. This length
has no relationship to the visual length
of pipe drawn on the Workspace.

Friction Model
Multiple friction data sets can be compiled for each library pipe material.
These different data sets are then
made available in the Data Set drop
down list. For AFT standard materials,
the friction data set is generally "Standard."
The Friction Model can be modified for
any individual pipe, and the default friction model can be set in Parameter
Options. The Friction Model for a library material can be modified by selecting the User Specified radio button in
Data Set, and must be directly specified for User Specified materials.
l

Absolute roughness
(default) - Absolute average
roughness height. Values of
pipe roughness can be found in
many pipe handbooks or from
manufacturer's data.

l

Relative roughness - Relative
roughness is the absolute
roughness divided by the pipe
diameter.

l

Hydraulically smooth Hydraulically smooth implies
that roughness is negligible.
This is not the same as frictionless.

l

Explicit Friction Factor - Friction factor for the pipe, you can
enter the value explicitly.

l

Frictionless - For troubleshooting purposes, it is occasionally
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useful to model a pipe as having no friction. There are limitations to where such a pipe
can be located in your model.

For detailed information on how these
Friction Models are defined, see Pressure Drop in Pipes - Detailed Discussion.

Fittings & Losses
Fittings & Losses allows the user to
define additional losses directly in a
pipe. This is useful to account for pressure losses without modeling large
numbers of elbows or similar fittings.
To specify library losses, click Specify
Fittings & Losses to open the Pipe Fittings & Losses window. An additional
K Factor loss can also be user specified.

Pipe Fittings & Losses
The Fittings & Losses library contains
many standard loss values. Because
many of these values are dependent
on pipe diameter, a pipe diameter
must be specified to open the Pipe Fittings & Losses window.
Losses are divided into several categories represented by tabs. To add fittings to the pipe, select the type, and
adjust the quantity column next to the
desired fitting.
After accepting the changes by clicking OK, a summary of the pipe's Fit-

tings & Losses will be displayed in the
pipe's properties window.
Note: Area Change fittings do not
change the size of the pipe,
they only represent the loss
factor based on the pipe diameter and the area ratio of
the loss. When including area
changes, notice the illustration of how the loss is
defined, where Apipe is the
area of the pipe and As is the
area of the loss. These area
changes are useful to model
fittings between a pipe and
another junction like a compressor.
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for favorite to add it to the list of favorite fittings and losses. On the left side
of the window there are several
options to filter the list. For example,
one may only want to see Crane fittings. In which case, Crane should be
checked, and all others unchecked on
the left hand side of the window. If a
list of only favorite fittings is desired,
check the box to "Show Favorites
Only".

Related Topics
Fittings & Losses Library
Specifying Losses
References

377
187
435

Heat Transfer in Pipes
Overview
Figure 1: Pipe Fittings & Losses

Fittings & Losses Workspace
Symbol
When a pipe has any loss value
assigned through the Fittings &
Losses tab, a symbol (default of &) is
added before the pipe number.

Favorite Fittings & Losses
In the Pipe Fittings & Loses window,
there is a column labeled Favorite for
each of the loss types. Check the box

Each pipe responds thermally to the
environment outside of the pipe. AFT
xStream offers several models that
allow you to model the heat transfer
characteristics of a pipe:
l

Adiabatic at Internal Surface An adiabatic pipe is one that
has perfect insulation and thus
no heat transfer takes place.
The temperature into the pipe
is taken from the upstream junction. Insulation data can be
entered but is not used for
thermal purposes. This model
assumes the fluid in the pipe
does not thermally interact with
the pipe wall.
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l

Convective Heat Transfer This model allows you to specify heat transfer data for the
internal fluid, pipe wall, three
layers of insulation and
external convection.

l

Convective Heat Transfer and
Heat Flux - This model allows
you to model convective heat
transfer while also specifying a
constant heat flux.

l

Convective Heat Transfer with
Heat Tracing - This represents
adding some type of heating
layer onto the pipe's outer surface. The amount of heating
may be entered as a constant
heat flux or by providing information on the power and number
of wire turns. Insulation layers
can then be added on top of the
heat tracing (heat flux source).

Note that similar to flow rate definition,
heat flow is positive when flowing into
the pipe, and negative when flowing
out.

Viewing Calculated Thermal
Results in Output
A table is displayed in the Output window Pipe area showing the temperature distribution in the pipe and
insulation for the steady-state system.

Figure 1: Thermal Data table in Output
window Pipe area shows the steady-state
temperature distribution in pipe

Clicking the button next to Show in the
Results Diagram column brings up a
Results Diagram for that particular
pipe:
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Figure 2: Pipe Heat Transfer Results Diagram

Related Topics
References

435

Convective Heat Transfer
There are 3 convective based models
for pipe heat transfer:

l

Convective Heat Transfer Represents a pipe thermally
affected solely by convection.

l

Convective Heat Transfer
and Heat Flux - Behaves the
same as the Convective Heat
Transfer model, but also
includes the effect of an
external heat flux such as radiation.

l

Convective Heat Transfer
with Heat Tracing - Similar to
the Convective Heat Transfer
and Heat Flux model, but
instead of applying the flux on
the outermost surface of the
pipe/insulation, the flux can be
applied directly to the pipe. As
the name suggests, this represents a device such as a
heated wire. If the flux is not
known directly, it can be determined based on Wire Turns and
Length.

Defining the Convective
Model
When one of the convective heat transfer models is selected, there are a
number of items that must be defined:
l

Resistance Geometry Radial or Linear

l

Number of Insulation Layers
- There can be up to three layers of insulation defined, in any
combination of internal or
external.
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l

External Heat Flux - Only
available if Convective Heat
Transfer and Heat Flux is selected. A constant flux applied to
the outermost layer of resistance.

l

Heat Tracing on Pipe (Flux) Only available if Convective
Heat Transfer with Heat Tracing is selected. A constant flux
is applied at the outer wall of
the pipe.

l

Ambient Conditions - The
temperature and velocity of the
fluid around the pipe. The fluid
can be either air or water.
These values are used for calculating the convection coefficient if correlation is selected
as the convection Data Source.
This correlation can be used for
pipes over which boundary layers develop freely, free of constraints imposed by other
surfaces. All of the external
fluid properties are evaluated at
the film temperature using data
from NIST REFPROP.

l

l

Fluid Internal The fluid itself
has a convection
coefficient that
affects the transfer of energy to
the pipe wall. By
default, the Gnielinski Correlation
is used to determine this value.
Alternatively, the
Dittus-Boelter
Correlation can
be used, or a
User Specified
value can be
entered.

l

Pipe Wall - The
wall of the pipe
has a thermal conductivity that
affects the heat
transfer. The
built-in pipe
materials have
thermal conductivity values
defined, and this
value is automatically selected. If a User
Specified pipe is
used, the conductivity will need
to be entered.

l

Insulation There can be several insulation
rows, depending
on the selection

Resistance Table - The table
at the bottom of the window
defines all of the resistance layers used in the thermal model.
l

Rows
l

Units - This special row defines
the units of any
value in the
column below a
cell.
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of Number of Insulation Layers. The
Insulation can be
selected from the
Insulation library,
in which case the
conductivity is
read from the library. User Specified insulation
requires this
value to be
defined.
l

External - Convection occurring
external to the
pipe and any insulation layers. By
default the Convection Coefficient is
calculated with
the ChurchillBernstein Correlation. The Correlation can also
be set to FreeHorizontal or
Free-Vertical
which requires
only an ambient
temperature, and
no fluid velocity.
The Free Horizontal and Free
Vertical orientations are in
reference to the
orientation of the
pipes. If the convection

coefficient is
known, a value
can be entered
by the user.
l

Columns
l

Apply - This can
allow
enabling/disabling of including certain layers
in the calculation.
This is useful for
comparing states
or scenarios
without redefining
the thermal
model.

l

Conductivity/Convection
Data Source Specifies from
where relevant
information is
attained. This can
be a Library, Correlation, or User
Specified.

l

Conductivity Applies to the
Pipe Wall and
Insulation. If Data
Source is a
Library, the particular insulation
must be selected.
If User Specified,
the conductivity
must be entered.
Note that
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obtaining the
thermal conductivity from an
insulation or pipe
material library
permits temperature dependent thermal
conductivity to be
employed. With
this option, AFT
xStream dynamically selects the
insulation thermal
conductivity during model solving
based on the
local temperatures that
exist. Conversely,
user specified values are always
constant.
l

l

Thickness Applies to Pipe
Wall and Insulation. If a Library
is used for the
Pipe Material, this
value is automatically populated. All
insulation layers
require a thickness.
HT Area Ratio This represents
any "extra" heat
transfer area that
may exist. For
example, if the

pipe has cooling
fins this ratio
would be larger
than one.
l

Convection
Coefficient Applies to Fluid
Internal and
External. Both values can be either
Correlation or
User Specified.

Figure 1: Convective Heat Transfer Layout
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Modeling a Constant Wall
Temperature
Assign an ambient temperature and
disable the External Resistance by
unchecking the box in the Apply
column. This will force the outside wall
of the pipe to be equal to the ambient
temperature. Note that this differs
from isothermal in that the fluid temperature can still change - only the outside wall of the pipe has a fixed
temperature.

Related Blogs
Let the Heat Flow: Modeling Heat
Transfer in Pipes in AFT Fathom and
AFT Arrow

Heat Tracing Flux Based
On Wire Turns And
Length.html
The Convective Heat Transfer with
Heat Tracing model requires additional information to represent the
thermal effect of a heat tracing.
xStream allows users the ability to
model Heat Tracing by either entering
the heat flux directly, or by providing
information on the number of turns
and power per unit length of wire,
which xStream will use to determine
the heat flux as described below.

Figure 1: Pipe Properties window with the
Conv. Heat Transfer with Heat Tracing
model enabled

Power and Turns - Detailed
Discussion
When you select the option to model
Heat Tracing based off a heated wire,
xStream models that heat flux based
on the theory described below.
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The total turns and turns per length
are related by the pipe length:

Each turn of the wire creates a right triangle on the "flattened" pipe, so we
can find the length of each segment by
the Pythagorean theorem.

Figure 2: Wire tracing geometry

The total length of the wire is related to
the number of turns and the segment
length.

Length of Wire
First, it may be necessary to determine the length of the wire itself, based
on a number of turns.
l

N - total number of turns on the
pipe

l

n - number of turns per unit
length

l

LPipe - total length of the pipe

l

r - external radius of the pipe

l

LWire - length of the wire

l

LTurn - length of one wire turn

The above figure shows a pipe with
heat tracing that has been "split open"
and laid into a flat rectangle to make
these equations more intuitive.

Incorporating this relationship and
rearranging:

Using the number of turns per unit
length:

or:
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Flux of Wire

Simplifying:

With the length of the wire found, the
flux based on power per length can be
found.
l

PTotal - total power usage of
the wire, along the entire pipe
length

l

p - power per unit length

l

Q'' - heat flux

l

A - area heat flux is applied to

Steady State Heat Transfer In Pipes

The heat flux is defined as the heat
delivered per area. Here, we assume
that the "total power" used by the heat
trace is equivalent to the total heat
delivered. Therefore:

The total power is equal to the power
per length times the length, and area
is related to pipe geometry:
Figure 1: Diagram of a pipe with Heat Tracing and Insulation

Substituting in for LWire:

There are many possible combinations of heat transfer that can be
defined in AFT xStream. In any of
these models there are various heat
flows that can be considered.
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Figure 1 shows the heat rates for one
of the more complex cases – convective heating with a heat trace on
the outer face of the pipe wall.
This topic will discuss heat transfer in
terms of steady state heat transfer calculations. Balancing these heat rates
and temperatures via iterative methods allows AFT xStream to come to a
unique solution. The Transient Heat
Transfer topic expands on how the
convective heat transfer calculations
are carried out during the transient.

The work done by the fluid is comprised of pressure work pv and shaft
work wshaft

Heat Rates
As a hydraulic solver, the primary heat
rate of interest is
, the heat
added to the fluid itself. Adding heat to
the fluid has the effect of raising its
temperature.

Combining and rearranging

We can derive an expression for
with the first law of thermodynamics. For convenience, we
use specific quantities (per unit mass)

Using the definition of enthalpy

The energy e is composed of internal
energy u and kinetic energy V2/2.
Note that the gravity term gz is neglected from this equation to simplify
the derivation.
In the steady state analysis, we consider that the velocity through the control volume remains constant. In
reality, changing temperature will
cause the density of the fluid to
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change, and thus the velocity. For this
reason, pipes in AFT xStream are
thermally sectioned. This means that
certain properties are considered constant throughout the section as an
approximation – having several sections in a pipe helps increase the
accuracy of this approximation.

or
by examining various
control volumes and surfaces:

There is also no shaft work being done
on the fluid.

We further assume that this can be
treated thermodynamically as a constant pressure process. That is, cp is
constant in the thermal section, like
density. With this assumption we can
use the relationship

We now have a system of equations
that allow us to determine all the heat
rates in the system given a mass flow
(determined from a mass balance), a
specific heat (defined versus temperature) and a change in temperature. However, we do not know
what this change in temperature is. To
find it, we need to relate the surface
temperatures to the heat rates.

Surface Temperatures and
Resistance
To find that
Thermal resistances are useful
because they directly relate the heat
rate between two points with the temperature between those points.
Rather than using specific quantities,
it is useful to relate heat rate and mass
flow. Multiply both sides by ṁ

The other heat rates in the system can
be related to
and other user
defined values like

The value of resistance depends on
the mechanism of heat transfer
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For conduction, the area and thus resistance changes with increasing r, so
an integration must be done

If the result for Tfluid matches the values used for ΔTfluid used for determThese resistances can all be calculated with user-defined data. AFT
xStream helps simplify this by offering
several correlations that can be used
to determine the heat transfer coefficients in the above equations from
more readily available parameters.

ining
, the correct solution has
been found. If they are different,
ΔTfluid needs to be adjusted and the
process repeated until reaching a
stable solution.

Overall Heat Transfer
With resistances and
, all the
surface temperatures can be determined. By bounding the system with a
given Tambient we can work outside in
to find the required Tfluid to obtain
those heat rates.

Wherever there are sequential
thermal losses, it is convenient to combine these losses. This is straightforward:
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Additionally, an overall heat transfer
coefficient U can be defined which
behaves similarly to h or k

We arrive at an expression relating the
temperature change along the pipe
and temperature change through the
pipe:

Using the heat rate and resistance
relationship, as well as the fact the
heat transfer is into the fluid

Correlations
Thermal resistances depend on the
conduction and convection coefficients k and h which can be directly
specified or calculated via a correlation.
Transforming the equation into a differential form on radius and length

Rearranging and integrating

The convection coefficient for internal
fluid convection can be calculated with
the Gnielinski Correlation or the Dittus-Boelter Correlation which can be
seen in Incropera.. These correlations
determine the Nusselt number of the
fluid – a ratio of convective to conductive heat transfer. Conductive properties are required input – with a
Nusselt number and conductivity
defined, the convection coefficient can
be calculated.
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These correlations also make use of
the Prandtl number, a ratio of viscous
diffusion to thermal diffusion.

Related Topics
References

435

Related Blogs
Gnielinski

Let the Heat Flow: Modeling Heat
Transfer in Pipes in AFT Fathom and
AFT xStream

Transient Heat Transfer
in Pipes
Dittus-Boelter

External convection behavior differs
from the above. AFT xStream
provides the Churchill-Bernstein correlation for determining a convection
coefficient from ambient temperature
and fluid velocity. This correlation can
be used for pipes over which boundary layers develop freely, free of constraints imposed by other surfaces. All
of the external fluid properties are evaluated at the film temperature.

AFT xStream uses a thermal resistance network to account for convective and conductive heat transfer
and calculate the steady state heat
rates. xStream then uses a discrete
solution method to account for radial
and axial heat transfer through the
pipes and fluid during the transient.
This topic discusses the solution methods used by xStream to determine the
heat rate and temperatures during the
transient. See the Steady State Heat
Transfer in Pipes page for information
on how the heat rate is derived, and
how the convection coefficients are
calculated.
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Transient Heat Rate

(3)

Consider a cylindrical control volume
as shown below in Figure 1. Note that
dz is perpendicular to the page and
thus is not shown.

From Fourier's law for conduction the
heat rate is defined as

(4)

Figure 1: Cylindrical control volume for
heat rate calculation through the pipe
wall/insulation, with dz extending out of
the page

By substituting Fourier's law into equation 3 above and dividing the whole
equation through by dr dФ dz, the following heat diffusion equation is
derived for the radial dimension.

(5)

The heat energy in the control volume
due to a change in temperature can be
written as:
(1)
The heat energy can also change in
response to heat flux and generation:
(2)
By simplifying the heat flux balance
and equating it to the heat energy due
to temperature change the following is
found:

Transient Pipe Temperatures
xStream will account for heat transfer
in the radial and axial directions.
However radial heat transfer is dominant, so the below discussion will
focus on calculating radial heat transfer.
To calculate the heat rate and temperature profile across the pipe walls
and insulation the heat diffusion equation (Equation 5) must be solved.
There is not a simple analytical solution for the heat diffusion equation
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derived above, so a discrete solution
method will be used.
The pipes and insulation layers will
each be sectioned radially similar to
the example in Figure 2 below, with
points 1, 2, and 3 representing calculation nodes at which the temperature and heat rate will be explicitly
calculated. Each node represents the
temperature, density, and thermal conductivity of the control volume they are
within.

Figure 2: Partial pipe cross-sectional area
representing the radially sectioning for
heat transfer calculations

There are a few assumptions that are
made to calculate the heat rate and
temperature.
First, for the purpose of calculating a
heat rate xStream assumes a linear
temperature profile between each set
of consecutive temperature nodes. In
reality the temperature would vary logarithmically through a single material.
However, using a logarithmic temperature function would be computationally difficult, and provide a
negligible increase in accuracy.
Second, the temperature is assumed
to be constant at the boundary of different materials, such as where the

insulation touches the pipe wall. In
reality there would be some contact
resistance creating a difference in temperatures between the pipe and insulation, but this is typically a negligible
effect.
Lastly, for calculation nodes that exist
at a boundary between pipe materials,
the thermal conductivity and density
are assumed to be an average (by
volume) of the staggered control
volume (Figure 3). This assumption is
made to simplify the solution by creating a continuous temperature profile. From testing this assumption
provides reasonable results.
Note: The discrete solution method
used for calculating radial
conduction can potentially
become unstable and give
physically unrealistic results
if the number of radial calculation nodes is insufficient.
The default number of nodes
should be sufficient for most
cases. The number of
thermal nodes can be
changed on the Sectioning
Panel.
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Optional Input for Pipes
Initial Flow Guess

Figure 3: Partial pipe cross-sectional area
with the staggered control volume outlined in red

Insulation for Pipes
Insulation data can be entered on the
Heat Transfer tab of a pipe. The insulation data is only included in the heat
transfer calculations if a convective
heat transfer model is entered. It may
be entered for other heat transfer models, but will only be used for cost calculations.
See Heat Transfer in Pipes for more
details.

The Initial Flow Guess for a pipe can
be specified. An appropriate initial
guess can decrease the number of iterations required to arrive at a converged solution. This initial guess will
only affect the steady-state solution
process.
The Solver generates initial guesses
on its own, which is usually sufficient
to get the Solver going in the right direction so a converged solution results.
If this is not the case, user defined
guesses can help obtain a solution.

Pipe Line Size and Color
Each pipe may have its line size and
color changed from the defaults configured in Workspace Options.

Display on Workspace
Related Blogs
Let the Heat Flow: Modeling Heat
Transfer in Pipes in AFT Fathom and
AFT Arrow

By default, only the pipe number is displayed on the Workspace. In addition
to this, the pipe name, nominal size,
and type/schedule can be displayed.

Design Factors
A design factor can be used to add
safety margins into the analysis. For
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pipes, two design factors exist:
l

l

Pipe Friction: friction factor is multiplied by the design factor
assigned to the pipe.
Pipe Fittings & Losses: total loss
factor (K factor or Equivalent
Lengths) is multiplied by the
design factor assigned to the pipe.

Parallel Pipes
A single pipe object can be specified
as a number of parallel pipes. When
multiple pipes are defined, the parameters in the pipe properties window
represent only one of the parallel
pipes.

Use Temperature Override
for Zero Flow
Enabling the Temperature Override
option will force the temperature in the
pipe to the specified value for the initial steady state solution. The override
will only occur for pipes with zero flow
in the steady state.
If the temperature override option is
no used the temperature in the pipe
will be set to the ambient temperature
if the heat transfer model is set as Convective Heat Transfer, or to the temperature of the connected boundary
junction if any other heat transfer
model is used. See Heat Transfer in
Pipes for more information.

Related Topics

Optional Input
Make Initial Flow Rate
Guesses for Pipes

186
499

Add/Remove Pipe Segment
Visual segments can be added to
pipes.
To add or remove segments, use the
Arrange -> Add/Remove Segments
submenu. These options are also
available by clicking the Add/Remove
Segments button
space Toolbar.

on the Work-

Note: These segments are useful
for creating a clear layout of
the system, but have no
impact on the solution - a
visual "bend" is not the same
as adding a Branch junction.

Related Topics
Keyboard Shortcuts for
Workspace

273

Reverse Direction
Every pipe has a reference positive
flow direction as indicated by its arrow.
This direction can be easily reversed
by selecting Reverse Direction from
the Arrange menu or clicking the
Reverse Direction button
Workspace Toolbar.

on the
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friction factor based on the
roughness of the pipe wall. Different equations are used
based on flow regime - laminar
flow uses the standard laminar
relationship, while turbulent
flow uses the implicit
Colebrook-White equation. In
the transition range between
laminar and turbulent flow, a linearly interpolated value is
used. The default transition
Reynold's Numbers can be
modified in the Environmental
Properties panel of Analysis
Setup.

Pressure Drop in Pipes Detailed Discussion
Depending on the pipe friction model
selected, the calculation of pressure
drop in a pipe differs.

Darcy-Weisbach Loss Model
Note: The pressure drop for compressible flow depends on
several equations, as discussed in Review of Compressible Flow Theory. The
effect of pipe friction is taken
into account as part of the full
compressible method. The
Darcy-Weisbach pressure
loss equation for incompressible flow is shown below
for simplicity.
AFT xStream utilizes the Darcy-Weisbach loss model to relate the Darcy
Friction Factor, the pipe geometry,
fluid density, and fluid velocity to pressure drop in the pipe. The Darcy Friction Factor differs from the Fanning
Friction Factor by a factor of 4.

l

This model requires the calculation of
a friction factor, as described below.
l

Roughness-Based Methods This method calculates the

l

Absolute Roughness
(default) - The absolute
average roughness
height εis specified directly.

l

Relative Roughness The roughness is specified as a ratio ε/D.

l

Hydraulically Smooth The ratio ε/D is set equal
to zero.

Explicit Friction Factor - The
friction factor to be used in the
Darcy-Weisbach equation is
specified directly
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Frictionless
The pipe will not have any pressure
drop across it. This is inherently
unrealistic behavior, but can be useful for troubleshooting purposes.

Design Factors
In each pipe you can specify a Design
Factor for the pipe friction. This is a
multiplier that is applied to the friction
factor calculated with the preceding
methods.

Related Topics
Features for Modeling Irrecoverable Losses
56
Conventions for Specifying
Base Area
187
Nomenclature
391
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Junctions
This section focuses on the Junctions
in the workspace as well as the theories that govern the junctions. Topics
included discuss the types of junctions
that xStream provides, the required
inputs for each junction, and theory
topics that indicate how the inputs to
the junction are used.

Contents
Junction Window Overview

182

Junction Loss Models

190

Junction Window Overview
The different types of junctions on the
Toolbox offer a great degree of freedom in assembling a pipe network
model. While there is some redundancy in capabilities between the junctions, each of the types of junctions
offers specialized features to allow
you to prepare a good conceptual
model of the physical system of
interest. Table 1 compares the features of the junction types.
There is a junction properties window
for each junction type. Each junction
Properties window falls into one of two
basic window formats, depending on
the number of connecting pipes
allowed for that junction type.

Note: AFT xStream does not prevent negative flow through
junctions. Should this occur,
AFT xStream will use the
same loss factor or pressure
drop data referenced to the
defined upstream pipe, just
as in forward flow. Because it
is possible that the loss factor
or pressure drop data would
not be the same for both flow
directions, the flow solution
could be misleading. For this
reason it is important that you
either properly define the
pipe flow directions for junctions or pay close attention to
the flow directions that result.
AFT xStream will not always
give a warning for this,
though it will for certain junctions.
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Table 1: Junction Property Windows and
Features

Junc- Con- Spe- C- Custotion
nec- cial d- m LibType ting Con- A rary
Pip- dities
ons

Area
Change

2

Yes

Assigned
Flow

1

Assigned
Pressure*

1/125

Yes

Yes

Bend/Elbow

2

Yes

Yes

Yes

Yes

Branc- 2-25
h
Check
Valve

2

Yes

Yes

Yes

Yes

Yes

Window
Format
1

End
General
Component

2

Yes

Heat
Exchanger

2

Yes

Orifice

1-2

Relief
Valve

1-2

Screen

2

Tank

1-25

Tee/Wye**

3

Valve

1-2

Venturi

2

1
Yes

1

1

Yes

Yes

1

Yes

1

Yes

Yes

1

Yes

Yes

1

Yes

Yes

1

Yes

2
2**

2
Yes

1

Compressor/Fan

2

Yes

Yes

1

Control Valve

2

Yes

Yes

1

Dead

1

1

Yes

Yes

1

Yes

Yes

1

*Assigned Pressure Junction connects to
only one pipe for static pressure, and up
to 25 for stagnation
**Tee/Wye junction has a unique format
closer to Format #2

Related Topics

Index 184

Notes
Status
Common Junction Input
Parameters

154
155
185

To inspect in this window format, position the mouse pointer over the connected pipe ID and hold down the right
mouse button.

Two Window Formats
Format #1: Junctions With
One or Two Connecting
Pipes
The first basic window format is for
junction types that allow only one or
two connecting pipes (see Figure 1).
While junctions do not have an explicitly defined flow direction like pipes
do, typically those with two pipes or
less adopt a direction from the connecting pipes. For these junction
types, upstream and downstream
pipes are recognized by AFT xStream
based on the reference positive flow
direction of the connecting pipes. The
upstream and downstream pipes are
displayed separately near the top of
the window.
In this first basic window type, it is generally important to have the pipes' reference positive flow directions
specified in the physically correct directions. A good example of this is a
Compressor junction. A compressor
will add pressure to the system, but it
does so only in the direction of positive
flow through the connecting pipes.
The compressor junction interprets
where to add the pressure based on
the directions of the connecting pipes.

Figure 1: Properties window format #1
(fixed connecting pipe display).

Format #2: Junctions With
More Than Two Connecting
Pipes
The second basic window format for
junction Properties windows is for junctions that allow more than two
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connecting pipes (see Figure 2).
These junctions typically allow up to
25 connecting pipes; the exception is
the Tee/Wye junction, which allows
only three.
An example of this second window
format is the Branch Properties window, shown in Figure 2, which has
three connecting pipes.

Common Junction Input
Parameters
Number
Every junction must have a unique ID
number. When new junctions are created, a junction number is automatically allocated.
The junction number can be changed
by the user to any unique integer
value greater than zero and less than
100,000. Junction numbers are only
identifiers and have no effect on the
model behavior.

Name
A name can be assigned to each pipe
for reference purposes. Names do not
need to be unique. The name can be
shown on the Workspace, in the
Visual Report and in the Output window.

Library List
A list of all available custom components. It displays components from
any connected library.

Figure 2: Properties window format #2

Selecting a component from this list
automatically retrieves the junction settings and populates the properties window. Changing the input manually will
deselect the component in the list.
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Copy Data From Jct

Jumping to Another Junction

The Copy Data From Junction dropdown list allows you to copy all or
some of an existing junctions’s properties to the current junction. Selecting
an existing junction will prompt the
user on what parameters should be
changed.

Quickly move to the next junction. See
Jump Feature.

In child scenarios, Copy Data From
Junction lists "Parent Junction Data,"
allowing the user to copy all or some
parameters from the parent junction.

Pipe Connectivity
The connected pipes are displayed.
This is helpful to determine potential
connection issues and easily identify
which pipes are upstream and downstream of the junction.

Related Topics
Notes
Status

154
155

Optional Input
Workspace Display
By default, only the junction number is
displayed on the Workspace. In addition to this, the junction name can be
displayed.

Special Conditions
Elevation
Every junction must have an elevation
reference. This value is the centerline
elevation of the connected pipe(s).
Junction elevations are used to
account for pressure changes due to
gravity, allowing calculation of absolute pressures in pipes.
A default elevation can be specified in
Parameter Options, automatically setting new junctions to the specified elevation.

The Special Condition can be
changed for some junctions. For
example, a valve can be set to closed,
preventing all flow. A symbol (default
of "X") will be placed before the junction label indicating that a special condition is applied.

Workspace Icon
You may want to change the icon to
better represent a specific junction
type. This is accomplished by clicking
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the Change Icon button on the
Optional tab. The Change Icon window appears, allowing you to choose
a new icon from a list of available
icons.
You may want to change the size of
the junction to distinguish it from other
junctions. This is accomplished by
clearing the use Workspace Default
for Size checkbox and selecting the
desired size in the drop down list.

Related Topics
Optional Input for Pipes

178

Specifying Losses
Local losses can be specified in two
ways. The most flexible way of including a loss factor in an AFT xStream
model is to associate it with a junction
specifically defined for that type of
loss. This allows you to define a loss
as a function of a flow parameter such
as Reynolds number or volumetric
flow rate, or as a function of the area
change ratio between the upstream
and downstream pipes. This method
results in the greatest clarity.
Secondly, you can include loss factors
with pipes. When you specify Fittings
& Losses in the Pipe Properties window, the loss is assumed to be distributed evenly along the pipe length,
much like friction losses. For this
reason a pipe-associated loss factor is
referred to as a distributed loss. The
losses at junctions, on the other hand,
are point losses.

It should be noted that for compressible flow, the location of a fitting/loss along a pipe will change the
pressure drop due to that fitting/loss.
This is because the velocity along a
pipe changes for compressible flow.
For this reason, the recommended
method for representing losses is to
define them in a junction.

Related Topics
Fittings & Losses Library
Fittings & Losses
Discharge Coefficient Loss
Model
K Factor Loss Model
Cv/Kv and XT Loss Model
Resistance Curve Loss
Model

377
161
190
191
193
196

Conventions for Specifying Base Area
Loss factors are area dependent.
When specifying a loss factor at a junction, the base area is of critical importance. By default AFT xStream
adheres to the following convention:
whenever it makes sense physically,
the base area is always the upstream
pipe flow area. However, this can be
modified by the user. In most Junction
Properties windows (on the Optional
tab), the base area can be specified
as the upstream pipe, downstream
pipe, user specified area, or user specified diameter.
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Related Topics
Features for Modeling Irrecoverable Losses
56
Pressure Drop in Pipes Detailed Discussion
180

However, head relationships are not
always available or meaningful. If a
pressure vs flow relationship is used,
a reference density must be specified. This is the fluid density used during testing and creation of the curve.

Reference Density
A relationship can be drawn for many
components between flow energy and
flow rate. This can be a decrease
(e.g., a loss across a valve) or
increase in energy (e.g. energy added
by a compressor). The specific parameter used to represent flow energy
can vary depending on application. It
can be given in terms of pressure
change or head change, and there is a
critical difference between the two.
Consider a centifugal turbomachine (a
pump or radial compressor): Kinetic
energy is imparted to the fluid by accelerating it along the radius of the
impeller. If the rate of rotation is held
constant, a denser fluid will have more
energy imparted to it than a lighter
weight fluid. This would give rise to
higher pressures. In other words, the
pressure change depends on the density of the fluid.
Sometimes curves are provided in
terms of head. This is convenient
because head is a unit of specific
energy - or energy per weight. Therefore, it does not vary with fluid density
like pressure does. The head added to
a fluid by a pump or compressor at a
fixed speed, for example, will be the
same for fluids of different densities.

Figure 1: Visual comparison of Pressure
Loss Curves for differing densities. Head
curves would be identical for this component

Note: Incompressible liquids are
used in the example in Figure
1, but the principles apply similarly to compressible flow.

Affected Parameters
There are several parameters that are
affected by the density of the fluid:
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l
l

l

Pressure - As discussed above
Mass Flow - The mass term contains information about the density
of the fluid
Power - More power is demanded
by a compressor to meet the head
curve for a denser fluid. While
head is independent of density
and therefore often reported by
manufacturers, power is not independent of density. Therefore, a
proper specification sheet that
includes power must also include
the reference fluid density.

Accounting for Reference
Density
Compressors and any Resistance
Curve allow for the specification of a
reference density if one of the above
parameters is selected. The selection
appears below the curve fit area as
shown in Figure 2.

l

conditions.
User Specified - This directly specifies the reference density. If the
fluid or operating conditions differ
from the testing conditions, the
entered curve will be corrected.

Related Topics
Curve Fitting

63

Equal Percentage Valves
Equal Percentage valves have a valve
plug shaped so that each increment in
valve percent open (lift) increases the
flowrate by a certain percentage of the
previous flow.
The relationship between valve lift and
orifice size is not linear but logarithmic.
It is expressed mathematically as follows:

Figure 2: Reference Density Selection

There are two options:
l

No Correction (default) - This
selection assumes that the component was tested with the fluid
defined in the Fluid Panel and is
operating at the reference

Where:
l

l

τ = valve rangeability (ratio of the
maximum to minimum controllable
flowrate)
H = valve percent open or lift (0 =
closed; 1= fully open)
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l

Cv,max = full open valve loss
value

relationships, replacing the static pressure at the restriction with the downstream stagnation pressure, Po,out.

Related Topics
Control Valve
Valve

229
244

Junction Loss Models
There are a number of loss models
available in xStream to account for frictional losses at the junctions in the
model. See the below topics for more
information on how losses are calculated for each of the available models.

Discharge Coefficient
Loss Model
Orifice subsonic losses for the Orifice,
Relief Valve and Venturi junctions can
be defined with a discharge coefficient, Cd.

Subsonic Loss
When solving the system, AFT
xStream creates a subsonic CdA for
the orifice using the Cd specified for
the subsonic loss model, and the specified orifice area. xStream then
solves the pressure drop by iterating
the following equation for pressure
drop for a given mass flow rate. The
equation below for mass flow rate can
be derived from isentropic

The assumption that the static pressure at the restriction can be replaced
with the downstream stagnation pressure, Po,out, is necessary to find a
solution, as the velocity must be
known to find the static pressure, and
the mass flow must be found before
the velocity can be a known quantity. It
is important to note that this assumption neglects static pressure recovery,
which could be a significant factor.

Sonic Loss
The above equation for the mass
flowrate can be simplified when the orifice is sonically choked. When the
Mach number at the restriction is 1,
the equation can be simplified as
shown below. The value of CdA used
here will be the CdA for sonic choking,
which is entered as a separate value
from the discharge coefficient, Cd, as
is discussed in the Subsonic vs. Sonic
Pressure Losses topic.
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Note: The CdA for sonic choking
may be different from the subsonic CdA loss model option
in xStream. The discharge
coefficient can vary at different pressure ratios due to
the vena contracta moving
closer to or farther from the
orifice restriction. For the
highest accuracy the CdA
used for subsonic and sonic
losses should be tested and
entered separately. See the
"Modeling Choked Flow
Through an Orifice" white
paper on AFT's website for
more information.

Transient Theory
The above equations for the mass
flow rate through an orifice are applied
in the transient simulation similar to
the approach used for other loss models. Inlet conditions are guessed at, a
mass and energy balance is applied to
find the outlet conditions, and then
those conditions are used to determine the mass flow through the orifice
for that guess. Iteration proceeds until
the guesses for inlet conditions are
consistent with the solved mass flow
equation.

Related Topics
Orifice
235
Relief Valve
237
Subsonic vs. Sonic Pressure 427

Losses

K Factor Loss Model
AFT xStream models component
losses according to the following equation:

(1)

where K is commonly referred to as
the loss factor. Note that for calculation purposes this pressure loss is
a stagnation pressure loss.
Table 1 lists the sources for the k
factor loss models used in AFT
xStream. The losses implemented directly in the code were chosen on the
basis of ease of use. Many loss factor
types are functions of the flow, and
thus too general to be easily incorporated.

Table 1: Loss model references

Crane (1988) offers good general purpose correlations for modeling irrecoverable losses in pipe systems. A
well prepared pipe flow analyst would
be advised to have copies of either or
both of these references.
Another lesser known source of loss
factor information is Idelchik's Handbook of Hydraulic Resistance (Idelchik
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2007). This reference is indispensable
for the engineer who must make
detailed assessments of pipe systems
in which so-called minor losses play a
significant roll. The reference is voluminous in scope and full of tables,
charts and equations for calculating
loss factors for almost any pipe
arrangement.
Miller's Internal Flow Systems (1990)
is another reference offering good general purpose hydraulic data.

K Factor Losses in Compressible Flow
Most handbook K factor data is based
on incompressible flow tests or theory.
Applying standard K factors to compressible flow components carries
some uncertainty. There are not any
universally accepted methods available to determine K factors for truly
compressible flow except in very specific situations.
xStream offers common handbook values for K factors, and you should use
caution in how you apply the data.
Also recognize that when you use the
“Fittings & Losses" in pipes, computationally these K factors are spread
out along the whole pipe as distributed
losses. In compressible flow, the location of a fitting along a pipe will affect
the actual pressure loss since velocity
is not constant along a pipe. The Fittings & Losses do not account for this.

Transient Theory

When a junction is defined using a K
factor, the junction inlet will be treated
as a static pressure boundary. A
guess for the inlet static pressure is
made, which can be used to solve for
the inflow conditions using the compatibility equations as shown for the
Assigned Pressure junction at the
downstream end of a pipe. With the
known inlet conditions, the inlet stagnation pressure and stagnation
enthalpy can be calculated and used
to solve for outlet stagnation pressure
using the K factor loss equation
above.
With the outlet stagnation pressure
and enthalpy the outlet conditions can
be solved using the method for an
assigned pressure boundary.
With both the inlet and outlet conditions known the inlet and outlet
mass flow rates can be calculated and
compared. If the mass flow rate difference is too large, then iterations on
the inlet static pressure will be completed until the mass flow rate tolerance is met.

Exit Junction Transient Theory
If a K factor loss is defined for a junction that is specified as an exit type
junction, such as a relief valve, then a
different solution method must be
applied as there is no downstream
pipe.
The user specified exit conditions are
assumed to be stagnation properties.
The K factor loss model can be
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rearranged and the compatibility equations substituted as follows.

conditions are determined, the mass
flow rate and stagnation enthalpy can
be used to solve for the outlet conditions.

Related Topics

The combined equations can then be
rearranged to solve for velocity and
density at the junction inlet.
If flow reverses at the exit junction
then the solution will be similar to the
solution with two pipes connected,
except that the effective pipe area at
the exit side of the junction will be
assumed to be equivalent to the area
of the pipe connected to the entrance
of the junction.

Sonic Choking Transient Theory
Either restriction choking or expansion
choking can occur at junctions
modeled with K factor loss, depending
on the geometry of the junction.
When the flow is choked iterations on
the inlet pressure will be performed
similar to the non-choked transient
solution. However, the sonic area will
be used as the dependent variable for
the iterations. Once the inlet

Area Change Loss Model
General Component
Heat Exchanger
Control Valve
Relief Valve
Valve
Orifice Loss Model
Transient Sonic Choking
Sonic Choking Detailed
Description
References

206
233
234
229
237
244
236
416
422
435

Cv/Kv and XT Loss
Model
AFT xStream allows the user to enter
valve loss coefficient data in terms of
Kv or Cv. Conversions are handled
seamlessly in the background. Kv is
the metric equivalent to Cv.
The valve Cv loss model type is
unique in that this loss model can be
used as part of both the subsonic and
sonic loss calculations across the
valve.

Subsonic Loss
The relationship between valve Cv,
XT, and flow is provided by ANSI/ISA75.01.01-2012 standard as follows:
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XT can be a complicated topic. If more
information on it is needed, a helpful
blog post on the topic can be found
here.
Where C is the flow coefficient (Cv or
Kv) and N is a numerical constant
found in Table 1 of the ANSI standard
referenced above. The units for the
flow, pressure and density will be
based off of the numerical constant
chosen.
FP is a correction factor for piping geometry. This correction will be treated
as 1 unless the Valve ID has been
entered by the user.
Xsizing is the ratio of the pressure
drop across the valve to the inlet pressure of the valve for subsonic flow:

Y is the expansion factor, which
accounts for the change in density as
the gas passes through the vena contracta, and is calculated as follows:

Sonic Loss
If choked flow occurs across the valve,
then the mass flow equation above is
still used. However, the Xsizing is now
equivalent to XT, which is the pressure ratio when the valve first begins
to choke.

Estimated Cv/Kv in Output
In the Output window the estimated
Cv /Kv can be displayed if the Cv /Kv
was not defined by the user. The estimated Cv /Kv value is calculated using
the mass flow rate equation shown
above, with Xsizing estimated as follows

Transient Theory
Where XT is the pressure ratio, X,
when the valve has just begun to
choke.

A valve junction has a pressure loss
across the valve. When the valve
closes this loss becomes infinite. With
two connecting pipes, the upstream
and downstream pipe parameters
must be determined through iteration.
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The valve will be treated as a mass
flow boundary. A guess for the velocity
is made, which can be used to solve
for the inflow conditions using the compatibility equations as shown for the
Assigned Flow junction at the pipe
inlet. This will provide values for the
conditions at the valve outlet, including the mass flow at the valve.
The outlet static pressure can now be
used to calculate the pressure ratio X
and the expansion coefficient Y as are
shown above. The calculated X and Y
can then be used in the to determine
the ANSI/ISA predicted mass flow as
shown above.
The mass flow calculated from the
assigned flow boundary solution and
the mass flow calculated from the
ANSI/ISA equation can now be compared. The difference between these
two values will be driven to zero using
iterations on velocity.

Exit Valves Transient Theory
If the valve is an exit valve, then the
downstream pressure is known. The
user specified exit properties are
assumed to be static. The compatibility equations can be substituted
into the ANSI/ISA mass flow equation
shown above, which is then
rearranged to solve for the inlet pressure at the valve.

If the flow reverses then a similar substitution can be done with the appropriate compatibility equation

Iterations are then performed by varying Pout (the pressure at the inlet of the
connected pipe).

Sonic Choking Transient Theory
Restriction choking can occur at any
time at the valve junction for either a
regular or exit type valve. If the valve
becomes choked, the valve Cv/Kv
equation for choked flow must be
used.

The mass flow term can be eliminated
to find the equation in terms of pressure, density, and velocity only
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Related Blogs
The wave and particle path compatibility equations can then be substituted to eliminate density and
velocity.

Though not shown here, this equation
can be rearranged into a polynomial
and solved for static pressure. Once
the static pressure is known the
choked valve can be solved using the
typical transient sonic choking calculation.
At the end of the calculation X will be
recalculated. If X is greater than
Xchoked then the solution is valid.
Otherwise, the valve is not choked,
and the non-choked valve calculation
are repeated using the choked valve
solution to bracket the velocity solution.

Related Topics
Nomenclature
Valve
Control Valve
Check Valve
Method of Characteristics
Sonic Choking
Sonic Choking Detailed
Description

391
244
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Making Sense of xT – Valve Loss in
Compressible Flow

Resistance Curve Loss
Model
The resistance curve loss model is
available in the General Component,
Screen, and Venturi junctions. It is useful when measured flow vs loss data is
available for a component.
It is not uncommon to obtain from an
equipment manufacturer a single data
point. For example, the data might be
3 psi pressure drop at 1 lbm/sec.
Along with this data point, another
always comes along for free. The
second data point is zero pressure
drop at zero flow.
The pressure drop characteristics of
most equipment follows the square
law. As the flow rate increases, the
pressure increases with the square of
the flow rate.
Therefore, in our example, an
increase in the flow rate to 2 lbm/sec
would result in a pressure drop of 12
psi. Although this may not be exactly
correct, it is much better than assuming a flat 3 psi drop for all flow rates,
which we know for certain is not correct.
The Fill As Quadratic button found in
the Curve Fit window can be used to
create a quadratic curve out of a
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single data point as was shown in the
below example. To do this, just enter
the single data point in the table, click
the Fill As Quadratic, then click Generate curve Fit to finish creating the
curve.

Table 1: Example data points for pressure
drop modeling using manufacturer data

Flow
Data
Rate
Poin(lbm/set
c)

Pressure
Drop
(psid)

Comment

1

0

0

Always
valid for
passive
equipment

2

1

3

Given by
manufacturer

12

Extrapolated
assuming
square
law

3

2

Related Topics
Curve Fitting
63
Troubleshooting Resistance
Curves
497
General Component
233
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Defining Junction Transients
This section contains information
related to defining transient behavior
for junctions. Topics include discussions on standard junction transient information and transient
initiation options. For information on
overall transient simulation controls
see the Pipe Sectioning and Output
group and Transient Control group.

The active transient data is entered on
the junction's Transient tab.

Contents

Junction Transient Data
Many junction types have an area
where active transient data can be specified. Active transient in this context
means that the behavior of a component over time is being directly
defined by the user. It is also possible
for components to react passively during the simulation as well - for
example, a relief valve opening under
excess pressure or a finite tank changing pressure as mass flows into or
out of it.

Table 1: Junctions that support transient
data

Figure 1: Transient tab for a Valve

In most cases, transient data can be
entered as absolute values or as a percentage of steady-state, as defined by
the first options in Transient Data.
The first data point always needs to
match the steady-state value which is
usually entered on the Loss Model
tab. xStream fills in that initial data
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point for the user, but it should always
be checked.
Lastly, take note that several junctions
require multiple inputs for transient
data to be used. This is different from
many liquid based transient solvers,
and should be kept in mind when
establishing transients in xStream.
Note: If a junction does not have
any active transient behavior,
there is no need to enter any
data on the Transient Data
tab.

Repeat Transient
If the transient data is periodic, you
can enter the data for one cycle of the
period and then tick the check box for
Repeat Transient. This will cause the
one cycle of transient data to be
repeated once it has reached the end.
The repetition will continue until the
end of the simulation.

Transient Special Condition
There are instances where you will
only wish to use the defined transient
data in certain cases or scenarios.
Instead of deleting the transient data,
specify the Transient Special Condition as Ignore Transient Data. The
data will be left in the window for future
use, but will not activate during the
run.

Initiation of Transient
There are multiple ways that the data
entered in Transient Data can be
applied during the simulation. The
default selection is Time for most junctions, meaning that the behavior vs
simulation time is directly defined by
the user.
It is also possible to initiate a transient
based on a system event. This will
execute the Transient Data when a
user defined parameter reaches a certain setting. For example, a valve can
be set to close only when a specific
flow rate becomes too low.
See Initiation of Transients for detailed
information.

Related Topics
Assigned Flow
Assigned Pressure
Valve
Heat Exchanger
Compressor/Fan
Control Valve
Check Valve
Related Blogs
And, Not, Or - Starting Transient
Events with Complex Logic
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Initiation of Transients

met and zero Event Time could be
well into the simulation.

In general, transients can be initiated
according to a certain time or according to certain events that happen in
the system. These two categories are
referred to as time based and event
based transients. This is defined in the
Initiation of Transient area of a junction's transient tab.

Figure 2: Time basis

Figure 1: Type of transient initiation

It is helpful to consider the different
time scales that are used when referring to the initiation of a transient, as
shown in Figure 2.
Absolute and Simulation Time are
often identical. The simulation Start
Time is set in the Simulation Duration
panel to an Absolute Time of zero
seconds by default, but it could be
non-zero. In Figure 2, the Simulation
Start Time is set to a value of 2
seconds – the entire Simulation Time
timeline is shifted forward 2 seconds.
Event Time refers to the time data
defined in Transient Data this could be
equal to Simulation Time (and Absolute Time) depending on how the
event is defined. For example, all
three time bases will match for a valve
closure event starting at the beginning
of a simulation with Start Time equal
to zero. However, the event may not
start until a certain system condition is

Time
Time based transients modify a parameter directly according to Simulation
Time.
For example, consider a valve closure
transient. The valve starts to close at
two seconds into the simulation, and
the time it takes for the valve to close
is one second. After that, the valve
stays closed. To define this event with
the Time option, the Start Time must
be set to zero, and the Transient Data
must look something like the data
shown in Figure 3.
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lbm/sec. Note that the Transient Data
is identical - but the initiation of the
event may happen at a very different
time.

Figure 3: Defining a valve closure at a specific time

Single Event

Figure 4: Event definition

Single Event initiated transients do not
begin until a certain condition is met.
To completely define an Event, four
parameters are required:
l

Event Type - What parameter
is being considered to initiate
the transient. See Table 1
below for a list of the possible
Event Types.

l

Condition - The logical relationship between Event Type
and Value (e.g. greater than,
less than, etc)

l

Value - The specific magnitude
of the Event Type parameter at
Location

l

Location - Where in the model
the Value should be observed

Given the same valve closure profile
described in Figure 3, we can set the
valve to remain open until (and if) the
flow at the inlet of P1 exceeds 20

Table 1: Event types

Dual Event Cyclic
The Dual Event options, as the names
imply, require the definition of two
events. The definition for each event
follows the same structure as a Single
Event.
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Dual Event Cyclic will continue monitoring both triggering events throughout the simulation and will apply the
corresponding transient data when the
conditions are met.
To continue with the valve example,
we can define our valve not only to
close when a flowrate is exceeded, we
can tell it to open when the flow drops
below a certain setting.

The difference is that the two defined
events are only applied once. That is –
after the second event is complete, no
more transients will be applied even if
the conditions are met.

Junctions With Inherent
Event Logic
There are two junction types in AFT
xStream which have built-in, or inherent, event logic. These are the check
valve and relief valve. The user does
not need to specify the nature of the
events, and in fact is not allowed to.
The inherent event logic is very similar
to the Dual Event Cyclic logic
described previously.

Figure 5: Dual Event set up. Note that a
Second Event requires additional data for
the Second Transient

l

Check valve - The check valve
has two built-in events. The first
is that it closes when backflow
starts to occur. The second is
that it reopens when sufficient
pressure differential occurs.
These transients are assumed
to be instantaneous.

l

Relief valve - The relief valve
has one built-in event. It opens
when the set pressure is
reached. This transient is
assumed to be instantaneous.

Dual Event Sequential
Related Blogs
Dual Event Sequential is nearly
identical to Dual Event Cyclic. In fact,
all of the required user input is the
same.

And, Not, Or - Starting Transient
Events with Complex Logic
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Multi-Condition Events
One of the Event Types available is
Multi-Condition. This feature allows
starting a transient based on more
than one parameter in the model.

Events and Multi-Condition Events
can be defined.
The Event Manager defines events
model-wide. That is, if the active scenario is changed, the same events will
be accessible.

For example, it may be desirable to
open a valve when either of two pressures is exceeded.
To define a Multi-Condition Event, first
select Multi-Condition as the Event
Type from the junction's Transient tab.

Figure 2: The Event Manager

Simple Events
Figure 1: Selecting Multi-Condition Event
Type

Event Manager
Clicking Multi-Condition Event opens
the Event Manager, where Simple

The Event Manager allows for the
definition of Simple Events and MultiCondition Events.
Simple Events are nearly identical to
normal (non Multi-Condition) events
defined in a Transient tab. They
require a Parameter, Condition,

Index 204
Value, and Object as well as a unique
Name.
Clicking "Create Simple Event..." adds
a new Simple Event to the list with
default values. These values should
be updated with the desired values
and applied with the Update button.
Simple Events can be duplicated to
help reduce repeated data entry.

Figure 3: Conditional logic for Multi-Condition Events

Any number of Simple Events can be
added to a Multi-Condition Event as
Sub-Events:

Multi-Condition Events
Multi-Condition Events are a collection
of other Events with a logical condition
applied to them. When creating a new
Multi-Condition Event, a prompt for a
Name appears. After entering a name,
an empty Multi-Condition is created
with a default logical condition of AND.
This logical condition can be:
l

AND - All of the Simple Event
conditions must be met for the
Multi-Condition Event to trigger.

l

NOT - The Multi-Condition
Event triggers when none of
the conditions evaluate to true.

l

OR - One or more of the Simple
Event conditions must be met
for the Multi-Condition Event to
trigger.

Figure 4: Multiple Events

Complex Multi-Condition
Events
More complex events can be defined
by adding one or several Multi-Condition Events as Sub-Events to another
Multi-Condition Event.

Figure 5: A Multi-Condition Event containing another Multi-Condition Event
(trigger if Limit 3 AND (Limit 1 OR Limit
2))
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Using Multi-Condition Events
All Multi-Condition Events are listed in
the junction's Initiation of Transient
section. Only one Multi-Condition
Event can be selected as the Initiating
Event for any particular Transient
Data.

And, Not, Or - Starting Transient
Events with Complex Logic

Area Change
The Area Change junction type must
always have two connecting pipes.
This junction type allows you to model
the irrecoverable loss that occurs at
the area transition between two pipes,
whether expansion or contraction.
The Area Change Properties window
follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format. A
flow direction through the junction is
adopted from the defined directions of
the two connecting pipes.
The Area Change Properties window
offers two standard types of area
change losses: the Conical Transition
and the Abrupt Transition.

Figure 6: The selected Multi-Condition
Event controls the trigger of the Transient
Data. Hovering over the Multi-Condition
events here shows an expanded definition of the event

Related Blogs

The critical parameter that influences
the magnitude of the area change loss
is the area ratio between upstream
and downstream pipes. Until you have
input the information for the upstream
and downstream pipes that allow for
flow area determination, the standard
Area Change junction loss factor is not
calculated. For conical transition geometries, you also need to specify the
conical angle. This angle has a range
of 0-180 degrees, with a 0 degree
angle representing a transition taking
place over an infinitely long length,
and a 180 degree angle representing
an abrupt transition.
If the standard loss factors provided
are inadequate for your application,
you may specify your own custom loss
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factor referenced to the base area you
specify.
Note:It is possible to have a vena
contracta through a physical
area change. If high velocities are possible, the Mach
number may reach sonic conditions and the flow will
choke. The optional CdA
input parameter is intended
to represent this vena contracta. The minimum possible
sonic flow area is entered as
the CdA and if sonic conditions are reached, AFT
Arrow will solve the system
on achoked flow basis.

The conical contraction correlation
(Crane 1988, A26) is

Related Topics
Common Junction Input
Parameters

185

Area Change Loss
Model
Two standard area change loss geometries are available: the conical transition and the abrupt transition.

The abrupt expansion correlation
(Idelchik 2007, 246) is

The conical expansion correlation
(Crane 1988, A26) is

The abrupt contraction correlation
(Idelchik 2007, 254) is
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Assigned Flow
The Assigned Flow junction type
allows you to connect one pipe and to
input a known steady-state and/or transient flowrate entering or leaving at a
particular location.

Note: While a 180 degree conical
transition is the same as an
abrupt transition, Crane's conical contraction equation
gives a different result at 180
degrees compared to
Idelchik's abrupt contraction
equation. Therefore, it is up
to the user to determine
which one to use.
All K factor equations are provided
here in terms of the upstream pipe.
The K factor in terms of the downstream pipe can be found as follows:

The Assigned Flow Properties window
follows the first of the two basic Properties window formats, displaying the
connecting pipe information in a fixed
format
The Assigned Flow junction type
allows you to specify positive mass
flow rates. Negative flow rates are not
accepted for steady flow, although
they are for transient flow. If, for
example, you have an outflow type
junction and your system is physically
flowing in, you cannot assign a negative flow rate to the junction. You
must reverse the connecting pipe reference flow direction to be consistent
with the actual direction and change
from an outflow type to an inflow type.

Transient Data

Related Topics
Nomenclature
K Factor Loss Model
References

391
191
435

On the transient data tab a flowrate
transient can be entered. A special feature is the ability to model a sinusoidal
flowrate transient. Input for the amplitude and frequency is required. If
data is present in the transient data
table, the sinusoidal transient is
summed with the data in the transient
data table.
A chopped sine wave takes the absolute value of the sine function. The end
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effect looks like doubling the frequency in the positive domain only,
and having nothing in the negative
domain.
For more information on transient
data, including event transients, see
Junction Transient Data.

Special Conditions
You can set a Special Condition for an
Assigned Flow junction, which will turn
the flow off and make it act like a Dead
End during steady-state.

Related Topics
Common Junction Input
Parameters
185
Junction Transient Data
198
SSL Module
Settling Slurry Module
An optional add-on module to AFT
Impulse which allows users to simulate settling slurries.

Assigned Flow Transient
Theory

determine the pressure based on an
initial guess for velocity.

The density can then be determined
directly from the equation of state as a
function of pressure and temperature.
Once the pressure and density are calculated, the mass flowrate can be
recalculated using the continuity equation. If the difference between the
defined and calculated mass flow rate
is too large the velocity is adjusted and
the process is repeated until the specified flow is met within a reasonable
tolerance.
Conversely, if the flow is known at the
downstream end, the positive wave
compatibility equation is used to calculate the velocity based on an initial
guess for pressure.

The density can then be found using
the particle path compatibility
equation.

With an assigned flow, the flow rate is
known at the pipe inlet or outlet. The
unknowns are then the velocity, the
pressure, and the density.
If the flow rate is known at the
upstream end of the pipe, the negative
wave compatibility equation is used to

Similar to the process above with a
known inflow the mass flow can be
recalculated using the continuity equation, and the pressure will be iterated
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on until the calculated mass flow is
within a reasonable tolerance of the
specified mass flow.

factors to be entered to account for
losses due to fittings or components at
the entry/exit to each of the connected
pipes.

Sonic Choking Transient Theory
An outlet assigned flow junction can
experience endpoint choking during
the steady state, or can become
choked during the transient due to transient events in the system. An inlet
assigned flow junction cannot be
choked in the steady state, but may
experience choking during the transient as a result of rapid transients in
the system. If sonic choking occurs at
the assigned flow junction a different
solution method must be enacted. See
Transient Sonic Choking for more
information.

Related Topics
Nomenclature
Method of Characteristics
Sonic Choking Detailed
Description

This junction is very similar to the Infinite Tank in that it fixes a pressure at a
boundary. However, the Assigned
Pressure allows the definition of either
a static or stagnation pressure boundary, whereas tanks are always stagnation pressure. Typically, any
pressure gauge on a pipe will be
reporting static pressure - it is important to select static pressure if this is
the actual boundary in the real system. A Tank would be inappropriate to
represent such a piping connection
with non-zero flow.
If stagnation is selected, the Assigned
Pressure accepts the connection of up
to twenty-five pipes. Static selection
limits the connection to one pipe.

Transient Data
391
411
422

Assigned Pressure
The Assigned Pressure junction
allows for the specification of a fixed
boundary pressure. The Assigned
Pressure window follows the second
of the two basic Properties window
formats. A table on the Loss Coefficients tab displays the connecting
pipe information, and allows loss

On the transient data tab a flowrate
transient can be entered. A special feature is the ability to model a sinusoidal
flowrate transient. Input for the amplitude and frequency is required. If
data is present in the transient data
table, the sinusoidal transient is
summed with the data in the transient
data table.
A chopped sine wave takes the absolute value of the sine function. The end
effect looks like doubling the frequency in the positive domain only,
and having nothing in the negative
domain.

Index 210
For more information on transient
data, including event transients, see
Junction Transient Data.

The density can then be determined
directly from the equation of state as a
function of pressure and temperature.

Related Topics

Conversely, if the static pressure is
known at the downstream end, the
positive compatibility equation is used.

Role of Pressure Junctions Detailed Discussion (Long) 453
Role of Pressure Junctions
and How They Work
58
Tank
241
Common Junction Input
Parameters
185
Junction Transient Data
198

The density can then be found using
the particle path compatibility
equation.

Related Online Content
l

Static vs. Stagnation Pressure
Video

Assigned Pressure Transient Theory
With an assigned pressure, the pressure is known at the pipe endpoint.
The unknowns are therefore the velocity, which can be obtained by solving
the appropriate compatibility equation,
and the density.
If the static pressure is known at the
upstream end of the pipe, the negative
compatibility equation is used.

If the known pressure changes with
time, then a current pressure is
obtained for the current time step and
used in the equations.
If the known pressure is a stagnation
pressure instead of the static pressure, additional complexities are introduced as the velocity must be known
to convert the given stagnation pressure to a static pressure. Therefore,
iterations must be performed using the
corresponding compatibility equations
as shown above combined with the
stagnation property relationships.

Sonic Choking Transient Theory
An outlet assigned pressure junction
can experience endpoint choking

211

Quick Start Guide

during the steady state, or can
become choked during the transient
due to transient events in the system.
An inlet assigned pressure junction
cannot be choked in the steady state,
but may experience choking during
the transient as a result of rapid transients in the system. If sonic choking
occurs at the assigned pressure junction a different solution method must
be enacted. See Transient Sonic
Choking for more information.

For bends that are not at a 90-degree
angle, you can enter the angle and the
standard loss factor will be calculated.

Related Topics
Nomenclature
Method of Characteristics
Sonic Choking Detailed
Description

window shows a schematic of the
selected geometry. Until you have
input the information for the upstream
pipe that allows flow area determination, the standard Bend junction
loss factor is not calculated. For
smooth radius bends, you also need
to specify r/D, which is the radius of
curvature over the pipe diameter. At
r/D less than one the Reynolds number must be known to calculate the
loss factor, and therefore cannot be
displayed until output is available.
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Bend
The Bend junction type must always
have two connecting pipes. This junction type allows you to model the irrecoverable loss that occurs when the
flow direction changes through a bend
or elbow.
The Bend Properties window follows
the first of the two basic Properties
Window formats, displaying the connecting pipes in a fixed format. A flow
direction through the junction is adopted from the defined directions of the
two connecting pipes.
The Bend Properties Window offers
three standard types of bend losses:
the Smooth Bend, the Standard Elbow
(the standard short radius threaded
elbow), and the Mitre Bend. The

If the standard loss factors provided
are inadequate for your application,
you may specify a custom loss factor
referenced to the upstream pipe flow
area.
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Note: In principle, the upstream
and downstream pipe diameters should be the same.
However, the Bend junction
only uses the reference area
specified under Basis Area
for Loss Model, even if the
physical flow is in the opposite direction. If you are working with a user-specified loss,
your geometry may have different diameter pipes connecting to the elbow. In this
case, you would purposely
define different upstream and
downstream pipe areas.
However, you would still want
to be careful that the custom
loss factor you assign is referenced to the correct area
that is specified in Basis Area
for Loss Model.

CdA for Sonic Choking
As the fluid goes around the bend, it
can separate from the wall. This results in a reduced physical flow area.
When assessing sonic choking, it is
this reduced area that is important.
The optional CdA input parameter is
intended to represent this reduced
flow area. The minimum possible flow
area is entered as the CdA and if sonic
conditions are reached AFT xStream
will solve the system on a choked flow
basis.

Bend Loss Model
90 degree bends
The three Bend loss correlations are
all for turbulent Reynolds numbers
(Crane 1988, A-29).
The K-factors for a smooth flanged
bend with r/D ≥ 1 are provided in
Table 1.

Table 1: K-factors for 90 degree smooth
flanged bends
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The standard threaded elbow is
given by:

The two non-90 degree bend loss correlations are for turbulent Reynolds
numbers (Crane 1988, A-29).
A smooth flanged bend with r/D ≥ 1
is given by:

where fT is the turbulent friction factor
given in Table 2.

Table 2: Pipe friction factors used for
Crane formulas

where n is the number of 90 degree
bends, K is the loss factor for one 90
degree bend (Table 1), and fT is given
by Table 2.
The Mitre bend is given by Table 3.

Table 3: K values for Mitre bends

The Mitre bend is given by:

Non-90 degree bends
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Smooth Flanged Bends, r/D <
1
The smooth, flanged bend with r/D < 1
loss factor uses a correlation applicable for turbulent Reynolds numbers
(Miller 1990, 209)
The loss coefficient is calculated
based on Miller's class 2 bend model,
which is sufficient for general design
purposes, and is given by

Branch
The Branch junction allows up to
twenty-five connecting pipes. The
Branch junction is the most flexible
junction type for building network models that have flow splits. The Branch
junction must have at least two connecting pipes.
The Branch Properties window follows
the second of the two basic Properties
window formats.
This junction will always be treated as
lossless.

C0 and Cf are assumed to be 1 for
class 2 bends. Kb* is given by the nomograph on page 207 of Miller.

Related Topics
Common Junction Input
Parameters

185

For r/D > 0.7 or Kb* < 0.4, CRe is given
by Miller Figure 9.3. Otherwise, CRe is
given by the equation below.

Branch Transient Theory

where the CRe for r/D = 1 is also found
from Miller Figure 9.3.

At a branch, there can be multiple
pipes. Two additional relationships are
needed, the conservation of mass and
conservation of energy. The total
mass flow in and out of the junction
must sum to zero. The branch junction
is treated as adiabatic, so the energy
must sum to zero as well.

Related Topics
References

435

A constant stagnation pressure Po is
asserted at the branch since the
branch is treated as lossless, meaning
there is no stagnation pressure loss.
By asserting a constant stagnation
pressure the branch can essentially
be treated as an assigned pressure
boundary, though the "known" stagnation pressure must be iterated on.

215

Quick Start Guide

Using the stagnation pressure solution
the flow rate and density can be
solved for with the appropriate compatibility equations as is done for the
Assigned Pressure Junction.
The total mass flow in can then be calculated

conservation of mass is not inherently
included. Mass conservation is
instead achieved using iteration.
The total mass outflow can be written
similar to the mass inflow summation
above. The total mass outflow can
then be calculated similar to the mass
inflow using the compatibility equations, known stagnation pressure solution and known stagnation enthalpy.

and the total energy flow is found
using
An iterative method for stagnation
pressure is used to drive the mass
inflow and outflow difference to zero.

Using the above equations and enforcing energy conservation, the stagnation enthalpy can be found as
follows

Sonic Choking Transient Theory

While the conservation of energy is
inherently enforced in the solution
using the above equation,

Expansion choking can occur at a
branch if the total cross-sectional area
of the inflow pipes is less than the total
cross-sectional area of the outflow
pipes. If sonic choking occurs at the
branch junction a different solution
method must be enacted. See Tran-
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sient Sonic Choking for more information.

AFT xStream allows you to model the
check valve by entering a User Specified closing velocity.

Related Topics
Nomenclature
Method of Characteristics
Sonic Choking Detailed
Description
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Check Valve
The Check Valve junction type
requires two connecting pipes. This
junction type allows you to model the
effect of a check valve which closes to
prevent back flow.
The Check Valve Properties window
follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format.
The Check Valve junction does not
have an explicit flow direction, but
adopts a flow direction from the connecting pipes for calculating loss. The
user can define the base area for the
loss model, though the default is set to
use the upstream flow area.
A check valve is a device that allows
flow in only one direction. AFT
xStream assumes that the Check
Valve is initially open (unless modeled
as Closed on the Optional tab). If the
flow solution indicates that the velocity
at the check valve is insufficient to
keep the check valve open based
upon the check valve input, AFT
xStream closes the valve. The valve
can close during the steady-state or
transient portion of the simulation.

The Loss Model for the open valve
can be specified as a Cv, Kv or K
factor by choosing an option on the
Valve Model tab and entering the Full
Open value.
An optional input in the Check Valve
Properties window is the CdA. This
parameter describes the effective
area restriction in the valve for the purpose of calculating sonic choking. In
most cases, information on the CdA
must be obtained from the manufacturer or from test data. Note that
the CdA input field is disabled if Cv or
Kv loss is used, as the Xt value is used
for sonic choking calculations in that
case.

User Specified
The User Specified option opens and
closes based on user-defined values
for velocity to close and a delta pressure to reopen. For steady-state analysis the valve is either fully open, or
fully closed. In a transient analysis, the
valve opens and closes instantaneously.
The inputs are as follow:
l

Forward Velocity to Close
Valve - By default this value is
zero. Some valves are designed
to start closing at some reverse
velocity - you can specify that here
as a negative value. Entering a
positive value in this field would
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l

imply that the check valve closes
while the flow is still continuing forward.
Delta Pressure to Reopen - Frequently after a check valve closes,
there is pressure across the valve
at which it will open again. You
can specify that delta pressure
here.

Special Conditions
A check valve can have a Special
Condition of None, Closed (stays
closed or allowed to reopen in transient), or Open (stays open).

Related Topics
l

l
l
l
l

Parameters Common to All Junction Properties Windows
Junction Transient Data
K Factor Loss Model
Kv, Cv, and XT Loss Model
Inherent Event Logic

can be added to the Junction Library.

Common Input Information
Like all junctions, Compressor/Fan
junctions require a junction number,
junction name, and inlet and outlet
elevations. Similar to other junctions,
compressors can have Design Alerts
and Notes applied to them. They
require two connecting pipes. Note
that the direction of the connected
pipes define which side of the compressor/fan is suction and which is discharge.

Compressor Model
This tab requires the selection and
definition of what type of compressor/fan the junction represents.
There are two models currently available:
l

Centrifugal (Rotodynamic)Represents a typical centrifugal
compressor where the head
added to the fluid is related to
the flow through the compressor via a compressor
curve.

l

Positive Displacement - Represents a steady state approximation of a positive
displacement compressor. The
flow is fixed to a constant value,
and whatever head is necessary to obtain that flow will be
supplied.

Compressor/Fan
The Compressor/Fan junction allows
you to model the pressure added to a
system by a compressor, and model
many transient events involving compressors/fans. Because all compressors/fans are different, AFT
xStream does not provide any standard types. Pressure and flow data that
describes the device must be obtained
from the manufacturer or from test
data. To reduce repeated data entry,
frequently-used compressors/fans
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All of the transient options need to
know when to start with Initiation of
Transient and allow the definition of a
Transient Special Condition.

Optional
Figure 1: Compressor/Fan Models

Variable Speed
This tab allows the speed of the compressor to vary. These options are
only available for a centrifugal compressor.
l

Fixed Speed (%) - Directly
modify the compressor curve
according to the Affinity Laws.
The Compressor/Fan Curve
entered in Compressor/Fan
Configuration is always
assumed to be the 100% speed
curve.

Transient
The Compressor/Fan junction allows
for Speed vs Time transients. This
allows the user to directly specify how
the speed of the compressor/fan
changes over time. This can be used
to model startups, trips, or control transients.
For more information on transient
data, including event transients, see
Junction Transient Data.

There are several optional parameters
that can be defined for a compressor/fan. Some of these are available to most junctions such as Display
on Workspace, and Workspace Icon.
Also present are several compressor
junction specific options:
l

Special Condition
l

None - The compressor/fan operates normally.

l

Compressor Off No Flow
- The compressor/fan is
shut off and blocked. This
is identical to a closed
valve.

l

Compressor Off With
Flow Through - The compressor/fan is shut off but
allows flow to continue
through. This is identical to
a lossless connection.

Additionally, there is the option to
insert the efficiency data of the compressor/fan motor.

Related Topics
Common Junction Input

185
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Parameters
Junction Transient Data
Initiation of Transients

198
200

Related Blogs
Modeling Fans, Blowers and Compressors - Oh My!

Centrifugal Compressor
Centrifugal Compressor
Curve
A Compressor Curve is required to
model a centrifugal compressor. This
is the typical Head or Pressure vs.
Flow information that will be available
from any compressor manufacturer.
To enter these curves, click Enter
Curve Data. Once this data has been
defined, previews of the applied
curves can be seen here.
Note: AFT xStream does not have
a means to account for stall
or surge lines for the compressor. Therefore, it is possible that xStream will allow
the compressor to operate at
unrealistic conditions. It is
advised that the user check
the results to ensure that the
compressor did not reach the
surge or stall lines during the
run, design alerts can be useful to assist with this check.

Figure 1: Standard Compressor Curve

Added Pressure
If the compressor curve is entered
using pressure rise information as
opposed to a head rise, the pressure
rise will need to be specified as either
a stagnation or static pressure. This
specification is performed on the Compressor Model tab under the Centrifugal Compressor specification. Note
that mechanical energy rises are typically entered in xStream as pressure
rises instead of head rises because
the usefulness of the head term in variable-density systems is diminished.

Compression Process Thermodynamics
In xStream the compressor will always
be modeled as adiabatic and 100%
efficient. The compressor efficiency is
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treated as an isentropic efficiency, so
100% efficiency in this case means
the compressor operation is isentropic. If the compression process is
adiabatic, the temperature rise is
given by the following isentropic relationship:

Compressor/Fan Configuration
The compressor configuration window
is used to define the specific operation
of a centrifugal compressor. It is
opened with the Enter Curve Data button from the Compressor/Fan Properties Compressor Model tab when
Centrifugal Compressor is selected.

Note that these pressures and temperatures are static and not stagnation. Gamma is the isentropic
expansion coefficient or specific heat
ratio, depending on the Fluid Accuracy
Options.
Note: The Compressor Configuration window provides
the option to enter efficiency
option for the sole purpose of
maintaining input when models are imported from other
AFT products. The compressor efficiency data will
not be used for calculation
purposes.

Related Blogs
Modeling Fans, Blowers, and Compressors - Oh My!

Figure 1: Enter Curve Data

Configuration Method
By default, a compressor/fan curve is
defined using the Simple configuration. This means that the user
inputs only one compressor/fan curve
for the junction.
If the Configuration Method is
changed to Multiple, additional input
becomes available on the right of the
configuration window. This allows
defining different curves to represent
the behavior of the compressor/fan at
different speeds. See a detailed
description in Compressor/Fan Multiple Configuration. This feature is
especially useful when multiple curves
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for a given compressor/fan junction
must be evaluated as it prevents the
user from having to delete and enter
curve data.

A compressor/fan can have two
curves defined:
l

Flow vs. Head/Pressure/Compression RatioRequired. This is what is commonly referred to as the "compressor/fan curve" and defines
how much pressure the turbomachine can add to a fluid at
any given flowrate.

l

Flow vs. Efficiency/Power (Optional) Data entered in this
column allows for quick assessment of power used at the operating point and the proximity to
Best Efficiency Point (BEP).

Compressor Data
The first tab of the compressor configuration controls the compressor's
most basic behavior - the compressor
curves.

After entering the raw values into the
table, the data needs to be curve fit.
If Mass Flow, Pressure, or Power are
used in the curve definitions, Reference Density becomes an additional
required input.

Configuration Data
This tab controls some additional
behavior or input for a compressor
junction. Entering or changing values
on this tab is optional.

Figure 2: Compressor Data
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a certain flow.
l

End Of Curve Flow Rate
(optional) - This value is used
to create a warning in the output if it is exceeded. It does not
affect the solution - the model
will behave identically however
this value is defined.

l

Preferred Operating Region
(POR) - % of BEP values falling
outside of the defined range will
generate a warning in the
model output. This range can
be defined by the user.

l

Allowable Operating Region
(AOR) - Similarly, this flow
range creates a warning in the
output when the user specified
flow range is not adhered to.

Graphs

Figure 3: Configuration Data

l

Best Efficiency Point (BEP) The Best Efficiency Point
(BEP) by default is calculated
from the entered efficiency or
power curve. This is generally
the preferred option as it best
relates to the true meaning of
BEP. A User Specified value
can be entered if no efficiency
or power curve is available, or if
it is desired to force the BEP to

The following tabs display the curves
that have been fit to the given data. If
multiple curves are defined, the Composite Graph tab becomes available.
The other graph tabs show the individual curves, along with points representing the raw data. It is a good
idea to check that these graphs to confirm the curve fit is reasonable for any
potential operating region.
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Positive Displacement
Compressor
Positive Displacement compressors/blowers can be considered
to provide a fixed flow for steady state
analysis. The positive displacement
compressor/blower allows for a fixed
flow to be defined in a straightforward
manner.
To model a positive displacement compressor/blower, select the Positive Displacement option on the Compressor
Model tab of the Compressor/Fan
Properties window.

Parameter
l

Volumetric Flow Rate - Fix
the volumetric flow rate through
the compressor/blower.

l

Mass Flow Rate - Fix the
mass flow rate through the compressor/blower.

Figure 4: Composite Graph

Fixed Condition
l

Fixed Flowrate - The value
and unit of the fixed flow
amount.

l

Nominal Efficiency - A fixed
efficiency, useful to calculate
power requirements. The positive displacement compressor
thermodynamics will be treated
as adiabatic regardless of the
defined efficiency value.

Related Topics
Curve Fitting
Reference Density
Related Blogs
Modeling Fans, Blowers and Compressors - Oh My!

63
188
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Defining Multiple Configurations
When opening the compressor configuration, change the Configuration
Method from Simple to Multiple. When
doing so, an additional user input
panel appears on the right hand side
of the window.

Figure 1: Positive Displacement Compressor/Blower Model

Related Blogs
Modeling Fans, Blowers and Compressors - Oh My!

Multiple Configurations
A single compressor junction can contain information for multiple compressor configurations - impeller trims
and operating speeds. This is useful to
compare different variations of a compressor without needing to redefine a
new compressor junction for every
case. The configuration of the compressor can easily be changed without
losing any information.

Figure 1: Multiple Configuration Method
Selected

In order to make use of the multiple
configuration feature, an RPM and
Impeller Diameter under Configuration
Information should be filled in. A
Description can optionally be added.
After modifying any information that
affects the definition of this
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configuration the Update Configuration box turns yellow:

Figure 3: Current Compressor Configurations
Figure 2: Update Configuration

Clicking Update Configuration Now
adds the Configuration to the Compressor Configurations listed in the
top-right.

To create an additional configuration,
click Create.
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Figure 4: Creating a new Configuration

Figure 5: Editing a Configuration

The compressor curves must be created and curve fit, as with a single configuration compressor. After
completing this and clicking Update
Configuration Now, the new configuration will be created and shown in
the Compressor Configurations area.
Configurations can be edited by selecting them in this area

Now that multiple configurations are
available, they can be selected on the
Compressor Model tab:

Figure 6: Selection of a Configuration

Affinity Laws
Compared to compressors, it is more
common for fans or blowers to operate
with variable speeds (adjustable in the
Variable Speed tab in the
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Compressor/Fan Properties window).
Affinity laws (also called homologous
laws) allow an estimation of the compressor/fan performance at speeds
other than the design speed.
Before discussing the affinity laws, it
should be noted that the affinity laws
are an approximation. In many cases,
compressor/fan manufacturers will
have performance data for a number
of speeds. These data should be used
if available. When not available, the
affinity laws can be used with an understanding that an approximation is
being made. The affinity laws are
known to have much lower accuracy
for compressors and blowers than for
fans.
Compressor/fan curves can generally
be curve fit to a polynomial:

The speed ratio is defined in terms of
the design impeller speed, N1 and the
desired operating speed N2 as:

Affinity Laws
For the following ratios, subscript 1
represents the parameter from the
defined curve (assumed to be at 100%
speed). Subscript 2 represents the

given parameter at the desired operating speed N2 .
l

Flow rate -

l

Compressor/fan head -

l

Power consumption -

l

Efficiency -

Application to Transients
During a transient event, the speed of
the compressor/fan may change. In
such cases, the affinity laws are used
to adjust the head/pressure curves
appropriately for the new speed. This
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is a process that often requires additional iteration.

Related Blogs
To Affinity and Beyond!

Transient - Speed vs.
Time
Certain configurations of a compressor allow the direct specification
of Speed vs. Time.

Transient Data
For Speed vs. Time, the variation of
speed must be directly defined in Transient Data. The speed of the compressor will be forced to meet this data
at each time step of the transient simulation, with the compressor curves
being adjusted every time step according to the affinity laws.

Figure 1: A Speed vs. Time transient

Related Topics
Initiation of Transients

200

Transient - Setpoint vs.
Time
When modeling a Positive Displacement Compressor with a steady
setpoint, it is possible to vary the setpoint over time. This replaces the
Speed vs. Time transient as defining
both the speed and the setpoint would
over constrain the system.
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Transient Data

characteristics at a location in the pipe
system.

For Setpoint vs. Time, the variation of
the setpoint must be directly defined in
Transient Data. The selected parameter will be forced to meet this data
at each time step of the transient simulation. The resulting speed variation
over time will be visible in the output.

The Control Valve Properties window
follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format.
The Control Valve junction does not
have an explicit flow direction, but
adopts a flow direction from the connecting pipes.

Control valve types

Figure 1: A Setpoint vs. Time transient

Related Topics
Initiation of Transients

Control Valve
Control Valve junctions are always
internal to the system, with two connecting pipes. This junction type
allows modeling of valves that offer
special pressure or flow control

xStream offers four types of control
valves: Pressure Reducing Valves
(PRVs), Pressure Sustaining Valves
(PSVs), Flow Control Valves (FCVs),
and Pressure Drop Control Valves
(PDCVs). Loss information for a control valve is not required, because control valves are dynamic devices that
change their geometry in response to
the pipe system behavior. The loss
that results is that required to maintain
the control parameter. A Loss When
Fully Open can be specified, and is
the loss that will occur should the
valve fail to a full open state.
l

200

A PRV is a device that controls
the pressure in a pipe system.
The PRV maintains a constant
control pressure downstream
of the junction as long as the
upstream pressure exceeds
the control pressure. If the
upstream pressure is lower
than the control pressure, the
ability to control pressure is
lost.

Index 230
l

l

l

A PSV is similar to a PRV in
that it controls pressure in a
pipe system. While the PRV
maintains a constant downstream pressure, the PSV maintains a constant upstream
pressure. If the downstream
pressure rises higher than the
control pressure, the ability to
control pressure is lost.
An FCV is a device that maintains a constant flow rate in a
pipe system. By setting the junction to an FCV type and entering a flow rate, the junction will
limit the flow through the connecting pipes to be equal to the
control flow rate. The FCV can
lose its ability to control flow
when the pressure drop across
it becomes zero or backward
flow begins.
A PDCV is a device that maintains a constant (stagnation)
pressure drop. For this option,
the valve is forced to always
meet its setpoint. An indicator
that an unrealistic pressure
drop has been demanded is a
failure to obtain a converged
solution.

PRV/PSV Static vs Stagnation Pressure
The control pressure for a PRV or
PSV can be either static or stagnation
. The default selection is static, as this
is the most frequent application in
industry.

Loss When Fully Open
By default, the valve will be set to
model the valve with no loss if it fails
open. This can be changed by choosing a loss model on the Control Valve
Model tab to use Cv, Kv, or a K factor.
When Cv, or Kv, is selected, the
option becomes available to pull the
value from an open percentage table
on the Optional tab.

Open Percentage Table
The Optional tab allows data to be
entered for special control valve characteristics. Specifically, the valve Cv
and Flow Area can be Specified vs.
the Open Percentage of the valve.
This data does not affect AFT
xStream’s flow solution. However,
engineers frequently desire to know
the valve’s open percentage during
operation to ensure it meets design
requirements. The Valve Summary (in
the Output window) always displays
the valve Cv, and if data is specified
for open percentage and flow area it
will also display open percentage and
flow area at the operating point.
AFT xStream can assist in creating
this Cv vs Open percent curve. This is
accessible in the optional tab by selecting "Edit Table" and then "Create Cv
vs. Open Percent...". This then opens
a window in which a user defined, linear, equal percentage, or Pre-defined

231

Quick Start Guide

curve can be defined and transferred
to the Cv vs. Open Percentage table.

In a transient simulation, a control
valve can regain control if system conditions change such that the control
valve can again control to its setpoint.

Special Conditions
Control valves have two special conditions: Fully Open - No Control, or
Closed.

Action if Setpoint Not Achievable
It is possible to build a system where
the control valve cannot control the
system to the specified setpoint, either
in the steady-state or during the transient analysis.
When the control valve cannot meet
the specified setpoint in the steadystate system, its behavior will depend
on why it could not control the system.
If the valve was fully open and would
need to open further to meet the setpoint, the valve will open fully and lose
control. An example of this situation is
a FCV with a setpoint of 100 scfm. If
the valve sees 90 scfm at 99.9% open,
it cannot control to 100 scfm, will lose
control, and open fully. In the opposite
direction, if the valve was fully closed
and would need to close further to
meet the setpoint, the valve will close
fully and lose control. An example of
this situation is a PSV with a setpoint
of 3 atm. If the valve sees 2.5 atm at
0.1% open, it cannot control to 3 atm,
will lose control, and close fully.

Related Topics
Common Junction Input
Parameters
K Factor Loss Model
Cv/Kv and XT Loss Model
Junction Transient Data

185
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193
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Related Blogs
Get in Control with Control Valves

Control Valve Transient
Theory
We can use the methods for known
flow or pressure to calculate the conditions at a control valve. AFT
xStream flow and pressure control
valves allow the control setting to be
changed with time. Whether constant
or changing, the flow or pressure is
known and can be used to solve the
equations.

Flow Control Valves
With the known flowrate, one can substitute into the Compatibility Equations
and solve for the upstream and downstream pressures, respectively, at the
valve. The valve loss solution can then
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be compared against the user-specified loss range to determine if the
valve can control to the setpoint for
that time step.
Once the valve loses control, it acts
like a regular valve. However, it is possible for the control valve to later
regain control if the upstream pressure raises sufficiently.

and open fully, as there must be a control pressure loss by definition.

Related Topics
Nomenclature
Method of Characteristics

391
411

Dead End
Pressure Control Valves
Pressure control can be specified on
the upstream or downstream side of
the valve, or as a differential pressure
across the valve. All three control
types use identical approaches to find
a solution at each time step which satisfies the control setpoint.
An iterative approach is required to
find a solution that meets the controlled parameter. A flowrate through
the valve is guessed at, the positive
characteristic is used to determine the
upstream pressure, and the negative
characteristic used to determine the
downstream pressure. The upstream
or downstream pressure is compared
against the valve setpoint, and further
iterations are used to find a flow solution which meets the setpoint.
If the valve is fully open or fully closed
yet cannot meet the control setpoint,
the valve will lose control and behave
as a regular valve. It is possible for the
control valve to later regain control if
the upstream pressure raises sufficiently. Note that the Pressure Drop
Control Valve will never lose control

The Dead End junction must always
have one connecting pipe. This junction type is one way to define flow in a
pipe as truly zero.
In steady flow, dead ends have no
flow and thus play no role in the solution to the system. However, in transient flow pipes that terminate in dead
ends can have flow. Thus dead ended
lines can and do influence the transient response of the system. Unless
you know otherwise for a specific system, dead ends should always be
included in the model.
The Dead End Properties window follows the first of the two basic Properties window formats, displaying the
connecting pipes in a fixed format.
The only required information is the
connecting pipe and the elevation.

Related Topics
Common Junction Input
Parameters

185
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Dead End Transient Theory
A dead end is similar to an assigned
flow, except the flow rate is zero
(Wylie, et al., 1993, pp. 44). The
unknown is then the pressure, which
can be solved by calling the appropriate compatibility equation. If the
dead end is at the upstream end of the
pipe, the negative wave compatibility
equation is used with zero flow.

References

435

General Component
The General Component junction type
is internal to the system and requires
two connecting pipes. This junction
type allows you to model the irrecoverable loss that occurs through
equipment that may not be explicitly
represented on the Toolbox and to
specify loss factors as a function of a
flow parameter.
The General Component Properties
window follows the first of the two
basic Properties window formats, displaying the connecting pipes in a fixed
format. The flow direction through the
junction is determined by the defined
directions of the connecting pipes.

Conversely, if the dead end is at the
downstream end, the positive wave
compatibility equation is used with
zero flow.

The path characteristic becomes completely vertical, but is still represented
by the particle path compatibility equation, using the pressure from the
appropriate wave compatibility equation.

When you select Resistance Curve,
the General Component Properties
Window makes additional features
available. You can specify polynomial
constants, fit a curve to available data,
or use interpolated x-y data.
When a variable loss is specified, AFT
xStream modifies the loss factor in the
Solver to agree with the solution. You
can choose any of the optional flow
and pressure parameters provided,
and you can specify the most convenient units.
No transient data can be entered for a
General Component. From a transient
point of view, the junction is a static
element.

Related Topics
Nomenclature
Method of Characteristics

391
411

An optional input in the General Component Properties window is the CdA.
This parameter describes an effective
area restriction for the purpose of

Index 234
calculating sonic choking. In most
cases, information on the CdA must
be obtained from the manufacturer or
from test data.

system.
Note that similar to flow rate definition,
heat flow is positive when flowing into
the system, and negative when flowing out.

Related Topics
Curve Fitting
Common Junction Input
Parameters
K Factor Loss Model
Resistance Curve Loss
Model
Troubleshooting Resistance
Curves
Reference Density

63
185
191
196
497
188

Heat Exchanger
The Heat Exchanger junction type is
internal to the system and requires
two connecting pipes. This junction
models the irrecoverable loss that
occurs through heat exchanger equipment along with a known heat rate
added to or removed from the fluid.
The Heat Exchanger Properties window follows the first of the two basic
Properties window formats, displaying
the connecting pipes in a fixed format.
The flow direction through the junction
is determined by the defined directions of the connecting pipes.

Transient Data
On the Transient Data tab, a heat rate
transient can be entered. Note that if
there is a heat rate and flow through
the junction reaches zero (either
because flow is halted or because flow
reverses), the solution will fail as heat
can no longer flow out of the junction,
causing heat to accumulate infinitely.
For more information on transient
data, including event transients, see
Junction Transient Data.

Special Conditions
The Special Condition for a Heat
Exchanger junction functions differently than other junctions. Here you
can turn off the heat transfer for the
heat exchanger.

Related Examples
Gas Turbine Fuel System
Example

554

Heat Transfer
Related Topics
On the Thermal Data tab you can
define a fixed heat rate into the

Curve Fitting

63
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Common Junction Input
Parameters
K Factor Loss Model
Junction Transient Data
Reference Density

185
191
198
188

Orifice
The Orifice junction type requires two
connecting pipes, unless it is defined
as an exit orifice, in which case only
one connecting pipe is allowed. This
junction type models the irrecoverable
loss that occurs through a plate-type
flow restriction. It also allows the specification of loss factors as a function
of a flow parameter and an orifice loss
for pipes with an area change.
The Orifice Properties window follows
the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. The
Orifice junction does not have an explicit flow direction, but adopts a flow direction from the connecting pipes.
Orifices that are located at exit points
are specified as exit orifices. These orifices require an associated back pressure definition. Exit orifices can only
be connected to a single upstream
pipe. To specify an exit orifice, select
the Exit Orifice checkbox on the Loss
Model tab. Then specify the exit pressure and temperature.

Orifice Types
AFT xStream provides two standard
orifice types: Sharp-Edged and
Round-Edged. These loss factors are

calculated based on correlations. In
addition to the standard orifices that
AFT xStream provides, users can
enter custom orifice loss factors.
The constant loss characteristics of an
orifice can be specified as a discharge
coefficient (Cd) or as a loss factor (K).
The standard orifice geometries
include a functional dependence on
the upstream and downstream pipe
areas, which may be different.
An optional input in the Orifice Properties window is the CdA for Sonic
Choking. This parameter describes
the effective area restriction in the orifice for the purpose of calculating
sonic choking. In most cases, information on the CdA must be obtained
from handbook or test data.
Note: The CdA for sonic choking
may be different from the subsonic CdA loss model option
in xStream. The discharge
coefficient can vary at different pressure ratios due to
the vena contracta moving
closer to or farther from the
orifice restriction. For the
highest accuracy the CdA
used for subsonic and sonic
losses should be tested and
entered separately. See the
"Modeling Choked Flow
Through an Orifice" white
paper on AFT's website for
more information.

Related Topics
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Common Junction Input
Parameters
185
Discharge Coefficient Loss
Model
190
Subsonic vs. Sonic Pressure
Losses
427

When the upstream and downstream
pipe diameters are different for a
round-edged orifice as shown in Figure 2, the round-edged orifice equation for different pipe areas is used
and is given by the following (Idelchik
2007, 258)

Orifice Loss Model
Sharp-Edged Orifice
The orifice loss factors are all for turbulent Reynolds numbers. The sharpedged orifice shown in Figure 1, is
given by the following equation
(Idelchik 2007, 259):

where

Figure 2: Round-edged orifice with different upstream and downstream pipe
areas

Figure 1: Sharp-edged orifice (in this case
Aup = Adown)

Round-Edged Orifice with Different Upstream and Downstream Diameters

Round-Edged Orifice with
Identical Upstream and
Downstream Diameters
When the upstream and downstream
pipe diameters are the same for a
round-edged orifice as shown in
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Figure 3, the round-edged orifice
equation for the same pipe areas is
used and is given by the following
(Idelchik 2007,262)

K Factor Loss Model
References

191
435

Relief Valve
The Relief Valve junction allows users
to model a device that opens at a specified pressure in the system.

where

Figure 3: Round-edged orifice with the
same upstream and downstream pipe
areas

For other orifice configurations, see
Chapter 4 of Idelchik's Handbook of
Hydraulic Resistance (2007).

The Relief Valve Properties window
follows the first of the two basic Properties Window formats, displaying the
connected pipes in a fixed format. The
Relief Valve junction adopts a flow direction from the connecting pipes.
A Relief Valve junction in AFT
xStream will always behave as an Exit
Rupture Disk, with the relief valve located at the end of a pipe leg. Below
the Set Pressure, the valve is closed
and behaves as a Dead End. When
the Set Pressure is reached, the valve
will instantly open and remain open for
the rest of the MOC Transient simulation. If the valve is open during the
AFT Arrow Steady Solution, it will
remain open for the entire MOC Transient simulation.

Valve Setpoints
Other Loss Models
For information on the discharge coefficient loss model see the Discharge
Coefficient Loss Model topic. For
information on the orifice loss when
the flow is choked see the Sonic Choking description.

Related Topics

The valve setpoints determine when
the relief valve will open. These setpoints are defined using pressure.
There are two setpoints the user
needs to define:
l

Exit Pressure - the ambient
pressure downstream of the
relief valve when open.
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l

Set Pressure - the upstream
pressure at which the valve
opens.

Note: The Relief Valve junction
operates exclusively using
stagnation pressure. The Set
Pressure and Exit Pressure
are defined as stagnation
pressures and all calculations are based on stagnation pressure.

Loss Model
The Relief Valve loss information is
entered on the Loss Model tab. The
Basis Area for each Loss Model is by
default the upstream pipe.
The following loss model options are
available:
l

CdA (Constant) - the relief
valve instantly changes from
closed to a fixed CdA. This CdA
is defined as the product of an
Orifice Effective Area (A) and a
Discharge Coefficient (Cd).
l

l

The Orifice Effective
Area can come from an
API 526 letter designation or it can be
User Specified.
The Discharge Coefficient must always be
specified by the user.
The value is typically

specified by the manufacturer.
l

K Factor - the relief valve
instantly changes from closed
to a fixed K Factor.

Note: The CdA for sonic choking
may be different from the subsonic CdA loss model option
in xStream. The discharge
coefficient can vary at different pressure ratios due to
the vena contracta moving
closer to or farther from the
orifice restriction. For the
highest accuracy the CdA
used for subsonic and sonic
losses should be tested and
entered separately. See the
"Modeling Choked Flow
Through an Orifice" white
paper on AFT's website for
more information.

Special Conditions
The relief valve has two Special Conditions:
l

Failed Open - the valve is
forced to remain open regardless of pressure conditions.

l

Ignore Relief Valve - the valve
is forced to remain closed
regardless of pressure conditions.

For more information see Special
Conditions.

239

Quick Start Guide

Method of Characteristics
Related Topics
Common Junction Input
Parameters
185
Discharge Coefficient Loss
Model
190
Subsonic vs. Sonic Pressure
Losses
427
K Factor Loss Model
191
Junction Transient Data
198
Initiation of Transients
200
References
435

Relief Valve Transient
Theory
The Relief Valve junction in AFT
xStream allows users to model a rupture disk in the system, and behaves
similarly to a regular exit valve. When
closed, the relief valve behaves
identically to a closed exit valve or a
dead end. When open, the relief valve
relieves to the user-specified Exit Pressure.
When the Relief Valve junction is
defined using the CdA Subsonic Loss
Model, the losses across the junction
are determined as described in the Discharge Coefficient Loss Model topic.
When the Relief Valve junction is
defined using the K Factor Subsonic
Loss Model, the losses across the
junction are determined as described
on the K Factor Loss Model topic.

Related Topics

411

Screen
The Screen junction type requires two
connecting pipes. This junction type
allows you to model the irrecoverable
loss that occurs through a screen,
mesh, or filter flow restriction. It also
allows you to specify loss factors as a
function of a flow parameter.
The Screen Properties window follows
the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. The
Screen junction does not have an
explicit flow direction; it adopts a flow
direction from the connecting pipes.
AFT xStream provides four standard
screen types for your use: sharpedged perforated plate, round-edged
perforated plate, circular wire screen,
and silk thread screen. The loss
factors for these screens are taken
from handbook values. In addition to
the standard screens that AFT
xStream provides, you may enter your
own custom screen loss factor that is
consistent with the application.
When you select Resistance Curve,
the Screen Properties window makes
additional features available. Using
these new features you can input
Screen loss factors or pressure drops
that vary with flow. To enter these
factors, you can fit a curve to available
data, or use interpolated x-y data. You
can choose any of the optional flow
and pressure parameters provided;
you can also specify the most convenient units.
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When a variable loss is specified, AFT
xStream modifies the loss factor in the
Solver to agree with the solution. You
can choose any of the optional flow
and pressure parameters provided,
and you can specify the most convenient units.

The circular metal wire screen,
shown in Figure 1, is given by the following equation for screen area Reynolds numbers above 1000 (Idelchik
2007, 598):

CdA for Sonic Choking
An optional input in the Screen Properties window is the CdA. This parameter describes the effective area
restriction in the screen for the purpose of calculating sonic choking. In
most cases, information on the CdA
must be obtained from the vendor or
test data.
Figure 1: Circular metal wire screen

Related Topics
Common Junction Input
Parameters
185
Subsonic vs. Sonic Pressure
Losses
427

The silk thread screen, shown in Figure 2, is given by the following equation for screen area Reynolds
numbers above 500 (Idelchik 2007,
598):

Screen Loss Model
The screen loss factors have much in
common with orifice loss factors. In
fact, the sharp-edged perforated
plate and round-edged perforated
plate screen losses are the same as
for orifices with similar area ratios and
equal upstream and downstream
areas. Refer to the orifice loss factor
equations for these relationships. The
relationships are good for screen area
Reynolds numbers above 100,000.

For other screen configurations, see
Chapter 8 of Idelchik's Handbook of
Hydraulic Resistance (2007).
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atmosphere. The Infinite Tank
model is convenient for specifying a fixed pressure in your
system. This tank model
applies a defined pressure at
the junction location in the
model. When solving a pipe
flow system, an Infinite Tank
causes the rest of the system to
distribute the flow in a manner
consistent with the defined pressure.

Figure 2: Silk thread screen

Related Topics
References

l

435

Tank
The Tank junction type allows you to
connect up to twenty-five pipes. A minimum of one connecting pipe is
required.
The Tank Properties window follows
the second of the two basic Properties
window formats.

Tank Model
There are two possible Tank Models
available in the Tank junction, Infinite
Tank and Finite Tank.
l

Infinite Tank - Infinite tanks
refer to a massive volume of
gas whose pressure and temperature do not change appreciably as a result of gas inflow
or outflow during the time frame
of the simulation. An example
is a large room or the

Finite Tank - Finite tanks refer
to a body of fluid which is small
enough that its pressure and
temperature change significantly during the time frame
of the simulation as a result of
gas inflow or outflow. An
example is a tank which is pressurized by a compressor as the
simulation progresses. Finite
tanks require specification of
tank geometry. Typically, the
pressure and temperature are
defined initially, and then calculated over time based on the
tank geometry.

Both tank models will require the initial
stagnation pressure and stagnation
temperature/enthalpy to be defined.
If the Finite Tank option is chosen,
then the volume and thermodynamic
behavior of the tank become required
inputs as discussed below.
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fixed based on the user specified initial conditions in the
tank. The variation in all other
parameters will be calculated
throughout the transient.

Known Parameters Initially
For the Finite Open Tank option, the
options become active to specify
whether the pressure and temperature
are defined by the user for the steady
state.
l

l

Initial Conditions Known This option should always be
chosen for tanks at the inlet or
outlet of the system which are
acting as boundaries, Or for
tanks with a known operating
temperature and pressure in
the steady state.
Initial Conditions Calculated
From Steady State - This
option should be used for tanks
that are inline or at intermediate
points in the system at which
the pressure and temperature
are not known.

l

Known Heat and Volume vs.
Time - The heat rate and
volume are explicitly defined by
the user throughout the transient. The variation in all other
parameters will be calculated
throughout the transient.

Related Topics
Role of Pressure Junctions Detailed Discussion (Long) 453
Role of Pressure Junctions
and How They Work
58
Assigned Pressure
209
Common Junction Input
Parameters
185

Tank Transient Theory
Thermodynamic Process
The tank thermodynamics can be specified using one of three options:
l

l

Adiabatic - The static enthalpy
and volume in the tank will be
fixed based on the user specified initial conditions in the
tank. The variation in all other
parameters will be calculated
throughout the transient.
Isothermal - The temperature
and volume in the tank will be

An infinite tank is equivalent to an
Assigned Pressure junction defined
with a stagnation pressure. The solution for a finite tank is more complex,
and is discussed below.

Adiabatic Finite Tank
For a finite tank a fixed volume is
known, along with an initial stagnation
pressure and temperature/enthalpy.
The known values can be used to calculate initial values for the density,
enthalpy, and energy.
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rate will change for the future time
step t + 1.
(1)

Isothermal Finite Tank
(2)

(3)

The total mass and energy in the tank
is calculated at the current time step,
and the mass flow rate and energy
flow rate out of the tank is assumed to
be constant between the old and current time step. This assumption is reasonable when the time step is
reasonably small, and the parameters
in the tank are changing relatively
slowly. With the known tank mass and
the constant tank volume the density
can be calculated for the current time
step using Equation 2. The pressure
and temperature are related to the
total energy using Equations 1 and 3
as shown above. We can iterate on
the pressure and temperature to solve
these equations.. After each iteration
the new pressure and temperature are
used to recalculate the density, which
is checked against the density calculated previously from Equation 2 to
confirm when the iteration is complete.
Once the pressure and temperature
have been calculated for the current
time step, the new pressure and temperature can be used to calculate how
the mass flow rate and energy flow

The isothermal tank solution will proceed similar to the adiabatic finite tank
solution outlined above. However, in
this case the temperature is fixed as
well as the volume.
The mass at the current time step can
be calculated assuming the mass flow
rate from the previous time step
remained constant. The mass and
volume can then be used to calculate
the density at the current time step,
which can be used to iterate on the
enthalpy state equation which is represented by Equation 1 above.
Once the pressure has been calculated for the current time step, the
new pressure and temperature can be
used to calculate how the mass flow
rate and energy flow rate will change
for the future time step t + 1.

Known Heat and Volume vs
Time
The Known Heat and Volume vs. Time
option allows the user to specify the
tank volume over time plus an external
rate of heat added to (or removed
from) the tank. A similar process to the
Adiabatic Finite Tank solution is used,
where the external heat rate is used
along with the mass flow into and out
of the tank to determine the new
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pressure, temperature, and enthalpy
inside the tank. The known tank
volume is also coupled into the solution to iterate on tank mass and gas
density as the tank volume changes.

Sonic Choking Transient Theory
An outlet tank junction can experience
endpoint choking during the steady
state, or can become choked during
the transient due to transient events in
the system. If sonic choking occurs at
the tank junction a different solution
method must be enacted. See Transient Sonic Choking for more information.

Related Topics
Nomenclature
Method of Characteristics
Sonic Choking Detailed
Description

391
411
422

Tee/Wye
The Tee/Wye junction type requires
three connecting pipes.

Loss Factor
The Tee/Wye is modeled as a Branch
with no loss factors entered for the connecting pipes.

Related Topics
Common Junction Input
Parameters

185

Tee/Wye Transient Theory
The Tee/Wye junction is a static element, and its solution method is the
same as the Branch junction.

Related Topics
Method of Characteristics

411

Valve
The Valve junction type requires two
connecting pipes, unless you specify it
as an exit valve, in which case only
one connecting pipe is allowed. This
junction type allows you to model the
irrecoverable loss that occurs through
a flow control component. You also
have the ability to change the loss with
time to open or close the valve in full
or in part.
The Valve Properties window follows
the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. A flow
direction through the junction is adopted from the defined directions of the
connecting pipes.
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Loss Model
The valve loss model can be defined
using one of two different valve parameters: Cv or Kv.

then "Create Cv vs. Time from Open
Percent...". This option enables the Cv
vs. Open percent to be defined from
several options:
l

Transferred - If a table has
already been defined on the
Optional tab of the Valve Properties window, it can be copied
over

l

User Defined - Data can be
entered directly into the table,
or imported from existing data

l

Linear - A linear curve is generated based on the user
defined full open Cv and percent increment

l

Equal Percentage - Generated as an equal percentage
curve

l

Pre-Defined - Pre-defined
curves for several common
valve Cv vs. Open profiles can
be chosen and adjusted for a
defined full open Cv value
based on data from Val-Matic
2009.

The upstream pipe is selected by
default as the Base Area for Loss
Model.

Exit Valves
Valves that are used as exit flow control mechanisms are specified as exit
valves. These valves require an associated back pressure definition. Exit
valves can only be connected to a
single upstream pipe. To specify an
exit valve, check the Exit Valve check
box, located at the bottom of the Loss
Model tab. After this box is checked,
you will be required to input the exit
pressure and temperature.

Transient Data
On the transient data tab a transient
Cv, Kv, or open percent vs. time table
can be entered to simulate the opening or closing of the valve. For more
information on transient data, including event transients, see Junction
Transient Data.
AFT xStream can also create a Cv vs.
Time profile based off of the open percentage table. To access this in the
transient tab select "Edit Table" and

After the Cv vs. Open Percent is
defined a transient can be defined
based on duration, increment for the
curves data points, and whether the
valve is opening or closing. A linear Cv
vs. Time curve will then be generated
for the given data.

Open Percentage Table
The Loss Model tab allows data to be
entered for special valve
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characteristics. Specifically, the valve
Cv, Xt, and Flow Area can be Specified vs. the Open Percentage of the
valve. This data does not affect AFT
xStream’s flow solution. However,
engineers frequently desire to know
the valve’s open percentage during
operation to ensure it meets design
requirements. The Valve Summary (in
the Output window) always displays
the valve Cv, and if data is specified
for open percentage and flow area it
will also display open percentage and
flow area at the operating point.
AFT xStream can assist in creating
this Cv vs Open percent curve. This is
accessible in the optional by by selecting "Edit Table" and then "Create Cv
vs. Open Percent...". This then opens
a window in which a user defined, linear, equal percentage or pre-defined
curve can be defined as described in
the Transient Data section and transferred to the Cv vs. Open Percentage
table. If a Cv vs. Open Percent table
was already defined on the transient
tab in the window to create a Cv vs.
Time profile as described in the Transient Data section, then this curve will
be automatically transferred.

Special Conditions

191
193
198
435

Related Examples
Gas Turbine Fuel System
Example

554

Related Blogs
Making Sense of xT – Valve Loss in
Compressible Flow
That Valve’s Got Character – Applying
Pre-defined Characteristic Curves

Venturi
The Venturi junction type requires two
connecting pipes. This junction type
allows you to model the irrecoverable
loss that occurs through a venturi area
change, which is frequently used in
conjunction with pressure taps in flow
measurement devices. It also allows
you to specify loss factors as a function of a flow parameter.
The Venturi Properties window follows
the first of the two basic Properties window formats, displaying the connecting pipes in a fixed format. The
Venturi junction does not have an
explicit flow direction, but adopts a
flow direction from the connecting
pipes.

The Special Condition for a valve
always closes it.

Related Topics
Common Junction Input

Parameters
K Factor Loss Model
Cv/Kv and XT Loss Model
Junction Transient Data
References
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Loss Models
AFT xStream does not provide any
standard venturi loss models. Venturi
flow characteristics vary from vendor
to vendor, so it is difficult to find generally applicable models. You must
enter your own custom venturi loss
factor that is consistent with the application. This information should be
obtained from the manufacturer or
from test data.
For convenience, you can specify constant loss characteristics of a venturi
as a discharge coefficient (Cd) or as a
loss factor (K).
If you would like to model the pressure
loss through the Venturi as varying
with the flow rate, select the radio button next to Resistance Curve under
the Loss Model tab of the Venturi Properties window. Once Resistance
Curve is selected, additional features
appear that allow you to input pressure drops versus flow data. To enter
this data, you can specify polynomial
constants, fit a curve to available data,
or use interpolated x-y data.
When a variable loss is specified, AFT
xStream modifies the loss factor in the
Solver to agree with the solution. You
can choose any of the optional flow
and pressure parameters provided,
along with the most convenient units.

CdA for Sonic Choking

An optional input in the Venturi Properties window is the CdA for sonic
choking. This parameter describes the
effective area restriction in the venturi
for the purpose of calculating sonic
choking. In most cases, information on
the CdA must be obtained from test or
manufacturer data.
Note: The CdA for sonic choking
may be different from the subsonic CdA loss model option
in xStream. The discharge
coefficient can vary at different pressure ratios due to
the vena contracta moving
closer to or farther from the
orifice restriction. For the
highest accuracy the CdA
used for subsonic and sonic
losses should be tested and
entered separately. See the
"Modeling Choked Flow
Through an Orifice" white
paper on AFT's website for
more information.

Related Topics
Common Junction Input
Parameters
185
Subsonic vs. Sonic Pressure
Losses
427
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Interface and User
Options
This section focuses on the how the
items within the various menus and
tabs that comprise AFT xStream can
be used to customize the user's experience within the software. Topics discussed include the options present in
each of the drop-down menus, the
tools available in the 5 Primary Window tabs, and descriptions of the customizable parameters in the User
Options menu.

Contents
Menus and Toolbars
Print Preview
Primary Window Overview
Status Bar
Quick Access Panel

Graph Results Window

291

Visual Report Window

309

User Options Overview

314

Menus and Toolbars
Many of the actions required to set up
an AFT Impulse model can be completed from the various menus located
at the top of the window. Additionally,
these menus can provide helpful features such as saving, importing and
exporting files, and accessing various
help documents such as the product
help files and examples. These menus
include

248
260
261
262
262

Model Status Light

268

Solution Progress Window

268

Workspace Window

269

Model Data Window

276

Output Window

280

l

The File menu

l

The Edit menu

l

The View Menu

l

The Analysis menu

l

The Tools menu

l

The Library menu

l

The Arrange menu

l

The Window menu

l

The Help menu

This topic also gives a high level overview of Toolbars, including the Main
Toolbar as well as each Primary Windows toolbar.
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File Menu
l

New - Opens new model.

l

Open - Calls Open file common
dialog window so pre-existing
model can be selected for opening.

l

Save - Saves input model to
disk using current model file
name.

l

Save As - Opens Save As common dialog so you can specify
a file name to save model to
disk.

l

l

l

l

Save Graph As - (Graph Results Only) - Opens Save Graph
As common dialog so user can
specify a file name to save
graph as a graphics image file
to disk.
Save Graph Data As - (Graph
Results Only) - Opens Save
Graph Data As common dialog
so user can specify a file name
to save graph x-y data to text
file on disk.
Import Graph Data - (Graph
Results Only) - Allows for data
as .txt and .dat to be imported
for creating graphs
Export Model Data - (Model
Data Only) - Opens formatting
window and Save As dialog
where you can specify data
from the Model Data window to
be saved to a delimited file
appropriate for spreadsheet
use. Available in Model Data
window.

l

Export Output - (Output Only)
- Opens formatting window and
Save As dialog where you can
specify data from the Output
window to be saved to a delimited file appropriate for spreadsheet use.

l

Export Force File - (Output
Only) - Opens Export Force File
window for the selected file
type from those shown below.
l

CAESAR II Force File

l

TRIFLEX Force File

l

ROHR2 Force File

l

AutoPIPE Force File

l

Import Excel Change Data (Workspace and Model Data
Only) - Imports data from Excel
file which modifies certain input
data. See Importing Excel Data
for more info.

l

Excel Export Manager Opens the Excel Export Manager.

l

Merge - (Workspace Only) Opens a Merge dialog where
you can specify another model
file to merge into the current
model.

l

Print Preview - Opens Print
Preview which allows you to
specify special formatting for
printed graphics and text, as
well as preview printed content
before sending it to the printer.

l

Start Batch Run - The Start
Batch Run button on the File
Menu opens a Batch Run
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dialog where you can select a
different scenarios or models
and initiates a process whereby
xStream runs the multiple scenarios/models automatically.
This tool can also be used to
export output to Excel using the
settings already configured in
the Excel Export Manager.
l

l

Load Background Picture (Workspace Only) - Loads a
background picture into the
Workspace. Formats supported include bitmap, windows
metafile, enhanced metafile,
JPEG, GIF and RLE. Available
in Workspace window.
l

Piping Component
File (PCF) - Import a Piping Component File

l

Caesar Neutral File
(CII) - Import a Caesar
Neutral File

l

l

Undo - (Workspace Only) Undoes the previous workspace manipulation action.
xStream will keep track of a historical list of changes, and
users can revert the workspace
back to any of those previous
states.

l

Redo - (Workspace Only) Reverts the workspace following Undo actions. xStream
will keep track of undo actions,
and users can redo any
changes that have been
undone.

l

Cut - (Workspace Only) - Cuts
the selected pipes and junctions on the Workspace and
places them on the clipboard.

l

Copy - (Workspace, Model
Data, and Graph Results Only)
- Copies the selected window
contents to the clipboard.

l

Copy Graphics - (Workspace
and Visual Report Only) - Copies selected Workspace or
Visual Report content to the
Windows clipboard. Formats
supported include bitmap, windows metafile, and enhanced
metafile.

l

Copy X-Y Data - (Graph Results Only) - Copies numerical

EPA Net File (INP) Import an EPA Net File

Export Piping Layout To
l

l

GIS Shapefile (SHP) Allows for Importing GIS
Shapefile (geospatial
maps) as .shp file.

EPA Net File (INP) Export an EPA Net File

Exit - Exits AFT xStream.

Related Topics
Workspace Window

269

276
280
291
309

Edit Menu

Import Piping Layout From

l

l

Model Data Window
Output Window
Graph Results Window
Visual Report Window
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data from graph to the Windows clipboard. Available in the
Graph Results window.
l

Paste - (Workspace Only) Pastes clipboard pipes and
junction contents (from previous cut or copy operation)
into the Workspace model.
Paste preview mode allows the
pasted pipes and junctions to
be moved and specifically
placed where desired and will
indicate interference with other
junction by changing color. A
green box indicates that there
is no interference and a red box
indicates that the junctions will
be overlapping and are not in a
proper location. Available in the
Workspace window.

l

Delete - (Workspace Only) Deletes the selected pipes and
junctions on the Workspace.

l

Duplicate - (Workspace Only) Duplicates the selected pipes
and junctions on the Workspace.

l

Duplicate Special - (Workspace Only) - Opens Duplicate
Special dialog window where
you can specify the increment
by which all pipes and junction
numbers will be increased
when the model is duplicated,
the creation of a new group
from the duplicated objects,
and whether to hide the duplicated objects in the output.

l

Select All - (Workspace Only) Selects all pipes and junctions

on the Workspace.
l

Select Last Selection - (Workspace Only) - The most recent
pipes and/or junctions selected
may be reselected by selecting
Select Last Selection from the
Edit menu.

l

Select Special - (Workspace
Only) - Opens Select Special
window where group of pipes
and junctions can be built up.

l

Select Flow Path - (Workspace Only) - Selects the
sequence of pipes and/or junctions in the flow path connected
to the selected pipe(s) on the
Workspace.

l

Select Shortest Path - (Workspace Only) - The shortest flow
path between two junctions can
be found and selected by
xStream. To enable this option,
two junctions must be selected
in the Workspace which
xStream will find a path
between.

l

Customize Icon - (Workspace
Only) - Allows user to change
junction icon color, orientation,
and icon image

l

Special Conditions - (Workspace Only) - Sets or clears
Special Conditions for selected
pipes and junctions on the
Workspace.

l

Groups - (Workspace Only) Allows you to create and manage groups of pipes and junctions.
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l

l

Renumber - (Workspace Only)
- Allows renumbering pipes and
junctions on the Workspace
using one of the Renumbering
methods.
Join Selected Pipes/Jcts(Workspace Only) - A continuous series of connected
pipes and junctions can be combined into a single pipe object
to simplify the Workspace. See
Combining and Splitting Pipes.

l

Global Pipe Edit - (Workspace
and Model Data Only) - Opens
Global Pipe Edit window where
editing of multiple pipes can be
performed.

l

Global Junction Edit - (Workspace and Model Data Only) Opens Global Junction Edit window where editing of multiple
junctions can be performed.

l

Delete Annotation - (Visual
Report Only) - Deletes the
selected pipes and junctions on
the Visual Report.

l

Create Annotation - (Visual
Report Only) - Allows you to create an annotation on the Visual
Report window.

l

Transfer Results to Initial
Guesses - (Output Only) - Copies solution results into initial
guesses for pipes and junctions.

l

Make Selection Same As Parent - (Workspace Only) Replaces all input data for the
selected pipes/junctions with

data from the pipes/junctions in
the current scenario's parent.
l

Clear Initial Guesses - Clears
all initial guesses in pipes and
junctions.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window

269
276
280
291
309

Related Blogs
AFT Responds to 2020 Customer Survey Feedback

View Menu
l

Last View - (Workspace Only)
- Switches to the most recent
Workspace view. The view is
changed by scrolling, zooming
or using the Workspace Find.
The Last View in the View
Menu will take you back to the
previous view of the Workspace. You can toggle between
two views by continuously clicking Last View.

l

Select Objects - (Workspace
Only) - Changes cursor to selection tool to select junctions,
pipes, etc.
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l

Overview Map - (Workspace
Only) - Opens overview map in
the Quick Access Panel.

l

Workspace Pan - (Workspace
Only) - Changes cursor to pan
tool to move around workspace.

l

l

l

l

l

l

l

Show Magnifier - (Workspace
Only) - Turns on the Magnifier
Tool in the Workspace
Show Object Status - (Workspace Only) - Toggles Show
Object Status, which checks
status of all pipes and junctions
in model.
List Undefined Objects (Workspace Only) - Opens
Undefined Objects window
which displays undefined pipes
and junctions and their properties.
Extended Model Check - Performs and exhaustive check of
model consistency and completeness.

Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window

Analysis Menu
l

Analysis Setup - Opens the
Analysis Setup window.

l

Time Simulation - Allows
selection of the Simulation
Mode used to run the model.

l

Pulsation Frequency Analysis - (PFA Module Only) Allows pulsation analysis settings to be ignored or used in
the model.

l

Run Model - When the model
is complete, the Run Model
selection sends the model to
the Solver for solution.

Related Topics

Highlight in Pipe and Jct Windows - (Workspace Only) Toggles Highlight feature for
pipe and junction Properties
Windows.
Bookmarks - (Workspace
Only) - Allows creation and
management of bookmarks.
Find - (Workspace Only) Opens window to find specific
pipes and junctions.

Related Topics

269
276
280
291
309

Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window

269
276
280
291
309

Tools Menu
l

Scenario Manager - Opens
the Scenario Manager window.

l

Last Scenario - This allows
you to toggle between two scenarios by loading the most
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recently loaded scenario. To do
this, load one scenario using
the Scenario Manager or the
Quick Access Panel, then load
the other. Use the Last Scenario in the Tools Menu to then
toggle between the two scenarios by continuously clicking
Last Scenario.
l

l

l

l

Compare Scenarios - This
option quickly sets up a comparison between the current
scenario and a related scenario.
Scenario Comparison Tool This tool opens the Modify Comparison window, allowing users
to compare differences
between any two or more scenarios in a model.
Generate Disconnected
Scenario - (Output Only) Generates a scenario which is no
longer connected into the Scenario Manager hierarchy and
thus does not inherit changes
from parents.
Integration Query - Opens
Integration Query window,
allowing users to have xStream
perform a numerical integration
of results over specified time
frames.

l

Output Control - Opens the
Output Control Window.

l

Output Print Content - (Output Only) - Configures print content for Output Window.

l

Output Language - Selects
language for display of output
results.

l

Model Data Control - (Model
Data Only) - Opens Model Data
Control Window.

l

Model Data Print Content (Model Data Only) - Configures
print content for the Model Data
Window.

l

Select Graph Parameters (Graph Results Only) - Opens
window to allow user to select
which parameters to graph.

l

Quick Graph Formatting (Graph Results Only) - Opens
window to allow user to change
quick graph title and axis
names, fonts, and scale values.

l

Visual Report Control (Visual Report Only) - Opens
Visual Report Control Window.

l

Design Alerts - Opens the
Design Alerts window.

l

Multi Condition Events Opens the Multi Condition
Events Window, which allows
users to make transients based
on more than one parameter in
the model.

l

Annotation Manager - (Workspace and Visual Report Only)
- The Annotation Manager,
available on the Tools menu,
allows you to specify whether
an annotation will be shown or
hidden, and in which scenarios
it should appear.
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Graph Results Window
Visual Report Window

l

Fluid Property Viewers Gives options to open either
the SteamCalc Viewer or
Chempak Viewer.

l

Activate Modules - Opens
Modules panel where optional
modules can be activated or
deactivated.

l

l

l

l

eLicense Information - Visible
if AFT xStream was opened
using an eLicense - shows general information about the eLicense.

291
309

Related Blogs
Get the Most Out of AFT's Fluid Property Viewers

Library Menu
l

Add Junction to Library (Workspace Only) - Prompts
you to enter the name to be
used in the Junction Library for
the currently selected junction.
After naming, adds junction to
the library.

l

Edit Junctions - Opens Edit
Junctions window where you
can delete or rename entries in
the Junction Library.

l

Model Diagnostics - Opens
the Model Diagnostics Window,
which allows users to check
various settings that may have
been changed during the
model-building process and
that may effect the model results

Edit Fluids- Opens Edit Fluids
window where you can add,
delete, modify or review custom fluids.

l

Edit Pipe Materials - Opens
Edit Pipe Materials window
where you can add, delete,
modify or review custom pipe
materials.

User Options - Opens User
Options window.

l

Edit Insulations - Opens Edit
Insulations window where you
can add, delete, modify or
review custom insulation materials.

l

Edit Fittings & Losses Opens Edit Fittings & Losses
window where you can add,

Keep Network eLicense
Checked Out - If a network eLicense is used, it can be kept
Checked Out to this machine.
This will prevent it from being
lost when going offline, and prevent it from being accessible by
other users. The license will be
good for the Checkout Period generally one week.

Related Topics
Workspace Window
Model Data Window
Output Window
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delete, modify or review custom pipe fittings and losses.
l

Library Manager - Opens the
Library Manager window.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
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Arrange Menu
l

Primary Windows - Allows
you to configure the Primary
windows in two panes in a horizontal or vertical orientation.
The primary windows can be
further rearranged by dragging
the tabs into the center of the
screen and adjusted by moving
the tab into the desired position
in the docking guide (see Figure 1).

Figure 1: The Docking Guide can be used
to view multiple primary window tabs at
the same time

l

Sort Table By - (Output Only) Allows user to order tables in
order of any variable and in
ascending or descending
order. Available in the Output
window.

l

Rotate Icon Right or Left (Workspace Only) - Rotates
icons for all selected junctions
on the Workspace. Available in
the Workspace window.

l

Rotate Selection Right or
Left - (Workspace Only) Rotates selected pipes and
junctions as a group. Available
in the Workspace window.

l

Align - (Workspace Only) Aligns selected pipes and/or
junctions on the Workspace.
You can choose to align pipes
and junctions, just pipes, or just
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junctions horizontally or vertically on the workspace. Available in Workspace window.
l

Pipe Drawing Mode - (Workspace Only) - Select the type of
grid layout that the model will
use.
l

2D Freeform - Junctions can be placed anywhere on the
Workspace.

l

2D Orthogonal Toggles orthogonal
drawing capability on
the Workspace. This
toggle is a shortcut to
enabling the feature in
User Options window.
See Orthogonal Drawing Overview for more
information.

l

l

l

l

(Workspace Only) - Makes all
selected pipes and pipes connected to selected junctions on
the Workspace orthogonal.
Available in the Workspace window.
l

Flip Vertex - (Workspace
Only) - Available when orthogonal drawing is enabled. This
will flip the vertex of all selected
pipes on the Workspace. Available in the Workspace window.

l

Scale/Flip Workspace (Workspace Only) - Scales
(shrinks or expands) or flips
either selected or all pipes and
junctions on the Workspace.
Available in the Workspace window.

l

Set Pipe and Junction Locations to Parent - (Workspace
Only) - Sets locations of pipe
and junction labels to the same
position as the parent scenario.
Available in the Workspace window.

l

Reset Label Locations (Workspace Only) - Sets locations of pipe and junction
labels to their default locations.
Available in the Workspace window.

l

Disable Pipes Snapping to
Isometric Grid - (Workspace
Only) - Toggles Snap to Grid
feature on the Workspace for
the selected pipe. When Snap
to Grid is disabled for that pipe,
the pipe end point no longer
snaps to grid points and pipe

Isometric - Uses an isometric grid.

Snap to Grid - (Workspace
Only) - Toggles Snap to Grid
feature on the Workspace.
When ON, all Workspace
pipes, junctions and annotations snap to an grid specified
in User Options window. Available in the Workspace window.
Show Grid - (Workspace Only)
- Toggles Show Grid feature on
the Workspace. Shows or
hides grid that is specified in
User Options window. Available in the Workspace window.
Make Selected Pipes and
Jcts Orthogonal -
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segments do not follow the
Isometric lines. Available in the
Workspace window.
l

l

l

Pipe Segments - (Workspace
Only) - Allows user to Add Segment (split single into two
pipes), Add Segment at Right
Angle, Add Multiple Segments,
Remove Segment, or Remove
all Segments. Available in the
Workspace window.
Lock Object - (Workspace
Only) - Locks selected pipes
and junctions on the Workspace so they cannot be
moved. A lock symbol appears
next to locked pipes or junctions when an attempt is made
to move the pipe or junction.
Available in the Workspace window.
Reverse Direction - (Workspace Only) - Reverses the reference positive flow direction of
all selected pipes on the Workspace. Available in the Workspace window.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
Related Blogs
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AFT Responds to 2020 Customer Survey Feedback

Window Menu
l

Workspace - Makes the Workspace window active.

l

Model Data - Makes the Model
Data window active.

l

Output - Makes the Output window active.

l

Graph Results - Makes the
Graph Results window active.

l

Visual Report - Makes the
Visual Report window active.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
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Help Menu
l

Open Help - Opens help site
home page

l

Use Offline Help - Indicates
that the PDF help file will be
used instead of the Online AFT
Help File when the help buttons
in topics are clicked. Note that
the PDF help file must be downloaded from the PDF Downloads page on the online help
site prior to using this option.
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l

Quick Start Guide - Opens
quick start guide pdf in English
or metric units

l

Keyboard Shortcuts - Opens
keyboard shortcut help page in
local help system

l

Show Examples - Opens to
example section of help file

l

Video Tutorials - Opens video
tutorials on aft.com in English
or metric units and English or
Spanish language

l

Technical Seminars - Opens
information on training courses
on aft.com

l

Flow Expert Package Opens information on aft.com
for individualized help from
AFT engineers for training,
modeling, consulting, and more

l

Online Learning Center Opens learning center on AFT
website with links to resources
such as blogs, video tutorials,
webinars, etc.

l

AFT Home Page - Opens
home page on aft.com

l

AFT Blog - Opens blog home
page on aft.com

l

Send Email to Support Links to AFT support in your
default email program

l

Latest Release - Opens page
on aft.com to download the
newest AFT xStream release

l

AFT Notifications - Opens
page on aft.com where you can
sign up for email notifications

for new software updates and
releases
l

About AFT xStream - Opens
window in AFT xStream with
information on current AFT
xStream version, license number, etc.

Related Topics
Workspace Window
Model Data Window
Output Window
Graph Results Window
Visual Report Window
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Toolbars
The Toolbars offer quick access to the
features used most frequently in AFT
xStream. The figures below show the
Toolbars. There are actually six toolbars in all. One is the Common Toolbar, and it is always shown. Its
features are common to all five
Primary windows. In addition, there is
one Toolbar for each Primary window,
offering features appropriate for work
in that window. You only see two Toolbars at a time in AFT xStream. The
function of each icon in a given Toolbar appears when you pass the
mouse over the icon button without
clicking on the button. Each of the functions on the Toolbar is also available
through the menu system.

Figure 1: Common Toolbar
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eral zoom states. Individual pages can
be printed.
Figure 2: Workspace Toolbar

Figure 3: Model Data Toolbar

Figure 4: Output Toolbar

Figure 5: Graph Results Toolbar

Figure 6: Visual Report Toolbar

Print Preview
The Print Preview window allows you
to access special print features such
as Print Preview and Fit to One Page.
It is accessed from the File menu or
using the shortcut CTRL + P.
The Print Preview window also offers
you a preview of the print content and
format for all Primary Windows. By
clicking the Print Preview button you
can review your printed material at sev-

The Fit to Page(s) feature causes the
graphic image generated from the
Workspace or Visual Report windows
to be compressed onto the specified
number of pages. This is a convenient
feature for creating reports of your
model. AFT xStream supports
whatever printer page sizes are supported by your printer, so use of legal
paper or larger may allow you to get
more visible details. The graphics can
also be centered vertically and/or horizontally. You also can fit your content
onto multiple pages.
The Page Setup option in the Print Preview window allows you to set the
page orientation, paper size/type, and
margins.
Additional special printing features
affect the Workspace and Visual
Report. The Selected on Workspace
option works with Workspace printing
by selectively printing the pipes and
junctions currently selected on the
Workspace.
By default, AFT xStream prints the
junction icons for the Workspace and
Visual Report with the same colors as
displayed on the screen. It also prints
the background color as the same
color as your Workspace or Visual
Report background. You can also specify that the junction icons be printed
in black and white (still with the color
background) or that the entire printout
be black and white.
If you added a background image from
the File menu, you can include this picture in the printout.
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Workspace window. The Model
Data window shows input data
in text form. This window works
hand-in-hand with the Workspace window to provide exceptional flexibility in manipulating
data.

Finally, if you have a grid displayed on
the Workspace or Visual Report, you
can include the grid in the printout.
Page options allow the use of a company logo, user comments, titles, and
different options for borders.
l

The Output window displays
the results of the analysis in
text form and lets you produce
attractive, effectively organized
printed output.

l

The Graph Results window
provides full-featured Windows
plotting capability. Here results
can be viewed in a variety of
ways for evaluating system transients or identifying important
trends. The Graph Results window also allows graph customization.

l

The Visual Report window
merges the output data with the
pipe system layout from the
Workspace to present a unique
perspective of the results. This
window also allows customized
layout of the information for documentation and presentation
purposes. An alternate use for
the Visual Report window is to
show textual input data combined with the input schematic.

Related Blogs
Quick Guide to Custom Output

Primary Window Overview
AFT xStream has five Primary Windows. The Primary Windows are
tabbed and can be pulled out of the
main window onto separate screens.
The Primary Windows are permanent
in that you work in one of these windows at all times. The Primary Windows work together to provide tools
for entering model input, analyzing results for accuracy, and preparing results for documentation.
Of the five primary windows, two are
input windows, two are output windows, and one displays both input and
output information. Figure 1 shows the
relationship between work-flow using
the primary windows.
l

The Workspace window allows
you to build the model visually
and see the model layout.

l

The Model Data window is the
text-based complement to the

You can change between the five
Primary Windows by selecting them
from the Window menu, the toolbar, or
by clicking the appropriate tab within
the AFT xStream window.
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Figure 1: Current scenario displayed in
the Status Bar

The Status Bar indicates the status of
certain operations - for example, when
opening a model the progress of loading the pipes, junctions, and scenarios
is displayed.
Figure 1: Primary window work-flow in
AFT xStream

Related Topics
Overview of AFT xStream 17
xStream Learning Resources 21
Overview of Fluid Transients 25
Philosophy of Computer
Modeling
57
Related Examples
Tank Blowdown Example
(English Units)
510

Status Bar
AFT xStream's Status Bar displays
contextual information about the current scenario or operation.

Figure 2: Status Bar displaying progress
when opening a model

Quick Access Panel
The Quick Access Panel as shown in
Figure 1, contains several useful
features. The Quick Access Panel
allows you to manage your scenarios
in a timely fashion, navigate significantly large models with the Workspace Overview Map, activate
modules, view a pipe or junctions
input properties and output results,
control what graph parameters are displayed, and manage Graphs using the
Graph List Manager.
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Figure 1: The Quick Access Panel

By clicking on the "Scenario" tab in Figure 2 below, you have the full scenario
customization ability using the Scenario Manager. You can create child
scenarios, expand or collapse various
families of scenarios, and utilize many
other Scenario Manager features here
as well.

Figure 2: The Scenario Manager
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When a model is significantly large in
size, it can be troublesome to have to
constantly drag the model around on
the Workspace to get to a specific
area of the model you want to view.
By clicking on the "Workspace Overview Map" button in the red box in Figure 3, you will bring up a map that is a
bird's eye view of the model. Drag the
small square in the Workspace Overview Map over various parts of the
model, then zoom in and out of the
model. You can also click the "Fit" button to see the full model zoomed out
on the Workspace, and use the mouse
wheel to zoom in and out.

Figure 3: The Workspace Overview Map

Clicking the Modules button in the bottom right of the Quick Access Panel in
Figure 4 allows you to activate or deactivate the PFA module in the Analysis
Setup window.
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Figure 4: Activating the Modules from the
Quick Access Panel

Figure 5: The Status Light and the Analysis Setup window

In the bottom far right of the Quick
Access Panel in Figure 5 is the Status
Light. Clicking on the Status Light will
display the Analysis Setup window.
When each item in the Analysis Setup
window is fully defined, it will have a
green check mark. When the model is
fully defined in the Workspace and all
necessary items in the Analysis Setup
window are completed, the Status
Light will turn from red to green.
Depending on the Analysis type and
module selection, additional items will
appear in the Analysis Setup window.

As seen in Figure 1, there is a "Properties" tab in the Quick Access Panel.
When pipes and junctions are drawn
on the Workspace, you can quickly
view the Pipe or Junction Properties
by first selecting a pipe or junction on
the Workspace, then clicking on "Properties" tab. This will display the Object
Property data as well as any Output
data if the model has been run. Figure
6 below shows an example of what the
Properties tab would look like when
clicking on pipe P1 on the Workspace
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after it has been defined and the
model was run.

Figure 6: Viewing the Pipe (or Junction)
Properties and Output Data from the
Quick Access Panel

Minimizing the Quick Access
Panel
By Default, AFT xStream opens with
the Quick Access Panel automatically
expanded. The Quick Access Panel
can be easily collapsed and pinned to
the side of the Workspace to allow for
a larger usage area of the Workspace.
Figure 7 shows the Quick Access
Panel initially expanded. By clicking
on the thumbtack pin button highlighted with the red box, the Quick
Access Panel will then become collapsed as shown in Figure 8. After the
Quick Access Panel is collapsed, it
can be temporarily expanded again

simply by hovering over the "Scenario"
sidebar with the mouse.
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Figure 7: The Workspace with the Quick
Access Panel Expanded
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Figure 8: The Workspace with the Quick
Access Panel collapsed

SSL Module
Settling Slurry Module
An optional add-on module to AFT
Impulse which allows users to simulate settling slurries.
PFA Module
Pulsation Frequency Analysis
Module
An optional add-on module to AFT
Impulse which allows users to
determine resonant frequencies in
their system.

Model Status Light
The light at the right of the Status Bar
located at the bottom of the AFT
xStream window, which indicates
whether or not the model can be sent
to the Solver.
Clicking on the Model Status Light will
show the Analysis Setup window
where the completion status of different panels can be seen.

Solution Progress Window
The Solution Progress window indicates the current state of the solution
iterations. During each of the three
stages of the solution process, the
Solution Progress window shows the
following information.
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l

Arrow Steady Solution - The
tolerance for the most out of tolerance junction or pipe is listed
for the appropriate tolerances.
General information about the
solution method and solution
control settings for the AFT
Arrow Steady Solution are also
shown. Note that both absolute
and relative criteria are always
displayed. These tolerances
can be helpful for selecting the
appropriate criteria on difficult
to converge models.

l

MOC Steady Solution - The
absolute and relative velocity
change across each block iteration is shown for the pipe with
the largest velocity change.
Information is also reported
about if the MOC Steady Solution criteria are met and about
any potential loss of mass or
energy in the MOC Steady Solution.

l

MOC Transient Solution - A
progress bar of the transient
simulation is shown.

Pausing the iterations allows the modification of certain AFT Arrow Steady
Solution parameters during the run, as
well as viewing the iteration history.
These options are available under
Other Actions, and are only applicable
to the AFT Arrow Steady solution.

Workspace Window
The Workspace window is the sole
area where you specify the model layout and connectivity. The Workspace
window has two separate functional
areas: the Toolbox on the far left and
the Workspace itself encompassing
the rest of the screen (see Figure 1).

The area in the bottom of the window
will give important feedback on the
model solution. It is important not to
dismiss messages in this area, as they
could have an impact on results. This
information will also be printed to the
General and Warnings sections of the
Output window as is applicable.
When the model solution is complete,
options to view Output, Graph
Results, and Visual Report become
available.

Figure 1: The Workspace window
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selected (highlighted) so that you can
move it into position (be careful not to
click off the selected portions or the
second model may be deselected).

Display and Printing
Features
The Workspace image can be:
l

Copied to the clipboard

l

Saved to a picture file

l

Saved directly to an Adobe
PDF file

l

Sent to the printer

Tip: To move a selected group of
objects, use a junction icon,
instead of a pipe, to drag the
group. This will avoid missing
the pipe and clicking on an
empty area of the Workspace
which will deselect your
group.

The Print Preview window allows the
above outputs to be applied to all or
selected Workspace objects.

Related Topics
Creating Pipes - the Pipe
Drawing Tool
Annotations
Optional Input
Workspace
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317

Merging Models
Two models can be merged together
using the command on the File menu.
Here’s how:
l

Open the first model

l

Choose Merge on the File
menu

l

From the file list, select the
model to be merged

If there are duplicate numbers, the
objects in the second model will be
changed. The second model will be

Merging Models with Multiple
Scenarios
If the model you are merging from has
multiple scenarios, only the base scenario can be merged. If you want to
merge one of the children of that
model, do the following:
1.

Open the model which you
want to merge.

2.

Open the Scenario Manager.

3.

Select the child scenario you
want to merge.

4.

On the Other Actions button (or
from the right-click menu),
choose the Save Scenario to
File Without Children.

5.

Enter a name and click OK.
This process creates a new
xStream model with the desired
scenario as the base scenario.

6.

Open the original model and
merge in the new model file created in Step 5.
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Renumbering Workspace Objects
Objects on the Workspace can be
renumbered by choosing Renumber
from the Edit menu. There are several
ways that Renumbering can proceed.

Renumber Wizard
The Renumber Wizard allows you to
renumber pipes and/or junctions by
simply clicking on them on the Workspace. Normal Workspace functions
are suspended when the Renumber
Wizard is active. The Renumber Wizard is activated on the Edit menu.
When the Renumber Wizard is active
the settings can be modified in the
Quick Access Panel. Click Done
Renumbering in the Quick Access
Panel to finish renumbering and exit
the wizard.

numbered selected pipe and will
attempt to march down the pipes in
the direction of flow. It is recommended that renumbering be performed after the model has been
completed so that the junctions and
pipes are completely connected.
Tip: If you want certain sections of
the model to be numbered in
sequence, then use the
Renumber feature on the
selected sections only. It is
also preferable in the case of
large or complicated models
to renumber small sections at
a time.

Renumber Increment
Renumber Increment is on the Edit
menu and allows you to increment or
decrement all selected pipes and junctions by a specified value.

Scale/Flip Workspace
Renumber Automatic
Selected pipes and/or junctions can
be renumbered starting at the lowest
selected number or at a specified number. If a pipe or junction which is not
selected to be renumbered already
has the next number in sequence, it
will only be changed if the Force
Sequential checkbox is checked.
xStream will start at the beginning of
the flow path containing the lowest

The Workspace can be scaled horizontally and/or vertically by choosing
Scale/Flip Workspace on the Arrange
menu. Scaling will move the junctions
and will stretch or shrink the pipes so
that the area the model covers is
changed by the percentage specified.
Flipping the Workspace horizontally
and/or vertically will move the pipes
and junctions to their mirror image locations. This is useful when you are
building a system which has

Index 272
symmetrical or mirrored sections. For
example, you could select the section,
duplicate it, and then flip it horizontally, vertically, or both with
Scale/Flip Selected Objects Only
checked.

Related Topics
Visual Report Window
Toolbars
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Annotations
Magnifier Tool
The Magnifier tool can be used to
provide a magnified view of any area
on the Workspace. This is useful for
navigating and viewing details of a
large model without needing to zoom
in on that area. The Magnifier tool can
be accessed from the Workspace Toolbar, as can be seen in Figure 1 below.
The magnifier tool can be enabled/disabled by clicking the button on the
Toolbar.
There are several options available to
adjust the Magnifier view:
l

Zoom Level - Adjusts the level
of magnification used

l

Magnifier Size - Adjusts the
size of the magnifier circle

The Toolbox tool to the right of the
Pipe Drawing Tool is the Annotation
Tool. With this tool, you can draw a
box that will contain an Annotation displayed on the Workspace.
The Annotation Tool allows you to create a text message, show an outline
around the message, insert pictures in
the message box, and draw lines with
pointers to certain areas of the model.
Different style, color and font options
are provided.
Annotations can be "attached" to the
Workspace, a pipe, or a junction.
When attached to the Workspace, the
annotation always remains in the
same location until you move it. When
attached to a pipe or junction, the
annotation will move when the pipe or
junction is moved. The Scenario
Options tab allows you to specify in
which scenarios the annotation
appears.
Annotations can be layered to be
either "Always in Front" or "Always in
Back".

Figure 1: Magnifier tool on the Toolbar

Annotations print out with the model.

The Magnifier tool can also be used in
the Visual Report window.

Annotations can be displayed or hidden among different scenarios using
the Annotation Manager from the
Tools Menu.
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you hold down the SHIFT key
down while drawing new pipes
on the Workspace the pipe vertex will flip. If you move an existing pipe and hold the shift key
while selecting a handle at one
of the pipe endpoints a new vertex will be inserted at that point
endpoint.

Extended Model Check
The connections and settings of each
pipe and junction are exhaustively
checked using the Extended Model
Check item on the View menu. This is
also helpful if the model seems to not
be connected correctly.
l

If you hold down the CTRL key
when completing the pipe drawing (just before releasing the
mouse button), the Pipe Drawing Tool remains active, and
you can draw a series of pipes
without returning to the Toolbox
each time.

l

To add pipe segments, use
CTRL+SHIFT+Y

l

To remove all pipe segments,
use CTRL+SHIFT+N

Keyboard Shortcuts for
Workspace
Selection Box
l

l

Select all objects completely
inside box by dragging cursor
from left to right
Select all object completely or
partially inside box by dragging
cursor from right to left

Pipe Drawing Tool
l

If you double-click the pipe
drawing tool, it will allow you to
draw multiple pipes at a time.
Clicking Esc or clicking the pipe
drawing tool again will deactivate the tool.

l

When orthogonal drawing is off
and you hold down the SHIFT
key while drawing pipes on the
Workspace, you can draw
pipes that are perfectly horizontal or vertical. When the
orthogonal drawing is on and

Junctions
l

If you double-click any junction
in the Toolbox, you will be able
to place multiple of that junction
on the Workspace by clicking
the Workspace where you
would like to place each junction. Clicking Esc or clicking the
junction icon in the Toolbox
again will deactivate the tool.

l

If you hold down CTRL key and
select a junction from the Toolbox and drop it onto an existing
Workspace junction, the old
junction will "morph" into the
new one. The junction type will
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change to the new junction
type, and data that can be kept
will be copied into the new junction.
l

If you hold down the CTRL key
then drag a junction on the
Workspace which has pipes
connected to it, the junction will
move but the pipes will not
move with it

l

If you hold down the SHIFT key
while selecting a junction from
the Toolbox and then drop the
junction onto an existing pipe,
the pipe will split into two pipes.
You will specify the length of
the first pipe and the second
pipe will be automatically set to
the remaining length from the
original pipe. Thus the sum of
the two pipe lengths will equal
the length of the original pipe.
You can also choose which
pipe contains any Fittings &
Losses that were specified
within the original pipe.

Figure 1: Split pipe keyboard shortcut

Pipe and junction Properties
window
l

When in a pipe or junction Properties Window you can toggle
the highlight feature by pressing the F2 function key. You
can also toggle this from the
View menu.

l

When in a Pipe Properties Window, if you press the F5 function key, you will jump to the
next highest numbered pipe. If
you press the CTRL key while
pressing the F5 function key,
you will jump to the next lowest
numbered pipe. The F5 function key also behaves this way
for junction Properties Windows.
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Pan and Zoom
l

The Workspace position can be
moved with CTRL + arrow
keys.

l

The Zoom level can be adjusted with CTRL + (+/-)

l

The Zoom level can be reset to
default with CTRL + 0

l

Mouses with scroll wheels can
be used to zoom by scrolling, or
to pan by clicking and holding
the scroll wheel

Switching Primary Windows
l

Go to the Workspace window
using CTRL + W

l

Go to the Model Data window
using CTRL + M

l

Go to the Output window using
CTRL + U

l

Go to the Graph Results window using CTRL + G

l

Go to the Visual Report window
using CTRL + I

Other
l

Many commands use common
windows shortcuts. Some of
the most common are listed
here:

l

Run the model: CTRL + R

l

Save the model: CTRL + S

l

Open a file: CTRL + O

l

Undo the last action: CTRL + Z

l

Cut: CTRL + X

l

Copy: CTRL + C

l

Paste: CTRL + V

l

Other available shortcuts can
be seen listed by their command on the menus

Related Topics
Add/Remove Pipe Segment
Combining and Splitting
Pipes
Creating Junctions
Defining Objects
Editing Objects
Morphing Junctions
Moving Objects
Creating Pipes - the Pipe
Drawing Tool
Workspace Pan
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Undefined Objects Window
This window is launched from the
Workspace toolbar or the View menu.
This window displays all undefined
pipes or junctions in the model. Clicking on the undefined object will display
the undefined properties in the list
below. All undefined data for all
objects can be saved to the file or
copied to the clipboard.
Any undefined object's Properties window can be launched by double-click-
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ing the object's name in the list to finish defining the object.

Duplicate Special
Duplicate Special allows the model to
be copy & pasted, while simultaneously applying other helpful settings as explained below.

Related Topics
Defining Objects

152
l

Increment All Pipe and Junction Numbers By - Adds the
specified number to all
pipe/junction numbers for the
created object duplicates. Useful for maintaining consistent
numbering

l

Create Group - Adds the
duplicates to a group.

l

Hide in Output - Automatically
hides the pipe and junction
duplicates in the Output window so only the original pipes
and junctions will be seen.

Raw Data Changes
When other objects in the model use
the same base raw data as the current
object and the data is changed, you
can decide whether to use the new
data on the other model objects.
This frequently happens when you
have multiple junctions based on the
same x-y data for compressor/fan
curves or junctions resistance curves,
and later change that x-y data. The
question is whether you want to have
the current junction you are working
on updated, or all junctions that use
that same base data.

Model Data Window
The Model Data window offers a textbased perspective on all engineering
information in the pipe flow model.
This window is immensely useful for
obtaining a global view of the model
and rapidly checking the input.

Figure 1: Raw Data Change Options

The Model Data window does not offer
any tools to build or add to a model; all
model assembly must happen in the
Workspace.
The Model Data window allows you to
manipulate existing elements from the
Workspace. Therefore, a complete
model can be assembled in the
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Workspace window without ever opening the Model Data window. In fact, for
small models this may be the preferred approach.
General, Pipe, and Junction section
display sizes can be changed by the
user by clicking and dragging the bars
between each section to re-size them.
Each section can also be hidden by
clicking the arrow in the upper left of
each section.
You can use the zoom feature in the
lower right hand corner of the Model
Data window to re-size the text displayed on screen.

Figure 1: The Model Data window displays input in text form

Editing Features
The Pipe table allows display of all
input data for all pipes in the model.
Details of Fittings & Losses are displayed in the Pipe Fittings & Losses
table, accessed with an adjacent tab.
The Pipe Fittings & Losses table displays all fittings with K factors grouped
into columns.
The other display tab in the pipe area
is the Pipe Detail Summary, which
assembles a list of details about each
pipe in another format useful to some
engineers.
The junction data area is below the
pipe data area. Here the junction data
is separated into tables for each junction type. Click the tabs to see the data
for any type of junction. All transient
data entered for the junctions can be
seen in the Transient Data tab on the
far right.
To edit information in the Model Data
window, you can open the Properties
Window for the pipe or junction. This
can be done by double-clicking anywhere in the row for the pipe or junction to be edited. Alternatively, you
can use the Global Edit windows
opened from the Edit menu.
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Display and Printing
Features
Model Data Control lets you specify
the combination of pipe, junction, and
general information you want to see in
the Model Data Window.
The Model Data Print Content window
lets you specify the content to include
in the printed Model Data report and
select the font to be used for printing.
This window is opened from the Tools
menu (or Toolbar).
The Model Data window contents can
be:
l

Copied to the clipboard

l

Saved to a formatted text file

l

Exported to Excel

l

Saved directly to an Adobe
PDF file

l

Sent to the printer

Related Blogs
Having model convergence problems? Start here!

Model Data Control Window
The Model Data Control allows you to
customize what data to show for the
pipes and for each junction type and
also which pipes and junctions to
show (see Figure 1). It can be opened
from the Tools menu (or Toolbar).

Pipe Data Display
The data to be shown for the pipes is
selected on the left side of the Model
Data Control window. Only the items
with check marks will be shown in the
Model Data window. All pipes shown
will report the selected items.

Junction Data Display
The data to be shown for the junctions
is selected on the right side of the
Model Data Control window. The data
is grouped by junction type. However,
some data is general and applied to
each of the junction types. Select the
junction type from the list and then
select the data for that junction type.
Each type also includes the general
data which may be
selected/deselected.
You can select/deselect the general
data for all junction types simultaneously by clicking Set Common.
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then be shared with different users.
The external file can be generated by
clicking the Save Control Format button at the bottom of the window. The
format can then be applied to other
model files by clicking the Load Control Format button.

Show Selected Pipes and
Junctions
Specific pipes and junctions can be
shown in Model Data. Click the Show
Selected Pipes/Jct tab, then click the
items in the lists to select the pipe(s)
and junction(s) to be shown.

Other Data
Figure 1: The Model Data Control window
allows selection of the parameters to
show in the Model Data window

Model Data Format
The Model Data Control format can be
saved to a file so that the format can
be quickly applied to other model files.
There are multiple ways to do this.
The Model Data Control format can be
saved to the internal User library by
clicking the Set As Default button,
then choosing User Default in a new
model file to apply the settings.
The Model Data format can also be
saved to an external file, which can

Here you can specify whether pipe
elevation data, junction curve data,
Design Alerts, and/or Force Sets will
be displayed in the Model Data window.

Scenario Format
A powerful Model Data feature when
using scenarios is to show all direct
ancestor data in the Model Data along
with data from the current scenario.
The Scenario Format features allow
you to do this, and to highlight where
data changes occur. Note that the
scenario name is appended to the
pipe and junction number in the left
columns. This tab only appears when
multiple scenarios exist.
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Library Connections
In the lower left of the Model Data Control window there is a Library checkbox. If this box is checked, your Model
Data Control parameters are setup as
determined by the library to which you
are connected. This is referred to as
an active library. To make it inactive,
uncheck the box or change one of the
Model Data Control settings controlled
by the library.
If the check box is unchecked, but
enabled, you are connected to a library but the settings are not being
passed to the Model Data Control window. The library is thus inactive. To
make it active, check the box then
click the OK button.
If the check box is disabled, there is no
connected library.

Output Window
The Output window is the primary
vehicle for communicating the results
of an analysis in text form (see Figure
1). The Output window follows the
same general window organization as
the Model Data window.
When a model is submitted to the
Solver, the Solution Progress window
appears. After the solution is obtained,
you can view the results in the Output
window by clicking the View Output
button.
If the information in the Output window
is not in the desired format, you can

choose Output Control from the Tools
menu (or Toolbar) to modify the
format. The Output Control window
lets you specify the parameters, their
units, and the order of their display in
the Output window.
The Output Print Content window available on the Tools menu (or Toolbar)
lets you specify the content to include
in the printed Output report and select
the font to be used.
The Sort window opened from the
Arrange menu (or toolbar) offers the
ability to sort the Pipe Results or Junction Results tables according to the values in any of the columns.
The Transfer Results to Initial Guess
feature on the Edit menu (and Toolbar) sets all pipe and junction initial
steady-state flows and pressures
equal to the converged results, which
causes future runs to converge much
faster.
You can view the input data for individual pipes or junctions directly from
the Output window in one of two ways.
First, if you press down the right
mouse button on the pipe or junction
number in the far left column of the
table you will see the Inspection window. Second, if you double-click the
pipe or junction number you will open
the Properties window in read-only
form where you can review input in
detail.
General, Pipe, and Junction section
display sizes can be changed by the
user by clicking and dragging the bars
between each section to re-size them.
Each section can also be hidden by
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clicking the arrow in the upper left of
each section.

selected column in a different unit.

You can use the zoom feature in the
lower right hand corner of the Output
window to re-size the text displayed
on screen

l

l

Sort - Sort the table in
Ascending or Descending order on the
selected column.

l

Add "Parameter" for
all Table Objects to
Excel Export Manager
- Add this column to the
Excel Export Manager.

l

Open Excel Export
Manager - Directly open
the Excel Export Manager.

l

Copy Selected Cell
Data - Copies all of the
values in the column to
the clipboard.

Row Header
l

Add all Object Parameters to Excel Export
Manager - Add this row
to the Excel Export Manager.

l

Open Excel Export
Manager - Directly open
the Excel Export Manager.

l

Find on Workspace Quickly locate an object
on the Workspace.

l

Copy Selected Cell
Data - Copies all of the
values in the row to the
clipboard.

l

Open Properties Window - Opens the

Figure 1: The Output window displays output in text form

Right-click Context Menu
Actions
There are several options available
when right-clicking on a cell, row
header, column header, or entire table
in the Output window:
l

Column Header
l

Change Units Quickly redisplay the
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properties window for
the associated pipe or
junction.
l

Table (upper left cell)
l

l

l

l

Add Object Table to
Excel Export Manager
- Add the entire table to
the Excel Export Manager.
Open Excel Export
Manager - Directly open
the Excel Export Manager.
Copy Selected Cell
Data - Copies all of the
values in the table to the
clipboard.

Cell
l

Add Object "Parameter" to Excel Export
Manager - Add this cell
to the Excel Export Manager.

l

Open Excel Export
Manager - Directly open
the Excel Export Manager.

l

Create Design Alert Create a Design Alert
related to the selected
object and value.

l

Copy Selected Cell
Data - Copies the value
of the cell to the clipboard.

Output Window Updates

Whenever you change the input
model, all output windows are erased.
This prevents you from changing your
input model, forgetting to rerun it, and
mistaking the previous Output window
for the current model's results.

Steady Flow Results
Figure 2 shows the steady flow results
in tables for pipes and junctions as
specified in the Output Control window. Details of the steady state results
at each pipe calculation station can be
viewed on the Axial Points tab of the
Pipes section.
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Time Slider will change what time step
results are displayed.
Note that the pipe stations shown are
those saved to the output file.

Figure 3: The Transient Output table in
the Output window shows output results
for pipe stations and at specified times
Figure 2: The Output window shows
steady flow results in the Pipes and Axial
Points tables and the various junction
tables. Transient data is shown on the
transient tabs.

Transient Flow Results for
Pipes
You can review the transient results
for any pipe station for any time which
was saved to file as specified in the
Simulation Duration panel. These results are shown in the Output window
Transient Output table (Figure 3)
Figure 3 shows the transient flow results at the initial time step (which is
equal to zero here). The columns of
data shown in Figure 3 are specified in
the Output Control window. Using the

Transient Max/Min Results
for Pipes
You can review the maximum and minimum transient results for all pipes for
all times. The data shown is not
dependent on which pipe stations or
time steps were saved to file. Figure 4
shows the Transient Max/Min table in
the Output window. The parameters
that are shown are the same as those
specified in Output Control. However,
there are four columns for each parameter. The four columns show the
maximum and minimum values for the
parameter, and the times at which
each maximum and minimum occurs
in the pipe.
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Figure 5: Summary version of the Transient Max/Min table
Figure 4: The Transient Max/Min table
details the maximum and minimum values for the entire simulation

Transient Event Messages
Summary Max/Min Results
There is a summary version of the
Transient Max/Min table, which is the
default view. The version shown in Figure 4 is what is called the Detailed version. You can switch between detailed
and summary views by selecting the
option on the Output Control, Format
& Action tab.
The summary version shows only maximum and minimum values for the
entire pipe, as opposed to each pipe
station. The summary also shows the
pipe station that is the overall maximum or minimum for the pipe. Therefore, for each Output Control transient
parameter there are six columns in the
summary version of the Transient
Max/Min table. See Figure 5 for an
example.

When events occur at junctions during
the transient simulation, a log of all
events is displayed in the two Event
Message lists. In the first list events
are sorted by junction number. In the
second list they are sorted by time.
The list includes when check valves
close (and re-open), relief valves
open, control valves lose control (and
regain it), as well as all standard event
transients.

Results Diagrams
Results diagrams are available for
steady state compressor/fan results
(see Figure 6). These diagrams allow
you display the information in a more
intuitive manner, copy the image of
the diagram to your clipboard, or print
the diagram. The option to show the
results diagram can be found in the
compressor/fan summary tab.
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PDF file
l

Sent to the printer

The printed and Adobe PDF output follows the same flexible, organized, and
accessible format as the Output window itself.

Related Topics
Exporting Force Data
Critical Warnings, Warnings, and Cautions
Applied Standards

34
463
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Output Control Window
The Output Control window (see Figure 1) allows you to customize the
parameters shown on the Output Window.
Figure 6: Compressor/Fan Results Diagram

Printing and Exporting
Data in the Output window can be:
l

Copied to the clipboard

l

Saved to a formatted text file

l

Exported to a delimited file suitable for direct importing into
spreadsheet software

l

Exported directly to Excel

l

Saved directly to an Adobe
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junction output, this list can be viewed
in alphabetized or categorized mode,
which makes it easier to find a parameter.
Choose a parameter to be shown by
selecting it on the left-hand list and
clicking the Add button, or double-clicking the parameter name. The selected
item will appear in the list on the right
either at the bottom or at the previously selected location. The list on
the right shows the order of the parameters to be displayed in the output
and the units (if any) in which to display the results.

Figure 1: The Output Control window
selects parameters for the Output window. Here the Pipe Output parameters are
shown. The other output parameters function the same way

Display Parameters
The Display Parameters tab controls
the parameters to be shown for the
pipes, junctions and summary reports.
The output type is selected from the
group of buttons at the top. For each
output type, the list on the left side
shows all available parameters for the
selected report. For the pipe and

You can change the order of the output by selecting a parameter on the
right-hand list, then clicking the
Reorder scroll bar on the far right or by
clicking and dragging the row using
the handle on the left. The list will be
reordered accordingly. The output is
presented from left to right in the order
defined in this list.
The units used for a parameter can be
changed by selecting the parameter
then choosing the desired units from
the adjacent drop-down list. By selecting the units of interest, you can obtain
your results in whatever units you find
most convenient and meaningful. This
means that you can enter all your
input parameters in one set of units (or
a variety of units, for that matter), and
have all your output parameters in a
completely different set of units.
To set selected units for both pipes,
junctions and summary reports to the
preferred units (set in the User
Options window), click the Use Preferred Units button. If you change the
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units of a parameter and you would
like that unit to be used for all similar
parameters in the list or entire output,
select the Same Units button.
You will note that some output parameters do not offer the ability to specify output units. These parameters
either do not have units associated
with them (such as Reynolds Number
or friction factor), or are in fact echoes
of input parameters (such as Pipe
Nominal Size).
Several Special Summary Reports
can be displayed in the Output window. These include the following:
l

Compressor/Fan Summary

l

Valve Summary

l

Heat Exchanger Summary

l

Tank Summary

l

Pipe Transient Summary

l

Forces Summary

General
The General Section is the text area
located at the top of the Output window. The project title, reference information and solution balance display are
controlled here.
You can enter a descriptive Analysis
Title which will be used in the Model
Data, Output and Visual Report windows. A title is required and can have
up to 100 characters.
You can keep a lengthy explanation or
any other documentation about your
model in the Reference Information

section. Names of projects, individuals, and assumptions can all be
kept with the model. This information
can then be included in your reports to
improve tracking.
There is an option "Show Solution Balance Summary" that is defaulted to
off. This option toggles the display of a
general output tab showing the total
flow entering and exiting each junction, as well as the sum of those flows.
This can be helpful in verifying the results as well as in some troubleshooting
cases.

Format & Action
The results can be automatically sent
to the printer or saved to a file when
the model has reached convergence.
Additionally, the results can be automatically saved as initial conditions
when the model is run. By saving the
results as initial guesses, the iteration
time for AFT xStream to arrive at a converged solution is reduced. The initial
guess can also be transferred manually by selecting Transfer Results to Initial Guesses on the Edit menu or
Toolbar. The model can also be automatically saved after the initial conditions are transferred. The valve state
(open, closed or failed) can also be
saved along with the initial conditions.
When enabled, the Wrap Table
Column headers option makes the output tables wrap the column headers
as an extra line if the header is wider
than usual.
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digits specified. Using the
above example with a limit set
to 4 then 1234.5/.09876 =
12500 or an order of magnitude
of 5. This is greater than the
limit. The entire column will not
be aligned and will be displayed as:

There are four formatting methods for
the pipe and junction output data:
l

Always Align Decimal Point
on Output - allows magnitude
of the data to be easily compared as the data is read down
the column. However, a number whose magnitude is small
may force larger numbers to
show many digits. For
example, assume that the minimum number of digits is set to
four, and there are two output
values: 1234.5 and .09876.
These two values will be displayed in the output as:
l
l

l

0.09876

Show Only Number of Digits
(not aligned) - forces the data
to use exactly the number of
digits specified, which may result in the decimal point location
changing from value to value.
Using this method with the
above example and four digits,
the output will be displayed as:
l
l

l

1234.50000

1235.
0.09876

Align Only When Max/Min <
Limit- aligns the data on the
decimal point only if the maximum value in the column
divided by the minimum value
is less than a limiting order of
magnitude that you set. If this
ratio is greater than the limit,
then each value in the column
will be exactly the number of

l
l
l

1235.
0.09876

Use Exponential When
Max/Min>Limit - similar to the
above method except that if the
ratio is greater than the limit
then the entire column will be
shown in exponential format.
Using the above example, the
column would be shown as
l

1.235E+03

l

9.876E-02

These formatting options are for the
entire Output window; however, the
last two are calculated and applied on
a column basis. In other words, if you
choose the third option one column
may be aligned but another may not
be.
The output can be forced to always display in exponential notation by choosing the checkbox.
The Limit Event Options box can be
checked to set maximum number of
events which will be displayed in the
Event Messages tabs that appear for
cases such as valve transients. This
can be useful in cases such as valve
chatter.
For transient results, the maximum
and minimum values for all selected
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parameters are shown in the Output
window. The results can show the
max/min values for all pipe stations, or
only the max/min values for anywhere
in the pipe. You can choose which
type of report you want by selecting
Detailed or Summary in the Max/Min
Transient Table Contents area. For
models with a large number of pipe
sections, the Summary report is generally preferable because of the time
required to display the Detailed table.
The Grid Headers and Design Alert
highlight colors can be configured to
create a visually appealing output for
ease of reading.
The box next to Show Results Diagram Column can be unchecked to
hide the column which allows easy
access to the Compressor Diagram
for Steady State compressor output.

Show Pipes/Jcts
You can choose which pipes and junctions are to be displayed in the Output
window. Clicking a selected item in the
list on the Show Pipes/Jcts tab will
deselect it. Clicking a deselected item
will select it. This feature is especially
useful when you are interested only in
a certain area of the model.
You can quickly define the output you
want by doing the following:
1.

Select the pipes and junctions
on the Workspace

2.

Open the Output Control window and select the Show

Pipes/Jcts tab
3.

Click the Workspace button for
both the pipes and junctions

4.

Click the Show button

Library Connections
In the lower left of the Output Control
window there is a Library checkbox. If
this box is checked, your Output Control parameters are setup as determined by the library to which you are
connected. This is referred to as an
active library. To make it inactive, uncheck the box or change one of the
Output Control settings controlled by
the library.
If the check box is unchecked, but
enabled, you are connected to a library but the settings are not being
passed to the Output Control window.
The library is thus inactive. To make it
active, check the box then click the OK
button.
If the check box is disabled, there is no
connected library.

Command Buttons
There are eight buttons at the bottom
of the Output Control window.
xStream has built-in default parameters, units and settings which you
can choose by clicking the xStream
Default button. You can also develop
your own settings, tailored to your project or industry, and have these used
by default (instead of xStream’s
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defaults). To make your own default,
first select the output parameters,
units and settings you would like to
use then click the Set As Default button. Your settings will be saved and
will be used each time any new project
is initiated. If you make changes to the
settings, and want to get back to your
defaults, click the User Default button.
The saved settings are updated only
when you click Set As Default.
You can save the output settings
(except for the selected pipes/junctions) to a file by pressing the Save
Control Format button and entering a
file name. These settings are loaded
again by pressing the Load Control
Format button and choosing the file
name. For example, you may have a
final report format that is always
desired. You can load this format
before generating final results. If you
have another format you use for
reviewing model accuracy, you may
want a larger number of parameters in
the output.

AFT Responds to 2020 Customer Survey Feedback

Output Parameters
A variety of parameters are available
to display in the Output window
depending on the junctions and loss
models used in the model.
A description of each parameter may
be seen by double-clicking the header
in the Output Window table, and is
also displayed below the Output Parameters table when that parameter is
selected in the Output Control window
(Figure 1).
Additional information can be found
below for some of the output parameters.

Figure 1: A description is provided at the
bottom of Output Control for the selected
parameter

The format files you create can be
placed on a network for sharing
among a group or company.
If you have made changes you don’t
want to keep, click the Cancel button.
Click OK to use the setting you have
specified

Related Blogs
Quick Guide to Custom Output

Cv Est./Kv Est.
The estimated Cv is only displayed
when the valve does not have a
defined Cv loss value. The estimated
Cv/Kv loss coefficient is estimated
using the sizing equations from the
ANSI/ISA-75.01.01-2012 standard, as
are discussed in the Valve Kv and Cv
Loss Model topic.
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Mass Flow Rate Net At Junction
Displays the total mass flow rate exiting the system through the junction,
which is useful to display the flow exiting through junctions such as a relief
valve. In other words, the Mass Flow
Rate Net At Junction is equal to the
flow rate into the junction from the
pipes minus the flow rate out of the
junction into the pipes.

Mass Flow Rate Through
Junction

When an applicable standard is used
in a calculation, an additional tab
appears in the general area of the Output Window. This tab indicates what
standard(s) were used for what calculations in the model.

Figure 1: Applied Standards when applied
for Cv/Xt loss at a valve

Displays the total mass flow rate
through the junction for junctions connected to only two pipes. If the junction is connected to more than two
pipes this parameter will be displayed
as N/A. When more than two pipes are
connected the user should refer to the
output for the pipes connected to the
junction in order to view the flow rate
through the pipes. The user can add
the "Mass Flow Rate Net At Junction"
to view flow exiting the system rather
than flowing out of the junction into a
pipe.

Graph Results Window
The Graph Results window, shown in
Figure 1, allows users to generate
high quality printed graphs.
The Graphing Panel offers several
types of standard graphs for transient
pipe or junction, profile, and force
information. Users can also control
graph content, plotting information for
multiple parameters, junctions, pipes,
paths, or scenarios simultaneously.
Results can be graphed as linear or
log versus linear.

Related Topics
References

Applied Standards
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Once a folder is created and selected,
a Graph can be added to its list by
selecting the “Add Graph to List” icon
found on the Graph Results Toolbar.
This can also be done by right-clicking
anywhere on the graph. Once Graphs
are in Folder individual Graphs can be
generated in unique tabs or each
Graph in a Folder can be displayed in
a single tab by right clicking on the
Folder and selecting “Load Current
Folder Graphs in New Tabs” or “Load
Current Folder Graphs in Same Tabs”.
These options are available in the
Graph List Manager toolbar as well.
Other options that can be found by
right clicking on a Folder or Graph in
the Graph List Manager or on the toolbar are:

Figure 1: The Graph Results window
offers full-featured plot generation

l

Load Graph in Current Tab –
Regenerates the graph in the
currently active tab.

l

Load Graph in New Tab –
Creates a new tab and regenerates the graph there.

l

Load Current Folder Graphs
in New Tabs – Regenerates
all the Graphs in a Folder in separate tabs.

l

Load Current Folder Graphs
in Same Tab – Regenerates
all the Graphs in a Folder in a
single tab.

l

Keep Folder Display Layout
– Saves the current layout in
the Graph Results window if
multiple graphs have been
loaded into one tab from a
folder.

Graph List Manager
Allows the user to create, update, and
even replace unique graphs that can
be regenerated with new data. Multiple graphs can be displayed at the
same time and organized into separate Folders. The default folder is
named “My Graphs” and more folders
can be created using the “New
Folder…” icon on the Graph List Manager Toolbar or by right clicking on
“My Graphs” and selecting “New
Folder…”
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l

Reset Folder Display Layout
– Resets the layout in the
Graph Results window if multiple graphs have been loaded
into one tab from a folder.

l

Add Graph To List – Saves
the Graph to the currently active list allowing it to be regenerated in the future.

l

Print Preview Selected Item Opens graph item directly in
the Print Preview window.

l

Update Current Graph In List
– Saves any changes to the current graph that have been
made. (e.g. Changing the
Graph Title or Line Style). Note
that it is preferred to use the
Replace Graph in List option if
changes to the parameters or
objects/paths being shown
have been made.

l

Move Graph Up – Moves the
selected Graph up one level.

l

Move Graph Down – Moves
the selected Graph down one
level.

l

Rename Graph… – Changes
the name of the Graph.

l

Duplicate Graph – Creates a
copy of the selected Graph with
a new name.

Replace Graph In List –
Replaces the graph highlighted
in the Graph List with the current graph that is shown.

l

l

New Folder – Creates a new
Folder where more Graphs can
be saved to.

Copy Graph Image – Copies a
.jpeg of the Graph to the clipboard

l

l

Delete Graph – Removes
Graph from the Graph List Manager.

Copy X-Y Data – Copies the
X-Y used by the Graph to the
clipboard

l

Show Data – Displays the X-Y
data used to generate the
graph in a column to the right of
the graph

l

Create Annotation – Add an
annotation to the graph that
can be formatted and saved to
be reloaded with the Graph in
the future.

l

Show Legend – Toggles the
legend off and on.

l

Show Check Boxes in
Legend – Adds a check box in
the legend that allows the user
to selectively turn off and on

l

l

Move To Folder – Moves the
selected Graph to a previously
existing Folder or a new Folder.

Graph Results Toolbar
The Graph Results Toolbar also has
many options that are available by
right clicking on the Graph Results
space at any point. These options are:
l

Select Graph Parameters –
Select the type of Graph to create and its parameters.
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certain curves in a Graph
without having to recreate a
new Graph.
l

l

l

l

Show Cross Hair – Displays
and cross hair that shows the
cursors X-Y values along the X
and Y axis. This also displays
the nearest data point X-Y values in a tooltip. If this feature is
used at the same time as
"Show Data" the Cross Hair will
focus on that highlighted data
point and display its values in a
tooltip. The user can also
change what data point is highlighted with the arrow keys and
the Cross Hair and tooltip will
move to that data point.
Show Range Finder – Adds a
toolbar at the bottom of the
graph that displays the entire X
axis, but allows the user to
zoom in to a specific range by
clicking and dragging the
handles on either side of the
range finder.
Show Junction Locations –
Add a vertical line with the number of the junction labeled at
the location of the junction
along the flow length.
Manage Junction Locations
– Allows junction labels on the
graph to be shown/hidden individually.

Including
l

Header, Axis, and
Legend names and
fonts.

l

X and Y scaling

l

Line color and thickness

Graph Outline Colors
The active graph will always have an
outline which indicates what state it is
in.
l

Orange – Graph not added to
list

l

Dark Green – Graph added to
list

l

Light Green – Graph added to
list, but changes have
occurred. These can be saved
and make they graph dark
green by selecting “Update Current Graph in List”.

Graph Tab Icons
Each Graph Type has a specific color
associated with it. This color will display in the box on the tab for the
Graph. The colors are below:
l

Transient Pipe – Dark Red

l

Zoom to 100% – Resets the
focus of the graph to 100%

l

Transient Junction – Dark
Gray

l

Format – Allows the user to
change the Graph’s format.

l

Profile – Purple

l

Forces – Yellow
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l

Frequency – Light Brown

l

Blank Graph – Light Gray

These tabs also display if the Graph in
the tab is not saved or has been
changed from the original Graph List
item by showing a small yellow square
over the tab's icon. If the current graph
has been saved, there will be no yellow square.

Graph Tab Actions
l

l

l

New Tab – Creates a blank tab
in which a new type of Graph
can be generate and added to
the Graph List Manager
Tab Actions
l

Close Active Tab

l

Close All Tabs

l

Close All But The Active
Tab

l

Two Vertical Tab
Groups

l

Two Horizontal Tab
Groups

l

Reset to Single Tab
Group

l

Tabs on…. – Selects the
location of tabs (defaults
to the bottom of the
Graph)

Graph Tab Selection –
Selects a Graph for the Graphs
currently in the tabs based on
name.

Printing and Exporting
The Graph Results image can be:
l

Copied to the clipboard

l

Saved to a picture file

l

Saved directly to an Adobe
PDF file

l

Sent to the printer

The x-y data in the Graph Results
graph can be:
l

Copied to the clipboard

l

Exported to a delimited file suitable for direct importing into
spreadsheet software

Animations of graphs can be saved as
.wmv or .mp4 files.

Data Point Limitations
By default, the maximum number of
data points xStream will plot for an individual graph is 500,000, though users
can change this limit under the General -> Other section of the User
Options window. This limit is in place
to help ensure users do not encounter
memory issues related to plotting
large numbers of data points. The
allowed range of data points plotted is
10,000 - 1,000,000. The data point
limit is applied to an individual graph.
Two parameters plotted as stacked
graphs count as two separate graphs.
Two parameters plotted with one as a
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secondary y-axis graph count as one
graph. One parameter plotted for two
scenarios on the same graph counts
as two graphs (i.e. the data point limit
is essentially doubled from a singlescenario graph to a two-scenario plot
graph).
When a user attempts to generate a
graph that exceeds the maximum number of data points, xStream will skip
data points in order to remain under
that limit. The frequency of skipped
data points is proportional to the
amount by which the generated graph
exceeds the maximum number of data
points. When data points are skipped,
there is the potential for important data
points to be excluded from the graph
such as maximum or minimum values.
Users can take the following steps to
avoid running into this issue, and to
double-check that the graph gives an
accurate representation of the results
and does not skip any maximum or
minimum data points:
l

Increase the limit in the User
Options window (the time
required to load a graph will
increase)

l

Plot fewer curves in the graph

l

Graph data for limited amounts
of time rather than the entire
simulation time

l

Save fewer output data points
from the Simulation Duration
panel in the Analysis Setup window

l

Double check results shown in
the graph with transient output

shown in the Output window.
Users can either reference the
Transient Output, showing output values for every time step
and pipe section data is saved
for, or examine the Transient
Min/Max values shown for the
parameters selected in the Output Control window.

Related Topics
Animating Graph Results
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Related Blogs
Quick Guide to Custom Output

SSL Module
Settling Slurry Module
An optional add-on module to AFT
Impulse which allows users to simulate settling slurries.
PFA Module
Pulsation Frequency Analysis
Module
An optional add-on module to AFT
Impulse which allows users to
determine resonant frequencies in
their system.

Quick Graph Formatting
Window
The Quick Graph Formatting window
allows you to customize the plot by giving you control over the many aspects
including:

297

Quick Start Guide
l

Axis titles and font sizes

l

Legend text and font size

l

Line thicknesses and basic
color sets

l

Axis min and max values

You can save the settings you set up
by clicking the Save button. If you
make changes to the settings, and
want to get back to previous settings,
click the Load button.

Graph Types

parameters can be plotted on the
same graph using the secondary axis.
To move a parameter to the secondary access, add it below the parameter that will be on the primary
access, then click the right blue arrow
button, or double-click on the gray
square to the left of the parameter.
This will cause the parameter to be
indented, as shown in Figure 2.
Further, if Design Alerts are specified
for the pipe (e.g., max/min operating
pressures), these can be cross-plotted
against the transient data by selecting
the check box under "DA".

AFT xStream offers several types of
graphs to help users better understand and interpret their data. Each
type of graph is given a brief description below.

Transient Pipe
Transient pipe results can be plotted
against time for any pipe station that is
saved to the output file. By default, all
stations for each pipe will be saved to
the output file. The amount of pipe
data saved can be changed in the Simulation Duration panel.
The user can plot the data for the
entire simulation, or for a user specified time frame.
One or more parameters can be
graphed by using the Add button with
the green plus sign. The Remove button can be used to eliminate extra
parameters. Parameters can either
be plotted in stacked graphs, or two

Figure 1: Creating a graph with a parameter on the secondary axis

Transient Junction
Similar to transient pipe results, transient junction results can be plotted
vs. time for any junction that is saved
to the output file. Junction data
includes items such as compressor
speed and valve Cv.

Profile
This graph category allows users to
plot the selected parameter(s) along a
flow path. In order to generate this
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graph, the specified pipes in the
Select Graph Parameters window that
comprise the path must form a single,
continuous path. If they do not, an
error message will appear listing the
pipes which are preventing the path
from being continuous. The independent variable in these graphs is
the length along the flowpath.
A path of pipes can be specified in one
of two ways. First, the user can select
the pipes in the displayed list. Additionally, you can select the path on the
workspace, and then use the Workspace button on the Select Graph
Parameters window to automatically
select all pipes currently selected on
the Workspace. These methods permit only a single path to be specified.
One or more flow paths can be specified using groups. Only those groups
that consist of a continuous pipe
sequence will be displayed as an
option in the Select Graph Parameters
window.
The results can be the values at a particular point in time, or the overall maximum and/or minimum values. You
can also cross-plot Design Alerts, the
max/min values, and the steady-state
results. This is done clicking the check
boxes underneath "Mx" for maximum,
Mn" for minimum, "SS" for steadystate, and "DA" for design alerts.
All profile graph types support animation. Animating graphs is discussed
further in Animating Transient Results.

Forces

If transient force sets have been
defined in the Forces panel, the resulting force data can be plotted vs.
time. Force sets selected from the list
of defined force sets will be plotted.
The unbalanced transient force data
can be plotted for the entire transient
simulation, or the user has the option
of selecting a specific time frame to display.
This force data can also be exported
for analysis in pipe stress analysis software.

Frequency
(PFA module only) As part of the pulsation frequency analysis, the tab will
appear to plot the frequencies identified for the system.

Multi-Scenario Graphing
Features
Users can plot information from multiple scenarios in the same plot. In the
Select Graph Parameters window, the
button for 'Multiple Scenarios' allows
users to select the scenarios in the
model they wish to plot for a particular
graph. The scenarios being plotted in
the graph must have the same pipe
layout for all scenarios, but can have
different sectioning in AFT xStream 2.
When creating multi-scenario profile
graphs, the current scenario will
determine start/stop time, time step,
junction label locations, and design
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alerts that are shown on the graph.
For multi-scenario graphs with different time steps/sectioning groups for
multiple paths will not be allowed.

Figure 2: Graph Parameters window showing Multi-scenario selection options

The active scenario must be included
in a multi-scenario graph. When creating a new graph, users are not able
to deselect the current scenario.
When a user loads a saved Graph List
Item that does not include the active
scenario, xStream will add the active
scenario into the Graph List Item, but
will not save the active scenario into it.

PFA Module
Pulsation Frequency Analysis
Module
An optional add-on module to AFT
Impulse which allows users to
determine resonant frequencies in
their system.

Scenarios can be selected using the
Multi-scenario... button as shown in
Figure 2 below.

Basic Graph Tutorial
Generating graphs is a powerful tool
for analysis. Below are step by step
instructions about how to make and
manage graphs from one of the
example models. Many of the graphs
created in this example will be multiscenario graphs. However, the information discussed within is the same
regardless of which scenarios are
selected.
For this example, the US - Gas Turbine Fuel System model file was used.
A copy of the completed model can be
downloaded from the Gas Turbine
Fuel System example, or can be found
in the AFT xStream installation folder.
Open the model and create three children of the 2 Sections Minimum Per
Pipe scenario. The three children scenarios evaluate three different closure
times of the Premix Gas FCV #2 valve
(J11): 0.01 seconds, 0.1 seconds, and
0.5 seconds. Run the three scenarios
and return to the 0.01 Second Valve
Closure scenario.
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To skip to different sections of this
tutorial, use the links below:
l

l
l

l

Transient Junctions and Saving
Graphs
Transient Profiles and Animations
Displaying multiple graphs simultaneously
Creating graphs from the Workspace

Transient Junctions and Saving Graphs (return to top)

the Transient Jct tab and selecting the
desired parameters. The only junction
with saved transient data will be the
valve J11. Add this junction to the
“Graph These Junctions:” column by
double-clicking the junction ID number, or selecting the “>” symbol. Select
“Cv” as the parameter. Select all three
valve opening children scenarios
using the Multi-scenario... button, and
then select “Generate”. This creates a
plot of “Cv vs. Time” for all three scenarios on the left.
Note that the Graph Guide, accessed
by clicking on the "What Would You
Like to Do?" icon on the upper right of
the graph, will guide you through the
process of creating a graph
Note: The model file used in this
tutorial does not have force
sets applied, so the Forces
graph tab is not available in
the Graph Parameters area.
The Forces tab will be available if force sets are defined
and applied in the Analysis
Setup window.

Figure 1: High Pressure Steam Example

Go to the Graph Results Primary Window and determine what type of graph
you want to generate. The first graph
created in this example will be a Transient Junction Graph. The Transient
Junction is one of several different
types of Graphs that can be made.
This graph is created by first selecting
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parameters are the ones used to generate the Graph.

Figure 2: Valve Cv vs. Time

The Graph has been created, but has
not yet been added to the list under
"My Graphs". To add this Graph to the
list, first select the “Add Graph to List”
icon on the Graph Results toolbar (this
option and many others can be
accessed by right-clicking on the
Graph at any time). Name the Graph
“Transient Junction - J11 Cv”. The
Graph has now been saved and will
be easily regenerated with the same
format if the output changes. The
name of the saved Graph can be seen
in the Graph List Manager, with two
small squares in the icon associated
with it indicating it is a multi-scenario
graph. The border of the Graph has
also changed to dark green along with
borders of the parameters and the
name of the Graph in the Graph List
Manager, indicating that the Graph is
current, saved, and that the displayed

Figure 3: Adding a Graph to My Graphs

Formatting options are available by
selecting “Formatting” above the different graph types. When formatting
changes occur the border of a Graph
will change from dark green to light
green, indicating a change has been
made to a graph in the Graph List.
Another indicator that the Graph is not
saved is the small yellow square over
the icon on the tab. Here, the title has
been changed from “Cv vs. Time” to
“Valve J11 Cv vs. Time”. Once the
formatting settings have been
changed, this change and other
formatting changes are not retained to
the Graph unless “Update Current
Graph in List” is selected.
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Figure 4: Update Formatting Changes to
Graphs

After selecting “Update Current Graph
in List” the border has changed back
to dark green and the yellow square
has disappeared. This indicates that
this is the current formatting of this
graph, and that regenerating this
graph will generate the same graph
(according to the current model output).

Figure 5: Valve Cv graph with updated
formatting changes

Transient Profiles and Animations (return to top)
The next step in the example is to
make a new Graph in a separate tab.
This is done by selecting the “New
Tab” icon in the lower right. This
Graph will be a “Profile” Graph that displays Static Pressure along the length
of the flow path from the compressor
through J11 and to Combustion Basket #3. Select pipes 1, 2, 3, 6, 9, 10,
and 11 in the system and change the
parameter to “Pressure Static” with
units of length in feet and units of pressure in psig. Make sure that the Mx
and Mn boxes are checked to display
the maximum and minimum static
pressures. Make sure "Animate
Using" is set to none.
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Note: An easy way to select the
pipes in a longer path would
be to select them in the Workspace, then click the Workspace button under Pipes to
automatically select the
desired path.

Figure 7: Pressure Static vs. Flow Length
Profile added to Graph List

Figure 6: Generating a Profile plot with
Min and Max Pressure Static

The graph shows the minimum and
maximum static pressures during the
transient simulation for each pipe station along the flowpath. Save this new
graph as a new Graph List item. The
two graphs we have made can be
switched quickly between by either
selecting the graph from the list, by
clicking on the corresponding tab, or
using Graph Tab Selection.

This is a useful graph, but animating
the pressure profile over time can
provide even more information. Animating from the Output file requires that
all data for the pipe stations being
animated to be saved to the Transient
Output File in the Pipe Sectioning and
Output panel, which is done by
default.
Select the Animate Using Output
option, then click generate.
After selecting generate the Graph will
now allow for animation with options to
Play, Record, Stop, and manipulate
the animation in other ways. The recorded animation can be exported to a
video file for convenience.
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Figure 8: Max/Min Profile Graph with
Animation

Displaying Multiple Graphs
Simultaneously (return to top)
Another option that is available is to
add another parameter to the graph.
This is called generating stacked
graphs. To do this select “Add” next to
“Select Parameter”. This will graph an
additional parameter that shares the
same X-Axis as the original parameter. For this example, select “Pressure Static” as the parameter, but with
units in barG rather than psig.

Figure 9: Stacked Pressure Profile with
different units

We now have the same plot twice,
which is not the most efficient way to
view this data. A better way would be
to have the secondary parameter
(which could be any of the available
options for a profile plot) on a secondary y-axis. This can be done by
double clicking on the arrow to the left
of “Pressure Static: barG” or by selecting the blue right arrow on the “Select
Parameter Row”. This will visibly
indent the secondary parameter.
When the Graph is regenerated it will
now only be one plot of Pressure
Static vs. Length, but it will have units
displayed in psig on the primary y-axis
and units of barG on the secondary yaxis.
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Figure 10: A Single Graph with Alternate
Units on a Secondary Y-Axis

Figure 11: The Resulting Graph when it is
Updated

Update the Current Graph in List using
the toolbar button. The Graph is now
complete and can be easily regenerated if input data is changed on the
Workspace and the model reran. It
can also be used to generate the
same graph for data from other scenarios.

It is now possible to close the Graphs
and regenerate them either in their
own tabs or all graphs in a folder in the
same tab. To test this out, close both
Graph tabs and then create a new
"Graph on same tab" folder from the
right click menu. Right click each of
the graphs made in this tutorial, and
choose to move the graph list items to
the "Graph on same tab" folder.
Right-click on the "Graph on same
tab" folder and then choose “Load
Folder Items” and then “Same Tab”.
After the Graphs have been loaded in
the same tab, the tab icon changes to
an orange square, indicating that multiple Graphs are being displayed on
one tab. All graphs will now be animated, with a vertical red line appearing
on the graphs with a time axis. This
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red line will move over the animation
time to compare values more readily.
Depending on the monitor display
being used, or the number of graphs
being displayed, this view may be
easy to view or difficult to see data.
For the sake of this example, we've
kept the display size relatively small,
meaning it is more difficult to view the
data on all the graphs. However, with
larger monitors available, it is likely
easier to view this data.

If we have two Time graphs with the
same x-axis, we can display them in a
single, stacked graph. This approach
to viewing graphs can be especially
helpful in examining how a junction
transient is affecting output parameters nearby. To create a stacked
graph of multiple Graph List Items,
first make sure both items have the
same time scale. Then, move them
into their own folder. Here, we've
moved the Combustion Basket #3 Profile graph back to the My Graphs
folder and moved the example's Combustion Basket #1 Temperature vs
Time graph to the "Graph on same
tab" folder. Finally, right-click the
"Graph on same tab" folder, select
"Load Folder Items", and then the
"Stack Common X-Axis in Same Tab"
option.

Figure 12: All graphs loaded into the
same tab

Other ways to view multiple graphs
simultaneously are to plot them as
stacked graphs, as we did previously
for our pressure profile in psig and
barG, or to plot saved graph items in
two tabs either stacked or side-byside. Right-clicking on a Graph-Tab at
the bottom of the window shows the
options for displaying two separate
tabs.

Figure 13: Load Current Folder Graphs in
Same Tab - Stack Same x-Axis

307

Quick Start Guide

As we just saw with the Profile Graph
Folder, it is possible to create more
Graph Folders other than “My
Graphs”. Saved Graph List Items can
then be organized into different folders
and can independently be generated
into their own tabs or a whole folder of
Graphs can be generated into one tab.
Using multiple folders will allow the
user to create many unique variations
of animations or other Graphs that can
be used to convey transient output in a
meaningful and intuitive manner.

Creating Graphs from the
Workspace (return to top)
Some graphs can also be generated
directly from the Workspace after running the model. To create a graph for
the valve inlet and outlet static pressures from the Workspace right click
on the valve J11, choose “Create Transient Graph for Pipes”, and select
“Pressure Static”.

Figure 14: Creating Transient Graphs of
the Inlet/Outlet Pipes Connected to a
Junction

This will automatically generate the
requested Graph with default units.
This is a quick and easy way to see
the pressure difference across the
valve. Notice that this graph will be a
Transient Pipe graph, since the pipe
inlet/outlet stations are being used to
graph the equivalent valve inlet/outlet
values.
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Figure 15: The Pressure Static vs. Time of
the Two Pipes Connected to Valve J11
Figure 16: Graph the Changes to Mass
Flowrate vs. Time from the Workspace

Make one more Graph from the Workspace by right-clicking pipe 10, selecting “Create Transient Graph for
Pipes”, “Mass Flowrate”, and then
“Outlet Only”.

This will add a Graph of the Mass
Flowrate at the Outlet Station of Pipe
10 as is shown below in Figure 17.
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In the Visual Report window, the positions of the junctions and pipes are
fixed based on their locations on the
Workspace. While the pipe system layout cannot be edited in the Visual
Report window, the integrated text results for each pipe or junction can be
rearranged by dragging and dropping
to improve the final appearance of the
window.
The contents of the Visual Report window can be:

Figure 17: Mass Flowrate vs. Time at the
Outlet of Pipe P10

Visual Report Window
The Visual Report will help you visualize the model data and flow solution
in relationship to the model layout.
The Visual Report window displays
the pipe system layout from the Workspace window with information in text
form (see Figure 1). Additionally, magnitudes of parameters may also be
shown with color variations using color
maps, or animated using Visual
Report Animation.
The values to be shown may come
from the input data (when in input
mode), the steady-state output or transient output results. You can change
between these by selecting the option
at the top of the Visual Report Control
window.

l

Copied to the clipboard

l

Saved to a picture file

l

Saved directly to an Adobe
PDF file

l

Sent to the printer

Visual Report animations can be recorded to a .wmv or mp4 file.
The controls in the lower-right corner
allows you to zoom in and out, as well
fit the image to the size of the screen.
The printed size is consistent with the
zoom state. That is, if you zoom out to
50%, the Visual Report screen prints
at 50% of its normal size.
The Visual Report window is always
erased when you make changes to
model input. If viewing output results,
rerun the model to view the new results.
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(Figure 1). You can also save custom
Visual Report window layouts to disk
for later recall, so you don't have to
reformat this window repeatedly.
When the Visual Report window is
opened and no output results are available, Visual Report Control will be in
the Input Display Mode. If transient output results are available, it will be
opened in the Transient Output Display Mode. Parameters available for
display vary depending upon the
mode, i.e. input, steady output, transient output, or animate. If output results exist the display mode may be
changed at any time.
Figure 1: Visual Report window integrates
input data and output results with model
layout

Related Topics
Animating Visual Report Results
40
Related Blogs
Quick Guide to Custom Output
AFT Responds to 2020 Customer Survey Feedback

Visual Report Control
The Visual Report Control window lets
you control the content and appearance of the Visual Report window
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may get crowded if too many are selected.

General Display
The General Display tab allows you to
configure several items.
The title, defined in the Output Control
window, file name and scenario name
can be shown or not shown depending
on your preference.
The units for all parameters can be
shown in a legend instead of next to
the parameter value. This will reduce
the amount of text and crowding
shown in the Visual Report window.
The legend can be moved to any location in the Visual Report window. If
this option is chosen while in input
only mode, all values will be converted
to a consistent set of units.
Figure 1: The Visual Report Control window allows you to configure the Visual
Report display

Display Parameters
The parameters to be shown in the
Visual Report window are selected
from the Display Parameters tab. The
left list selects the pipe parameters
and the right list selects the junction
parameters. In these lists you can
show only the parameters you have
selected in the Output Control
window, or all output parameters. You
can select more than one parameter;
however, the Visual Report window

You can change various font sizes by
clicking the Change button beside any
one of the three types of text-containing categories (Data/Text, Title,
and Legend) under the Fonts header
and choosing the font, font style, and
font size desired.
Tip: The font and font size in the
Visual Report can also be
changed outside of the General Display in Visual Report
Control by clicking on the
Fonts button and the Font
Size Up or Font Size Down
buttons, respectively, on the
Toolbar.

Index 312
The number of digits to show in the
numerical display can be configured
using the provided drop-down list.
Normally on the Workspace, closed
objects are displayed using special
graphics (dashed lines, X’s, etc.). The
number of a junction which has special conditions set, by default, has an
X preceding the J (e.g. XJ56). If you
want these symbols to be used in the
Visual Report window also, choose
the Show Closed Symbols checkbox.
Normally, pipes in closed sections are
shown as dashed lines, and junctions
outlined with a dashed line. If you want
these symbols to be used in the Visual
Report window also, choose the Use
Closed Object Style checkbox.

To restore the settings to what is
shown in the Workspace and the data,
click the Reset to Workspace Defaults
button.
Multiple objects can have items
toggled on or off at once by selecting
the desired objects with the left-most
checkboxes and clicking the corresponding checkbox at the top of
each column. Selections can also be
made with the standard selection buttons at the bottom of these panels.

Show Selected Pipes/Junctions
You can choose on an individual pipe
and junction basis what you would like
to show in the Visual Report window.
This display customization feature is
useful for large models where only
some of the data points are of interest.
Each pipe and junction is listed in their
respective Display Options frames.
Every object can display four pieces of
information on the Visual Report Number, Name, Data, and the Object
itself. The display of these items is
indicated by the existence of a check
mark in the corresponding box. To
toggle the display of a particular item
for a particular object, simply click the
checkbox.

Figure 2: Show Selected Pipes/Junctions
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Color Map
The Color Map feature allows you to
visualize magnitudes of various parameters by coloring the pipes. There is
one Color Map for the steady output
mode, one for the transient output
mode, and another for the input only
mode. A Color Map is useful to show
graphically where, for example, high
velocities or reverse flows are located
or to visualize the pipe diameters or
lengths in a model.
To create a Color Map, first choose a
parameter and units for which all pipes
will be categorized. Then choose a
color, select the operator (i.e. >, >=, =,
<=, <) and enter a value, then press
Add to Map. Values may be categorized on an absolute value basis
by selecting this option.
The order of entry is not important.
xStream will sort the entries first by
value and then by the operator, with
the > being above the <. The pipes will
be colored using the first match found
in the map, starting from the top of the
map. If no match is found, the pipe will
be the Workspace pipe color. Be careful to avoid overlapping operators and
values. If, for example, the map had
the following four colors,
1) >=60
2) <60
3) >=20
4) <20
then there is no way colors 3 and 4 will
be used because any pipe less than

20 is also less than 60. Since <60 is
before <20 in the map, the pipe will be
colored using 2.
To avoid overlapping colors, only use
less than (<) as the last entry. A better
map would be to use
1) >=60
2) >=20
3) <20
You can choose to categorize the
pipes based on their absolute values
by choosing the Display Absolute
Value checkbox. To delete a map
value, click the color you want to
delete then click the Remove Setting
button.
Instead of coloring the pipes, you
could choose to color just the pipe
numbers. This is done by choosing the
Color Pipe Labels and clearing the
Color Pipes checkboxes in the Color
Options area. You could also apply
the colorization to both. Choose the
Print Black & White checkbox if you
don’t have a color printer. The pipes
will be printed in black.
The color map values can be displayed in a legend by checking the Display in Legend checkbox. The color
map will appear in the legend after the
pipe and junction units, if that option
was selected. The legend may be
dragged and dropped to any location
in the Visual Report window.
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Auto Color Map

Related Blogs

An automatic color map can be generated for you by selecting "Auto Color
Map". This feature will generate a
color map using greater than (>) conditions to divide the difference
between your max and min value into
the number of conditions. These conditions will have their own unique color
that is automatically set on a rainbow
spectrum. These colors can be manually changed by selecting the "..." button.

AFT Responds to 2020 Customer Survey Feedback

Saving Visual Report Layouts
The Visual Report window content is
specified in the Visual Report Control
window. To open the Visual Report
Control window, choose it from the
View menu or Toolbar. Through the
Visual Report Control window, you
can choose the parameters you want
to see in the Visual Report window.
The parameters and text locations are
automatically saved with the model.
However, you may want to save the
settings for use with a different model.
To save your preferred layouts to an
AFT xStream visual layout file, click
the Save Options button and assign a
file name. The default file extension is
.ivs. Later you can load your customized layouts for rapid preparation
of the Visual Report window.

User Options Overview
AFT xStream provides an array of
User Options in a single window that
can be found in the Tools menu.
The General section of the User
Options window allows you to adjust:
l

Enabling the Startup Options
Window

l

Enabling the Tip of the Day feature

l

Enabling orthogonal drawing
tips

l

Displaying Fluid Accuracy Settings in the Analysis Setup window Fluid panel

l

Whether to confirm before clearing output results

l

Enabling Highlighting Required
Data on Property windows

l

Options for opening models
with scenarios

l

Visual Themes and Styles

l

The default location of the
Quick Access Panel

l

Number of data points to show
in input tables

l

Maximum Number of Data
Points per Graph

l

Setting parameters for "button
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flashing" for curve fit buttons on
Junction Property windows

User Option Defaults
There are six buttons at the bottom of
the User Options window. xStream
has built-in default parameters, units
and settings which you can choose by
clicking the Reset to AFT xStream
Defaults button. You can also develop
your own settings, tailored to your project or industry, and have these used
by default (instead of xStream’s
defaults). To make your own default,
first select the parameters, units and
settings you would like to use then
click the Save As New User Defaults
button. Your settings will be saved and
will be used each time any new project
is initiated. If you make changes to the
settings, and want to get back to your
defaults, click the Load User Defaults
button. The default settings are
updated only when you click Set As
New User Defaults.
If you have made changes which you
don’t want to keep, click the Cancel
button. Click Save and Close to use
the settings you have defined.

changing the Preferred Units will maintain the units used when the data was
input, regardless of changes made to
unit preferences. After saving your preferred units, a window appears asking
if you would like the output parameters
to be displayed in your preferred units.
Choose Yes if you do want the output
parameters to be displayed in the preferred units, or No if you want the output parameters to be displayed in the
units previously used.

Preferred Units
To customize the units used by AFT
xStream, first select Preferred Units
under the Unit System section in the
User Options window under the Tools
menu.
AFT xStream allows you to specify certain units from a large selection to be
displayed in the main interface.
The primary selection is the Unit System:
l

US - Only US units will be available

l

Metric - Only Metric units will
be available

l

Both with US Defaults - All
Units will be available, but US
units will be chosen by default

l

Both with Metric Defaults All Units will be available, but
Metric units will be chosen by
default

Unit System
You can set the units you prefer to use
in AFT xStream in the Unit System section. Once selected as the preferred
units, these units appear as the
default units in all instances in which
empty fields exist in the model input.
Any model input existing prior to

Additionally, a filter can be applied to
limit the selection:
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l

All Units - all units for the Unit
System will be displayed

l

Common Only - only "common" units will be displayed

l

Common Plus Selected
Industries - Units particular to
certain industries can be
included with the common units

If the selection has been limited to
Common Only, there may units common for certain industries no longer
present. The Additional Units for
Industry section allows the user to
append additional sets of units to the
Common unit set. For example, barrels/day is a common unit in the petroleum industry but not many others.
Checking the Petroleum box adds
these units to the main interface.
Preferred Units allows fine grain control over what unit in the above selection is displayed as the default when
defining model input. For example, it
may be desired to have a particular
parameter such as pipe diameter
default to inches, while keeping other
parameters metric. This area allows
the user to define such defaults.

Show/Hide Unit Items
For additional control of the available
units, select Show/Hide Unit Items
under the Unit System section. From
here, you can select which units for
each Unit Family Type you would like
to be available for the model input and
output by checking the box next to
each unit you would like to be used.

Removing units that you do not wish to
use as input or view as output can simplify your modeling and reduce errors
associated with incorrect units.

Edit Custom Unit Names
A custom unit name can be assigned
to display different names in the interface for units. For example "feet/min2"
could be changed to display as
"ft/min2."
To assign a custom unit name choose
the appropriate Unit Type from the
drop-down and enter the Custom Unit
Name in the table.
To speed up the process of entering
custom unit names the units can be
exported to csv and re-imported as follows:
1.

Click "Save Units to CSV" and
save the file where it will be
easy to locate

2.

Open the CSV file in a spreadsheet editing software like
Excel, and fill in the desired custom unit names in the Custom
Name column

3.

Save the CSV file

4.

In the User Options window
click "Load Units from CSV"
and select the edited CSV file

317

Quick Start Guide

Note: To use units with superscripts, make sure the csv file
is saved with UTF-8 encoding. This can be done in
Excel by choosing save as
and selecting "CSV UTF-8"
as the file type.

Related Blogs
AFT Responds to 2020 Customer Survey Feedback

Workspace
In the Workspace section, you can
change the symbols used, text content, and location of the text on the
Workspace. Note that all display
changes are made only for the user's
convenience/preference and do not
affect the model calculations. Additionally, many display options available in the User Options window are
also available in individual pipes and
junctions.

Grid
A traditional 2-D grid or an Isometric
grid can be enabled on the workspace
for modeling convenience by choosing
the appropriate Pipe Drawing Mode.
The number of lines in the grid can be
adjusted to create a grid that is fine,
medium or coarse. The grid can be hidden or shown by checking or

unchecking the Show Grid box accordingly. If the grid is shown, the grid line
pattern can be solid or dashed. The
pipes and junctions can also be
snapped to the grid, which moves junctions and pipe end points to the
closest intersection of grid lines.
2D Orthogonal drawing mode can be
enabled in the drawing area. This
provides automatic Workspace drawing guides in which vertices are automatically inserted into pipes to enforce
drawing only along the horizontal and
vertical. When junctions are moved
with connected pipes, then pipes may
also have vertices inserted to maintain
orthogonality. The various pipe drawing modes can also be toggled on the
Arrange menu.

Pipes
The display of pipe lines, closed pipes,
pipe endpoints, and pipe direction
arrows can be adjusted according to
your preferences here.
Pipe line thickness can be adjusted
from 1 to 10 pixels by selecting the
desired pixel value in the box next to
Pipe Line Thickness (pixels). You may
choose to show all pipes as having the
same thickness, or you can vary the
thickness with an increasing pipe diameter. If varying the thickness according to the pipe diameter, you can allow
xStream to vary the thickness in a
gradual fashion with larger diameters
shown as having increasingly larger
thicknesses, or you can customize two
diameters between which the
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thickness will vary. In the latter case,
any pipes with diameters below this
minimum value will have the pipe thickness of the minimum diameter pipe,
and any pipes with diameters above
this maximum value will have the pipe
thickness of the maximum diameter
pipe. To customize the pipe thickness
variation, input the minimum and maximum diameter between which you
wish the pipe thickness to vary, as well
as the pipe thickness that will represent the minimum diameter pipe and
the pipe thickness that will represent
the maximum diameter pipe. The pipe
thickness will vary in a linear fashion
between the two diameters specified.
From the User Options window, you
can select how you would like a closed
pipe to be displayed in the workspace.
The options include a solid line,
dashed line, a dotted line, and
dashed-dotted combinations.
When building a model, xStream automatically adjusts pipe endpoints to the
centers of junctions for user convenience. If you would like to disable
this feature, uncheck the box next to
Automatically Adjust Pipe Endpoints
to Junction Centers in the Pipes window.
The display of flow direction arrows on
the pipes can also be adjusted. Under
the Pipe Direction Arrows section of
the Pipes window, you can select the
size of arrow you would like to be displayed as a percentage of the pipe
thickness. Additionally, you can opt to
not show a pipe direction arrow by
checking the option Do Not Show
Arrow.

Note: The pipe direction arrow is
used as a reference direction
for flow and does not change
direction on the workspace if
the calculated flow is in the
opposite direction indicated
by the arrow. Instead, the
flow is reported as a negative
flow in the output.

Junctions
The junction icon style displayed on
the Workspace can be chosen in Junctions underneath the Workspace section in the User Options window. The
two available icon styles include classic icons and transparent icon. Classic
icons are the icons used in earlier versions of AFT products in which each
junction is surrounded by a box, and
transparent icons are updated icons
not surrounded by boxes.
You can also select the icon size and
label location for junctions. To adjust
the size, click on the box below Icon
Size in the Junctions window and
choose the percentage of the default
size that you would like the junction
icons to be sized. For the junction
label location, you can select from any
of the eight locations shown in the window by clicking on the selection circle
that corresponds to the desired location.
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Note: Junction and pipe labels can
be moved individually on the
Workspace by using the
mouse to drag and drop the
label according to your preferences.
The final option in the Junctions window of the User Options is to enable
or disable a dotted outline around a
closed junction. If this option is
enabled, a dotted box will appear
around the junction. If this option is disabled, no dotted box will appear.

Labels
Display settings for pipe and junction
labels on the Workspace can be customized under Labels in the Workspace section of the User Options
window. When a pipe or junction is
inserted onto the Workspace, the next
whole number available at the increment specified in this window is automatically assigned to the new pipe
and/or junction. xStream's default is to
increment pipe and junction numbers
by one. Therefore, the first pipe you
place on the Workspace will automatically be labeled as Pipe 1 (P1 for
brevity), the second will automatically
be labeled P2, etc. Junctions are
labeled in a similar fashion with a "J" in
front of the number to indicate it is a
junction. However, if you choose a different increment in the User Options
window for pipes and/or junctions, the
automatic numbering will increment
pipes and/or junctions according to

the specified number. You can renumber any pipe or junction individually as
long as the number is not already
used in any scenario of the model. If a
number at the increment is already in
use, xStream will skip to the next available whole number. Pipe and Junction
label numbers are limited to integers
between 0 and 99,999.
Note: A unique label must exist for
each pipe and junction on the
Workspace. Therefore, there
cannot be more than one P1
in the model, but a P1 and J1
can exist simultaneously
because the leading letter is
different.
Additionally in this section in the User
Options window, you can select if you
would like the pipe and/or junction
numbers only to be displayed, if you
would like the names only to be displayed, or if you would like both the
name and number to be displayed. To
choose which display option you
would like, select the radio button next
to the desired display option under
Pipe/Junction Default Display.
Note: If you would like a pipe
and/or junction display label
type to vary from the default
option selected in Labels in
the User Options window,
you may choose the display
label type for individual pipes
and junctions in the Optional
tab of the individual pipe or
junction properties window
under Display on Workspace.
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You can also choose whether the pipe
and junction labels should be moveable at all times, or if they should only
be moveable when the user is holding
down the shift key. Select which
option you prefer by clicking on the
radio button next to your preference.
Restricting the movement of labels
can be especially helpful to users with
complicated or dense models, as it is
possible to inadvertently grab a label
when attempting to reposition or
select an icon on the Workspace.

Colors and Fonts
The Colors and Fonts window located
under the Workspace section in the
User Options window allows you to
change the colors of the following parameters seen on the Workspace:
l

Pipe and Junction Symbols

l

Junction Numbers

l

Pipe Numbers

l

Pipes

l

Selected Items

l

Undefined Numbers

l

Workspace Background Base
Scenario

l

Workspace Background
Children

l

Workspace Background of
Grandchildren

l

Workspace Background 3rd
Generation

l

Workspace Background 4th
Generation +

l

Grid

The currently selected color for each
parameter is shown to the right of the
parameter. To change the color for
any parameter, either select the box
containing the parameter's color and
then click on the Set Color box under
the list, double click on the box containing the color you would like to
change, or click the "..." button next to
the color of the parameter you would
like to change. A color window pops
up that allows you to choose from 48
basic colors, or to create a custom
color by clicking anywhere in the color
box and adjusting the slider at the right
of the box to create the color of your
choice. If you would like to save the
custom color for use in other areas of
the model, click on any empty box
underneath Custom colors: and then
click on the Add to Custom Colors box
below the color box. When finished
with selecting a color, click OK on the
bottom left of the Color window.
If you would like the background color
of the children and grandchildren scenarios to maintain the same color as the
base scenario, click on the Set All
Background Colors to Base Color button under the Parameter/Color list.
You may also choose to change the
font of all junction and pipe names and
numbers by clicking on the Change
Font button to the right of the Font for
Junction and Pipe Numbers on the Colors and Fonts box in the Workspace
section. A preview of the current font
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is given underneath the Font for Junction and Pipe Numbers title.

Other
Symbols representing pipe or junction
special conditions and inflow or outflow are listed in the Other window
under the Workspace section in the
User Options window. These symbols
can be changed by the user. To
change a symbol, click on the box containing the symbol you want to
change, and type in the new symbol.
If you choose to include a background
picture in your model, you can adjust
the picture size in this section, as well.
To scale a background picture, enter a
Scale Multiplier in the box underneath
Background Picture Scaling.

Parameters
The Parameters section of the User
Options window allows you to specify
some default parameters and model
input when a new pipe or junction is
added to the Workspace. Changing
any of the parameters in this window
adjusts the specified default pipe
and/or junction input parameters
and/or values to simplify the modeling
process and to prevent the user from
having to enter repetitive data.

Pipes and Junctions
Pipe and Junctions, located within the
Parameters section of the User

Options window, allows you to specify
default pipe and junction input information.
Under the Default Pipe Data box in
this window, you can enable or disable
the option Use Most Recent Pipe Size
Data. If you enable Use Most Recent
Pipe Size Data, the pipe property windows of new pipes added to the Workspace will automatically contain pipe
diameter, material, and friction information from the most recently entered
pipe. This prevents you from having to
re-enter the pipe diameter, material,
and friction model information in the
case that several pipes require this
same input. Disabling this feature
leaves the pipe diameter, material,
and friction model for each new pipe
added to the Workspace as the default
specified in the User Options window.
The Default Junction Elevation box
allows you to select the default junction elevation you would like for all
new junctions added to the Workspace. If you select Unspecified in this
box, the junction elevation field in the
Junction Properties window remains
empty until you specify each junction
elevation individually. If you select
Use Most Recent, the junction elevation of a new junction added to the
Workspace is shown as the elevation
of the most recently specified junction.
If you select Specified, you are able to
input an elevation of your choice that
will automatically be input into each
new junction that is added to the Workspace.
The Default Design Factors box
allows you to add a default Design
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Factor to each pipe shown in the list
on the Pipes and Junctions window.
Setting a default design factor for
pipes can be especially useful when
applying safety factors on given equipment.

Files
The Files section of the User Options
window allows you to specify file locations for saving models, database
folders, user settings, and model
backup files. You can also customize
the model backup file settings here.

contains the library, select the location, and click OK. You can add multiple folders to be searched. To add
additional folders, repeat the process
for each folder.
The User File consists of all saved settings and preferences. In order to
backup these user settings in a *.ini
file, click Add under User File Backup
Locations. Browse to the file location
in which you would like to save these
settings. Once you have selected the
desired file location, click OK. Note
that the User File can be saved in multiple locations. To add additional locations, repeat the process for each
folder that you would like to save the
settings.

File Locations
Under File Locations in the Files section of the User Options window, you
have the option to select the default
folder in which to save your model. If a
default model folder is specified, this
location will be the default location to
save the model. To specify the default
location, click Add below the Default
Model Folder box and browse to the
location you want to set as the default
folder. Once you have selected the
folder, click OK. The location of the
default model folder will then show in
the Default Model Folder box. You can
add more than one default folder, but
only the folder selected in blue will be
the active default folder.
To specify locations for xStream to
search for library files, click Add under
the Library Search Locations box.
Browse to the file location that

Backup Settings
A backup file is a copy of a previously
saved version of your *.xtr file that can
function as a complete, standalone
model. These files are used as a
safety measure to provide you with
one or more previous versions of the
model in the case that the current
model is deleted or damaged.
To customize the amount of backup
files (i.e. the number of previously
saved versions of the model) and the
frequency that the model is saved,
open the Backup Settings window,
which is located under the Files section of the User Options window.
From the Backup Settings window,
choose the total number of backup
files you want to save by clicking on
the drop-down box next to Number of
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Backup Files Created and specify the
total number of files. After the model
has been saved initially, subsequent
instances of saving the model will create a new backup file each instance
until the number of backup files saved
equals the number of backup files specified in Backup Settings. The most
recent backup file will always contain
the file extension *.bak001. The file
extension of earlier versions is
numbered in chronological order with
earlier versions receiving larger numbers in the file extension. Therefore,
given any model file, the backup file
with a file extension of *.bak002 will
always contain the model file saved
after (more recently than) the backup
file containing the file extension of
*.bak003. Likewise, for the same
model, the backup file with the file
extension of *.bak003 will always contain the model file saved after (more
recently than) the backup file containing the file extension of *.bak004.
This extension naming convention
applies to any number of backup files.
If you want xStream to automatically
save the model file periodically when
the file is open, tick the box next to
Automatically Save Model and select
the frequency in the drop-down box.
If you need to use a backup file as a
standalone model, change the extension to .xtr for the backup file, and
open the file in xStream.
You can opt to save no backup files by
choosing "0" in the Number of Backup
Files Created box.

Encoding
The File Encoding option can be set to
"Unicode" in order to use characters
outside of the standard english keyboard such as diacritics, cyrillic, etc for
text fields such as the pipe/junction
name, notes, etc.
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File Import and Export
This section focuses on the various
file types that can be imported and
exported from AFT xStream. Topics
included discuss importing piping layouts from various sources, importing
and exporting between AFT products,
and importing and exporting data with
Excel.

Contents
Importing Piping Component
Files
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Importing GIS Shapefiles
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Importing and Exporting Epanet
Files
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Other AFT Products
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Exporting to Excel
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Importing Excel Data
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Related Blogs
Meet the Import Piping Layout Wizard
Now it’s Super Easy! Changing Input
Data in AFT Models using Excel
Change Data

That was EASY! Quickly Change Pipe
and Junction Input Data into AFT models using Excel Change Data

Importing Piping Component Files
AFT xStream includes the ability to
import Piping Component Files (.pcf),
which can be generated by a wide
range of software, and provide a quick
way to get started with the transient
modeling portion of a project. Files
can be imported into existing models.
Selecting File > Import Piping Layout
From > Piping Component File (.pcf)
brings up the Import Piping Layout
Wizard in the Quick Access Panel, as
shown below in Figure 1.
The Import Piping Layout Wizard is
organized into sections that help guide
the import process:
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l

Folder Browser - After browsing to a folder, all .pcf files
within the folder will be listed
here. Simply clicking a file in
the list will show a preview of
the import in the Workspace.
The location of the preview can
be moved by dragging the icon
in the upper-left of the selection
area.

l

Object List - When a file is
selected, the objects to be created will be listed here. Each
individual object can be reassigned to a certain Junction, if
the automatic assignment is
not correct. For example, the
originating software may have
only had a "valve" while this
could be a Relief Valve or a
Control Valve. Changing the
AFT Object type will change
the preview in the Workspace.
Right-clicking on an object
shows a menu for converting
object types.
l

l

Property Window This button opens an
additional panel that
shows the raw properties for the currently
selected object.
Link Materials - Opens
the File Object Link window, where the Materials Codes from the pcf
file can be associated
with a pipe material,
size, and type in the AFT
Pipe Material library.

The selection from the
AFT Pipe Material library
will overwrite any diameter information from
the pcf file. Selections
made for a pcf material
will be applied to all
pipes that reference that
pcf material. Pipes associated with each material can be seen by
clicking the arrow on the
left expand the group
(Figure 2).
l

l

Show Ignored Objects
- Certain types of
objects are ignored on
import - these can be
objects such as flanges,
or additional file components such as materials or bolt
specifications.

Options
l

Min Pipe/Max Pipe Information fields on the
length of the shortest
pipe and longest pipe in
the list of pipes to be
imported.

l

Ignore Pipes of Length
Less Than - Do not
import pipes shorter
than this amount.

l

Ignore Pipes of Diameter Less Than - Do
not import pipes smaller
than this diameter.
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l

Ignored Pipes - How
many pipes will be
ignored based on the
above settings. Ignoring
pipes can be helpful in
keeping a model clean
and free of unnecessary
components. For
example, a pipe stress
software may require
many short pipe segments in between welds
or flanges. However,
these types of connections are almost
always ignored for gas
transient analysis. By
ignoring short pipes, the
amount of "import clean
up" required can be
reduced.

l

Preferred Scale - The
wizard will Auto Scale
the import by default. If a
different scale is
desired, this option can
be disabled and a custom scale entered.

l

Show Pipes in Preview
- Display the pipes in the
Workspace preview.

l

Show Junctions in Preview - Display the junctions in the Workspace
preview.

l

Combine Pipes When
Possible - It is required
that all pipes in the Workspace be connected by
two junctions. However,

this is not a requirement
in all software. Therefore, some .pcf files may
be generated with several pipes "end to end."
If the pipes were imported this way, either junctions would need to be
added, or the pipes
would need to be manually combined, before
the model could be
solved.
l

Import Bends as Pipes
- Pipe bends can be considered as junctions or
simply a visual change
in direction of the pipe.
This is identical to using
segments to show piping layout. Note that
these bends are visual
only and have no losses
associated with them to account for losses,
either junctions or fittings & losses must be
used. This option is helpful to reduce unnecessary model clutter.

l

Ignore Fitting Lengths
- Neglects additional
length added to pipes
that accounts for the
equivalent length of fittings and losses, and is
not actually part of the
physical pipe length.

l

Import Data to Pipe or
Junction Notes Field Add the raw data from

327

Quick Start Guide
the originating file to the
Notes tab of the corresponding object.

Figure 2: File Object Link window for Piping Component File Import

Related Blogs
Meet the Import Piping Layout Wizard

Importing GIS Shapefiles
Import GIS Shapefile
Figure 1: Piping Component File Import

GIS Shapefiles that adhere to the
ESRI standard can be imported into
xStream for ease of model creation.
These files have the extension .shp,
but there are two other supporting file
types that need to be in the same
folder as the .shp in order for the
import to work correctly. These are
.shx and .dbf file types. The option is
located under File > Import Piping Layout From > GIS Shapefile (.shp). This
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opens the "Import Piping Layout Wizard" in the Quick Access Panel that
allows the importing of one line .shp
that is of pipes and multiple point .shp
files for branches, valves, compressors/fans, and tanks. Once the
.shp files have been added to this window the object type, scaling, and mapping can be selected.

l

Pipes can map:
l

Labels - Names

l

Length - If no length is
imported, the pipe
lengths will be calculated based upon the
shapefiles scaling.

l

Friction - Absolute
Roughness, Relative
Roughness, and Explicit
Friction Factor friction
models are available.

l

Inner Diameter

Type
Any .shp files that are of lines are automatically set to the object type of
"Pipes". Only one .shp file containing
lines can be imported at a time. Any
.shp file that is of points can be set to
Branches, Valves, Compressors/Fans, or Tanks.

l

l

Scaling
The default scaling is 1 grid point to 1
foot. This can be adjusted by selecting
the "..." button in the Scaling column.
This button opens a new window in
which a new scale can be committed
to the shapefile. This window also
allows the viewing the coordinates of
specific points and parts of different
shapes within the shapefile.

Mapping
The Data Mapping window allows the
user to select what data fields have relevant data for xStream to import.

l

l

Branches can map:
l

Labels - Names

l

Elevation

Compressors/Fans can map:
l

Assigned Flow Imports as a Fixed
Flowrate compressor

l

Labels - Names

l

Elevation

Tanks can map:
l

Labels - Names

l

Elevation

Valves can map:
l

Labels - Names

l

Elevation

Related Blogs
Meet the Import Piping Layout Wizard
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the preview in the Workspace.
Right-clicking on an object
shows a menu for converting
object types.

Importing Caesar II
Netral Files
AFT xStream includes the ability to
import CAESAR II Neutral Files (.cii),
providing a quick way to get started
with the transient modeling portion of
a project. Files can be imported into
existing models.
Selecting File > Import Piping Layout
From > CAESAR II Neutral File (.cii)
brings up the Import Piping Layout
Wizard in the Quick Access Panel, as
shown below in Figure 1.

l

Property Window This button opens an
additional panel that
shows the raw properties for the currently
selected object.

l

Link Materials - Opens
the File Object Link window, where the pipes
can be associated with a
pipe material, size, and
type in the AFT Pipe
Material library. The
selection from the AFT
Pipe Material library will
overwrite any diameter
information from the CII
file, and will be applied
to all of the pipes.

l

Show Ignored Objects
- Certain types of
objects are ignored on
import - these can be
objects such as flanges,
or additional file components such as materials or bolt
specifications.

The Import Piping Layout Wizard is
organized into sections that help guide
the import process:
l

l

Folder Browser - After browsing to a folder, all .cii files within
the folder will be listed here.
Simply clicking a file in the list
will show a preview of the
import in the Workspace. The
location of the preview can be
moved by dragging the icon in
the upper-left of the selection
area.
Object List - When a file is
selected, the objects to be created will be listed here. Each
individual object can be reassigned to a certain Junction, if
the automatic assignment is
not correct. For example, the
originating software may have
only had a "valve" while this
could be a Relief Valve or a
Control Valve. Changing the
AFT Object type will change

l

Options
l

Min Pipe/Max Pipe Information fields on the
length of the shortest
pipe and longest pipe in
the list of pipes to be
imported.

Index 330
l

Ignore Pipes of Length
Less Than - Do not
import pipes shorter
than this amount.

l

Show Junctions in Preview - Display the junctions in the Workspace
preview.

l

Ignore Pipes of Diameter Less Than - Do
not import pipes smaller
than this diameter.

l

l

Ignored Pipes - How
many pipes will be
ignored based on the
above settings. Ignoring
pipes can be helpful in
keeping a model clean
and free of unnecessary
components. For
example, a pipe stress
software may require
many short pipe segments in between welds
or flanges. However,
these types of connections are almost
always ignored for gas
transient analysis. By
ignoring short pipes, the
amount of "import clean
up" required can be
reduced.

Show Labels In Preview - Show the corresponding label from
the .cii file in the Workspace preview. This is
only shown in the preview and will not be
imported into the model
itself.

l

Combine Pipes When
Possible - It is required
that all pipes in the Workspace be connected by
two junctions. However,
this is not a requirement
in all software. Therefore, some .cii files may
be generated with several pipes "end to end."
If the pipes were imported this way, either junctions would need to be
added, or the pipes
would need to be manually combined, before
the model could be
solved.

l

Import Bends as Pipes
- Pipe bends can be considered as junctions or
simply a visual change
in direction of the pipe.
This is identical to using
segments to show piping layout. Note that
these bends are visual
only and have no losses

l

l

Preferred Scale - The
wizard will Auto Scale
the import by default. If a
different scale is
desired, this option can
be disabled and a custom scale entered.
Show Pipes in Preview
- Display the pipes in the
Workspace preview.
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associated with them to account for losses,
either junctions or fittings & losses must be
used. This option is helpful to reduce unnecessary model clutter.
l

Ignore Fitting Lengths
- Neglects additional
length added to pipes
that accounts for the
equivalent length of fittings and losses, and is
not actually part of the
physical pipe length.

l

Import Data to Pipe or
Junction Notes Field Add the raw data from
the originating file to the
Notes tab of the corresponding object.

Figure 1: CAESAR II Neutral File Import
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not correct. For example, the
originating software may have
only had a "valve" while this
could be a Relief Valve or a
Control Valve. Changing the
AFT Object type will change
the preview in the Workspace.
Clicking on an object in the
workspace highlights it in the
wizard.

Importing and Exporting
Epanet Files
AFT xStream includes the ability to
import and export EPANET Files
(*.INP). EPANET is public domain
modeling software developed by the
US Environmental Protection Agency.
Many different applications support
the file format, so it can therefore
provide a quick way to get started with
the transient modeling portion of a project.
Selecting File > Import Piping Layout
From > EPANET File (.inp) brings up
the Import Piping Layout Wizard in the
Quick Access Panel, as shown below
in Figure 1. Note that importing from
EPANET requires that the Workspace
be empty.

l

Property Window This button opens an
additional panel that
shows the raw properties for the currently
selected object.

l

Link Materials - Opens
the File Object Link window, where the pipes
can be associated with a
pipe material, size, and
type in the AFT Pipe
Material library. The
selection from the AFT
Pipe Material library will
overwrite any diameter
information from the
EPANET file, and will be
applied to all of the
pipes.

The Import Piping Layout Wizard is
organized into sections that help guide
the import process:
l

l

Folder Browser - After browsing to a folder, all .inp files
within the folder will be listed
here. Simply clicking a file in
the list will show a preview of
the import in the Workspace.
The location of the preview can
be moved by dragging the icon
in the upper-left of the selection
area.
Object List - When a file is
selected, the objects to be created will be listed here. Each
individual object can be reassigned to a certain Junction, if
the automatic assignment is

l

Options
l

Min Pipe/Max Pipe Information fields on the
length of the shortest
pipe and longest pipe in
the list of pipes to be
imported.

l

Ignore Pipes of Length
Less Than - Do not
import pipes shorter
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than this amount.
l

Ignore Pipes of Diameter Less Than - Do
not import pipes smaller
than this diameter.

l

Ignored Pipes - How
many pipes will be
ignored based on the
above settings. Ignoring
pipes can be helpful in
keeping a model clean
and free of unnecessary
components. For
example, a pipe stress
software may require
many short pipe segments in between welds
or flanges. However,
these types of connections are almost
always ignored for gas
transient analysis. By
ignoring short pipes, the
amount of "import clean
up" required can be
reduced.

l

Preferred Scale - The
wizard will Auto Scale
the import by default. If a
different scale is
desired, this option can
be disabled and a custom scale entered.

l

Show Pipes in Preview
- Display the pipes in the
Workspace preview.

l

Show Junctions in Preview - Display the junctions in the Workspace
preview.

l

Import Data to Notes
Field - Add the raw data
from the originating file
to the Notes tab of the
corresponding object.

l

Auto-Zoom Preview This option can be
enabled to automatically
zoom out so that the
whole model can be
seen in the workspace,
which can be convenient
for large systems.
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Related Blogs
Meet the Import Piping Layout Wizard

Importing and Exporting
from Other AFT
Products
Models made in other AFT products
such as AFT Arrow can be opened directly in AFT xStream and vice versa.
This can be a useful starting point
when it is desired to perform additional
analysis on a model that has already
been built in another AFT product,
such as if it is desired to perform transient analysis on a system previously
built in AFT Arrow.
To convert a model from one AFT
product to another just browse to the
model you would like to convert and
open it in the software you are converting the model to. This can be done
by changing the file extension selected, as is shown below in Figure 1.
Note that though AFT Fathom and
AFT Impulse are not explicitly listed,
models from Fathom and Impulse can
also be converted by selecting "All"
and browsing to the model file.

Figure 1: EPANET Import/Export Dialog

When the model is opened in AFT
xStream a backup copy of the original
model will be created from which the
original model can be restored if
needed. See the Backup Settings
explanation for more information on
backup files.
The conversion process will automatically change junction types not

335

Quick Start Guide

included in AFT xStream, such as the
Spray Discharge junction, to either a
General Component or Branch junction. Be aware that some features
available for use in other AFT
products are not available for use in
AFT xStream. If a junction is defined
using a feature not available in AFT
xStream, the non-applicable information will be removed, and the user
may be required to input additional
information to fully define the model. It
is advised to fully review the model
after import.

spreadsheet. Specific values from the
model can be exported, as well as
columns, rows, or entire output tables
as defined in Output Control. These
items are controlled with the Excel
Export Manager, available from the
File menu.

Figure 1: The Excel Export Manager

Adding Items to the Excel
Export Manager
Figure 1: File extensions options for
Open File window

Exporting to Excel
AFT xStream includes a powerful ability to export any Output data to any
specific cell(s) in an Excel

Data from the Output can be added to
the Excel Export by clicking New, or
by selecting an existing item and clicking Duplicate. Items can also be created directly from the Output Window
by right-clicking on a cell or header.
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Figure 2: Adding items directly from the
Output

Each row in the Excel Export Manager
corresponds to a cell, column, row, or
table of data to be added to the spreadsheet. Each column helps define what
data will be transferred where. The
grid below the entries shows a preview of where the data will be added to
help prevent intersecting data by showing where there are overlapping
regions. Note that graph items can
vary in size and do not show a complete region here.
l

l

Apply to Export - Items can be
optionally included or excluded
from the export.
Export Type - What type of
data is being exported. This
affects other settings, and will
affect how much room is
required on the target Excel
sheet.
l

Single Value - The
value of a single parameter for a single pipe or
junction object.

l

l

Column - Values of a
single parameter for all
of the displayed objects.

l

Row - Values of all displayed parameters for a
single object.

l

Table - Values of all displayed parameters for
all displayed objects.

l

Graph - The graph
points from a specified
Graph List Item.

l

Other - Additional
information not available
in a standard Output
table, such as Fluid
definition, Model Title, or
Scenario Names.

Source - Where the data is
coming from.
l

Pipe - From the steadystate Pipe section of the
output.

l

Axial Points - From the
Axial Points tab in the
pipe output section

l

Junction - From the
Junction section of the
output.

l

General Output Summary - From one of the
available output Summary sections. For
example, if there is a
compressor junction in
the model, Compressor/Fan Summary is
available.
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l

Transient Max/Min From the Transient
Max/Min tab in the Pipes
section of the output.

l

Forces - From the
Forces tab in the pipe
output section

l

l

l

model. It is important to recognize that the Excel Starting
Cells can be defined in a way
that data gets overwritten. The
Ending Cell column is a handy
reference to help avoid this.
l

Header - Optionally export the
name of the Parameter(s)
related to the item.

l

Units - Optionally export the
name of the Unit(s) related to
the item.

l

Add Excel Comments Optionally adds an Excel comment to the value cell that contains the Parameter name and
unit.

l

Show Example - Displays an
example of how the exported
cells will appear.

Graph - From a specified Graph List Item.

Object - The object in particular that is desired. If Column
or Table are selected for Export
Type, this selection will be fixed
to ALL.
Parameter - The parameter in
particular that is desired. If
Row, Table or Graph are selected for Export Type, this selection will be fixed to ALL.

l

Units - The units of the exported value. This is available only
for Single Value and Column
Export Types. Some parameters do not have units and
this will display N/A.

l

Excel Sheet - Which Excel
Sheet to export to. This value
can be edited by the user - if it
is desired to export to a named
sheet this can be entered here.

l

Excel Starting Cell - The
upper-left cell to export the data
to.

l

Excel Ending Cell - The automatically calculated lower-right
cell of the data, which depends
on the Export Type, export
options, and the number of
parameters or objects in the

Figure 3: Example Export
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changes made need to be
manually saved by the user
in Excel.
There are two options available for
exporting:
l

Clear Sheet Data - All of the
existing data on the sheets specified in the Excel Sheet
column will be cleared. This is
especially useful for setting up
a new export when many
changes are being made.

l

Automatically Export After
Running Model - After the
model is run, the Export will be
carried out automatically, per
the settings defined by the user
in the Excel Export Manager.

Figure 4: Result of the above example.
Color added for emphasis.

Excel Export Location
After all of the desired data has been
added to the Excel Export Manager,
the next step is to actually export the
data. There are three options available for the export:
l

l

l

Create New Workbook - A
new Excel Workbook will be
opened with the exported data.
Previously Saved Workbook
- Browse to a Workbook saved
to file. The Workbook will be
opened and the modifications
made to the sheets as specified.
Currently Opened Workbook
- Select a Workbook that is currently open in Excel. The
already open Workbook will be
modified.

Note: The Excel Export Manager
does not save Excel files for
non-batch run exports. Any

Advanced Options
Items can be added directly from the
Output instead of adding custom items
with the New button. There are two
behavioral options that can be modified for this action:
l

Open Excel Export Manager If enabled, the Excel Export
Manager will be opened every
time an item is added from the
Output. This is useful for
double checking the setup.

l

For Existing Items l

Add New Item - The
item selected will be
added to the Excel
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l

Export Manager even if
it already exists.

never saved, but in batch mode it is
required.

l

Select Existing - If the
item already exists, do
not add a duplicate item
and instead select the
existing item.

l

Ask - If the item already
exists, prompt the user
on the action to take.

In the Batch Run tool, users are also
able to use Excel Export without having to run the scenarios again. Note
that if any of the scenarios in the Batch
Run do not have output, the batch
Export Only will not export any data for
that scenario, as it will not run those
scenarios to get output.

Create an Export Guide When exporting, an Export
Guide can optionally be
included in the export. The
Export Guide contains information about the model and the
generation of the export, to
help keep the connection
between the data and the
model clear for future reference.

Exporting Data From Multiple
Scenarios
The Excel Export Manager can be
employed with Batch Runs with a
couple of important distinctions.
First, if multiple sheets are specified in
the Excel Export Manager, the only
way to export multiple scenarios is to
export every scenario to its own
Workbook. To keep data from multiple scenarios in one Workbook, there
can only be one sheet specified in the
Excel Export Manager.
Second, the Excel File will be saved
after each scenario. In normal
single-scenario exports the file is

Figure 5: Saving Results From Multiple
Scenarios
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Related Blogs
Quick Guide to Custom Output
Paint a Clear Picture Faster Than
Ever with AFT's New Excel Export
Manager

Importing Excel Data
A Microsoft Excel spreadsheet can be
used to make changes to objects in an
AFT xStream model. The values in the
Excel file are located in specific locations as described in the Setting Up
Excel section.

recommended to enter the values
above for the header row.
Each column has certain accepted values, which can depend on the values
in neighboring columns.
Note: A template spreadsheet containing validation rules for the
required layout is included in
the AFT xStream installation.
By default the file path is:
C:\AFT Products\AFT
xStream\AFT xStream Excel
Import Workbook.xlsx

Apply Column
Setting Up Excel
When reading an Excel file, AFT
xStream will search for a worksheet
named AFT Transfer. There can be
other worksheets in the workbook but
xStream will only look for a sheet with
this name. The file structure looks like
the following:

This column accepts Yes or No. Only
changes marked as Yes will be imported into the model.

Object Type
This column must be a junction name
or Pipe. Valid choices can be seen
below in Table 1.

Object Number

Figure 1: Sample AFT Transfer Excel
Sheet

Row 1 and column A are not read by
AFT xStream - these cells can have
any value in them, though it is

This corresponds to the junction or
pipe number.

Parameter
The specific parameter to be changed.
These parameters vary based on the
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Object Name selected. Each parameter has a type (C/S/I) associated
with it, as is explained in the next section.

Parameters are decimal numbers,
integers, or strings.

Table 2: Valid Change Codes for each
type of Parameter
Table 1: Object Types, Associated Parameters, and Change Codes

Value
The actual value to change the Parameter to or by.
For special conditions there are specific values assigned to each special
condition option, as are listed in the
table below.

Table 3: Values used to import special
conditions

Change Code
Each Parameter has restrictions on
how it can be changed. All of the
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Scenario Path Name
The Scenario that the changes are
intended to apply to. If no scenario is
present, the changes will be applied to
the current scenario.
It is important that the Scenario name
is uniquely qualified - if there are multiple scenarios with the same name,
the full Scenario Path Name can be
used. Scenario Path Names can easily be copied from AFT xStream by
right-clicking the scenario name and
selecting "Copy Scenario Path Name."

Importing the File
When the sheet has been completely
filled out, it can be imported from File > Import Excel Change Data. When
importing the data, the Object Change
Log will appear, listing the changes
that were made and any errors that
occurred during the import.

Table 4: Excel Importing Error Messages

Note: In order for the junction to
accept the changes, some
fields must already contain
data. For example, if the control setpoint for a control
valve is being changed, there
must already be a setpoint
and units entered into the control valve junction object. This
is to ensure that the correct
set of units are being used.
These values can be set
using Global Edit to an arbitrary value before the
changes are made from
Excel.

Related Blogs
Now it’s Super Easy! Changing Input
Data in AFT Models using Excel
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Change Data
That was EASY! Quickly Change Pipe
and Junction Input Data into AFT models using Excel Change Data

Index 344
Figure 1: Design Alert Manager

Design Alerts
Design Alerts are a powerful feature
that can help speed up the modeling
process and help verify that the model
is behaving as expected. The creation
of a Design Alert does not constrain or
affect the operation of the model in
any way. However, it automatically creates an output alert any time the
design limit is violated. One common
use case might be defining a maximum allowable pressure for the pipes
in the model. While the output can be
reviewed manually for these violations, this quickly becomes tedious
as the model grows in size. Creating a
Design Alert instead allows the engineer to spend less time reviewing output tables as any violation will be
immediately identified.
The Design Alert Manager allows the
user to create or modify Design Alerts.
It can be accessed from the Tools
Menu or in the Design Alerts tab in
pipe and junction properties windows.
Design Alerts can also be created directly from the output, or can be imported/exported for use in other models.

Creating and Applying
Design Alerts
Click Create New Design Alert to add
a new Design Alert to the model. The
Design Alert Manager expands to
allow the creation of the new alert.
A Name, Object Type, and at least
one Parameter are required. Depending on the Object Type, a different
selection of Parameters is available,
as shown below. To add a Parameter:
1.

Select the desired parameter

2.

Select whether this is the maximum or minimum allowable
value

3.

Enter the value with the appropriate units (if applicable)

4.

Click Add to List.

Several Parameter limits can be
added to one Design Alert. For
example, an alert can be created that
requires a pressure within a range by
adding both the maximum and minimum pressure limits.
To update a Parameter, simply create
it again and click Add to List - the old
value will be replaced with the new
one.
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Figure 4: An Existing Design Alert

The Design Alert now exists, but has
not yet been applied to any objects in
the model. To include objects in the
model, select them in the pane on the
right.
Figure 2: Creating a Design Alert

Figure 3: Available Design Alerts

At this point, the Design Alert still has
not been created. To finalize it, click
"Update/Add Design Alert."

Figure 5: Fully Defined Design Alert

Note that the application of Design
Alerts can also be managed for individual objects in their Properties Window's Design Alerts tab.
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Figure 7: Design Alert Violations in Output

Figure 6: Apply Desired Design Alerts to
this Object

When running the model, the selected
object's output values will be checked
against the limits that have been
defined. If any of the Design Alerts are
violated, the user will receive a Design
Alert warning and the violating parameters will be highlighted in the output
tables.

Design Alerts can be cross-plotted in
the Graph Results window vs. the
actual results. One good example
where this is useful is for cross-plots of
maximum and minimum allowed operating pressures.
Design alerts are visible in every scenario in a model, but can be turned off
or on for specific scenarios. When creating a design alert for the first time it
will be active in that scenario and all its
child scenarios. For more information
about scenarios, please read the Scenario Manager help topic.

Design Alerts From Output
Right-clicking on a cell in the Output
Window brings up a context menu.
One of these options is Create Design
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Alert...

and whether it is a maximum or minimum can be selected. The associated
object is automatically selected as
part of the Design Alert, but this is not
required and additional objects can be
selected now.
After the Design Alert has been created it can be further modified in the
Design Alert Manager.

Figure 1: Output Context Menu

Create Design Alert automatically
defines a Design Alert based on the
selected value and quantity:

Design Alert Importing &
Exporting
Design Alerts can be exported to a
text file to be imported into other
model files. This allows the user to
quickly load commonly used design
alerts into multiple model files.

Export a Design Alert
To export a Design Alert:

Figure 2: Automatically defined Design
Alert

The Design Alert needs to have a
name defined to be added. The specific value of the alert can be modified,

1.

Fully define a Design Alert for
any parameter in the Design
Alert Manager. For this
example, we are using a velocity design alert (Figure 1).

2.

From the Other Actions menu,
select Save, then save the file
with a descriptive name.
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Figure 1: Defined Design Alert window

Import a Design Alert
1.

Open the Design Alert Manager
from the Tools menu.

2.

From the Other Actions menu,
select Load, then browse to the
saved design alert file.

3.

The Design Alert should now be
added to the Existing Design
Alerts list, and can be applied to
objects in the model.
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Scenario Manager
The Scenario Manager (in the Quick
Access Panel) is a powerful tool for
managing variations of a model,
referred to as scenarios. It lets you to
quickly test the same model with selected differences (such as compressor
size, pipe diameter, system location,
units, etc.) to find the system which
works best. The Scenario Manager
allows you to:
l

Create, name, and organize
scenarios

l

Select the scenario to appear in
the Workspace (the ‘current’
scenario)

l

Delete, copy, and rename scenarios

l

Duplicate scenarios and save
them as separate models

l

Review the source of a scenario’s properties

l

Pass changes from a scenario
to its variants

l

See what scenarios have output by automatically changing
the text color to blue if they
have output

All scenarios are saved within the
model file.

Scenario
A variant case of a model that is created in the Scenario Manager.

Base Scenario
The Base Scenario is the root scenario at the top of the scenario tree. As
the highest level ancestor, It does not
inherit from any other scenario. A new
scenario can be inserted above the
base scenario, at which point the new
scenario would behave as the base
scenario, and the original base scenario would behave as a child scenario.
"Base Scenario" is the default name
given in a new, single scenario model.

The Scenario Manager
Illustrated in Figure 1, the top of the
Scenario Manager displays the scenario tree, showing the names of the
currently defined scenarios, their relationship to other scenarios, and which
is the current Workspace scenario
(the current scenario is identified both
as the scenario with a green check
mark next to it and in AFT xStream’s
Status Bar). At the bottom, there is a
place where you can record notes
related to that scenario (propagates to
children).
Those attributes whose value comes
from a different scenario are linked,
while those values coming from the
selected scenario are not linked.
Linked attributes will inherit changes
made in the same object and attribute
of the linked ancestor. This inheritance will occur over as many generations as the link exists.
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Any scenario can be made current by
double-clicking on it.
Figure 1 illustrates a model with a
Base Scenario with three children:
"Compressor A Running", "Compressor B Running", and "Both Compressors Running". Each of these
have two children: "One Process
Tank" and "Two Process Tanks", representing the different operating cases
where the process fluid could be fed to
either one or two storage tanks.

Figure 1: Scenario Manager on Quick
Access Panel

Related Examples
Gas Turbine Fuel System
Example

554

Creating, Organizing,
and Editing Scenarios
Figure 1: Scenario Manager Window

Scenarios are referred to as either a
parent or child, plus the Base Scenario, which may be thought of as the
root scenario. Upon opening a new
model file, only a Base Scenario will
be present. To create a new scenario
below the Base Scenario, right-click
the Base Scenario and select Create
Child.

The "Compressor A Running", "Compressor B Running", and "Both Compressors Running" scenarios were
created by first selecting the Base
Scenario and clicking 'Create Child'.
Each of the "One Process Tank" and
"Two Process Tanks" scenarios were
created by choosing 'Create Child' for
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each of the three different compressor
configuration scenarios.
Note: Alternatively, one could have
made the "Compressor A
Running" scenario current
and created the "One Process Tank" and "Two Process Tanks" scenarios below
it. Then, with "Compressor A
Running" still selected, select
'Clone With Children' twice,
then rename the new clones
"Compressor B Running" and
"Both Compressors Running".
The "One Process Tank" and "Two
Process Tanks" scenarios may be
thought of as grand children of the
Base Scenario. This concept of scenario ancestry is helpful in keeping
track of the differences and similarities
between scenarios discussed later.
A box with a plus sign next to a scenario indicates it may be expanded to
reveal children scenarios while a box
with a minus sign indicates the level is
fully expanded with all children scenarios shown, if any. No box indicates
there are no children. Levels may be
expanded by clicking on the plus sign
and condensed by clicking on the
minus sign.
Right-clicking a scenario provides the
following choices:
l

Create Child with No Output
- create child scenarios without
results saving duplication and
load time

l

Rename - renames the selected scenario

l

Delete Scenario - deletes the
selected scenario

l

Delete All Children -deletes
all children of the selected scenario

l

Clone Without Children - creates a copy of the selected
scenario at the same level (a
sibling). Cloning a scenario
prompts the user for a name for
the new scenario

l

Clone With Children - creates
a copy of the selected along
with its children. Cloning a scenario prompts the user for a
name for the new scenario

l

Insert Scenario Above Selected... - creates a new scenario
where the selected scenario is
and shifts the selected scenario
and its children down a level.
This can be used to create a
new base scenario. If this is
done the user will be prompted
to rename the previous base
scenario.

l

Promote - raises a scenario
one level, i.e. from a child to a
sibling, active only for scenarios more than one level
below the base scenario

l

Copy/Save Scenario Names
l

Copy Scenario Path
Name - copy the fullyqualified name of the
scenario to the Windows
clipboard ("Base
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Scenario/Case 1/Child
3")
l

Copy Scenario Path
Name With File Name copy the fully-qualified
scenario name along
with the model name
("Model.xsm :: Base
Scenario/Case 1/Child
3")

l

Save Scenario Names
Only to File... - copy all
scenario names on separate lines, with indents
to show child/parent relations

l

Save Full Scenario
Paths to File... - copy
all scenario names on
separate lines, with the
full path name used for
each scenario

l

Save Scenario to File
Without Children - saves the
selected to scenario to a separate file without its children

l

Save Scenario to File With
Children - saves the selected
scenario and its children to a
separate file

l

l

Compare to Active Scenario
- compares all parameters for
all objects between the selected scenario and active scenario and displays the
Comparison Grid showing the
results
Scenario Comparison Tool opens the Scenario

Comparison tool to create a
custom scenario comparison
Note: It is important to remember
that AFT xStream’s Edit
menu Undo does not apply to
Scenario Manager operations. To undo a Rename
scenario operation, you can
rename the scenario again to
the old name. To undo a
Clone or Save Scenario operation, you can delete the
clone or file created. Once a
scenario is deleted or promoted, there is no way to undelete or un-promote the
scenario.

Viewing Scenario Differences
A scenario’s data and that for all of its
direct ancestors can be viewed in the
Model Data Window. This functionality
can be enabled in the Model Data Control window.

Fast Scenario Changes
AFT xStream remembers the most
recent scenario you had open, and
allows you to quickly change back to
that scenario by using the Last Scenario feature. Last Scenario is found on
the View menu and Toolbar

.
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Modifying Individual
Scenarios
When first created, a scenario is
identical to its parent. To modify or run
a scenario, it must first be made in the
current Workspace scenario by selecting it in the Scenario Tree on the
Quick Access Panel, then double clicking it or choosing the Load Scenario
option on the Right Click menu. (The
name of the current scenario is displayed in AFT xStream’s Status Bar
and is indicated in the Quick Access
Panel with a green check mark.)
Once a scenario is the current scenario, changes may be made to differentiate it from its parent using any
of AFT xStream’s editing tools and
functions. When an attribute is
changed within a scenario it breaks
the link for this attribute. Subsequent
changes in the scenario’s ancestors
will no longer affect this attribute.
Properties of a scenario that may differ from its ancestors include:
l

Presence and location of
objects - one may add or delete
pipes and junctions within a
scenario and the workspace locations may vary from scenario
to scenario

l

Pipe and junction properties all values set in the Properties
windows

l

Fluid - fluid selected

l

AFT Arrow Steady Solution solution method, tolerances,
relaxation

l

Output Control - Output window
content and formatting

l

MOC Transient - The transient
settings can be varied between
scenarios

l

Library Manager - The connected database content can
be varied between scenarios

l

Visual Report Control - Visual
Report content and color maps

Model Data Control and User Options
apply to all scenarios.

Scenario Inheritance
Scenario Manager will pass changes
made in a scenario to linked attributes
of its descendants, allowing multiple
scenarios to be modified in one operation and maintain similarity between
scenarios where desired.
Any attribute whose value is the same
as that of the scenario’s parent is
linked to the parent. In turn, if the parent’s attribute value is the same as
that of its parent, then the child’s attribute is linked to its grandparent. This
ancestral linking of attributes can exist
across any number of generations. A
change made to a scenario will be
passed downward to its children,
grandchildren, etc., as far as the link
exists. Changes are NOT passed
upward from child to parent.
Once an attribute is changed within a
scenario, the link is broken to that individual attribute. Subsequent changes
in the scenario’s ancestors, parent,
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grandparent, etc., will no longer affect
that attribute, but all other attributes
within the scenario will remain linked.
The Model Data window with Ancestral Data enabled shows how the data
changes between scenarios.

Scenario Logic Examples
For many users, it is easiest to grasp
Scenario Manager when it is
explained how the coding logic is actually implemented. Blank fields for children, grandchildren, etc., mean to look
to the parent for the data. The Base
Scenario never has blank fields (Table
1). Data only passes downwards,
never upwards.

If a scenario is changed, and its child
has different data, then the change will
not pass downwards (see Table 3).

Table 3: Changing the Base Scenario Diameter from 3 to 6 would not impact Child
#1 or any descendants in that line.
Changing the Length from 25 to 40 would
also change the length in Child #1, Grandchild #1, and any descendants of Grandchild #1.

Table 1: Blank fields for Child #1 and
Grandchild #1 mean that the data is to
come from the parent. If the Base scenario data is changed, all descendants are
changed.

If a child scenario does not have a
blank field, then data for that property
is initiated at that scenario level (see
Table 2).

Table 2: Child #1 does not have a blank
field, so its Diameter would be 2, not 3, as
would Grandchild #1.

If a child scenario has data that is different than the parent, its children cannot relink to the parent (see Table 4).
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l

Table 4: Even if the Grandchild #1 has the
same Diameter as the Base, it is not
linked to the Base because it and its parent are not blank.

l

If a child scenario’s data, which was
previously changed and is thus different from the parent, is changed
back to the same vale as the parent,
the inheritance link is re-established
(see Table 5). Its descendant’s link is
also re-established.
l

Table 5: If the Diameter in Child #1 is
changed to be the same as the Base, it
will be "blanked out" the next time the
scenario is loaded and the link re-established. And so will Grandchild #1, if its
Diameter is also the same.

Table 6 shows data for two pipe properties across three scenarios. The
data that would be used when each
scenario is loaded is as follows:

Base scenario
l

Diameter = 3

l

Length = 25

l

Changes to Diameter
will not pass downwards

l

Changes to Length will
affect only Child #1.

Child #1 scenario
l

Diameter = 2

l

Length = 25

l

Changes to Base Diameter will not affect Diameter

l

Changes to Base
Length will affect Length

Grandchild #1 scenario
l

Diameter = 2

l

Length = 15

l

Changes to Base Diameter will not affect Diameter

l

Changes to Child #1 Diameter will affect Diameter

l

Changes to Base
Length or Child #1
Length will not affect
Length
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Table 6: Input data for these properties
explained in the text.

especially useful for running a group
of scenarios or models during lunch or
overnight.
To run models in batch mode, follow
these steps:
1.

Click "Start Batch Run" on the
File menu.

2.

Select the Batch Run Type.
This is where you select if you
want to run scenarios from the
current model or different
model files. If the current model
does not have any scenarios,
then only the second option will
be available.

3.

If the Batch Run Type is "Scenarios in Current Model", then
choose the Add Scenarios button and select the scenarios
you wish to run.

4.

If the Batch Run Type is
"Models from Different Files",
then the models can be selected individually using the "Add
Model Files" button, or loaded
from a Batch File (by Choosing
the "Load Existing Batch File"
button). A Batch File is a text
file listing all models you would
like to run. At any time, a selected model file can be removed
by clicking the "Remove Selections". The current list of models can be saved to a Batch File
for use in the future by clicking
the "Save List to File" button.

5.

Use the Output Options in the
lower left to save the output
data to a file and/or send it to a
printer or Adobe PDF file. All

Re-Establishing Broken Scenario Links
A link may be re-established by returning the attribute to the same value as
that of its parent. This can be done
manually by entering the value or
selecting the Copy Data From Pipe list
and selecting the Parent Pipe Data
option. Within other data windows, it is
done by selecting the Same As Parent
option in Output Control, Analysis
Setup, Cost Settings, Database Manager or Visual Report Control.
Since links are identified by comparing
attribute values of pipes or junctions
with the same Workspace ID number,
renumbering a scenario will break the
links of all pipes and junctions
renumbered. Since numbers must be
unique, once a link has been broken
by renumbering, it may not be reestablished.

Running Models in
Batch Mode
AFT xStream scenarios or models can
be run in batch mode, a feature that is
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reports will use the specified
font.
6.

7.

8.

Alternatively, the option can be
chosen to Save Using Excel
Export Manager by either saving to separate sheets, or saving the scenarios to separate
workbooks. The Excel Export
option can only be chosen if the
batch run type is for Scenarios
in Current Model. Additionally,
the desired output must first be
configured in the Excel Export
Manager under the File menu
for any data to be exported.
Check the box to Run Batch in
Background if you wish for all
selected scenarios to run
without showing the Solution
Progress window. AFT
xStream will run the simulations in the background and
will not interrupt any work being
done in other programs.
Click the Start Run button to
begin the batch run.

AFT xStream then opens each scenario or model file in sequence, automatically runs each scenario/model
that has a completed Analysis Setup
Window, and sends results to the specified destination. All pertinent information that is generated during the
batch run (such as error messages)
are automatically displayed when the
final scenario/model is finished. Output files generated from each scenario
or model run is automatically saved
before moving to the next run.

The entire batch run can be canceled
at any time by clicking the Cancel button in the Solution Progress window.
Output from scenarios that have
already been run is still retained when
the Batch Run is canceled.
Note: You can plot output from multiple scenarios using MultiScenario Graphs.

Open Model Using Last
Scenario
When the model is saved, the current
scenario is remembered, and by
default, reloaded when the model is
opened again. Your preference of
whether to always open the model to
the most recent scenario or to the
base scenario can be specified in the
User Options window.

Scenario Comparison
Tool Overview
Scenario Comparison Tool (accessed
via the Tools menu) is a powerful tool
that allows users to compare model
parameters between scenarios in a
given model. It lets users quickly
identify differences between two or
more scenarios without needing to
search through the model data for
each scenario or inspect each element of the model. This tool can be
especially powerful for users reviewing others' models, or for users

358

Quick Start Guide

returning to models after a period of
time. It can also be powerful for
troubleshooting purposes. The Scenario Comparison Tool lets you:
l

Compare any two or more scenarios

l

Compare selected Pipes and
Junctions between selected
scenarios

l

Compare selected Pipe and
Junction parameters between
selected scenarios

l

Compare selected General
Properties between selected
scenarios

To modify the comparison use the
Modify Comparison button at the bottom of the window.

Related Examples
High Pressure Steam Forces Example

To set up a comparison from the Scenario Manager, first select the pipes
and junctions to compare in the workspace. Then, select the desired scenario to compare the current scenario
to in the Scenario Manager. Note the
current scenario is indicated by the
green check-mark symbol. Right-click
the desired scenario, and select Compare Selected Scenarios.... This will
bring users to the Scenario Comparison window and display a grid of
the differences between the selected
objects in the two scenarios.

From the Workspace
588

Related Blogs
New Feature Highlight - Scenario
Comparison Tool

Accessing Scenario
Comparison Tool
The Scenario Comparison tool can be
accessed from the Scenario Manager,
the Workspace, and the Tools menu.

From the Scenario Manager

From the workspace, users can
quickly select desired pipes and junctions in the scenario and compare
them to those found in any other scenario.
First, select the desired pipe(s) and/or
junction(s) in the workspace. Then,
right-click the Workspace, choose
Compare Scenarios, and select the
desired comparison. This will bring
users to the Scenario Comparison window and display a grid of the differences between the selected objects
in the two scenarios.
To modify the comparison use the
Modify Comparison button at the bottom of the window.
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From the Tools Menu
From the Tools menu, there are multiple options to generate the Scenario
Comparison Report.

report, or by selecting Scenario Comparison Tool from the Tools menu.
The Modify Comparison window is
shown in Figure 1 below.

A comparison grid can be directly generated by selecting the desired objects
to compare in the Workspace, then
selecting the scenarios to be compared from the Compare Scenarios
menu option.
Alternatively, the Scenario Comparison Tool menu option can be
selected to build a custom scenario
comparison by directly selecting the
scenarios, objects, and parameters to
be included in the comparison. See
Modify Comparison for more information on the available options.
Click the Show Comparison button at
the bottom of the window to view the
comparison. To make additional
changes, use the Modify Comparison
button at the bottom of the window.

Figure 1: Scenario Comparison window
options to Modify Comparison

Select Scenarios to Compare
Related Blogs
New Feature Highlight - Scenario
Comparison Tool

Modify Comparison
Several Options are available to customize the Scenario Comparison Grid.
These options are available from the
Modify Comparison button at the bottom of the scenario comparison

The Scenario Comparison Tool has
four pre-set templates for comparing
scenarios, plus the ability to set up a
custom comparison. These are:
l

Parent: This template compares the current scenario with
that scenario's parent.

l

Ancestors: This template compares the current scenario with
all of that scenario's direct
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ancestors. This setting would
be similar to the comparison
available in the Model Data window, though it does provide a
more comprehensive comparison.
l

Siblings: This template compares the current scenario with
all of that scenario's siblings.

l

Exhaustive: This template
compares all of the scenarios in
the model with each other.

l

Custom: This option allows
users to compare any two or
more scenarios throughout the
model.

Select Pipe and Junction
Properties
This section sets what parameters will
be compared such as length, diameter, roughness, etc.
Users can choose to compare a set of
specified properties, or all pipe and
junction properties by selecting the
desired properties under Select Pipe
and Junction Properties. Only properties selected in this section will be
considered when the comparison is
run.
A helpful option to filter the parameters to be displayed in the comparison is to display the parameters
shown in the Model Data window. This
can simplify the comparison, but might
hide some differences between scenarios. Use the Model Data Control win-

dow to further define what parameters
are shown with this option.

Select General Properties
This section sets what General Properties will be compared such as fluid
properties, tolerances, etc.
Users can choose to compare all or a
select set of general properties for the
scenarios including options that are
located in the Analysis Setup window
such as the AFT Arrow™ Steady Solution, Fluid, Sectioning, and MOC Transient panels.

Select Pipes and Junctions
This section sets which pipes and junctions will be compared for the model.
Users can choose to compare all
objects in the model, or a selected set
of pipes and junctions. Users can
manually select the desired objects,
select those highlighted in the workspace, or use the Select Special tool
to select desired groups or other sets
of objects.

Related Blogs
New Feature Highlight - Scenario
Comparison Tool

Index 361

Scenario Comparison
Grid
Choosing the Compare Selected Scenarios menu item from the right-click or
Tools menu will bring the user directly
to the Scenario Comparison Grid
based on any selected Workspace
objects and scenarios. The settings
for the scenario comparison can be
seen/modified by clicking Modify Comparison at the bottom of the window.
The tabular data from the report can
be copied to and pasted to a separate
file or worksheet using the Copy button at the bottom of the window.

When a large comparison is run, typically many of the objects/parameters
in the model will be unchanged across
scenarios, which may result in a large
number of items with no differences.
To help condense the Scenario Comparison Grid, several toggles are available at the top of the Item and
Parameter columns which allow the
user to show/hide rows in the report.
Switching the toggle to All will show all
items or parameters being compared.
If the toggle is set to differences, then
only Items/Parameters that have a different value in at least one scenario
will be shown. Thus, if both toggles
are set to All, then all parameters will
be displayed for all items. If both
toggles are set to Differences, then
only items that have parameters with
different values will be shown, and
only the parameters that differ will be
displayed.

Color Coding

Figure 1: Default Scenario Comparison
Report view

Filtering Options

The cells in the Item and Parameter
columns will be colored either yellow
or green to indicate whether that item/parameter has differences between
the scenarios being compared. Yellow
indicates differences, while green
indicates that no differences exist.
Parameters will be colored yellow if
the value of that parameter is different
in at least one scenario that is being
compared. Items will be colored yellow if at least one parameter that is
being compared for that item has a different value in one or more scenarios.
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The Highlight Unique Values toggle is
used to color the values to visually link
identical values. All values under the
currently active scenario will remain
grey, while values that have differences will be colored. This is powerful to quickly see differences when
more than two scenarios are being
compared. If two scenarios have the
same value for a parameter, the values will have the same shading. See
Figure 2 below for an example.

Figure 2: Scenario comparison showing
differences only. Each unique value is
highlighted with a different color to indicate which scenarios have differences
from the currently active scenario, which
is the "3.5 inch" scenario for this
example.

Related Blogs

New Feature Highlight - Scenario
Comparison Tool
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Add-on Modules
AFT xStream has one optional add-on
module which extends its modeling
capabilities into other areas. The module allows pulsation frequency analysis.
l

Introduction to the PFA Module
(Pulsation Frequency Analysis)

Introduction to the PFA
Module

How Does the PFA Module
Work?
The Pulsation Frequency Analysis
(PFA) module is used to determine resonant frequencies that could damage
system equipment by calculating the
acoustic resonance.
The general steps of pulsation analysis involve the following:
1.

The piping and process equipment system is first modeled.

2.

At run-time a pulse is generated to determine excitation
frequencies, and generate the
forcing function. This forcing
function is then placed in the
transient data of the junction at
which the pulse is applied.

3.

The model is run with the forcing function to generate the
Acoustical Frequency Analysis
graph, providing information on
the resonant frequencies in the
system.

4.

Replace the pulse transient
with a transient at the frequencies of interest in the reciprocating compressor and turn
on the API-618 evaluation
option

5.

When the model is run xStream
will show warnings if API-618 is
violated

What is the PFA Module?
Steady state pressure and flow dynamics, henceforth referred to simply as
“pulsation”, is a common problem,
which can cause high vibration,
fatigue failures, frequent maintenance
outages, and flow uniformity or
product quality problems.
The PFA module helps engineers
identify and avoid resonant frequencies in systems. Problems can
arise when the frequencies that are
excited by pulsation are at or near the
acoustic resonant frequencies of a
fluid system. The module is used to
calculate the acoustic resonance frequencies that could damage system
equipment.
The PFA module can also be used to
check compliance with the pressure
limits defined in API-618 for reciprocal
compressors.
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the Modules panel.

Using the PFA Module
The user has the option of activating
or not activating the PFA module
when AFT xStream first loads. After
AFT xStream is loaded, the PFA module can be activated or deactivated for
use from the Tools menu. Whether or
not PFA is activated impacts the Analysis menu and Graph Results window.
If the PFA module is active, the user
can still run models without pulsation.
This is selected under Pulsation Frequency Analysis on the Analysis
menu. Hence there are three possibilities for the PFA module.
l

PFA is not active

l

PFA is active and pulsation is
disabled

l

PFA is active and pulsation frequency analysis is performed

Figure 1: Pulse Setup panel in the Analysis Setup window

Related Examples
Frequency Analysis - PFA
Example
604

Defining Pulsation Settings
The Pulse Setup panel (Figure 1)
allows you to specify required input for
the PFA module, including the junction
at which the pulse will be applied, as
well as the pulse properties. This
panel will not be visible unless the
PFA module has been activated from

Pulse Properties
At the top of the window the Pulse
Properties can be specified, including
the junction that will act as the source
of the pulse and the magnitude of the
pulse. By default, the magnitude of the
pulse is twice the steady-state flow,
but you have the option to define this
magnitude as “User Specified”. This
pulse will be assumed to last for two
time steps and then return to steady-

Index 365
state flow. The pulse can only be
applied to an assigned flow junction.

Cutoff Frequency. Therefore it is
important to define a large enough
Cutoff Frequency to be able to analyze all relevant frequency responses.

Cutoff Frequency
The cutoff frequency in xStream is the
maximum frequency for displayed output. The defined cutoff frequency must
be less than or equal to the detectable
frequency for the analysis, which is calculated using the equation for maximum frequency as follows

where dt is the time step. The time
step for the model is not known until
run-time; However, the time step can
be estimated based on the inputs on
the Pipe Sectioning panel. The Pulsation Summary at the bottom of the
Pulse Setup panel shows the Detectable Frequency based on the current
settings on the Pipe Sectioning panel,
as well as the minimum number of sections required to capture the specified
cutoff frequency. If the current Cutoff
Frequency and sectioning are not
valid for the analysis, then either the
Cutoff Frequency should be
decreased, or the minimum number of
sections should be increased.
When the Analysis is run it is possible
to account for all frequencies up to the
Detectable Frequency calculated
based on the time step. However, the
results in the output will only display
frequencies up to the user defined

Minimum Number of Frequency Samples
The minimum number of frequency
samples used to generate the forcing
function is specified in the Frequency
Analysis section of the Pulse Setup
panel. The default of 1000 should be
sufficient for most cases. The Minimum Number of Frequency Samples
will impact the required simulation duration - a larger number of samples will
require a longer simulation duration.
The required simulation duration can
be calculated by dividing the minimum
number of frequency samples by the
detectable frequency. If the current
simulation duration is not long enough
to accommodate the minimum number of frequency samples, then the
simulation duration should be
lengthened on the Simulation
Mode/Duration panel, or the minimum
number of frequency samples should
be decreased.

Evaluate with API-618
The Evaluate with API-618 feature
can be used to determine if the pressure response at any of the acoustic
natural frequencies of the system
exceeds the limits defined in API-618
for reciprocating compressors. To
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evaluate API-618 the model should be
first be run with PFA enabled and the
API-618 feature disabled to determine
the acoustic frequencies. Once the
excitation frequencies are known,
child scenarios can be created by the
user to evaluate the pressure results
when the compressor operates at the
excitation frequencies, as is demonstrated in the last step of the Frequency Analysis Example. The API618 evaluation should be enabled in
the excitation frequency child scenarios to check if the pressure results
exceed the limits in API-618.

reach constant amplitude at
about 0.25 seconds. It is best to
choose a slightly longer time
interval than the estimated time
interval for increased accuracy
when checking API-618.
Note the Time Until Steady
State Pulsation input only
changes which pressure results are included in the API-618
evaluation, the transient results
are not impacted by this time.

The required inputs to check API-618
are as follows:
l

Speed - The speed the reciprocating compressor is operating at.

l

Number of Heads - The number of pistons in the reciprocating compressor.

l

Time Until Steady State
Pulsation - The time required
for the dissipation of artificial
transients caused by the introduction of a flow rate wave to
the system. This time should be
determined by running the scenario with the "Time Until Steady
State Pulsation" set to 0, then
plotting the pressure results at
the outlet of the compressor.
The Time Until Steady State
Pulsation should be set as the
time at which the pressure
waves have consistent amplitudes. For example, in Figure
2 below the waves begin to

Figure 2: Example pressure results at the
outlet of the reciprocating compressor
with an oscillating flow transient specified.

Pulsation Summary
The Pulsation Summary section at the
bottom of the Pulse Setup panel
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provides information on the current
transient settings in the model to
check that the sectioning and simulation duration are sufficient based
on the user-specified Cutoff Frequency and Minimum Number of Frequency Samples. Therefore the
Pulsation Summary will only be able to
display results if the Pipe Sectioning
panel and Simulation Mode/Duration
panel have already been fully defined.
The Update For Me button under the
Pulsation Summary can be used to
update the Minimum Number of Sections and/or the Stop Time for the simulation if they are not sufficient based
on the user-specified Cutoff Frequency and Minimum Number of Frequency Samples.
A short description of each of the
Pulsation Summary items is given
here.
l

Minimum Sections
l

Current Count - Displays the "Minimum
Number of Sections Per
Pipe" defined on the
Pipe Sectioning panel

l

Detectable Frequency
- Displays the Max Frequency calculated as discussed above in the
Cutoff Frequency section

l

Required for Cutoff Displays the required
Minimum Number of
Sections Per Pipe which
allow the Detectable

Frequency to be greater
than or equal to the
Cutoff Frequency
l

Minimum Simulation Duration
l

Current Duration - Displays the current simulation duration defined
on the Simulation
Mode/Duration panel
(Stop Time minus Start
Time)

l

Actual Samples - Displays the Actual
Samples used for the frequency analysis, calculated by multiplying
the Current Duration by
the Detectable Frequency

l

Required For Min.
Samples - Displays the
minimum required simulation duration based
on the user-specified
Minimum Number of Frequency Samples and
the calculated Detectable Frequency

Related Examples
Frequency Analysis - PFA
Example
604

Interpreting Pulsation
Results
The accuracy of results when using
the PFA module in xStream will be
affected by the sources of error
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described in the Transient Result
Accuracy topic, but there are a few
additional considerations specific to
the PFA module.

PFA Module Glossary

The methodology the PFA module
uses assumes that the fluid parameters change linearly in the system,
similar to the assumptions made for
the Method of Characteristics in the
transient solver. The assumption of linear behavior primarily affects the magnitude of the frequency response
results, rather than affecting the locations of the largest amplitude
responses. However, if the error for
the analysis is large it is possible that
the predicted resonant frequencies
may be shifted. To minimize error the
considerations in the Transient Result
Accuracy topic should be taken into
account, in particular running the
model with higher sectioning counts. It
may also be prudent to analyze the
system response not only at the predicted resonant frequencies, but also
at frequencies near to the predicted
frequencies to ensure that all frequencies of concern have been
accounted for in the system.

Much of the terminology associated
with pulsation analysis is specific to
time-frequency analysis and/or to
vibrational analysis. The following
words have been defined for ease of
comprehension when working with the
PFA module. Note that most of the
defined words include page numbers
and, occasionally, equation numbers.
All of these references can be found in
the document referenced at the end of
this page.
l

Sample Rate - The inverse of
the time step (Page 14)

l

Harmonic Frequencies - Multiples of the base frequencies
that excite the system

l

Forcing Function - The function that will be used to “ring”
the system. This function can
be the pulse in a non-low-passfiltered system, or can be
determined by the cutoff frequency that is determined by
using Fast Fourier Transform
(Page 7)

l

Pulse - The near-instantaneous increase, then normalization, of flow

l

Fast Fourier Transform (FFT)
- A method used to transpose
the time-domain (flow vs. time)
into the frequency-domain
(magnitude vs. frequency)

l

Cutoff frequency (fc) - This is
the maximum frequency that
will be shown in the frequency

Related Topics
Method of Characteristics

411

Related Examples
Frequency Analysis - PFA
Example
604
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analysis results.
l

Detectable Frequency - This
is the maximum frequency
which will be recognized by
xStream during the transient
solution. If frequencies exist
above this frequency they will
be aliased to lower frequencies
in the final solution.

References
1.) Blanding, James M., Ph.D., and
Trey Walters, PE. Pulsation Analysis
in Positive Displacement Pump Systems Using Waterhammer, Modal,
and Animation Software. Houston, TX:
45th Turbomachinery & 32nd Pump
Symposia, Sept. 2016. http://www.aft.com/documents/TechnicalPapers/2016/TPS2016PulsationAnalysis.pdf
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Libraries
One of the more powerful features of
AFT xStream is that it provides extensive customization capabilities. AFT
xStream provides the tools to build
custom libraries for fluid properties,
pipe materials, and all junction types
except Volume Balance. AFT xStream
incorporates these libraries internally
and offers them to you through list
boxes.

Network Library Overview

383

Library Verification

388

Library Locations in General
Preferences

389

Related Blogs
Databases 101 - Get to Know Them

There are three categories of libraries:
Local User, External, and AFT
Internal.

Databases 201 - Name That Fluids

The Local User Library is located in
the Xtr_USER2.DAT file in the local
user directory, and stores user-specified data for most component types
for local use. It cannot be transferred
to other users.

Databases 401 - Managing Databases

The AFT Internal Library is located
in the xStream2.DAT file in the local
user directory and stores AFTprovided libraries, as well as user-specified fittings & losses. It cannot be
transferred to other users.
External libraries are created by the
user and can contain data for any of
the library types. In AFT Impulse you
can create multiple network or local
custom libraries using the Library Manager on the Library menu. External libraries can be shared to multiple users
from a network location as is discussed in Creating an Enterprise-wide
Network Library System.
Library Manager

370

Databases 301 - Those Are Some
Nice Pipes!

Library Manager
Accessed from the Library Menu, the
Library Manager is a new feature to
AFT xStream 2 and replaces the Database features used in previous versions. The Library Manager allows
you to:
l

Connect to and disconnect
from libraries

l

Create and delete libraries

l

Add content to libraries

l

Review the content of libraries

l

Move contents between libraries
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Related Blogs
Databases 101 - Get to Know Them

removed and will always appear in the
list of available libraries. External
shared libraries will also always
appear in the available library list.

Databases 201 - Name That Fluids
Databases 301 - Those Are Some
Nice Pipes!

Figure 1: Library Browser in the Library
Manager

Databases 401 - Managing Databases

Library Browser
The first panel of the Library Manager
is the Library Browser. Use the Library
Browser to create a new library, add
an existing library, view contents of an
added library, and connect or disconnect libraries to the model.

Adding and Removing Existing Libraries
To work with a library you must first
make it available to AFT Impulse.
Referring to Figure 1, clicking on the
Add Existing Library button will open a
standard file dialog box with which you
may browse to and select a library. A
library may be removed from the list of
available libraries by right-clicking on
the library and selecting Remove
Library from List. A summary of the library contents can be seen in the section on the right when a library, library
section, or component is selected in
the list of available libraries.
The AFT DEFAULT INTERNAL
LIBRARY and the AFT XSTREAM
LOCAL USER LIBRARY may not be

Connecting and Disconnecting Libraries
In order to use the components from a
library in the model the library must be
connected. A library is connected to
the model when it is shown with a
check mark in the Library Browser. All
libraries are automatically connected
when they are first added to the
Library Manager.
Sections or components in a library
can also be connected/disconnected
on an individual basis if the library as a
whole is connected.
It may be desired to disconnect a library if you do not want the components from that library to be
available for use in the current model,
but you do want the library to be available for use in other models.
Clicking on Set As Default will establish the list of connected libraries as
the default list, while clicking on User
Default will set the connections to the
default list.
AFT Internal Pipe Material libraries
can be connected or disconnected as
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a group from the Other Actions button
under the available libraries list.

Editing Library Contents
Existing content can be moved to/from, copied to/from, or deleted from
available libraries in the Library
Browser.
To edit an item right-click on the item
in the Library Browser, then click the
desired action from the right-click
menu. Note that moving, copying, and
deleting can be done to a library as a
whole, or can be done for just a section or single component in a library.
Individuals components can also be
edited by choosing Edit Component,
which will take you directly to the Edit
section for the component type.

the available libraries list. You will be
prompted to provide a name for the
file, and a library description (Figure
3). The provided description will be displayed as the library's name in the
Library Manager.
To add content to an external library
copy or move content from an existing
library as described in the Editing
Library Contents section. Junction
components can also be directly
added to external libraries as is
described in the Junction Libraries
topic.
For more details on creating and sharing external libraries see Creating an
Enterprise-wide Network Library.

Figure 3: After specifying a library file
name, you will be prompted for a description which will then appear in the Library
Manager when this library is selected

Figure 2: Library contents can be transferred or deleted from the right-click
menu

Related Blogs
Creating External Libraries
Databases 101 - Get to Know Them
By default library items are stored in
the AFT Default Internal Library or
Local User Library, both of which cannot be shared with other users. Library
items can be moved or copied to an
external library which can be shared
with multiple users.
To create an external library click the
Create New Library button underneath

Databases 201 - Name That Fluids
Databases 301 - Those Are Some
Nice Pipes!
Databases 401 - Managing Databases
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Junction Library
Adding Custom Junction
Data to the Component
Library

item in the list and click the Edit Data
button. This opens the data into a
Properties Window where the data
can be modified.

Related Blogs
To simplify modeling and eliminate
repetitive data entry, AFT xStream
allows you to save frequently-used
junction data to a custom library. Once
saved, the custom equipment can be
selected from the Library List in the
Properties window at any later time for
immediate recall of the data. Using
this tool, you can easily build your own
library of compressors, valves, or
other components supplied by specific
manufacturers.
To save a Custom junction to the
library - open the junction Properties
Window and enter all required data.
Close the window and choose Add
Component to Library from the Library
menu. You will be prompted to enter a
name for the custom component.
Enter a descriptive name and close
the window. If you open the junction
again, the custom name will be selected in the Library List.

Editing the Component
Library
You can delete or rename any existing
library component in the Edit Junctions panel of the Library Manager,
accessed from the Library menu. To
edit an existing library entry, select the

Databases 101 - Get to Know Them
Databases 201 - Name That Fluids
Databases 301 - Those Are Some
Nice Pipes!
Databases 401 - Managing Databases

Fluid Library
AFT xStream provides a fluid library
for numerous common fluids. If the
working fluid you wish to model is not
in this library, you may elect to enter
the fluid properties in a custom library
for later recall using the Edit Fluids
panel in the Library Manager.
You can open the Edit Fluids panel
from the Library menu or from the Edit
Fluid list button in the Fluid panel in
Analysis Setup. The Edit Fluids panel
allows you to review currently defined
AFT Standard and custom fluids, to
change the data for custom fluids, and
to enter new fluids. All AFT Standard
fluid properties are assumed to be a
function of temperature. Custom fluids
can be a function of temperature or
solids concentration.
Once you have entered a custom fluid,
it will appear in the Fluids Available in
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Library list of the Fluid panel when
AFT Standard is selected.
You can add new fluids in the Library
Manager Edit Fluids panel by clicking
the Add New Fluid button. A number
of fluid properties are required for a
compressible flow analysis. There are
also several optional properties. The
required properties are dynamic viscosity, specific heat at constant pressure, enthalpy, and molecular weight.
Other entries for critical property data
are used for some of the equation of
state and enthalpy models. A constant
compressibility factor can be
assigned. The thermal conductivity is
optional if pipe heat transfer is being
modeled as adiabatic or isothermal.
Except for the constants, density, and
enthalpy, all properties are assumed
to be functions of temperature only.
The assumption can break down in
systems with very large temperature
changes, and should be checked by
the user. These properties are
modeled with fourth order polynomials, and features for creating
curve fits from raw data are provided.
The enthalpy is a strong function of
temperature but a weaker function of
pressure. Frequently the pressure
dependence of enthalpy can be
ignored. The three enthalpy models
offered by AFT Arrow allow you to
choose different ways of handling the
pressure dependence.
The Fluid Library window also allows
you to open the Change Fluid Data
window which is essentially the same
window as the Add New Fluid window.
For easy editing, data for the fluid you

wish to change is entered for you in
the appropriate areas. The original
curve fit data you entered is also displayed.
The Add New Fluid/Change Fluid
Data windows offer cross-plotting of
your custom curves against the curve
fit data points. You can also import
data from text files into these windows.

Related Topics
Curve Fitting
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Pipe Material Library
Adding Custom Pipe Materials to the Pipe Materials
Library
You can open the Edit Pipe Materials
panel from the Library Menu. Using
this panel, you can easily add to the
user library the geometric information
for any pipe material in the length units
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of your choice. Custom pipe materials
can be selected for use in the Pipe
Properties Window, minimizing the
data entry required by the user.
Pipe materials typically have a range
of nominal sizes and a specific type,
class, or schedule that describes the
actual dimension. AFT xStream works
with the inner diameter of the pipe,
since that is the parameter that directly affects the fluid mechanics.
To add custom pipe materials to
the user library, choose the entry location you desire in the list on the left
(Pipe Materials, Sizes and Types),
then click the New button below. For
example, to add an entirely new material, click the Pipe Materials item at the
top of the list then click the New Material button. To add a new size for an
existing material (say Steel), click
Steel in the list then click the New Size
button. To add a new type to the Steel
1 inch size, click 1 inch under the Steel
material in the list then click the New
Type button.
When adding a new material, you also
will be asked to specify a geometry,
enter a nominal size, type of material,
diameter, wall thickness, friction data
set, and friction value to define the first
data. Optionally you can add in a wall
thickness. From then on you can enter
additional nominal sizes and types.
The name descriptors you choose for
the material, size, and type are at your
discretion. They can contain text
mixed with relevant numbers if you
desire.
You can also add multiple Friction
Data Sets for each pipe material. This

allows you to keep, for example, different friction values that may apply to
the same pipe under different conditions. These conditions could be
related to the age of the pipe or the
type of fluid being carried. See the Friction Data Sets section below for more
information.
In addition to manual entry of the custom pipe materials, you also can
import pipe material data from a file.
When you click the Import From File
button, a dialog box will appear
explaining the necessary import file
format. By choosing to import from a
file, you will be able to have a separate
copy of the data for later access.

Friction Data Sets
Friction Data Sets are pipe friction values for a particular pipe condition.
To create a new Friction Data Set
select a Pipe Material, Size, or Schedule to associate the data set with, then
click New Data Set from the Friction
Data Set tab on the right (Figure 1).
Modify the Friction Data Set description to provide a name, then enter the
Friction Model and Value.
A Friction Data Set can be associated
with the entire pipe material, or with
specific sizes or types. For instance, a
friction data set associated with Steel
(i.e., the top level) might be called "25
year usage" and have a roughness
value of 0.005 inches. This data set is
then available to all sizes and types of
steel. However, if "25 year usage" is
associated only with the 1 inch of
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Steel, it will apply only to the pipe
schedules that are 1 inch.
You can also associate friction data
sets with a specific type (i.e., schedule). For instance, you can make a "25
year usage" and associate it only with
1 inch schedule 40 Steel pipe and
assign its roughness value as 0.006
inches. Then all Steel pipe would use
0.005 inches for "25 year usage" friction while the different value for 1 inch
schedule 40 of 0.006 inches would
supersede the value of 0.005 inches
associated with all Steel pipe.
Finally, among multiple friction data
sets you can specify a default data
set.
Multiple friction data sets can be created for each type of pipe material. For
example, there may be separate friction data sets for Steel pipe such as:
New Pipe, 10 Year Use, 20 Year Use
and 30 Year Use. Typically, the older
pipes will have higher friction.

Figure 1: Friction Data Set tab on the Edit
Pipe Materials panel

Pipe Physical Properties
The Pipe Material Library window
allows you to assign physical properties of the pipe. The density and
Poisson ratio of the pipe can be
entered as constants, and the modulus of elasticity as a function of temperature.

Related Topics
Curve Fitting
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Insulation Library
The Edit Insulations panel is accessed
from the Library menu. This panel
allows you to view the insulation data
provided with AFT xStream, or to add,
edit or delete user defined insulation
materials. Insulation library items are
used for heat transfer calculations in
pipes.
To add a new insulation material click
Add New Insulation, then enter the
data in the Insulation Physical Properties window. The insulation thermal
conductivity is entered as a function of
temperature, and density as a constant.
Insulation data can be applied directly
to pipes, and can also be associated
with the Pipe Material Library as insulation data sets.
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Fittings & Losses
Library
The Edit Fittings & Losses panel can
be accessed from the Library Menu
and allows the user to review the Fittings & Losses data provided by
default in xStream, and to add, edit or
delete user defined Fitting & Losses in
the AFT Default Internal Library.
Fittings & Losses can either be added
by using the entry form in the window,
or by importing a text file as described
below. To enter a new Fitting/Loss
item in the Edit Fittings & Losses
panel click Create New Loss Item.
Define the applicable category, type,
geometry and loss model information
then click Accept. The user-defined
item will appear in the Fittings &
Losses on the left under the relevant
category/type with the source shown
in parentheses as "U".
Custom fittings & losses are saved to
the local user library. From there the
user can move them to other libraries
(see Library Manager).

The entries in the file should be in the
order as shown in Figure 1, but with no
headers in the workbook. If a header
row or a blank row is used, xStream
will present a warning, but give the
user the option to still import the valid
rows.

Figure 1: Example of import file setup for
a custom elbow/bend. Headers should
not be present in the file to import.

Valid options for each of the columns
are listed below, with detailed options
given in Table 1.
l

Category - Must match one of the
values from Table 1. "Other" may
be used if none of the specific fitting/loss categories fit.

l

Type - This field is required, any
name/value may be entered.
Types already existing in the library are shown in Table 1, and
may be used if desired.

l

Sub Type - This field is optional.
A sub-type may be chosen from
Table 1, or any other name/value
may be entered.
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l

l

Geometry - This field is optional.
A geometry type from Table 1
must be used if a geometry is
entered. If the Geometry field is
left blank, the Geometry Value will
be ignored.
Geometry Value - This field is
only required if a Geometry type
has been entered. Any positive
numerical value may be entered.

l

Loss Model - This field is
required. The Loss Model must be
either "K (constant)" or "K / fT
(Crane)".

l

Loss Value - This field is
required. Any positive numerical
value may be entered for the loss
value.

l

Reference/Notes - This field is
optional. Any information may be
entered here as needed.

Table 1: Valid Entries for each field. The
Geometry Value and Loss Value fields will
accept any numerical entry. The Reference/Notes field will accept any entry.
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Network Library Overview
Custom libraries contain custom data
generated by the user, including fluid
properties, pipe materials, and data
for junctions types such as pumps and
valves.
All custom data created by the user is
kept on the local computer in a file
called XSM_USER2.DAT in the local
user directory. This data is not shared
and is always available to the local
user for access or for editing.
In addition to the local user library, you
can create multiple network or local
custom libraries. The Library Manager
window on the Library menu simplifies
this process. See Creating an Enterprise-wide Network Library System for
details on how to do this.

Benefits of Shared
Libraries
When the xStream libraries are placed
on a network, powerful data management procedures can be

implemented. Specific, qualitychecked data can be entered into libraries located on a local or wide area
network of PC's. This data is not
accessible to the end users through
AFT xStream itself, so it is guarded
data.
Once the data is placed on a network,
users can connect to any library listed
in the Library Manager. Users can connect to as many libraries as they want.
If the user connects to a library with
these files and selects to be connected to any of these control files, the
model will inherit the control formatting
specified in the control files. This
means that special report layouts, special graphical representations and colors, and other special controls can be
decided upon by the library constructor, and those control features
can be loaded into local models by
end users. This is highly useful for creating customized reports for certain
customers or project requirements.
By way of example, assume the Output Control content was specified as
coming from the "Woodland Park
Office Library" library.
If you uncheck the Library checkbox or
change certain data in the Output Control window, the library will remain connected but change to an inactive state.
When the library is inactive, none of its
data flows through to the model. To
bring the Output Control data back
into sync with the connected library,
recheck the Library check box in Output Control.
This entire custom library concept
lends itself naturally to the idea of
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specific project libraries. Each project
has differing requirements that
depend on the nature of the project
and the end customer. Data for each
project can be assembled into separate libraries, allowing faster and
more accurate transmission of the controlled data and desired reporting
formats to engineers.
Maintaining a network library allows
commonly-used data to be controlled,
which may be helpful in instances
where quality control is strict.

Creating an enterprisewide, network library
system
Overview
Users of AFT xStream on a network
can access common libraries to simplify model verification, improve analysis and reporting consistency, and
eliminate redundant work.
To accomplish this there is some initial
setup that must be done. First, the
data for components, materials,
formats, etc., needs to be created and
saved to various data files. Secondly,
these files must be made available to
the users of AFT xStream by creating
a file named DATABASE.LIB in the
xStream folder. Thirdly, the users
need to connect to the new libraries listed and select the sections to use.
Each of these broad steps is discussed below. To maintain control and

integrity of the data, it would be
advised that one person is given the
responsibility to create and maintain
the network libraries. The discussion
below will be given from the viewpoint
of this person.
Table 1 shows the relationship
between Internal Libraries and
External Libraries as well as the library
file listing that AFT xStream uses to
find these libraries. An External
Library is any library file that is created
by the user and listed in the XTR_
DBUSER.LIB residing in the user’s
local user directory. The user can
make these available and unavailable,
and connect and disconnect from
these libraries using Library Manager.
The library files themselves may be
located on any local or mapped drive.
These library files are also distinguished by being under the local
user’s complete control. External
Shared Libraries, on the other hand,
are common to all AFT xStream users
on the network, therefore the local
user cannot remove them from the list
of available libraries. However, the
user can choose to connect or disconnect from these libraries using
Library Manager. Finally, to complete
the discussion, there are two special
libraries, the Default Internal Library
and the Local User Library. These files
are AFT xStream Internal Libraries
which cannot be disconnected or
made unavailable.
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Table 1: A summary of the types of libraries used for the example below. Note
the difference between External and
External Shared libraries is just which
*.LIB file their file path is listed in.

Library
Groups &
Filenames

Library
Titles

Library
Locations

(XTR_
DBUSER.LIB)

VailMaterials.dat

Vail
Resort
Materials

Network
Location,
with path listed in XTR_
DBUSER.LIB

xStream
Internal
Libraries

XSTREAM2.DAT
XTR_
USER2.DAT

AFT
Default
Internal
AFT
Library xStream 2
folder
AFT
xStrea- AppData
m
folder
Local
User
Library

External
Shared
Libraries
(DATABASE.LIB)

VailMaterials.dat

External
Libraries

Vail
Resort
Materials

Network
Location,
with path listed in
DATABASE.LIB

Creating Library Files
The first thing to do is create the files
that contain the information to be
shared. These files will be referred to
as library files and can contain information about pipe materials, components (e.g. pumps, valves, etc.),
fluids, etc. The following are several
ways to create library files:
l

Use the Create New Library button in the Library Manager, as
described previously. Data can
be taken from the current
model or other libraries.

l

Copy and paste sections from
one file into another file using a
text editor.

This discussion will focus on the first
and second methods. Let’s assume
that the person responsible for the network library has already created a new
pipe material. Also, assume that the
goal is to create a network-wide library
to contain this material.
The information for the material is
copied from the Local User Library
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(XTR_USER2.DAT) to a new file
using the Library Broswer in the
Library Manager. For the source library choose Local User Library and
then select Pipe Materials. Then click
Create New Library and enter a file
name, VailMaterials.dat, for this
example. Enter a description of the library - this description is how AFT
xStream users will refer to the library
and should concisely describe what is
in the library (for this example we’ll
use "Vail Resort Materials"). Rightclick the pipe materials section from
the Local User Library and choose
Copy Content to copy the pipe materials to this new library file. The pipe
material library file has now been created and is ready to be used.

Sharing Library Files Using
DATABASE.LIB
Now that the library file for the Pipe
Materials has been created, it needs
to be made available to the users of
AFT xStream. Depending on the
scope of use, library files can be
placed into one of two groups. If the library is to be used locally by one user, it
is put in the External Library group. On
the other hand, if the library is to be
common among many users and
shared over a network it is put into the
External Shared Library group.
Continuing the above example, the
goal is to share the library file, so it will
need to be an External Shared Library
listed in the DATABASE.LIB file in the
xStream directory on the network.

However, since xStream does not
write directly to the network files for
security reasons, it is easiest to temporarily treat these files as local
External Library files which will be listed in the XTR_DBUSER.LIB file located in the local user directory of the
local machine.
It is recommended that External
Shared Library files be copied to the
network server and placed in a subfolder of the AFT xStream folder (e.g.
AFT Products\AFT xStream\Libraries). The files may, however, be located anywhere on the network that is
accessible to the users. For our
example, we are going to put the pipe
material library on the network in a subfolder called Libraries. It is easier to
copy the file to the Libraries folder
before they are made available in AFT
xStream. This will help establish the
correct paths to the files as the files
are made available using the Library
Manager.
Once the library file is in the network
location, open the Library Manager in
AFT xStream to the Library Browser.
Each of the new library files we have
created needs to be added to the Available Libraries list by clicking Add Existing Library and browsing to the file.
Once you click OK, the description of
the library you just added appears in
the Available Libraries list. Once you
have added the new library, click
Close and the External Library listing
file (XTR_DBUSER.LIB) in your local
user directory is automatically
updated.
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Now we need to discuss how the
paths should be setup. When you add
a library, AFT xStream will write the
full path of the library to the External
Library listing (XTR_DBUSER.LIB).
That means that if you browsed to the
library file using a mapped drive letter
then the path will include that drive letter. However, if other users try to
access the libraries but have the AFT
xStream folder mapped to a different
drive letter they will not be able to locate the library files. Other options
include using either relative paths or
the computer name in the path (e.g.
\\Network Server\Eng Apps\AFT
Products\AFT xStream\Libraries\filename.dat). You can automatically have AFT xStream use the
computer name when you add the file
by choosing Network Neighborhood,
then the computer and then browse to
the library file. If you would rather use
relative paths, you can manually edit
them in the library listing file. All library
files must be relative to the AFT
xStream folder where the executable
is located.
When the pipe materials library was
added it became an External Library
listed in XTR_DBUSER.LIB. Now we
need to move this listing from the local
machine to the AFT xStream folder on
the network so that all users can
access the library files. Once the listing file is moved to the network, it must
be renamed DATABASE.LIB. Once
this is done, all users can now access
the library file we have created.

Connecting to the External
Shared Libraries
Now that the libraries have been
placed on the network and made available to all AFT xStream users, each
user must now connect to the libraries
and make the sections active as
needed. When a user opens the
Library Manager, the External Shared
Libraries are listed in the Library
Browser. Make sure the checkbox is
checked to make those libraries connected for use. Also ensure that the
sections within the library are checked
for use. A library can be connected
without having any sections selected
and active. Finally, to have these connections in place every time you start
AFT xStream, click Set As Default. To
apply these settings to a model made
previously, open the model, go to
Library Manager, click User Default
and, if you have set the default, the
connections and setting will now be
applied to the model.

Sharing Model Formats/Preferences
Note that the Library Manager used to
provide the option to include formats/preference settings such as the Output Control or Visual Report Control
layouts into shared libraries. These
type of files can still be shared, but are
no longer shared through the Library
Manager. Instead these type of format
files must be loaded directly through
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their control windows, such as loading
the Output Control format being
loaded in the Output Control window.

be added to a custom library
l

Library Verification
The Library Verification window is displayed when you open a model or new
scenario which contains connected library items that have some inconsistency.

1. Library Item Not Found
You may have a library item that is not
found in any currently connected library. For example, a compressor may
be connected to a library, and derive
its data from that library. However,
when the model is loaded, the source
library is not available. This could be
for several reasons that will be discussed shortly.
The compressor in the model does in
fact have all of the required data
needed to run the model. But when it
is not found in the library, you will be
offered several options:
l

l

Disconnect it from the
source library – this means
that the model will forget the library the compressor came from
and make it a standalone compressor not connected to any
library.
Add it to a library – this
means that the compressor can

Leave the library connection
– this means that the compressor will remember what library to which it was originally
connected and connect to that
library again when it is made
available to AFT xStream. If,
however, you try to open the
Compressor Properties window, AFT xStream will disconnect the compressor from
the library and warn you.

The compressor might have lost its library connection for one of these reasons:
l

The library is no longer available because it was removed
either through the Library Manager or because your libraries
have been changed on the network.

l

The model is being run on a different PC than where it was created, and the original libraries
are no longer available. This
could be, for example, because
you have moved the model
onto a laptop computer to take
it on travel. Or it could happen
because the model was
developed by another company
which had developed libraries
of its own but which are not
available to you.

Whatever choice you make, the model
will retain all its engineering data and
yield the same results as it did originally.
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the Rocky Mountain Compressor Company (i.e., RMCC)
Model 100A. But since that
time, the RMCC library has
changed. Perhaps there was
an input error in the original
data, or better data has since
become available and the library was updated. If this were
the case, it would be best to
update all your compressors to
the library values.

2. Item in Model is Different
from Library
You may have a library item in the
model that is connected to a external
library, but for some reason the data is
not the same. For example, you may
have a compressor curve for the
Rocky Mountain Compressor Company's Model 100A in your model, but
it does not match the compressor
curve for this model in your library.
Here you have three choices:
l

Update the items in the
model to match the library –
this will actually change the
model's input data, and it might
yield different results than originally

l

Update the library (if it is
local) to match the model's
items – this will change the library, but will leave the model's
input data as it was. It will yield
the same results as it did previously.

l

Disconnect it from the
source library – this will leave
the model as it was, and it will
yield the same results.

The compressor in the model might
have a different compressor curve
than the one in the library for one of
these reasons:
l

When the model was built, the
compressor was connected to

l

The library may have been
changed by an unauthorized
individual, and while it was
accurate originally, now the
data is no longer valid. In this
case, it would be best to not
update the compressor in your
model, and to inquire into the
cause of the inaccurate data
within your organization.

Library Locations in General Preferences
When performing an engineering analysis with or even without cost estimating, there may be many engineering
libraries that underlie the model.
These libraries need to be connected
in the Library Browser in order to be
accessible by the model. However, to
know what libraries are actually
needed, one needs to first load the
model. This creates a dilemma.
To help alleviate the dilemma, users
can create "Library Search Locations"
in the User Options window. Figure 1
shows an example. Once specified,
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you can set these as your default locations by clicking the Set As Default
button. When AFT xStream tries to
open a model that requires certain libraries, and those libraries have not
been connected already, AFT
xStream looks for them in the locations specified in the User Options. In
addition, AFT xStream looks in the
model's folder. If AFT xStream finds
the libraries in one of these locations,
it automatically adds it to the list of connected libraries in the Library Manager. If it cannot find a library, it
informs you once the model is loaded.

Figure 1: Library Search Locations can be
defined in the User Options window
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Theory and References
This section focuses on the fundamental theories that are used in
AFT xStream's solution method. Additionally, this chapter gives information
on the source material for the theories
used. Topics include discussions on
the theories that comprise the network
solution, compressible flow theory,
sonic choking, transient flow theory,
and information on references used in
the development of AFT xStream.

Content

cp

specific heat, constant pressure

cv

specific heat, constant volume

CV

valve coefficient

D

diameter of a pipe

e

specific energy

F

Force

f

friction factor

fT

turbulent friction
factor (used by
Crane, 1988)

Nomenclature
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fL

laminar friction
factor

Review of Compressible Flow
Theory
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fTr

transition friction
factor

Nomenclature

F

error value in mass
balance

a

sonic speed

g

gravitational constant

A

cross-sectional flow
area of a pipe

h

internal convection
coefficient

h

enthalpy, static

B

compatibility equations parameter for
method of characteristics

ho

enthalpy, stagnation

H

head

J

Jacobian matrix

k

thermal conductivity

K

loss factor

C

Cd

compatibility equations parameter for
method of characteristics
discharge coefficient
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L

length of a pipe

v

specific volume

mass flow rate

V

volume

M

Mach number

V

velocity

n

general constant

w

work

N

compressor synchronous speed
(rpm)

x

distance along pipe
centerline

z

elevation

P

pressure, static
Z

Po

pressure, stagnation

compressibility
factor

Pw

wetted perimeter

P

power

q

heat rate to a pipe

Q

volumetric flow rate

r

radius

r

relaxation

R, R’

resistance or gas
constant

Rc

coefficient of rigidity

Re

Reynolds Number

s

fan speed

s

entropy

t

time

T

temperature, static

To

temperature, stagnation

u

internal energy

α, μ, θ

angle

β

diameter ratio

β

coefficient of
volume expansion

λ

method of characteristics multiplier

η

efficiency

ν

kinematic viscosity

ε

roughness

γ

specific heat ratio

ρ

density

τ

shear stress

ω

rotational velocity

μ

dynamic viscosity

Subscripts
i

junction or pipe sta-

Index 393
tion at which solution is sought
j

junctions with pipes
connecting to junction i

R

rated conditions for
a compressor, usually BEP

o

stagnation
infinity, far away,
ambient

new

current time for
computation

old

most recent time
for computation

Review of Compressible
Flow Theory
This topic gives an overview of
internal compressible flow theory. For
a more complete development of compressible flow theory, please consult
one of the many textbooks available
(Anderson, 1982, Saad, 1993, and
Shapiro, 1953).

What is Compressible Flow?
Compressible flow is a specialized
branch of fluid mechanics that
describes the flow of gases. This field
of study is sometimes called gas
dynamics, which is a synonymous
term.

Compressible flow theory draws heavily from the fields of fluid mechanics
and thermodynamics. This important
branch of fluid mechanics has been
developed almost completely since
the year 1900. Its development has
been largely driven by the extraordinary progress in the applied fields of
aerodynamics and aircraft technology.
The field of compressible flow breaks
down naturally into the two related
areas of internal and external flow.
Among the important applications of
external compressible flow are the
design of aircraft and airfoil design.
Among the important applications of
internal compressible flow are pipe
flow, nozzles and gas turbines. In AFT
xStream, the interest is entirely in
internal compressible flow.
The basic feature that distinguishes
compressible from incompressible
flow is the changing density of the gas.
The density of the gas is related to the
temperature and pressure of the gas
through an equation of state. The variable density makes traditional incompressible analysis techniques of
limited usefulness, and in general
makes pipe flow analysis much more
complicated.
The variable gas density has several
important ramifications. First, the velocity of the gas is related to density
through the continuity equation, and
thus velocity also becomes a variable
even in constant area pipes. Second,
the density dependence on temperature means that the energy equation is coupled to the equation of state
and must be solved simultaneously
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with the other governing equations.
And last, the velocity of the gas is constrained by the sonic gas speed. Thus
unusual effects like sonic choking can
occur which further complicates analysis.
It should be noted that not all gas
flows are compressible. In some
applications the gas velocities are low
enough or the pressure drops are
small enough that compressible
effects are insignificant. In such situations, systems can be modeled with
traditional incompressible techniques.
AFT xStream is capable of modeling
gas flows that are either compressible
or incompressible.

Equation of State
The equation of state relates the density, pressure and temperature of a
gas. In principle, knowledge of any
two of these parameters makes it possible to determine the third.
The ideal gas equation of state is
given by the following

where Rg is the gas constant for the
particular gas. The above equation is
known as the ideal gas equation,
because it offers an idealized model to
relate the pressure, density and temperature of a gas. For simplicity, the
“g” subscript will be dropped and it is
to be understood that R is not the universal constant, but that for a particular gas.
Experiments have shown that Equation 63 can be applied to a more general selection of gases by introducing
the compressibility factor, Z, which
compensates for departure from ideal
gas behavior.

(64)

There are many methods of determining Z. These methods are found in
textbooks and handbooks, each having strengths and weaknesses.

First Law and Isentropic Relationships
where

is the universal gas constant

and is the molecular weight of the
gas. These two terms are frequently
combined into a constant Rg

(63)

From the First Law of Thermodynamics we know that

(65)
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For a reversible process, the work
term can be represented by the following

(66)

By using a suitably average specific
heat constant, the enthalpy can be
related to temperature

(71)

where v is the gas specific volume
(inverse of density). In addition, the
incremental addition of heat is given
by

and can be substituted into Equation
70 to obtain

(67)

where s is the entropy. Substituting
Equations 66 and 67 into 65 and
rearranging yields

The specific volume is the inverse of
density, thus

(72)

(68)

The enthalpy is related to the internal
energy by the following identity

(69)

Differentiating yields

To simplify the following concepts, a
perfect gas will be assumed and extensions to real gases will be made
without proof. Later applications will
describe the effects of real gas behavior in more detail.
For a perfect gas, the third term in
Equation 72 can be modified to obtain

so that Equation 68 becomes

(73)
(70)
Integrating Equation 73 results in
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(74)

In many applications the local gas flow
is isentropic, which causes the left
side of Equation 74 to go to zero yielding

(79)

The ratio of specific heats can also be
calculated by

(80)
(75)

For an ideal gas it can be shown that

(76)

The parameter γ is very important in
determining the thermodynamics in
isentropic processes. When considering a real gas, as the pressure
increases Equation 80 takes on a modified form (Bejan, 1988, pp. 178)

or rearranging
(81)
(77)
By algebra Equation 75 becomes
where γ is the ratio of specific heats.
For a real gas, Equations 76 and 77
become

(78)

(82)

By similar methods it can be shown
that
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(83)

To summarize, Equations 82 and 83
are isentropic relationships that are
valid for real gases if the appropriate
value for γ is used.

(85)

Using Equation 85 in Equation 84 and
carrying through the differentiation

Sonic Speed and Mach Number
The sonic speed of a gas is the velocity at which disturbances propagate
within a gas. Unless a system is specially designed to produce supersonic
flow, the sonic flow speed is the maximum speed at which the gas can
travel.
It can be shown that a sound wave is
an isentropic phenomenon involving
virtually no energy loss, and that the
speed of sound is given by the following equation (based on mass and
momentum conservation)

(84)

where a is the speed of sound and the
subscript “s” refers to isentropic conditions. Another more useful form of
Equation 84 is obtained by combining
Equations 82 and 83 to relate pressure and density

or using the ideal gas equation (Equation 63)

(86)

Equation 86 is the classic equation for
speed of sound, and since the specific
heat ratio varies only slightly, the
speed of sound effectively depends
only on temperature.
For real gases, Equation 86 requires
using the real gas equation (Equation
64) to obtain

(87)

As an example of sonic velocity, consider air at 70º F (530º R). The specific
heat ratio for air is about 1.4, and
assuming ideal gas (Z = 1) then
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Stagnation Properties in
Compressible Flow

The relationship between the gas velocity and sonic speed is known as the
Mach number.

(88)

The Mach number is a dimensionless
quantity that is the most important
parameter in compressible fluid flow.
Relating all parameters to the Mach
number greatly simplifies compressible flow calculations.
In general, the sonic gas velocity is the
maximum that can be attained in a system, thus the largest Mach number in
a pipe system is 1. This is known as
sonic flow. Flows less than Mach 1 are
referred to as subsonic flows. It is in
fact possible to attain Mach numbers
greater than 1 by using a specially
designed convergent-divergent
nozzle. Flows greater than Mach 1 are
referred to as supersonic flows. There
are special applications for supersonic
flows in internal flow systems, however these applications are not generally of interest to the piping engineer
and thus no attempt is made to
address supersonic flows in AFT
xStream. AFT xStream strictly
assumes that Mach 1 is the maximum
in the system.

In application of Equation 65 to compressible pipe flow, use of the fluid
enthalpy simplifies energy balance calculations. The enthalpy is a convenient parameter that combines the
internal energy changes with the work
performed by volume changes in the
flow. The energy equation is:

(89)

A new parameter called the stagnation
enthalpy is introduced which is
defined as:

(90)

Introducing Equation 71 into Equation
90 results in

(91)

where To is the stagnation temperature. The stagnation properties
are sometimes referred to as “total”
properties, which is a synonymous
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term. In contrast, the temperature, T,
is the thermodynamic temperature
that we are accustomed to, and takes
on the more descriptive name of static
temperature.
Using Equation 79 to replace cp results in

(92)

Between pressure, temperature,
enthalpy and density, it is easiest to
grasp the physical difference between
static and stagnation properties when
considering pressure. The classic
example is a pitot tube that is normal
to the flow or pointed directly into the
flow. Figure 1 depicts the distinction.
The ratio of stagnation to static conditions for pressure and temperature
are shown in Figure 2.

and using the Mach number, Equation
88, this becomes

(93)

Equation 93 relates the stagnation
and static temperatures through the
single flow parameter Mach number
and γ, which is frequently constant.
Following from Equation 82 and 83

(94)

(95)

Figure 1: Comparison of static and stagnation pressure measurement at a pitot
tube.
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frictionless pipe will have constant
stagnation pressures even if the area
(and hence velocity) changes. The
stagnation enthalpy will remain constant as long as no heat transfer and
no elevation change occurs (see Equation 89). If the stagnation enthalpy is
constant, the stagnation temperature
remains constant insofar as Equation
71 remains valid. Departures from
Equation 71 mean that the stagnation
temperature can change in an adiabatic pipe, but this change is usually
small. For a perfect gas, Equation 71
is always valid and thus stagnation
temperature is always constant in adiabatic flow.

Figure 2: Variation of stagnation to static
temperature ratio and stagnation to static
pressure ratio with Mach number. Gamma
= 1.4.

The stagnation temperature, stagnation enthalpy and stagnation pressure (and to a lesser extent,
stagnation density) are of great importance in compressible flow systems.
The stagnation property is made up of
the “static” portion (which is the thermodynamic portion) and the
“dynamic” portion (due to the fluid
motion). The stagnation property is
that property that would exist if the
flow was brought to rest. In a fluid at
rest (such as a large gas tank) the
stagnation and static properties are
equal.
The stagnation properties take on significance because they combine the
effect of fluid velocity. Thus, a

The convenience of stagnation properties is that frictional pressure loss
and heat transfer calculations can be
performed by using the stagnation
property, thus avoiding the need to
separately calculate dynamic (velocity) effects.
Also of importance is the issue of pipe
networks. When a branch exists in a
compressible flow network, a change
in flow area is almost certain. The
change in flow area means a change
in velocity, and hence a change in the
static pressure and static temperature.
However, the stagnation pressure and
temperature must always match at
branching boundaries. The result is
that the stagnation pressure and temperature are the key variables to solve
for in a network pipe system.
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Motion, which states that the change
in momentum is proportional to the
sum of the acting forces, or

The Continuity Equation
The continuity equation is the equation that applies the Law of Mass Conservation. For steady flow, the vector
integral form of the continuity equation
is given by

(99)

For gas flow in a pipe, the acting
forces are the pressure forces and friction forces. Assuming one-dimensional flow in a constant area pipe, the
differential form of Equation 99 is

(96)

Carrying out the integration of Equation 96 and assuming one-dimensional flow in a pipe results in

(100)
(97)

If the pipe is of constant area, Equation 97 can be differentiated to obtain
the following

(98)

Equation 98 states that any increase
in gas density must be accompanied
by a decrease in velocity.

The Momentum Equation
The momentum equation is an expression of Newton’s Second Law of

where τw is the wall shear stress. The
wall shear stress can be expressed in
terms of a Moody friction factor, f (onefourth of the sometimes used Fanning
friction factor), and defined as

(101)

Substituting Equation 101 into Equation 100 results in

(102)

Equation 102 relates the change in
fluid momentum (the third term) to the
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pressure forces (first term), friction
forces (second term) and body forces
(fourth term). The four terms balance
to zero.

because of the simplifications that result, in general only static conditions
should be used. Thus

The Energy Equation
The First Law of Thermodynamics
was introduced earlier in Equation 89,

(89)

or, using the stagnation enthalpy
(Equation 90), the energy equation
becomes

Frictional Effects in Pipes
To clearly understand the effect of friction in a pipe, it is convenient to look at
the case of isothermal flow. The
momentum equation, Equation 102,
will be used as the starting point. Neglecting gravity effects,

(103)
From the continuity equation (98)
In the case of constant elevation, dz is
zero and Equation 103 states that any
heat transfer in a pipe is accompanied
by a proportional change in stagnation
enthalpy. If no heat transfer occurs
(adiabatic flow), the stagnation
enthalpy is constant.
For a perfect gas, the enthalpy is
related to temperature by Equation 71.
In general, enthalpy is a function of
static temperature and pressure

Substituting this into the momentum
equation

For ideal gas, isothermal flow,
While it is tempting to relate stagnation conditions on a similar basis
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(104)
Therefore, from the continuity equation (98)
Therefore

The conclusion therefore is that in isothermal frictional pipe flow, the velocity will always increase along the
pipe. Simply put, the gas will accelerate. It can also be shown that the
gas will accelerate if the flow is adiabatic. This further means that the
Mach number will increase along the
pipe length, eventually reaching Mach
1 sonic conditions if the pipe is long
enough.

or using the Mach number

or

(105)

For subsonic flow, the quantity on the
right hand side will always be negative. Therefore, dP will always be negative when there is isothermal flow
with friction, which is what one would
expect. If dP is negative

Once sonic conditions are reached, no
additional acceleration is possible.
Thus the flow will experience sonic
choking. When a flow experiences
sonic choking, lowering the downstream pressure to increase the differential pressure will not increase the
flow. This phenomenon is frequently
encountered in long gas transfer lines,
and is addressed by placing compressors in the pipeline at regular intervals.
It should be noted for completeness
that the previous development
assumed isothermal flow.

then from the equation of state (104)

If pipe conditions are such that a gas
is cooled along its length, then it is possible to decelerate a compressible
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flow. The reason decelerating flow
can occur when the gas is cooled is
seen from the equation of state. The
ideal gas equation, in differential form,
is

The case of adiabatic flow is frequently encountered in short pipelines
or in cases where the pipes are well
insulated. When the flow is adiabatic,
the static temperature will decrease
along the pipe. This can be seen from
Equation 93. For perfect gases, the
stagnation temperature is constant in
adiabatic flow. As the Mach number,
M, increases, the static temperature
must decrease.

and eliminating density using the continuity equation

But what happens when the pipe is
cooled? When cooled, the stagnation
temperature will decrease and the
static temperature will actually
decrease more than it would naturally.
Thus, we can see that adiabatic flow
cannot always be relied upon to be an
extreme case.

If cooling occurs, then the temperature
change is negative, and because the
pressure change is also negative, the
velocity change can be either negative
or positive. Thus, accelerating or
decelerating flow is possible. In most
applications, the pressure changes
more rapidly than the temperature,
making the velocity change positive
resulting in accelerating flow.

Isothermal and Adiabatic
Flow
Since the majority of gas flow applications operate somewhere between
isothermal and adiabatic flow, these
two idealized cases are frequently
taken as the extremes to consider. As
discussed in the previous section, this
is not strictly true.

The case of isothermal flow is frequently encountered in long gas transfer pipelines. When the flow is
isothermal, then by definition the temperature remains constant. This can
only occur if the gas is heated from its
tendency to cool down. In a long transfer line exposed to ambient conditions,
the tendency is for the gas pipe material to come to equilibrium with the surroundings, and the gas will tend
toward equilibrium with the ambient
conditions as well. The gas is heated
by the ambient conditions outside the
pipe.
In a more general case of gas heating,
the heating may be strong enough to
actually increase the static temperature. This means that the isothermal condition is not the extreme
limit either. There is, in fact, no limit to
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gas heating effects until conditions
reach ionization or dissociation.
Figure 3 shows an example of air flow
in a pipe where the adiabatic and isothermal flow do not bracket the range
of possible flow conditions.
This discussion points out a frequent
misconception among engineers that
isothermal and adiabatic flow are the
extreme cases to consider in gas
flows. A more accurate statement is
that the conditions under which the
majority of gas pipelines operate have
heat transfer boundary conditions that
maintain the gas between adiabatic
and isothermal behavior. For most
practical applications, adiabatic and
isothermal flow can be considered as
the extreme cases. But it has been
shown that this is not a completely general rule, and may be incorrect in
some applications.
One last comment of practical importance. Whether a pipe operates adiabatically or isothermally or somewhere
in between or outside, the primary
impact of these assumptions is on the
gas temperature.
Frequently, for analysis simplification
purposes, a gas is assumed to operate either adiabatically or isothermally,
and the result is that the flow rates and
gas pressures in the system do not
change significantly between these
two idealized cases. Thus, if the purpose of the analysis is to determine
the system flow rate or flow distribution in a network, the heat transfer
assumption used for the pipe will frequently have only a second order
effect on the results.

Figure 3: Comparison of temperature profiles and flow rate predictions for adiabatic, isothermal, heated and cooled air
flow in a 20 ft. long 1 inch steel pipe. Inlet
conditions are 100 psia, 111 °F and outlet
pressure is 60 psia. Cooled flow has ambient temperature of 30 °F. Heated flow has
ambient temperature of 220 °F. Both
heated and cooled cases have pipe wall
and insulation heat transfer coefficients
which total to 100 Btu/hr-ft2-F. Note how
adiabatic and isothermal cases do not
bracket conditions. See Walters, 2000.
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Transient Theory
AFT xStream simulates transient systems using fundamental equations
based on conservation of mass,
momentum, and energy. These fundamental equations are solved using
the Method of Characteristics.

such as the Method of Characteristics.
For a complete development of the
equations please see one of the many
excellent references (Moody 1990,
Wylie 1993, Chaudry 1987, and Swaffield 1993).

The math and calculations needed to
support AFT xStream's transient simulations can be complex at times. The
topics in this section attempt to clearly
detail the theory behind AFT xStream.
Please reach out to AFT Support if
you have further questions.

Transient Flow Equations
Any rigorous fluid dynamics solution
must start with the most fundamental
laws of physics. For fluid flow there
are three core equations - conservation of mass, Newton's second
law of motion, and conservation of
energy. We will consider the below
control volume in a pipe. The control
surfaces 1 and 2 are permitted to
move relative to one another, and the
unlabeled control surface on the pipe
wall must remain fixed to the wall. For
the purposes of analyzing a fluid transient, it is safe to consider the system
one-dimensional in the x direction.
Note that there is one radial effect that
is important to consider - the change
in cross-sectional area of the pipe.
The resulting equations are nonlinear
hyperbolic partial differential equations, requiring a numeric solution

Figure 1: Control volume

Continuity Equation
First we apply conservation of mass to
the control volume via Reynold's
Transport Theorem:
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Simplifying to one dimension:

According to the Leibniz integral rule:

Momentum Equation

Applying this relationship and canceling terms:

Considering a mean value of the integral:

The application of Newton's second
law follows from the same control
volume above. Again applying Reynold's Transport Theorem we begin
with the following relationship:

Very similar to the continuity equation,
we can apply a one dimensional simplification, the Leibniz integral rule,
and consider the resulting integral as
a mean over the interval. These steps
are extremely similar to the above and
are not shown for brevity.

Divide by δx

Summing the forces on the body:

Expand and group terms to find the
continuity equation:
To find the shear term, we consider a
steady force balance with only two
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terms - the pressure across a section,
and the shear term. We can find the
pressure across the section with the
Darcy-Weisbach relationship. Note
that this step assumes that the transient shear term can be calculated
with an equivalent steady state velocity.

Gathering the remaining terms, we
arrive at the momentum equation:

Energy Equation
First apply Reynolds Transport Theorem to Newton's first law:

Incorporating this, dividing through by
δx, and assuming that the areas on
the pressure terms can be considered
constant, we arrive at the following
combined equation:

Expanding the partial derivatives, and
dividing through by ρA, we find the
continuity equation and can drop
those terms.

From the First Law of Thermodynamics:

Assuming that the shaft work and viscous work are zero, only the pressure
work will contribute as follows:
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Combining the three equations above,
the surface integrals can be simplified
as follows

Assuming that gravity and elevation
are constant with time, the partial derivative of gz can be dropped. The
internal energy derivative can then be
substituted into the overall equation.

Simplifying the surface integrals into
one dimension, the equation becomes

After expanding the partial derivatives
and grouping the common terms results in the following energy equation.
Dividing through by ∂x, expanding the
derivatives and grouping the derivatives results in the following.

Modified Conservation Equations
To further simplify the above, the continuity equation indicated above can
be eliminated. To eliminate the
internal energy term use the definition
of internal energy and take the partial
derivative as follows.

The continuity, momentum and
energy equations derived above contain a large number of variables which
make them unwieldy.
The stagnation and static enthalpy
terms in the energy equation can be
eliminated using the definition of stagnation enthalpy, the first law of
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thermodynamics, and various thermodynamic relations and identities.
The rearranged energy equation is as
follows.

After inserting the above continuity
equation into the Modified Energy
equation, multiply through by a2 to find
the Modified Continuity Equation as follows
In this form, part of the momentum
equation can be inserted into the
energy equation. Rearrange the
momentum equation as follows. Note
that the sin(α) term in the momentum
equation shown previously is equivalent to dz/dx.

The rearranged momentum equation
can now be inserted into the energy
equation to get the Modified Energy
Equation:

The continuity equation can be
rearranged to insert into the Modified
Energy Equation as follows

The Modified Continuity and Energy
equations can be further simplified by
defining the variable F. The final modified equations for F, continuity,
energy, and momentum can be seen
below in order:
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Note that for the above equation, the
area was assumed to be constant, so
all partial derivatives with respect to A
were dropped to simplify the equation.
Rearranging terms from the linear
combination above

Method of Characteristics
The Method of Characteristics is a general approach for solving a partial differential equation by reducing it to a
system of ordinary differential equations.
We see here how it is applied to the
transient flow equations. The three partial differential equations have three
unknowns P,V, and ρ, and two independent variables x and t. Application
of the Method of Characteristics will
generate six ordinary differential equations.

Characteristic Equations
First linearly combine the equations
with the introduction of constant
factors represented by λ:

We define relationships for λ1, λ2, and
λ3 :
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By asserting that λ3 = 1, it is found that

and
where

Substituting into the above equation:

We have three solutions for λ, each
valid along a certain characteristic
line, as will be described further
below. The solutions are as follows

This represents the six characteristic
equations that we are searching for,
paired as the right running (R), left running (L), and particle path (P) sets of
equations:

The relationship between the time
step, length step, sonic velocity and
velocity from the characteristic equations shown here is crucial for effectively sectioning the pipes, which is
discussed further in Pipe Sectioning Introduction to Method of Characteristics.
Note: This set of ordinary differential equations represent
an exact solution to the governing equations, given the
minor assumptions that flow
is one dimensional, gravity
does not change in time and
space, and the pipe is rigid
and constant area.

Numerical Method
We can simplify the equations further
into a form that is convenient for
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simulation.
For each of the equations multiply by
dt as is shown below for the right running characteristic

Figure 1: Characteristic grid. The point 4
sees effects from points R, L, and P after
some time dt, which has equal magnitude
of dx/a

Setting up the integral along the right
running characteristic line:

This equation can be integrated along
the right running characteristic.
It is useful at this stage to consider a
graphical representation of the characteristic grid.
On the characteristic grid point 4 will
be affected by the right running characteristic from point R, the left running
characteristic from point L, and the
particle path characteristic from point
P.

This integrand represents the exact
solution. However, in order to evaluate
the integral, several major assumptions will be made:
1.

The values are only known at
the grid points (points 1, 2, and
3 in Figure 1). Therefore, interpolation is required to find the
values at points R, L, and P. In
literature this is often cited as
the largest source of error. Linear interpolation is used to
determine the position, z, and
the properties at each of the
starting points R, L, and P.
Though compressible flow properties do not vary linearly along
a pipe, it has been found that
more sophisticated interpolation is less stable and
requires a much larger calculation time, which is why linear interpolation is used for
xStream.

2.

The variables in each integrand
cannot all be related, so an analytical solution cannot be found
for each of the integrals.
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Instead, the integrands are
assumed to be constant, using
the values from the starting
point. In some cases this may
be a good approximation, as
the properties are relatively constant. However, in other cases,
such as at high Mach numbers,
the properties would change
rapidly in reality. Adding additional sections helps reduce
error caused by this assumption.
3.

Related to the constant integrand and interpolation assumptions, the characteristic lines
are assumed to be straight. In
reality the slope would constantly change as both the velocity and sonic velocity are
changing over time. Assuming
the characteristic lines are
straight allows the starting
points R, L, and P to be interpolated as discussed above.

We can repeat the above process for
the left running characteristic and
particle path characteristic to arrive at:

where

Using the 3 assumptions above, the
integral is trivial, and the below solution can be found for the right running
characteristic:

where
We have finally arrived a system of
three equations with only three
unknowns - pressure, density and velocity at point 4. These equations can be
further arranged into a convenient
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form known as the compatibility equations.

(Particle
Path
Characteristic)

Related Topics
Transient Result Accuracy 45
Nomenclature
391
Cv/Kv and XT Loss Model 193

Compatibility Equations
From the characteristic equations
(repeated below), we can construct
three convenient equations known as
the compatibility equations.

(Positive
Wave
Characteristic)

The only unknown terms in these
equations are the pressure, velocity
and density at point 4. The other terms
are found from a previous time step, or
from the initial conditions as determined from the steady state MOC simulation.
Rearranging terms:

(Negative
Wave
Characteristic)
and defining six new constants (constant for this time step):
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Which can be solved directly for pressure and velocity, then used to directly
calculate density.
Note:The compatibility equations
allow a solution of all interior
points in a pipe. However, the
pipe endpoints are solved by
applying specific boundary
conditions. The boundary
condition relationships build
on the previous methods,
and offer the final needed
information to generate a
complete solution.

Related Topics
Method of Characteristics

411

Transient Sonic Choking
We have our simplest equations yet:

During the transient solution sonic
choking may begin at any of the geometries described in the Sonic Choking Detailed Description topic,
including all junctions except for the
dead end junctions. In addition to the
geometries previously discussed,
sonic choking may occur at a junction
at the inlet of a pipe in response to
rapid system changes. Choking at the
inlet of a pipe is not sustainable, and
may result in shock waves moving
through the system, as is discussed
further below.
AFT xStream evaluates every boundary calculation (i.e. junction inlet/outlets) at every time step to determine if
sonic choking would occur. If sonic
choking is detected at a junction,
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xStream will adjust the solution
method at that junction accordingly.
Under sonic conditions, the defined
boundary condition at the choke point
is no longer meaningful, as it cannot
be reached. However, because the
flow is sonic the velocity must be
equal to the sonic velocity, a. Sonic
velocity depends on the local state,
which is unknown. Therefore, iteration
is required to determine the velocity.
Iterations will be performed on the
velocity using the appropriate wave
compatibility equation to calculate
pressure. To calculate the density for
an inflow the pressure and the specified temperature/enthalpy will be
used. For an outflow boundary the
density is calculated using the particle
path compatibility equation.

Shock Waves
A shock wave is a compression wave
across which velocity transitions from
supersonic to subsonic, and also
causes discontinuities in other properties such as pressure, temperature,
and density. (Saad, 1993) It is
simplest to discuss shock waves by
discussing how compression waves
are formed. Compression waves may
or may not become shock waves,
depending on the conditions.
A compression wave is generated in a
pipe or duct due to a series of incremental, instantaneous velocity
changes in the flow. Each velocity
change generates a sound wave that
begins traveling through the gas. As

the gas compresses each subsequent
wave will have a higher sonic velocity
caused by the increasing temperature.
Eventually the faster waves will catch
up to the initial wave, causing the compression wave to steepen and the
pressure drop across the wave to
increase. If an abrupt enough velocity
change occurs, then the compression
wave will become a shock wave.
AFT xStream does not employ any
shock wave solution methods in the
solver. However, the method of characteristics, which is frequently used to
model wave movement, can approximate the movement of shock waves
through gas systems.

Related Topics
K Factor Loss Model
Method of Characteristics
Sonic Choking Detailed
Description
Sonic Choking
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Related Blogs
Making Sense of xT – Valve Loss in
Compressible Flow

Compressible Flow Theory in Single Pipes
In order to provide a robust method to
solve compressible flow in pipe networks, numerous fundamental equations must be solved simultaneously.
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The AFT Arrow steady state solver
which AFT xStream uses, solves the
continuity (i.e., mass balance) equation, the one-dimensional momentum
equation, the energy equation, the
equation of state, and the Mach number equation which ties together temperature and velocity.
If you are unfamiliar with the field of
compressible flow, it is suggested that
you first read the compressible flow
review topic and/or consult a textbook
for a thorough description of the subject.

Extension of Single-Pipe
Methods to Networks
Methods to solve the single pipe equations are available in the literature
(Anderson, 1982, Saad, 1993, and
Shapiro, 1953), but their extension to
pipe networks involves significant difficulties. In a network system, the flow
and energy must balance at each
branch point. Traditional solution methods in incompressible flow systems
break down because the relationships
between pressure and flow cannot be
expressed in a single convenient equation. Thus the calculation speed and
reliable convergence benefits of
incompressible flow matrix methods
are much more difficult to obtain in
compressible flow calculations. Heat
transfer and the resulting temperature
effects further complicate the analysis.
To address these issues, AFT
xStream's primary steady solver

incorporates unique methods of relating the various thermodynamic and
fluid dynamic parameters to each
other resulting in a solution methodology that is fast and offers good
convergence characteristics. AFT
xStream’s primary steady methods
maintain the integrity of single pipe
methods while preserving the required
mass and energy balances at all
branch points.
The specific techniques used by AFT
xStream's primary steady solver to
obtain solutions to the equations of
compressible flow are proprietary and
probably of little interest to the user.
What the user will be most interested
in is what equations are solved (so
that results can be cross-checked)
and what balances are calculated at
branch points. Therefore, sufficient
information is provided to enable
users to verify results, while the proprietary aspects of AFT xStream’s
solution methods are not described.

Fundamental Equations
The continuity equation applied to a
constant area pipe yields:

(1)

The one-dimensional momentum
equation applied to a constant area
pipe yields:
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(2)

Assuming the pipe is straight over the
computing section, Figure 1 shows the
relationship between dx and dz:

Related Topics
Nomenclature

391

Continuity Equation at a
Branch
By applying the continuity equation at
branch i, we loop over all connecting
pipes and get

(3)

(1)

where
is the flow rate in the pipe
connecting junctions i and j.
Figure 1: Relationship between distance
along pipe (dx) and vertical elevation
change (dz).

Related Topics
Nomenclature

The fourth term on the left of Equation
2 accounts for pressure changes due
to body forces. AFT xStream models
body forces due to gravity. The default
value of g in Equation 2 is the standard earth acceleration (i.e., 32.174
ft/sec2 or 9.81 m/sec2).
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Energy Equation at a
Branch
By applying the energy equation at a
branch i, we loop over all connecting
pipes and get

From the equation of state for a real
gas:

(4)

or, in terms of stagnation enthalpy,
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mixture stagnation enthalpy, or the
average stagnation enthalpy of all
inflowing pipes.
(47)

where is the stagnation enthalpy at the
connection point of pipe and junction.
The elevation term shown in Equation
30 drops out because all pipes at the
junction connect at the same elevation.

Related Topics
Nomenclature

If only one pipe flows into the branch,
the branch stagnation enthalpy will
equal the stagnation enthalpy coming
out of the pipe. But if more than one
pipe flows into the branch, the stagnation enthalpy will reach an averaged
condition. It is this averaged stagnation enthalpy that results from mixing two or more streams at different
stagnation enthalpies. This stagnation
enthalpy is supplied to all outflowing
pipes. This is depicted in Figure 1 and
follows Equation 49.

391

Network Implementation
To provide converged solutions in the
shortest time possible, matrix solution
techniques are used. Matrix techniques allow all pipes to be solved simultaneously, which is faster and offers
the best convergence characteristics.
To obtain a valid solution in a network,
the stagnation pressure at each
branch point will be equal and the
mass flow and energy flow will sum to
zero at the branch. Although the stagnation pressures at the pipe endpoints
will equal that at the connecting junction, this is not true for stagnation
enthalpy (and temperature). The stagnation enthalpy at the end of a pipe
will be that enthalpy that results from
the heat transfer in the pipe. Once the
fluid flows into the junction, the stagnation enthalpy will change to the

(49)

where the + superscript indicates the
summation applies only to positive
inflows into the junction.
The concentration balance at a junction is similar to stagnation enthalpy.
The junction concentration itself will
not match the concentrations for the
inflowing pipes, but will be a mixture of
the incoming flow streams.

421

Quick Start Guide
After the primary steady solver converges, AFT xStream loops over each
junction and adds up the inflow and
outflow of mass and energy and compares the sum to the solution tolerances. If it appears that any junction
is out of tolerance, a warning is given
in the output.
In the Solution Balance Summary
table AFT xStream provides additional
information on the balance at each
junction. This table can be displayed
by selecting the option in the Output
Control window General Output folder.
Figure 1 shows an example of the
Solution Balance Summary table.

Figure 1: Flow weighted mixing and
energy balance

Related Topics
Nomenclature
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Verifying Network Solutions
AFT xStream's primary steady solver
uses a modified Newton-Raphson matrix method to obtain a system level balance of mass and energy. When the
Solver is finished, the continuity and
energy equations are satisfied at all
branching sections. Once solved, it is
a simple matter to go back and sum up
all mass flows and energy at each
branch to verify that these equations
are satisfied. In fact, AFT xStream
does just that.
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the downstream conditions, such as
lowering the pressure, produce no
additional flow. In many pipe applications sonic choking dominates the
system behavior.
Predicting the flow rates under such
sonic choking conditions can be very
difficult depending on where the choking occurs. AFT xStream is designed
to identify sonic choking and predict
the system behavior under such conditions. In addition, xStream can
approximate moving shock waves in
the system.

Related Topics
Cv/Kv and XT Loss Model 193
Sonic Choking Detailed
Description
422
Transient Sonic Choking 416

Figure 1: Solution Balance Summary
table shown in the Output window offers
a balance report of all junctions in the window.

Sonic Choking
Sonic choking occurs in a pipe system
when the gas attempts to accelerate
to a velocity faster than the local sonic
velocity at some point in a system.
Being unable to accelerate any further, the gas reaches its maximum
velocity at sonic velocity. Changes to

Sonic Choking Detailed
Description
Sonic choking occurs when some location in the pipeline experiences a
local velocity equal to the sonic velocity of the gas. AFT xStream can
account for sonic choking, and approximate moving shock waves in gas systems.

Sonic Choking Types
Sonic choking can occur in three geometric configurations in a pipe system.
Figure 1 depicts the three possibilities.
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The first case can be called endpoint
choking because it occurs at the end
of a pipe as it exits into a large vessel
or the atmosphere. In this situation,
the gas cannot drop its pressure to
match that at the discharge without
accelerating to sonic velocity. A choke
point forms at the end of the pipe,
which results in a pressure discontinuity across which the discharge
pressure condition is met.
The second case can be called expansion choking, and is similar to the first
case. Expansion choking can happen
when the flow area of the pipe is
increased rapidly. For example, this
occurs when the pipe is expanded
from a two inch pipe to a three inch
pipe. Another example is when a pipe
enters a flow splitter where the sum of
the pipe areas on the splitting side
exceeds the pipe area of the supply
pipe. A choke point forms at the end of
the supply pipe, and a pressure discontinuity is established.
The third case can be called restriction
choking. This can occur when the gas
flows through a restriction in the pipe
such as an orifice or valve. In such a
case the flow area of the gas is
reduced, causing a local increase in
velocity which may reach the sonic
velocity. A choke point forms at the
restriction, with a pressure discontinuity similar to the first two cases.

Figure 1: Three configurations which can
result in sonic choking. From top to bottom, endpoint choking, expansion choking, and restriction choking

Figures 2-4 show example stagnation
pressure and Mach number profiles
for the three cases. The data for the
cases are: Supply air at 100 psia and
1000° R discharging to 30 psia, with
Figure 2) 2 inch pipe with no restrictions or expansions, Figure 3) 2 inch
pipe expanding to 3 inches at the midpoint, Figure 4) all pipe is 2 inch with
orifice at midpoint with 0.6 area ratio.
Mach number spikes to 1 at the orifice
then reduces to 0.29 immediately
after. For clarity this spike is not
shown.
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Figure 2: Example stagnation pressure
and Mach number profiles for endpoint
choking.

Figure 4: Example stagnation pressure
and Mach number profiles for restriction
choking. Note that the Mach Number
reaches 1 within the restriction at 0.5.

Steady State Sonic Choking
During the steady state the choked
flow rate can be determined from
Equation 50 by inserting a Mach number of 1 in Equation 51. These equations can be derived from the
continuity equation (Saad, 1993):

Figure 3: Example stagnation pressure
and Mach number profiles for expansion
choking.

(50)

where:
(51)
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In practice it is difficult to apply Equation 50 to choked conditions because
the local stagnation conditions, P0,
and T0, are not known at the point of
choking. For instance, to apply these
equations to endpoint choking (Figure
1, top), one must calculate the stagnation pressure and temperature at
the end of the pipe before the choke
point. The problem is that the stagnation pressure and temperature
before the choke point depend on the
flow rate, which is what we are trying
to calculate.
The only way to accurately calculate
such a problem is to do the following:
1. Assume a flow rate
2. March down the pipe
3. If the Mach number reaches unity
before the end of the pipe, lower the
assumed flow rate and repeat steps 13 until the Mach number reaches
sonic right at the pipe endpoint.
Obviously this is not practical without
a computer.
The area, A, in Equation 50 can also
be CdA, where the Cd is less than one
and accounts for area reductions due
to flow separation. This occurs in orifices, valves and other internal restrictions. Note that the Cd used here is
not equivalent to the discharge coefficient used for subsonic flow calculations. See Subsonic vs. Sonic
Pressure Losses for more information.
A helpful output parameter in AFT
xStream is the sonic area, which can
be compared against actual area to
determine what CdA would cause
choking at a restriction:

(52)

A CdA smaller than the sonic area
indicates that the flow would be
choked. The sonic area is one of the
output parameters.

Transient Sonic Choking
During the transient, the above choking mechanisms will still be applicable,
though additional scenarios, such as
choking at the inlet of a pipe, may
occur. In addition the calculation
method must be adjusted as the
Method of Characteristics is used for
transient pipe calculations, rather than
the marching methods used for the
steady state. See Transient Sonic
Choking for further details.

Sonic Choking Effects
The effect of sonic choking in pipe
design or operation is that the maximum physically possible pipe flow
rate has been reached for the supply
conditions. Lowering the discharge
pressure will not produce more flow
rate. Figure 5 illustrates this by showing the flow rate as a function of discharge pressure in a two inch pipe
carrying air. This pipe does not have
any restrictions, and experiences end-
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point choking at any discharge pressure below 63.6 psia.

Figure 6: Example of increasing choked
flow rate with supply pressure.
Figure 5: Example of dimensionless flow
rate vs. dimensionless pressure drop.
Sonic choking occurs just past the dimensionless pressure drop of ~0.5, after
which the flow can no longer increase.

Some engineers misapply the concept
of sonic choking and conclude that the
sonic flow rate is the maximum possible through the pipe for all conditions. This is not the case. If the
supply conditions can be increased,
the flow rate through the pipe can be
increased. In fact, the increased
choked flow rate appears to increase
linearly with increased supply pressure. See Figure 6.

The pressure drop across the choke
point in choked flow cannot be calculated directly. Methods such as "normal shock tables" do not apply. The
only way to calculate the pressure
drop is to use the choked flow rate as
a new boundary condition on the pipe
downstream of the choke point. This
boundary condition is facilitated by
knowing the stagnation enthalpy
change across the choke point is constant. For the steady state solution
governing equations can then be
applied to the remaining pipes to solve
for the static conditions. During the
transient solution the static conditions
can be found from the static conditions
at the downstream station at the previous time step.
Finally, a pipe can choke in more than
one location. This occurs when the
choked flow rate determined by the
first choke point is applied to the pipes
downstream of the shock wave and
the gas at this flow rate cannot reach
the end of the pipe without
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experiencing another shock wave.
There is no limit to the number of
choke points in a pipe other than the
number of possible geometric configurations it contains which may
cause sonic choking.
The three mechanisms that cause
choking can all occur in the same
pipeline in any combination and any
order.
See Walters, 2000 and Walters and
Olsen, 1997 for more information.

Related Topics
Nomenclature
Method of Characteristics
Transient Sonic Choking
Sonic Choking
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Subsonic vs. Sonic Pressure Losses
There are two separate pressure loss
mechanisms when gas flows through
a restriction, expansion, or end point.
l

l

Subsonic losses are standard
"form" losses and are dependent on the geometry of the
restriction, expansion, or end
point. This is the common K
factor, or discharge coefficient
for subsonic flow.
Sonic losses result when sonic
choking occurs. Sonic losses
are dependent on the minimum
effective flow area (CdA) and
are unrelated to the K factor.

The two loss mechanisms cannot
occur simultaneously in nature or in
AFT xStream. During a time step if
one mechanism is in use, the input
data for the other mechanism is
ignored by AFT xStream. The loss
mechanism in use can switch during
the transient as system operation
changes.
It is also important to note that sonic
choking at a restriction cannot be calculated if the CdA for Sonic Choking is
not entered. In this case, AFT xStream
will always use subsonic loss calculations if no CdA for Sonic Choking
has been entered, even if the actual
system would experience choked flow
at that restriction. The only exception
to this is if the restriction occurs at a
valve which is defined in terms of
Cv/Kv and XT, which can account for
both subsonic and sonic loss at the
valve.

Related Topics
Orifice
Relief Valve
Discharge Coefficient Loss
Model
Screen
Venturi
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Stagnation Properties
Solving compressible flow equations
requires equations to relate static and
stagnation properties. The following
equations are used by AFT xStream to
relate stagnation temperature,
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pressure, enthalpy, and density (T0,
P0, h0, and ρ0, respectively), velocity
(or Mach number, M), and static temperature, pressure, enthalpy, and
density (T, P, h, and ρ, respectively).

Flow Theory
Nomenclature
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Pipe Material Library
References

Stagnation temperature:

Stagnation pressure:

Stagnation enthalpy:

Stagnation density:

Related Topics
Stagnation vs. Static Pressure
Boundaries
65
Review of Compressible
393

The pipe material properties in AFT
applications were origianlly compiled
from a variety of unofficial sources.
Many of those sources are now obsolete. Beginning in 2016, pipe material
properties are taken directly from
national/international standards such
as: ASTM, ANSI, AWWA, and ASME.
Several new material standards are
also added. For example: DIN and
JIS. With the addition of a significant
number of new pipe material standards, the increased volume and scope
necessitate splitting the pipe material
library into several smaller independent libraries. All of the pipe material found in older AFT applications are
still available, but are now called "AFT
Customary".
Maintaining several independent pipe
libraries facilitates including or excluding specific standards. For example: a
pipe engineer in Germany may prefer
to use only ISO and DIN standards.
The Library manager can be used to
"Connect" or Disconnect" each of the
pipe material libraries. A list of available pipe libraries can be found below.
Note that while AFT attempts to
provide this standard information to
make defining pipe information easier
for the user, the prudent engineer will
always verify this information against
manufacturer specifications. ASTM
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and ANSI standards exist for the thickness and diameter specifications for
some of these materials. Furthermore,
AFT attempts to source reference
information from reputable and authoritative sources. However, data for pipe
roughness and thermophysical properties including density, thermal conductivity, modulus of elasticity, and
Poisson's ratio have no single standard to follow. Thus, the user should
always check that the pipe material
inputs match the actual pipe material
data for their system.
l

l

l

l

l

Fiberglass - Green Thread l

Source = Fiber Glass
Systems product data,
http://www.nov.com/Segments/Completion_
and_Production_
Solutions/Fiber_Glass_
Systems/Chemical_
Industrial/Green_
Thread.aspx

l

Roughness References
= Fiber Glass Systems
product data

l

Density References =
Average value calculated based on ID, OD
and Weight in Fiber
Glass Systems product
data

l

Thermal Conductivity
References = Fiber
Glass Systems product
data

l

Modulus of Elasticity
References = Fiber
Glass Systems product
data

l

Poisson's Ratio References = Fiber Glass Systems product data

l

Additional References =
ASTM D2996 - 17

Copper Pipe - ASTM l

Source = ASTM B42-10

l

Additional References =
Thermal conductivity
data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2; Perry's
chem eng Handbook,
7th ed. Table 10-33

Copper Tubing - ASTM l

Source = ASTM B88-09

l

Additional References =
Thermal conductivity
data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2; Perry's
chem eng Handbook,
7th ed. Table 10-31;
www.cranecopper.com.au/sizes/astmb88.asp

Ductile Iron - ANSI l

Source = ANSI-AWWA
C150-A21.50-08

l

Additional References =
Thermal conductivity
data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

HDPE - AFT Customary -
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l

l

l

Source = Applied Flow
Technology

l

Additional References =
Thermal conductivity
data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

PVC - ASTM l

Source = ASTM D178506

l

Additional References =
Thermal data from:
Materials Science and
Engineering, Callister,
Table C.4

l

Source = George Fischer Engineering handbook page 425
Additional References =
Thermal conductivity
data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

Rectangular Duct - AFT Customary l

l

l

PVDF - AFT Customary l

l

Handbook, Nayyar, 7th
ed, Table A3.2 for Type
304

l

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1

l

Poisson's Ration
Referenecs = Perry's
Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
Type 304 @ 20oC

Stainless Tubing - AFT Customary l

Source = Applied Flow
Technology

l

Additional References =
Thermal conductivity
data from: Piping Handbook, Nayyar, 7th ed,
Table A3.2

Steel - AFT Customary l

Source = Applied Flow
Technology

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,

Source = Applied Flow
Technology

Stainless Steel - ANSI l

Source = ASME-B36_
19M_2004

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conduct References = Piping
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0.23 C, 0.635 Mn
l

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

l

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - ANSI l

Source = ASME B36.102004

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

l

l

l

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn
Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1
Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC
Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - DIN 2391-1 l

Source = DIN 2391-11994

l

Steel - DIN 2458 l

Source = DIN 24581981

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3
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l

l

l

l

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn
Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1
Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

l

Source = BS EN 102161-2002

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

l

l

Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

l

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - EN 10216-2 (s1) l

Source = BS EN 102162-2002

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - EN 10216-1 (s1) -

l

Handbook, Nayyar, 7th
ed, Table A3.1

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn
Modulus of Elasticity
References = Piping
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l

l

Paper 410, 1988 edition,
A-23 for Comerical Steel
l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

l

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - EN 10217-1 (s1) l

Source = BS EN 102171-2002

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

l

l

l

l

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn
Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1
Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC
Additional References =
ANSI 36.10, CRANE
Technical Paper 410

l

Steel - EN 10217-4 (s1) l

Source = BS EN 102174-2002

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conductivity
References = Piping

Steel - EN 10217-2 (s1) l

Source = BS EN 102172-2002

l

Roughness References
= CRANE Technical
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Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn
l

l

l

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1
Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC
Additional References =
ANSI 36.10, CRANE
Technical Paper 410

l

l

Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

l

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - EN 10217-6 (s1) l

Source = BS EN 102176-2002

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn

l

Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1

l

Poisson's Ratio References = Perry's Chemical Engineer's
Handbook, 7th ed, 1997
p.28-45 Table 28-18 for
SA-35P12 @ 20oC

l

Additional References =
ANSI 36.10, CRANE
Technical Paper 410

Steel - EN 10217-5 (s1) l

Source = BS EN 102175-2002

l

Roughness References
= CRANE Technical
Paper 410, 1988 edition,
A-23 for Comerical Steel

l

Density References =
Piping Handbook, Nayyar, 7th ed, Mohinder L
Nayyar, Table A3.3

l

l

Thermal Conductivity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.2 for
Wrought Carbon Steel,
0.23 C, 0.635 Mn
Modulus of Elasticity
References = Piping
Handbook, Nayyar, 7th
ed, Table A3.1
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Chempak Technical
Information - Detailed
Discussion
© Copyright 1998 Madison Technical
Software Inc. Used with permission.
Note: The information in this
Appendix was taken from
Section 8 of the Chempak
Operating & Reference
Manual, Version 4, Windows
Edition, Issue: January 1998.
Section numbering was left
unchanged, and some sections that were judged not relevant were not included so
the numbering is not sequential.
Note: Notation and references in
this Appendix apply only to
this Appendix, and are referenced at the end.

8.1 General
This section sets out the data sources,
correlations and estimation methods
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used in the CHEMPAK database. In
putting together the database, the
methods and sources were selected in
the following order of preference.
· Published experimental data
· Published correlations based on
experimental data
· Specific category correlations
· General estimation methods
Madison Technical Software has followed the general recommendations
in Reid and in Danner and Daubert as
far as selection of specific category
correlations and general estimation
methods are concerned. In selecting
specific compound data, a combination of sources has been used
wherever possible. Important sources
of specific compound data used by
CHEMPAK are:

estimated or adjusted by Madison
Technical Software. It has been our
policy to adopt and maintain a critical
approach to available data sources
and correlation methods.
The following sections set out details
of the correlations and estimation
methods used. In certain cases, the
user is directed to the original references, particularly where the
method is complex.
Data sources for Aqueous Solutions/Heat Transfer Liquids are published experimental data and
correlations based on experimental
data.

8.2 Physical Constants
8.2.1 Critical Temperature

· J Chem Eng Data

The great majority of values are
believed to be experimental. Where
values had to be estimated, the
Joback method was used.

· Daubert & Danner

8.2.2 Critical Pressure

· ESDU publications

· International Critical Tables

Most of the values are experimental.
In cases where experimental data
were not available, the critical pressure was derived from the Joback
method.

· CRC Handbook

8.2.3 Critical Volume

· Vargaftik

A majority of the values are experimental. A great majority of the remaining compounds for which
experimental values were not available had accurate boiling-point
volumes available from which critical
volume estimates were derived using
the Tyn and Calus correlation. For a

· Reid et al
· Perry et al

· API Technical Data Book - Petroleum Refining

In many cases, the compound property values are a combination of published data, published correlations
and general estimation methods.
Several properties in certain compound categories have been

439

Quick Start Guide

few substances, estimates of the critical volume were derived from the
Joback method.
8.2.4 Normal Boiling Points
All values are believed to be experimental. In some cases, the values
were slightly adjusted for vapor pressure.
8.2.6 Acentric Factors

· Critical Volume: average error about
2%
· Freezing Point: average error about
11%
8.2.8 Tyn & Calus Relation
Tyn & Calus showed a close (< 3%
error) relation between molar volume
at normal boiling point and the critical
molar volume of the form,

The acentric factor is defined as

Vb = a Vcn

w = -log10(Pvr at Tr = 0.7) - 1
In all cases the acentric factor was
derived from the vapor pressure correlation ( see section 8.8)
8.2.7 Joback Group Contribution
Method
The Joback method is used to derive
values of Tc, Pc, Vc and Tf where no
experimental data or other predictive
method was available.
Tc = Tb/(0.584 + 0.965 Sum
(Dt) - Sum(Dt)2)
Pc = 1/(0.113 + 0.0032 na Sum(Dp))2
Vc = 17.5 + Sum(Dv)

a = 0.285
n = 1.048
8.8 Vapor Pressure
The vapor pressure is expressed in its
reduced form
Pvr = Pv/Pc
Reduced vapor pressure varies from
very low values at freezing point to
unity at the critical point.
8.8.1 Published Correlations
The experimental correlations are
commonly given in the following
formats:
Wagner Equation
ln(Pvr) = (aX + bX1.5 + cX3 +

Tf = 122 + Sum(Df)
where na is the number of atoms in
the molecule and the D contributions
are given by Joback and by Reid et al
(1987). Error magnitudes for the
Joback method are as follows:
· Critical Temperature: average error
about 1%
· Critical Pressure: average error
about 5%

dX6)/Tr
with
X = 1 - Tr
FKT Equation
ln(Pv) = a + b/T + cln(T) + dPv
/T2
Antoine Equation
ln(Pv) = a + b/(T + c)
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8.8.2 Gomez-Thodos Vapor Pressure Equation
Gomez-Nieto and Thodos give the following equation:
ln(Pvr) = B(1/Trm - 1) + G(Tr7
- 1)
G = aH + bB
a = (1 - 1/Tbr)/(Tbr7 - 1)
b = (1 - 1/Tbrm)/(Tbr7 - 1)
H = Tbrln(Pc/Pb)/(1 - Tbr)

The advantages of this method are,
· fit guaranteed at T = Tb and T = Tc
· good performance with polar compounds
· good performance over Tr = 0.5 to 1
In addition, tests carried out by
Madison Technical Software show the
clear superiority of this method especially at low temperatures over the
Lee-Kesler method.

For non-polar compounds,

8.8.3 Lee-Kesler Vapor Pressure
Equation

B = -4.267 - 221.79/(H2.5exp
(0.038 H2.5)) + 3.8126/exp
(2272.33/H3) + D

Lee and Kesler give the following
vapor pressure equation:

m = 0.78425 exp(0.089315 H)
- 8.5217/exp(0.74826 H)
D=0
except D = 0.41815 for He, 0.19904
for H2, 0.02319 for Ne
For polar non-hydrogen-bonding compounds (e.g. ammonia and acetic
acid),
m = 0.466 Tc0.1667
G = 0.08594 exp(0.0007462
Tc)
B = (G - aH)/b
8.8.2 Gomez-Thodos Vapor Pressure Equations
For polar hydrogen-bonding compounds (water, alcohols),
m = 0.0052 M0.29Tc0.72
G = (2.464.M) exp(0.0000098
MTc)
B = (G - aH)/b

ln(Pvr) = f(0) + wf(1)
w = acentric factor
f(0) = 5.92714 - 6.09648/Tr 1.28862 ln(Tr) + 0.169347 Tr6
f(1) = 15.2518 - 15.6875/Tr 13.4721 ln(Tr) +0.43577 Tr6
The characteristics of this equation
are,
· guaranteed fit at Tr = 1 and 0.7
· accurate for non-polar compounds
This equation is used in the LeeKesler and Wu & Stiel equations of
state.
8.8.4 Interpolation and Extrapolation
In many cases an accurate empirical
equation is known which does not
extend to the critical point or to the
freezing point. The approach taken
here is to fit the Wagner equation by
least squares to the empirical equation and use the Wagner equation to
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extrapolate to the freezing point and to
the critical point.
Extrapolation by this method to the critical method is a very accurate procedure. Extrapolation to the freezing
point is less accurate but it does
provide reasonable values.
In CHEMPAK, the vapor pressure correlations set out in this section are
used to provide the basic data. Empirical relations are used wherever possible.

The low pressure polar correlation is
given by,
Fp0 = 1 0 < mr < 0.022
Fp0 = 1 + f(Zc) 0.022 < mr <
0.075
Fp0 = 1 + f(Zc).g(Tr) 0.075 <
mr
f(Zc) = 30.55(0.292 - Zc)1.72
g(Tr) = 0.96 + 0.1(Tr - 0.70)
mr = 52.46 m2Pc/Tc2
m = dipole moment, debye

8.9 Vapor Viscosity

Pc = critical pressure, bar
Tc = critical temperature, K

The methods of Lucas are employed
here. The equations take two forms:
· Low Pressure (< 2 atm)
· High Pressure (> 2 atm)
8.9.1 Low-Pressure Equation
v0 = a0k0{a1 + a2Trn + a3exp
(a4Tr)+ +a5exp(a6Tr)}Fp0,Fq0
v0 = low pressure viscosity in
kg/ms
k0 = M0.5Pc0.667Tc0.1667
with Pc in Pa and Tc in K
a0 = 0.0026373
a1 = 0.018

8.9.1 Low-Pressure Equation
In the above equations, if Zc > 0.292
the Fp0 is taken as unity.There are
only a few compounds that are polar
with Zc sufficiently larger than 0.292 to
make Fp0 significantly different from
unity. The evidence in any case is
scanty.
The low-pressure correction for
quantum gases (hydrogen, helium
and deuterium), Fq0, is given by,
Fq0 = 1.22 Q0.15{1 - 0.00385
(12 - Tr)2/M}
with
Tr < 12

a2 = 0.807

Q = 1.38 for helium

a3 = -0.357

0.76 for hydrogen

a4 = -0.449
a5 = 0.340
a6 = -4.058
n = 0.618

0.52 for deuterium
8.9.2 High-Pressure Equation
Define,
Z1 = v0/a0k0
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For Tr <=1, we define,

then,

Z2 = 0.60 + 0.76 Prm + (1 - Tr)
(6.99Prn - 0.60)
m = 3.262 + 14.98 Pr5.508
n = 1.39 + 5.746 Pr

Y = Z2/Z1
Fp = (1 + (Fp0 - 1)/Y3)/Fp0
Fq = (1 + (Fq0 - 1)(1/Y - 0.007
(ln(Y))4))/Fq0

For Tr > 1 define,
Z2 = Z1{1 + aPre/(bPrf + 1/(1
+ cPrd))}

v = v0YFpFq

8.10 Vapor Conductivity

with,

a1 = 0.001245

The method of Ely and Hanley is adopted for both high and low pressure
vapor conductivity. The method is
based on hydrocarbon data but gives
reasonable values for non-polar nonhydrocarbons. Errors are usually less
than 10% except for highly polar compounds. There are few experimental
data and no satisfactory correlations
for high pressure conductivity for polar
compounds.

a2 = 5.1726

The vapor conductivity is given by,

a = (a1/Tr)exp(a2Trn)
b = a(b1Tr - b2)
c = (c1/Tr)exp(c2Trm)
d = (d1/Tr)exp(d2Trp)
e = 1.3088
f = f1exp(f2Trq)

k = k1 + k2 + k3

n = -0.3286
b1 = 1.6553

with,

b2 = 1.2723

k1 = 1944 v0H(1 + 0.042332
(Cvo - 3R/2))

c1 = 0.4489
c2 = 3.0578
m = -37.7332
d1 = 1.7368
d2 = 2.2310
p = -7.6351
f1 = 0.9425

k2 = r0H(b1 + b2(b3 - ln
(T0/b4))2)
k3 = k30k31(k32 + k33k34) - 1
k30 = H/1000
k31 = exp(a1 + a2/T0)
k32 = exp(a3 +
a4/T01.5)r00.1

f2 = -0.1853

k33 = 6.1843(r0 - 1)r00.5

q = 0.4489

k34 = a5 + a6/T0 + a7/T02

443

Quick Start Guide

The parameters in the above equations are given by:

w = acentric factor
Zc = critical compressibility

v0 = low pressure methane
viscosity = Sum(cnT0(n-4)/3)
c1 = 2.90774E-01
c2 = -3.31287E-01

T* = Tr for Tr <= 2
= 2 otherwise

c3 = 1.60810E-01
c4 = -4.33190E-02
c5 = 7.06248E-03
c6 = -7.11662E-04

V* = V/Vc for 0.5 < V/Vc < 2
= 0.50 for V/Vc <= 0.50
= 2 otherwise

c7 = 4.32517E-05
c8 = -1.44591E-06
c9 = 2.03712E-08

b1 = -2.5276E-04
b2 = 3.3433E-04
b3 = 1.1200E+00
b4 = 1.6800E+02

H = 16.04 f0.5/M h0.667
Cv0 = low pressure specific
heat at constant volume in J/mol.K
R = gas constant = 8.314
J/mol.K

a1 = -7.1977E+00
a2 = 8.5678E+01
a3 = 1.2472E+01
a4 = -9.8463E+02
a5 = 3.5947E-01

M = molecular weight g/mol
f = TcF1/190.4

a6 = 6.9798E+01
a7 = -8.7288E+02

h = VcF2/99.2
Tc = critical temperature, K
Vc = critical volume, cc/mol
F1 = 1 + (w - 0.011)(0.56553 0.86276 ln(T*) - 0.69852/T*)

r0 = 16.04 h/V
T0 = T/f
V = specific volume, cc/mol
T = temperature, K

F2 = {1 + (w - 0.011)(0.3949
(V* - 1.02355) - 0.93281(V* 0.75464)ln(T*)}(0.288/Zc)

8.11 Ideal Gas Thermodynamic Properties
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Ideal gas thermodynamic properties
(i.e. at low pressure) are required for
the estimation of the thermodynamic
properties of liquids and gases.
8.11.1 Method of Joback
For those substances not covered by
published correlations, the group contribution method of Joback is used to
estimate Cp0 and the heats of formation.
Cp0 = a + bT + cT2 + dT3

Extrapolation as far as 50 K (-223 C)
using monotonic power functions fitted
to known values at higher temperatures gave estimates whose error
did not exceed 10% at 50 K and which
averaged about 2% in the range 100 K
to 273 K. This extrapolation was
tested against known values for over
80 hydrocarbons and non-hydrocarbons. Thermodynamic properties
calculated are limited in CHEMPAK to
temperatures above minus 100 C.
8.11.3 Derived Ideal Gas Properties

with,
a = Sum(njDa) - 37.93
b = Sum(njDb) + 0.210
c = Sum(njDc) - 3.91E-04
d = Sum(njDd) + 2.06E-07

Ideal gas enthalpy and entropy are
derived by integration of the ideal gas
specific heat:
The ideal gas enthalpy, h0, is given by
the integral of Cp0 from T0 to T

where nj is the number of groups of
type j and the D contributions are for
this type of group. T is in deg K. The
user is referred to Joback for details.
Reid et al (1987) gives values of the
group contributions. The error associated with this method is usually less
than 3%.

h0(T) = [C0T + C1T2/2 +
C2T3/3 + C3T4/4]

8.11.2 Low-temperature values of
Cp0

evaluated between T0 and T. T0 is a
zero-value reference temperature.
The specific heat at constant volume
is simply related to the specific heat at
constant pressure:

To our knowledge, no general estimation method exists for Cp0 below
about 260 K. In addition, empirical
datapoints and correlations in this
region are not generally available. In
order to extend the applicability of the
estimation methods to temperatures
below 260 K, extrapolation of known
values and correlations was investigated by Madison Technical Software.

evaluated between T0 and T.
The ideal gas entropy is given by the
integral of Cp0/T from T0 to T
s0(T) = [C0lnT + C1T +
C2T2/2 + C3T3/3]

Cv0 = Cp0 - R

8.12 The Equations Of
State
8.12.1 General
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The two equations of state employed
in CHEMPAK are as follows:
1. The Lee-Kesler equation of state
for non-polar compounds with moderate values of acentric factor

simple and reference fluids are determined by a pair of PVT equations with
identical form but with different parameters.
We define,

2. The Wu & Stiel equation of state for
polar compounds or those with
extreme values of acentric factor
The equations of state are used to predict the following vapor properties:
· Specific Volume
· Compressibility
· Expansion Coefficient
· Specific Heats
· Enthalpy/Internal Energy
· Entropy

Pr = P/Pc
Tr = T/Tc
Vr = PcV/RTc
where P, Pc, T and Tc are the actual
and critical pressures and the actual
and critical temperatures of the fluid of
interest.
First, Vr(0) is calculated using the constants for the simple fluid. Then Vr(r) is
calculated using the constants for the
reference fluid. From these quantities,
Z(0) and Z(r) are calculated:
Z(0) = PrVr(0)/Tr Z(r) = PrVr

· Heat of Vaporization
8.12.2 The Lee-Kesler Equation of
State
The Lee-Kesler equation of state is a
three-parameter (Tc, Pc and w) equation explicit in pressure with general
applicability to compounds with low
polarity and moderate acentric factors.
The Lee-Kesler equation defines two
fluids as follows,

(r)/Tr
The compressibility of the fluid of
interest is calculated using,
Z = A(0)Z(0) + A(r)Z(r)
A(0) = 1-w/w(r)
A(r) = w/w(r)
w = acentric factor for fluid of
interest

· a simple fluid with zero acentric
factor

w(r) = acentric factor for reference fluid (0.3978)

· a reference fluid with acentric factor
= 0.3978

The expansion coefficient, specific
heat departures, enthalpy and,
entropy departures are derived from
the simple and reference PVT equations using the relations detailed in
Lee and Kesler and in Reid and elsewhere. The component simple fluid
and reference fluid values are combined by using relations of the same

The specific volume and other properties for any fluid are determined by
interpolation between the simple fluid
properties and the reference fluid properties using acentric factor as the interpolating variable. The properties of the
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form shown above for compressibility.
Danner & Daubert give typical maximum error values 20 kJ/kg for vapor
enthalpy and 70 kJ/kg for liquid
enthalpy. Typical errors for specific
volume of vapors are 1 to 2%.
8.12.3 The Wu & Stiel Equation of
State
The Wu & Stiel equation of state is a
four-parameter equation of state
developed as an extension to the LeeKesler equation of state to cover polar
compounds and compounds with high
values of acentric factor. The parameters of this equation of state are,

water. With Pr and Tr for the fluid of
interest,
Z(0) = PrVr(0)/Tr from simple
fluid equation
Z(r) = PrVr(r)/Tr from reference fluid equation
Z(p) = PrVr(p)/Tr from polar
fluid equation
Z = A(0)Z(0) + A(r)Z(r) + A(p)Z
(p)

A(0) = (1 - Y) - (w/w(r) - Yw
(p)/w(r))

· Critical Temperature, Tc

A(r) = w/w(r) - Yw(p)/w(r)

· Critical Pressure, Pc

A(p) = Y

· Acentric Factor, w

A(0) + A(r) + A(p) = 1

· Polarity Factor, Y

When Y = 0 these equations reduce to
the non-polar Lee-Kesler formula.
When Y = 1 and w = w(p), they reduce
to the Keenan equation of state for
water.

The Wu and Stiel equation of state
uses three reference fluids as follows:
· simple fluid with zero acentric factor
· reference fluid with acentric factor =
0.3978
· polar fluid (water) with acentric
factor = 0.344 and polarity factor = 1.0
The specific volume and other properties for any fluid of interest are
determined by interpolation between
the properties of the reference fluids
using acentric factor and polarity
factor as interpolating variables.
The properties of the simple and reference fluids are determined from the
Lee-Kesler equation of state. The properties of the polar fluid are determined
from the Keenan equation of state for

The expansion coefficient, specific
heat departures, enthalpy, internal
energy and entropy departures are
derived from the simple, reference
and polar PVT equations. The component simple fluid, reference fluid
and polar fluid values are combined
using relations of the same form as
shown above in the case of compressibility. The polarity factor is
determined from empirical density
data in accordance with the relations
set out by Wu and Stiel. Wu & Stiel
report excellent results using this equation of state for polar compounds.
Errors in specific volume were less
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than 1 to 2% for example for the vapor
phase.

setting the polar contribution equal to
zero.

8.12.4 Calculation of Saturation Values

8.12.5 Enthalpy and Entropy
Scales

Fluid properties along the saturation
line are solved for as follows. For a
given value of Tr,

All enthalpy and entropy values are
quoted relative to a reference zerovalue temperature T0. This temperature is taken in all cases to be the
higher of 273.15 K and the normal
melting point.

1. The simple fluid component properties are solved at Tr , Psr(O) where
this latter quantity is the Lee-Kesler
reduced saturation pressure at Tr and
w=0
2. The reference fluid component
properties are solved at Tr and Psr(r)
where this latter quantity is the LeeKesler reduced saturation pressure at
Tr and w = 0.3978
3. The polar fluid component properties are solved at Tr and Psr(p)
which is the reduced water saturation
pressure at Tr with Psr(p) = Ps(p)/ Pc
(p)
The compressibility of the fluid of
interest is found by,
Zs = A(0)Zs(0) + A(r)Zs(r) + A
(p)Zs(p)
This relation gives the saturation state
of the fluid of interest by interpolation
between the saturation states of the
simple, reference and polar fluids at Tr
rather than by interpolation between
the three fluids at Tr and Psr where
this latter quantity is the reduced
vapor pressure of the fluid of interest.
The above relations are presented for
the case of the Wu & Stiel equation of
state. The relations for the Lee-Kesler
equation of state may be obtained by

Two cases can be distinguished:
1. If the critical temperature is greater
than or equal to 273.15 K then the
enthalpy and entropy of the saturated
liquid are taken to be zero at T0. In this
case the enthalpy and entropy functions are,
h(T,P) - hLs(T0) = [h(T,P) - hv
(T,P0)]es + [h0(T0,T)]ig - [hLs(T0) - hv
(T0,P0)]es
s(T,P) - sLs(T0) = [s(T,P) - sv
(T,P0)]es + [s0(T0,T)]ig - [sLs(T0) - sv
(T0,P0)]es
2. If the critical temperature is less
than 273.15 then the enthalpy and
entropy of the low-pressure vapor are
taken to be zero at T0. In this case the
enthalpy and entropy functions are,
h(T,P) - hv(T0,P0) = [h(T,P) hv(T,P0)]es + [h0(T0,T)]ig
s(T,P) - sv(T0,P0) = [s(T,P) sv(T,P0)]es + [s0(T0,T)]ig
The zero point for water is taken to be
273.16 K in accordance with the
Keenan equation of state for water.
Liquid enthalpy and entropy are zero
at that temperature and saturation conditions.
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8.13 Properties Of Mixtures
8.13.1 Scope of Correlations
CHEMPAK provides the user with the
facility of defining mixtures of compounds in the database which then
may be stored in the database for
future use. The properties of mixtures
are calculated using the techniques
set out in this section. The user should
note the following:
A mixture can be formulated using any
components in the database except
other mixtures, aqueous solutions,
heat transfer liquids and User-Defined
Liquids.
No check is carried out by CHEMPAK
on the chemical stability, compatibility
or miscibility of the selected components or the defined mixture. The
user must be satisfied as to the physical reasonableness of the formulation
of the mixture.
The accuracy of the calculated properties can be expected to be better
when the selected components are
chemically similar to each other. The
accuracy of the calculated properties
of very dissimilar components is not
known but may only be order-of-magnitude in some cases. It is to be expected that the errors involved with
mixtures of non-polar compounds will
be less than with mixtures of polar
compounds.
The range of applicability of the correlations is as follows:

A low-limit temperature is defined corresponding to the maximum of the
reduced melting points of the mixture
components. Properties cannot be
accessed at temperatures lower than
this. A high-limit temperature of 1300
K or the pseudocritical temperature
(whichever is the greater) is defined
for vapor properties. Vapor properties
cannot be accessed at temperatures
greater than this. The high limit temperature for liquid mixture properties is
the pseudocritical temperature of the
mixture as defined by the Lee-Kesler
rules. Liquid properties cannot be
accessed at temperatures higher than
this.
8.13.2 Mixture Critical Properties
Critical Temperature
Tc = Sum(xiVciTci)/Sum
(xiVci)
where xi, Vci and Tci are the mole fraction, critical volume and critical temperature of component i. The
reference used here is Li. This method
is generally recommended by Reid
and by Danner and Daubert. Deviations for binary hydrocarbon mixtures
can be expected to be less than 4 K.
Errors for multicomponent hydrocarbon mixtures average about 11 K.
Errors for binary mixtures of nonhydrocarbons would be of this order.
Critical Volume
Vc = Sum(aiVci) + Sum
(aiajbij) (all i,j)

ai = xiVci2/3/Sum(xiVci)
bii = 0 bij = 2cij(Vci + Vcj)
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cij = Aij + Bijdij + Cijdij+2
+Dijdij3 +Eijdij4
dij = ABS{(Vci2/3 - Vcj2/3)/
(Vci2/3 + Vcj2/3)}
The binary constants Aij thru Eij are
given by,

components. In this case the critical
pressure is taken equal to the LeeKesler pseudocritical pressure.
Acentric Factor
In accordance with the Lee-Kesler
rules,
w = Sum(xiwi)
wi = component acentric
factor
xi = component mole fraction
8.13.8 Vapor Pressure

The reference for this method is
Schick and Prausnitz. An average
error of 10% can be expected for binary mixtures.
Critical Pressure

Accurate determination of the vapor
pressures of mixtures normally
requires a full vapor-liquid equilibrium
model with knowledge of interaction
parameters. Such a VLE model is not
a part of CHEMPAK. In CHEMPAK,
however, an approximation is used in
order to be able to determine the mixture phase for given input T and P.
The Lee-Kesler mixing rules give for
the acentric factor,

wm = Sum(xiwi)

wm = Sum(xiwi)

Tcm = Sum(ZiTci)

wi = -log(Pvri at Tr = 0.7) - 1

Zi = xiVci/Sum(xiVci)
Tcm* = Sum(xiTci)
Pcm* = Sum(xiPci)
Pc = Pcm*[1 + (5.808 + 4.93
wm)(Tcm/Tcm* - 1)]
This method is based on a simplification of the method of Kreglenski
and Kay as amended by Spencer,
Daubert and Danner. Errors in the
application of this method average
about one bar - see Reid et al for
details. This method is not applied
when the mixture contains inorganic

wm = -log(Pvrm at Tr = 0.7) - 1
= Sum(-xilog(Pvri at Tr = 0.7) - xi)
hence,
log(Pvrm at Tr = 0.7) = Sum
(xilog(Pvri at Tri = 0.7))
The vapor pressure is represented for
all compounds in the CHEMPAK database by the Wagner equation:
ln(Pri) = (aiXi + biXi1.5 + ciXi3
+ diXi6)/Tri
Xi = 1 - Tri
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Hence, for the mixture, the Wagner
coefficients are given by,
am = Sum(xiai) bm = Sum
(xibi)
cm = Sum(xici) dm = Sum
(xidi)
where xi is the component mole fraction.
8.13.9 Thermodynamic Properties
of Mixtures
The Lee-Kesler and Wu & Stiel equations of state are used to calculate the
thermodynamic properties of liquid
and vapor phases for all pure compounds in the database. To calculate
the thermodynamic properties of mixtures, a set of pseudocritical constants
are defined for each mixture and the
properties are calculated in the usual
way.
CHEMPAK uses the original LeeKesler rules as follows:
Zci = 0.2905 - 0.085 wi
Vci = ZciR0Tci/Pci

8.13a Thermodynamic
And Transport Properties Of Mixtures
8.13.10 Vapor Viscosity
The pure component equations are
used with the following pseudocritical
constants defined for each mixture per
the formulation of Prausnitz and
Gunn:
Tcm = Sum(xiTci)
Zcm = Sum(xiZci)
Vcm = Sum(xiVci)
Mm = Sum(xiMi)
Pcm = ZcmR0Tcm/MmVcm
8.13.11 Vapor Conductivity
The pure component equations are
used with the following pseudocritical
constants from Yorizane et al defined
for the mixture:
Tcm = Sum(xixj(Vci1/3 +
Vcj1/3)3(TciTcj)1/2)/(8Vcm)

Vcm = Sum(xixj(Vci1/3 +
Vcj1/3)3)/8

Vcm = Sum(xixj(Vci1/3 +
Vcj1/3)3)

Tcm = Sum(xixj(Vci1/3 +
Vcj1/3)3(TciTcj)1/2) / (8Vcm)

wm = Sum(xiwi)
Zcm = 0.2905 - 0.085 wm

wm = Sum(xiwi)

Pcm = ZcmR0Tcm/MmVcm

Mm = Sum(xiMi)

Mm = Sum(xiMi)

Zcm = 0.2905 - 0.085 wm
Pcm = R0ZcmTcm/Vcm
R0 = Gas Constant
The Stiel polarity factor for a polar mixture is computed from the mixture
liquid specific volume

8.13.12 Ideal-Gas Mixture Properties
Ideal-gas mixture properties are taken
as the mole fraction of the pure component properties. The pure com-
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ponent properties are defined per
mole of substance.

8.14 Notation

m Mixture
0 Low Pressure
p Constant Pressure
ra Rackett

C Specific Heat

ref Reference

e Expansion Coefficient

r Reduced

h Enthalpy

s Saturated

log Logarithm to base 10

v Vapor

ln Natural Logarithm

v Constant Volume

m Dipole Moment

Superscripts

M Molecular Weight

(o) Simple Fluid

P Pressure

(r) Reference Fluid

R Gas Constant

(p) Polar Fluid

r Riedel Parameter
s Entropy
T Temperature
v Viscosity
V Specific Volume
w Acentric Factor
x Mole Fraction
Y Wu & Stiel Polarity Factor
Z Compressibility

Subscripts
b Boiling
c Critical
es Equation of State
f Freezing
ig Ideal Gas
L Liquid
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Role of Pressure Junctions - Detailed Discussion (Long)
In modeling a generalized pipe network, it is possible to construct models
that do not have a unique solution. A
common occurrence of this is when a
model contains one or more sections
which are completely bounded by
known flow rates. A series of
examples with accompanying explanation will clarify situations where this
occurs. The length of this topic is proportional to the frequency with which
engineers get confused over the
issue. It became apparent that an
exhaustive, lengthy discussion was
necessary for some engineers. Do not
dismiss this topic too quickly because
of its length.
Before beginning it will be helpful to
consider an aspect of the philosophy
of computer modeling. At the risk of
stating the obvious, it must be recognized by the user that a computer
model cannot calculate anything that
cannot in principle be calculated by
hand. All the computer does is accelerate the calculation process. Some
users expect the model to generate
independent information and become
frustrated when the software requests
additional information from them. But
if the user was doing the calculation by
hand that same information would still
be required. The difference is that in
the case of the hand calculation, the
engineer would be forced to think
through why the information is
needed.

However, when the engineer interacts
with AFT xStream, they do not need to
think at the same depth as in the hand
calculation. So when AFT xStream
asks for the additional information, it is
not as apparent why it is required. This
disconnect in thinking can cause frustration for the user. Fully understanding the concepts in this topic will
greatly reduce the frustration for some
users, and will improve the quality of
models for all users.

Examples
The simplest example is the system
shown in Figure 1. In AFT xStream
terms, the system has two assigned
flow junctions.

Figure 1: Model with two assigned flows.
This model does not have a unique solution.

Obviously, the flow in the pipe is
known. But what is the pressure at the
inlet? At the outlet? It cannot be
determined because there is no reference pressure. The reference pressure is that pressure from which other
pressures in the system are derived.
There can be one or more reference
pressures, but there always has to be
at least one.
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The model in Figure 1 can be built with
AFT xStream and if you try and run
this model, AFT xStream will inform
you that it cannot run it because of the
lack of a reference pressure. In AFT
xStream there are five junctions that
can act as a reference pressure: the
tank, assigned pressure, control
valves with pressure setpoints, and
valve and relief valve after cracking
(with the exit valve option).
There are a couple other things worth
noting about Figure 1. First is that the
model in Figure 1 has redundant
boundary conditions. When one flow
is specified in a single pipe, the other
end must have the same flow. Thus
the second known flow does not offer
any new information. Because the conditions are redundant, there is no
unique solution to the model in Figure
1. In any AFT xStream model, there is
always at least one unknown for each
junction in the model – either pressure
or flow rate. Sometimes there are two
unknowns such as a compressor/fan.
It is possible the user may not know
either the flow or the pressure at the
compressor/fan. In such cases the
user is required to specify the relationship between flow and pressure.
This relationship is called a compressor/fan curve, and by specifying
the relationship between the two,
effectively one of the two unknowns
can be eliminated. Thus we always
end up with one unknown for each
junction.
Second, if the user was allowed to specify two flows as in Figure 1, they
could specify them with different flow
rates. Clearly they must have the

same flow, so an inconsistency
occurs. The basic reason the inconsistency is possible is because Figure
1 does not have a unique solution.
Figure 2 a-c shows three other model
configuration possibilities. It is not possible to specify inconsistent conditions
for any of the Figure 2 models, and
they always have a unique solution no
matter what input is specified by the
user.

Figure 2: Top two models with one pressure and one assigned flow, bottom
model with two pressures. All of these
models have a unique solution.

The four models in Figures 1 and 2 a-c
contain all logical possibilities. In all
four cases there are four things we
want to know. The pressure and flow
at the inlet, and the pressure and flow
in the outlet. In each case we know
two of these four. The problem is that
in the Figure 1 model the lack of a reference pressure makes it impossible
to determine the inlet and outlet pressures, even though we know the flow.
The three models in Figure 2 a-c all
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have at least one pressure and thus all
four of the desired parameters can be
determined. Table 1 summarizes this.
Also note in Table 1 that in the Figure
2c case the flow can be determined,
but it is by iteration.

A pressure at any one of the three
boundaries in Figure 3 would be sufficient to allow a unique solution of the
system. It is also possible that there
could be two pressures and one flow,
or three pressures. As long as there is
one pressure a unique solution exists.

Table 1: Four logical possibilities of
boundary conditions for single pipe systems

As we consider multi-pipe systems,
there are a host of other possibilities
that present themselves. All other configuration possibilities which lack a reference pressure ultimately boil down
to the same problem that exists in Figure 1.
The pipe lengths, diameters and friction factors are not included in the
remaining models because they do
not influence the main point of this
topic. It is assumed that these parameters can be obtained for each pipe
and the resulting pressure drop calculated with standard relationships.
Consider the model in Figure 3. With
three boundaries having a known flow,
this clearly has the same problem as
the model in Figure 1. No unique pressures at any location can be calculated.

Figure 3: Three known flows at boundaries lack a reference pressure, similar to
the model in Figure 1. This model does
not have a unique solution.

Now consider the models in Figure 4.
The Figure 4a model does have one
reference pressure, but in this case
there is still a problem. The Flow Control Valve (FCV) is controlling the flow
to 10 gpm, and the downstream flow is
demanding 10 gpm. The section of the
system before the FCV can be solved
(because there is a pressure
upstream), but the section after the
FCV does not have a unique solution.
Why? In order to obtain a unique solution, the pressure drop across the
FCV must be known. But any pressure
drop could exist and satisfy the conditions of this model. It is thus not
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possible to determine the pressure at
the outlet flow demand because it
depends on the FCV pressure drop
which is not known. The model in 4b
does have a pressure downstream of
the FCV, and thus there is a unique
pressure drop across the FCV and a
unique solution exists for the model in
Figure 4b.
If you input the remaining data for the
Figure 4a model and run it in AFT
xStream, you will get the message
shown in Figure 5. AFT xStream identifies the part(s) of the model where a
known pressure is needed.

Figure 5: AFT xStream message when
you try to run the model shown in Figure
4a.

Sizing Compressors or Fans
with Flow Control Valves
Figure 4a-b.: The model at the top does
not have a reference pressure after the
Flow Control Valve so the pressure drop
across the FCV cannot be determined.
The top model does not have a unique
solution. The bottom model has a pressure upstream and downstream, and a
unique solution exists.

An analogous situation to Figure 4a is
when the user is trying to size a compressor using the Compressor/Fan
with a fixed flow. The Compressor/Fan
with a fixed flow is really just a reverse
FCV. It controls the flow by adding
pressure, rather than reducing it. Figure 6 shows this case and is another
example of a model without a unique
solution, requiring more than one pressure junction. If the user instead
entered a compressor or fan curve for
this model, it could be solved.
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Figure 6: A compressor/fan modeled as a
fixed flow behaves identically to the FCV
model in Figure 4a, for which no unique
solution exists

Increasing in model complexity, Figure 7 shows some additional
examples of models without a unique
solution. In particular, Figure 7b has a
compressor/fan with a fixed flow that
can add as much pressure as it wants,
and the downstream FCV can then
take out as much as it wants. There
are an infinite number of possible solutions.
While it would be highly unusual for a
system to have two FCV’s in series, it
is worth considering the model in Figure 7b further. It is common to have an
FCV in series with a compressor/fan.
How does one size the compressor/fan in such a case? There are
several ways to do this, one of which
is to change the compressor/fan from
a fixed flow to an actual compressor or
fan curve. Trying multiple curves will
guide you to the best compressor or
fan.
But there is a better way. Consider for
a moment the pressure drop across
the FCV in Figure 7b. In the installed
system, is any pressure drop acceptable? Usually not. It is typical to have

pressure drop limits based on the system design and the FCV itself. A common requirement is a minimum
pressure drop across the FCV. If no
minimum pressure drop exists, let’s
say we choose a compressor or fan
that results in the pressure drop
across the FCV being 0.01 psid. If the
system is built and the compressor or
fan slightly underperforms its published curve, the FCV will not be able
to control to its flow control point. Even
if the compressor or fan does operate
exactly on the published curve, eventually fouling in the pipes will result in
increased pipe resistance (and pressure drop) and again the FCV will not
be able to control to its flow control
point.

Figure 7: Neither model above has a
unique solution. The top model has two
flow control valves in series. The bottom
model has a compressor/fan modeled as
a fixed flow in series with an FCV. In both
cases either a third pressure junction is
needed between the two middle junctions, or one of the junctions must be
changed from a flow controlling device.

To avoid these kinds of problems in
installed systems, a minimum Cv or
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pressure drop across the FCV is typically required. This minimum pressure drop provides the key to sizing
the compressor/fan in Figure 7b.
Rather than model the FCV as a flow
control valve, instead model it as a
pressure drop control valve (PDCV)
set to the minimum pressure drop
requirement. Then a unique solution
exists, the model will run and the compressor/fan can be sized. Once the
compressor/fan is sized and an actual
curve exists, the curve can be entered
and the valve can be switched back to
an FCV. Remember that when we use
the PDCV, we are still getting the flow
we want for the true FCV, because the
compressor/fan is now providing the
control.
Think for a moment what we just did.
We went through a thought process
that many engineers have gone
through during their hand calculations.
Specifically, we size the compressor/fan such that the FCV pressure drop is minimized. If the FCV has
a larger pressure drop than the minimum, the compressor/fan must add
more pressure to overcome this
excess pressure drop. In short, it must
use more energy and is thus less efficient. Figure 8 depicts this process.

Figure 8a-c: The model at the top is the
same as Figure 7b and does not have a
unique solution. To size the compressor/fan, change the model to the
second one shown above, which uses a
pressure drop control valve (PDCV) rather
than an FCV. Once the second model is
run, the compressor/fan is sized, a curve
exists, and the model at the bottom can
be run using an FCV.

Let’s make a slight addition in complexity to the model in Figure 8. In this
case we have two flow control valves
in parallel (Figure 9). To size this compressor/fan, we apply the process
described in Figure 8. We choose one
of the FCV’s, make it a PDCV, size the
compressor/fan, choose a compressor/fan with an actual curve, enter
the curve into the model, and then
return the PDCV to an FCV.
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Figure 9: A compressor/fan with a fixed
flow in series with two parallel FCV’s. The
model in its current form does not have a
unique solution. To size the compressor/fan, first change the FCV at J7 to
a PDCV.

This brings up the question, which
FCV should one choose to turn into a
PDCV? When FCV’s are put in parallel, frequently the pipe design has
one of the FCV’s further away from the
compressor/fan than the others.
Because of the additional piping leading to this FCV, it will be the weakest
link in the chain of parallel FCV’s by virtue of having the lowest pressure drop
across it. The most remote FCV
should be chosen as the PDCV. If the
most remote FCV is chosen, when the
minimum pressure drop required is
applied to the PDCV all other FCV’s in
the parallel system will have greater
than the minimum pressure drop —
thus satisfying the pressure drop
requirement for those FCV’s as well.

What if you do not know which FCV is
the most remote? In this case make
your best guess, change it to a PDCV
at the minimum required pressure
drop, run the model, then verify
whether all other FCV’s have a pressure drop that meets or exceeds the
requirement. If not, then the FCV with
the smallest pressure drop as determined by the first run is in reality the
weakest FCV. Choose this FCV,
change it to a PDCV, and then change
the original PDCV back to an FCV
since it is not the weak link. If the pipe
system leading to each FCV is truly
identical and all FCV’s have identical
pressure drops, any of the FCV’s will
serve as the PDCV.
The preceding process can be extended to cases where there are three or
more FCV’s in parallel, and also cases
with more than one compressor/fan in
parallel supplying the FCV’s.
In Figure 9 the most remote valve is
J7, the one on the right. If the minimum pressure drop is 5 psid, change
J7 to a PDCV with a 5 psi drop. This
results in the output shown in Figure
10a. Notice how the pressure drop
across the other FCV at J6 is greater
than 5 psid because it is closer to the
compressor/fan. Also notice how the
flow through J7 is still 1 lbm/s even
though it is not controlling flow. Once
again, the reason for this is that the
compressor/fan is controlling the flow
to 2 lbm/s, and with the J6 FCV controlling to 1 lbm/s, the excess must go
through J7. The compressor/fan is
thus sized and its pressure rise is
shown in Figure 10b (59.83 psid).

Index 460
FCVs is that the pressure drop cannot
be known ahead of time. The pressure
drop depends on the balance of the
pipe system.
Consider the simple system shown in
Figure 11. With the pressure controlled downstream of the PRV, the
pressure upstream is not known.
Without knowledge of the PRV's pressure drop, the pressure upstream of
the PRV cannot be determined and
thus no unique solution exists.

Figure 10a-b: Results from changing J7 in
Figure 9 to pressure drop control valve

AFT xStream results for the model in
Figure 9 after J8 has been changed to
a PDCV. Top results show valve summary and bottom results show compressor/fan size.

Pressure Control Valves
The problem of non-unique solutions
can also occur when a Pressure Reducing Valve (PRV) or Pressure Sustaining Valve (PSV) is used. A PRV is
used to control pressure downstream
of the valve, while a PSV controls pressure at the valve inlet. One thing that
PRVs and PSVs have in common with

Figure 11: If a PRV is downstream of a
known flow the PRV pressure drop cannot be calculated. This model does not
have a unique solution.

Figure 12 shows the possible cases
with PRVs and PSVs, while Table 2
comments on the six cases. In summary, at least one known pressure is
always needed on the side of a pressure control valve opposite of the controlled side.
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Figure 12a-f.: Six possibilities for PRV
and PSV configurations. Cases A and E
do not have unique solutions. See Table 2
for comments.

Table 2: Summary of six possibilities for
PRV and PSV configurations.

If a compressor/fan is being sized in
series with a PRV or PSV, modeling
the compressor/fan as an assigned
flow will not permit a unique solution if
the compressor/fan is upstream of a
PRV or downstream of a PSV. The
reasons for this are the same as those
in the previous section on FCVs.
In combination with the previous
examples, it should be apparent how
the non-unique solution problem can
occur in more complicated systems. In
all such cases, the reasoning will boil
down to the same problems already
discussed.

Closing Parts of a System
A model may be built which has sufficient information to obtain a unique
solution. Then a user closes a junction
and all of a sudden the problem of no

Index 462
unique solution occurs. This is shown
in Figure 13. The top model has a
unique solution and will run fine. In the
bottom model the valve is turned off
and the section of the system downstream of the valve has only known
flows. No reference pressure exists in
this section because it is isolated from
the known pressures in the section on
the left.

AFT xStream models always require
one reference pressure, and may
require more if the engineer uses control valves, compressor/fans with
assigned flows, or closes pipes or junctions. The actual number of reference
pressures needed depends on the
model, but AFT xStream always
checks to be sure sufficient reference
pressures exist and stops to warn the
user when they do not.
This capability is a powerful diagnostic
feature that will help guide the user in
building meaningful models.

Figure 13: Top model has reference pressures at J1 and J2. Bottom model has
closed valve at J4 which isolates the J5
and J6 assigned flows. There is no reference pressure for J5 and J6 and no
unique solution exists for the bottom
model.

Summary
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Critical Warnings, Warnings, and Cautions
A number of warnings may be given in
the output when you run an AFT
xStream model. These warnings are
intended to alert you about potential
problems with the model or solution.
Some warnings may prove to be harmless upon closer inspection, but you
should never ignore them.
There are different warning levels
depending on the importance of the
warning.
1.

2.

3.

4.

CRITICAL WARNING – A critical warning is very important
and reflects a high possibility of
incorrect results in the output.
Output with critical warnings
should be used only for error
resolution purposes and never
for engineering decisions.
WARNING – A warning offers
important information about the
converged solution or the
model itself. The information
should always be reviewed.
CAUTION – A caution message is of less importance than
a full warning. The included
information may or may not be
of interest to the user, but is
intended to alert the user to
potential issues with the model
or results.
Design Alert Warnings –
When results exceed a user’s
design alert a notification is
given.

Any of the warning message types
above can be double-clicked in the
Output window to take you directly to
the pipe/junction referenced in the
message.
The below pages describe most of the
warnings you may receive, with a brief
explanation given of each. Whenever
any warnings occur that are
WARNING or CRITICAL WARNING
level, the General Results section of
the Output Window will be displayed
with the text in red.

Related Topics
Use the Model Data Window
495
Solution Method Panel
98
Simulation Mode/Duration
Panel
91

Critical Warnings
A Critical Warning message in AFT
xStream alerts users to serious issues
in the model results. These messages
should always be reviewed by the
user, and results containing these
messages should never be used for
anything other than error resolution
purposes.

CRITICAL WARNINGS
l

Characteristic speed exceeded
maximum determined from...
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l

Global energy balance disabled

l

Global mass balance disabled

l

Junction X Had Reverse Flow Compressor/Fan Head Could
Not Be Predicted

l

Maximum transient pipe Mach
number X higher than estimate
Y

l

Pipe Mach number exceeded 1
during the simulation.

l

Results do not represent a converged solution

l

Required flow to supply the
pressure control valve at junction X is above sonic flow

l

Setting relaxation lower than relative pressure/flow tolerance
gives unreliable results

l

Specified flow through/out of
junction X is above sonic flow
and cannot be supplied

Characteristic speed
exceeded maximum
determined from...
A Critical Warning message in AFT
xStream
Full Message text is:
The characteristic speed exceeded
the maximum determined from estimated maximum pipe temperature and
Mach number at X seconds, Pipe Y,
Section Z.

This critical warning indicates that at
some time during the simulation the
characteristic speed exceeded the
maximum characteristic speed, which
is equivalent to the MOC grid section
length divided by the time step. If this
happens the solver in xStream will
attempt to interpolate properties outside the MOC characteristic grid,
which may introduce instability and
inaccuracies to the solution.
The Estimated Maximum Pipe Temperature During Transient and/or the
Estimated Maximum Pipe Mach Number During Transient in the Sectioning
panel should be increased to increase
the maximum characteristic speed.
For more information about the MOC
solution, please refer to the Pipe Sectioning and Method of Characteristics
pages. This warning message is generated when points R or L are outside
of points 1 or 3 in Figure 1 on the Pipe
Sectioning page.

Related Topics
Method of Characteristics
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Global Energy Balance
Disabled
A Critical Warning message in AFT
xStream
Full Message text is:
Global energy balance disabled by
user in Solution Control window
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This critical warning message alerts
users they have disabled the Global
Energy Balance option in the
Advanced Parameters Panel. Results
shown with this critical warning do not
represent a valid converged solution.

Global Mass Balance Disabled
A Critical Warning message in AFT
xStream

This critical warning message displays
for centrifugal compressor when
reverse flow occurs at the compressor
and the Manufacturer's Curve is being
used for calculations. The compressor
head rise under such conditions is
unknown. The zero flow value is used.

Maximum transient pipe
mach number X higher
than estimate Y

Full Message text is:
Global mass balance disabled by user
in Solution Control window

A Critical Warning message in AFT
xStream
Full Message text is:

This critical warning message alerts
users they have disabled the Global
Mass Balance option in the Advanced
Parameters Panel. Results shown
with this critical warning do not represent a valid converged solution.

Junction X Had Reverse
Flow Compressor Head
Could Not Be Predicted
A Critical Warning message in AFT
xStream
Full Message text is:
The Compressor Junction X had
reverse flow during the transient. The
head/pressure rise was estimated
from the zero flow value.

The maximum transient pipe Mach
number (X) was higher than the estimate (Y). Results should not be considered accurate until the simulation is
re-run with an estimated maximum
pipe Mach number higher than the
actual transient maximum.

The Mach number at some location in
the pipes exceeded the Estimated
Maximum Pipe Mach Number During
Transient, which is defined in the Sectioning panel of Analysis Setup. This
can cause instability in the solver and
significant error in the results. The
model should be re-run with the Estimated Maximum Pipe Mach Number
During Transient set to at least 0.1
greater than the maximum pipe mach
number encountered during the simulation.
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Mach Number Exceeded
1 During Simulation
A Critical Warning message in AFT
xStream

solution. The displayed results should
only be used for purposes of determining the reasons for nonconvergence.
Under no circumstances should these
results be used for engineering purposes.

Full Message text is:
Pipe Mach number exceeded 1 during
simulation.

AFT xStream is limited to sonic and
subsonic flows, and cannot model
flows exceeding Mach 1. However,
the MOC calculations during the MOC
Transient simulation can on occasion
calculate velocities slightly above 1.
This critical warning is shown by
default when the Mach number in the
pipes exceeds 1.0001. Users should
examine results with this critical warning carefully, and recognize that results after Mach 1 is exceeded may be
in error.

Results Do Not Represent Converged Solution
A Critical Warning message in AFT
xStream
Full Message text is:
These results do not represent a converged solution. Use only for error resolution purposes.

This message alerts users that results
are displayed for an unconverged

Required flow to supply
the pressure control
valve at junction X is
above sonic flow
A Critical Warning message in AFT
xStream
Full Message text is:
Required flow to supply the pressure
control valve at Junction X is above
sonic flow and cannot be supplied.
Please review results and change
your model.

This critical warning message means
the user has specified a pressure at a
pressure control valve which requires
a flow which is physically impossible
because of sonic choking. The set
point should be changed to allow physically realistic flows.

Setting relaxation lower
than relative pressure/flow tolerance
gives unreliable results
A Critical Warning message in AFT
xStream
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Full Message text is:
Setting relaxation lower than relative
pressure(flow) tolerance gives unreliable results.

Setting the relaxation to a value close
to or lower than relative tolerance can
lead to false convergence and invalid
results. AFT xStream alerts the user to
this when inputting data in the AFT
Arrow Steady Solution Control panel,
and also alerts the user once the solution has been obtained.

Specified flow
through/out of junction
X is above sonic flow
and cannot be supplied
A Critical Warning message in AFT
xStream

Warnings
A Warning message in AFT xStream
alerts users to issues in the model that
will affect the model results. These
warnings often offer important information about the converged solution or
the model itself, and should always be
reviewed before considering the results to be meaningful for the system.

WARNINGS
l

Automatic sectioning did not
achieve the desired steady conservation error.

l

Chempak temperature and/or
pressure is out of range for the
following

l

Control valve open percentage
outside valid range

l

The difference in velocity
exceeds the specified percent

l

Energy may not be balanced at
Junction X

l

FCV could not control flow at
Junction X

l

Flow may not be balanced at
Junction X

l

Inlet and outlet pipes at Junction X do not have the same
stagnation enthalpy

l

Junction X Exceeded End-ofCurve Flow Rate...

l

Junction X had reverse flow during the transient

Full Message text is:
Specified flow through (out of) Junction X is above sonic flow and cannot
be supplied. Please review your results and change your model.

This critical warning message means
the user has specified an outflow
which is physically impossible
because of sonic choking. This message can also occur if Assigned Flow
junctions, Flow Control Valves, or
Compressor/Fans modeled as a fixed
flowrate are used.
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l

Maximum system pressure
exceeded enthalpy table's maximum pressure of X

l

Transient temperature was
below fluid minimum temperature

l

Maximum transient pipe temperature higher than estimate

l

Transient temperature was
below saturation temperature

l

Maximum transient pipe temperature significantly lower
than estimate

l

Unique solution not possible Relief valve cycles

l

MOC Steady solution did not
reach a nominally steady state
before transient

l

Negative added pressure by
compressor at Junction X

l

Physical flow area is less than
the sonic area at junction X...

l

Pipe/Junction X property calculation exceeded maximum
local iteration limit

l

Pipe/Junction X property calculation failed to continue
towards convergenc

l

Pipe X temperature is outside
temperature limits in AFT Arrow
Steady Solution Control

l

Pipe X temperature outside
valid temperature range

l

PRV could not control pressure
at Junction X

l

PSV could not control pressure
at Junction X

l

Temperature is below the saturation line for the following. . .

l

Transient choking exists at junction X. The specified flow or
pressure could not be met.

l

Transient data was extrapolated at Junction X

Automatic Sectioning
Did Not Achieve Steady
Conservation
A Warning message in AFT
xStream
Full Message text is:
Automatic Sectioning did not achieve
the desired Steady Conservation Error

Automatic Sectioning is a tool found in
the Sectioning panel of the Analysis
Setup window when Advanced
Options are shown. This tool attempts
to add pipe sections until the conservation error between the AFT
Arrow Steady and MOC Steady Solutions is below the allowable error. This
warning is shown if the Automatic Sectioning is unable to meet the allowable
error. The allowable error may be
exceeded if the maximum number of
sections is reached.
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Chempak Temperature/Pressure Outside Valid Range
A Warning message in AFT
xStream

percentage data is operating outside
the range of 0-100%. In many cases, it
is likely that the user has not defined
open percentages outside of the valid
range, but instead has entered data
that might allow xStream to extrapolate values outside that range.

Full Message text is:
Chempak temperature and/or pressure is above/below valid range for the
following:

The final solution had temperature
and/or pressure conditions in the specified pipes obtained with Chempak
physical property data which were beyond Chempak’s range of applicability.
The range value is also displayed.
This warning indicates the results may
not be valid. It also may indicate an
input error in the model because of the
extreme temperature or pressure
state.

Control Valve Open Percentage Outside Valid
Range
A Warning message in AFT
xStream
Full Message text is:
Control Valve open percentage outside valid range of 0-100% at Junction
X

This message is a warning that a control valve which includes open

Difference in Velocity
Exceeds Specified Percent
A Warning message in AFT
xStream
Full Message text is:
The maximum difference between the
AFT Arrow Steady solution and the
MOC Steady Solution for velocity is
X%

The MOC Steady Solution is used to
transition from the AFT Arrow Steady
results to the MOC Transient simualtion, and some change in system
velocities is expected. This difference
is checked prior to the MOC Transient
simulation. The user can define an
allowable change between the two
steady solutions on the MOC Steady
Solution panel, with a default value of
10%.
Pipes with initial velocities less than
10 ft/sec are not included in this check
as a small absolute change in velocity
can be a large relative change in velocity.
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Energy may not be balanced at Junction X
A Warning message in AFT
xStream
Full Message text is:
Energy may not be balanced at Junction X (total = Y)

This warning alerts users that the converged energy balance results may be
incorrect for the AFT Arrow Steady
Solution. Once a converged solution is
obtained, AFT xStream checks all junctions to ensure an energy balance
exists. It compares the imbalance to
the mass flow weighted enthalpy tolerance, and when the imbalance
exceeds the tolerance, this warning is
generated.
If the magnitude of the energy imbalance is close to the tolerance specified, it is generally safe to ignore this
warning, although it may make sense
to reduce tolerances further and rerun
the model.
If the magnitude of the energy imbalance is large, the converged solution
that may be incorrect. When a large
imbalance exists, it may be an indicator the model is not realistic.
These warnings should always be
reviewed in detail, and the user should
perform hand calculations on the
energy balance at the affected junctions to verify whether an acceptable
solution exists.

Note: This warning will usually
occur when you assign isothermal boundary conditions
to pipes in your model. If
pipes are forced to flow at the
isothermal temperature specified, it is usually not possible to balance energy at the
junctions. The warning can
be ignored in such circumstances, because the
energy imbalance is a natural
result of the isothermal
assumption.

FCV could not control
flow at Junction X
A Warning message in AFT
xStream
Full Message text is:
FCV could not control flow at Junction
X

This warning alerts users that the Flow
Control Valve at junction X was not
able to control the flow, and backflow
may have occurred.

Flow may not be balanced at Junction X
A Warning message in AFT
xStream
Full Message is:
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Flow may not be balanced at Junction
X (total = Y)

This warning alerts users that the converged mass balance results may be
incorrect for the AFT Arrow Steady
Solution. Once a converged solution is
obtained, AFT xStream checks all junctions to ensure a mass balance exists.
It compares the imbalance to the flow
tolerance, and when the imbalance
exceeds the tolerance, this warning is
generated.
If the magnitude of the flow imbalance
is close to the tolerance specified, it
may be safe to ignore this warning,
although it likely make sense to
reduce tolerances further and rerun
the model.
If the magnitude of the energy imbalance is large, the converged solution
that may be incorrect. When a large
imbalance exists, it may be an indicator the model is not realistic.
These warnings should always be
reviewed in detail, and the user should
perform hand calculations on the
energy balance at the affected junctions to verify whether an acceptable
solution exists.

Fluid is no longer in the
vapor phase because
the fluid temperature/pressure is...
A Warning message in AFT
xStream

Full Message is:
Fluid is no longer in the vapor phase
because the fluid pressure is above
the Saturation Pressure for the following...
The solution indicates that the temperature and pressure conditions at
the specified pipe are such that one or
more gas components has reached
saturation conditions. xStream will
attempt to extrapolate gas-phase properties beyond saturation conditions
because xStream assumes the fluid is
single-phase. Optionally, the user can
choose to limit properties to Saturated
Conditions in the Advanced Transient
Parameters panel.
Results from the MOC Transient after
the transient temperature and pressure reaches the saturation temperature and pressure should be
treated with caution.

Inlet and outlet pipes at
Junction X do not have
the same stagnation
enthalpy
A Warning message in AFT
xStream
Full Message text is:
Inlet and outlet pipes at Junction X do
not have the same stagnation
enthalpy.

The stagnation enthalpy entering a
junction should equal the stagnation
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enthalpy exiting, assuming no flow
splits and an adiabatic junction. This
warning tells you that the values differ.
Results are likely incorrect, and may
not represent a converged solution.

Junction X Compressor/Fan added negative pressure
A Warning message in AFT
xStream

xStream defines this point as the Endof-Curve. Such data has been defined
for this compressor in the Compressor
Configuration window, and the system
is operating past the End-of-Curve
flow rate. Thus the results may be
invalid, because the compressor may
not actually operate at that point.

Junction X Had Reverse
Flow During Transient

Full Message text is:

A Warning message in AFT
xStream

Junction X Compressor/Fan added
negative pressure.

Full Message text is:

A compressor junction with an
assigned flow rate had a pressure loss
across the compressor junction either
in the steady state or transient system.
This warning is meant to alert the user
that the compressor is not adding pressure as they may be expecting.

Junction X Exceeded
End-of-Curve Flow Rate
A Warning message in AFT
xStream
Full Message text is:
Junction X Exceeded End-of-Curve
Flow Rate

Junction X had reverse flow during the
transient. The head/pressure rise was
estimated from the zero flow value.

A transient event could cause reverse
flow at a compressor junction in the
model. In this situation, the head/pressure rise across the compressor
is estimated from the value at zero
flow.

Maximum system pressure exceeded enthalpy
table's maximum pressure of X
A Warning message in AFT
xStream
Full Message text is:

Centrifugal compressor curves typically only extend to a given flow. AFT

Maximum system pressure exceeded
enthalpy table's maximum pressure of
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X. Enthalpy is extrapolated for pressures exceeding this value.

This warning indicates that the AFT
Standard fluid database is being used
with the Table Enthalpy model, and
that the maximum system pressure
exceeded the maximum pressure for
the enthalpy data. The Table enthalpy
model uses interpolation based on the
current pressure to calculate the
enthalpy at a given temperature. If the
pressure at a point in the system
exceeds the maximum pressure data
available for the fluid in the AFT Standard fluid database, then the enthalpy
must be extrapolated, leading to inaccuracy in the results. Extrapolation far
above the maximum temperature will
lead to increased inaccuracy, and may
cause convergence issues. Consider
using an alternate fluid database such
as NIST Refprop or Chempak with a
higher maximum pressure.

Maximum Transient Pipe
Temperature Higher
Than Estimate
A Warning message in AFT
xStream
Full Message text is:
The maximum transient pipe temperature (X) was higher than the estimate (Y). The estimated maximum pipe
temperature should be set marginally
above the maximum.

This warning indicates the maximum
temperature in the pipes during the
transient simulation is higher than the
Estimated Maximum Pipe Temperature During Transient value specified by the user in the Sectioning
panel. A temperature higher than the
estimate may cause the maximum
sonic velocity to be higher than estimated, and in turn mean the time step
for the MOC Transient simulation is
too small to properly simulate highvelocity flow.
The user should provide a more accurate estimated maximum temperature
and re-run the simulation. If high Mach
numbers are never seen during the
simulation, it may be acceptable to set
the estimated maximum pipe temperature lower than the actual maximum temperature.

Maximum Transient Pipe
Temperature Significantly Lower Than
Estimate
A Warning message in AFT
xStream
Full Message text is:
The maximum transient pipe temperature (X) was significantly lower
than the estimate (Y). The estimated
maximum pipe temperature should be
set marginally above the maximum.

This warning indicates the maximum
pipe temperature during the transient
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simulation is significantly lower than
the Estimated Maximum Pipe Temperature During Transient value specified by the user in the Sectioning
panel. The estimated maximum temperature is used to help determine the
time step for the simulation. In this situation, it's possible that more time
steps are used than are necessary to
capture the system's transient behavior. Lowering the estimate will make
each time step longer, reducing run
time.
The user should provide a more accurate estimated maximum pipe temperature and re-run the simulation.

MOC Steady Solution
Did Not Reach Nominally
Steady Before Transient
A Warning message in AFT
xStream
Full Message text is:
The MOC Steady Solution did not
reach a nominally steady state before
the transient started.

The MOC Steady Solution runs a
series of Block Iterations and checks
the velocity change across each
block. The MOC Steady Solution is
considered nominally steady when the
velocity change between blocks is
less than the values specified in the
MOC Steady Solution panel. If the
velocity change across a block is
never lower than the allowable

change, a nominally steady state will
not be reached, and this warning will
be shown.
The user should increase the allowable change, increase the maximum
number of MOC Steady Block Iterations, or increase the number of sections used.

Physical flow area is
less than the sonic area
at junction X...
A Warning message in AFT
xStream
Full Message text is:
Physical flow area is less than the
sonic area at junction X. Sonic choking probably exists but was ignored in
this solution because no CdA was specified.

AFT xStream cannot account for sonic
choking at a junction unless the CdA
for Sonic Choking is specified. For several junctions, a physical area is specified by the user. For example, for an
orifice the orifice area or diameter is
specified. However, the real flow area
is less than this physical area because
of vena contracta and wall separation
effects. In order to perform a proper
sonic choking calculation, AFT
xStream needs to know the CdA.
When this warning is displayed, AFT
xStream has determined that the
sonic area was less than the physical
area at the specified junction, but
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sonic choking was ignored because
no CdA was specified. Thus sonic
choking may exist even though AFT
xStream could not calculate it.
When this warning is displayed it is
recommended you obtain the proper
CdA for the junction and run the model
again.

Pipe/Junction X property
calculation exceeded
maximum local iteration
limit
A Warning message in AFT
xStream
Full Message text is:
Pipe/Junction X property calculation
exceeded maximum local iteration
limit.

The final network solution was not
within tolerance for a local iteration.
The local iteration limit set in the AFT
Arrow Steady Solution panel was
exceeded, but the Solver ignored this
and continued on. If a network solution
is obtained but this out of tolerance
situation exists, AFT xStream
attempts the network solution again
up to five times in a row. If the out of tolerance situation remains, AFT
xStream ceases further attempts and
displays the convergence notification,
then gives this warning in the output.
The property can be any of several
solver parameters and depends on

the actual subroutine where the problem occurred.
Along with the warning, the Error
value and Tolerance are displayed,
along with a Code #. For AFT xStream
to consider this local iteration to be
converged, the Error value needs to
be less than the displayed Tolerance.
This Tolerance is not the tolerance the
user can specify in the AFT Arrow
Steady Solution panel, but rather an
internal “hard-wired” tolerance that
has been set by the software
developers and arrived at through
experience.
If the Error value is relatively close to
the displayed Tolerance, it is generally
safe to ignore this warning. If it is
much larger, the remainder of the output is probably invalid.
In either case, changing the solution
method in the AFT Arrow Steady Solution panel frequently solves the problem.
The Code # identifies the subroutine
where the problem occurred. This
information is not of much assistance
to the user, but can be of help to AFT
technical support staff when
troubleshooting models.

Pipe/Junction X property
calculation failed to continue towards convergence
A Warning message in AFT
xStream
Full Message text is:
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Pipe/Junction X property calculation
failed to continue towards convergence.

The final network solution was not
within tolerance for a local iteration.
This was determined by AFT
xStream’s Auto-Detect feature. The
Solver ignored this and continued on.
If a network solution is obtained but
this out of tolerance situation exists,
AFT xStream attempts the network
solution again up to five times in a row.
If the out of tolerance situation
remains, AFT xStream ceases further
attempts and displays the convergence notification, then gives this
warning in the output. The property
can be any of several solver parameters and depends on the actual subroutine where the problem occurred.
Along with the warning, the Error
value and Tolerance are displayed,
along with a Code #. For AFT xStream
to consider this local iteration to be
converged, the Error value needs to
be less than the displayed Tolerance.
This Tolerance is not the tolerance the
user can specify in AFT Arrow Steady
Solution, but rather an internal “hardwired” tolerance that has been set by
the software developers and arrived at
through experience.
If the Error value is relatively close to
the displayed Tolerance, it is generally
safe to ignore this warning. If it is
much larger, the remainder of the output is probably invalid.
In either case, changing the solution
method in the AFT Arrow Steady Solu-

tion panel frequently solves the problem.
The Code # identifies the subroutine
where the problem occurred. This
information is not of much assistance
to the user, but can be of help to AFT
technical support staff when
troubleshooting models.

Pipe X temperature is
outside temperature limits in AFT Arrow Steady
Solution Control
A Warning message in AFT
xStream
Full Message text is:
Pipe X temperature is equal to or
greater than the maximum temperature limit (equal to or less than the
minimum temperature limit) of Y set by
the user in Solution Control. Results
may be incorrect.

The user has temperature limits
defined in the AFT Arrow Steady Solution Control panel. These limits control
the search space for temperatures
while solving. However, the final solution had one or more pipes at the temperature limit, meaning the limit
restricted the solution and may give
incorrect results. The user should
either remove or change the temperature limit.
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Pipe X Temperature Outside Valid Fluid Temperature Range
A Warning message in AFT
xStream
Full Message text is:
Temperature at inlet/outlet of Pipe X is
above the max (below the min) fluid
temperature range.

The temperature specified for the pipe
is outside the range of valid temperatures. See Fluid Panel.

PRV could not control
pressure at Junction X
A Warning message in AFT
xStream
Full Message is:
PRV could not control flow at Junction
X

This warning alerts users that the Pressure Reducing Valve at junction X was
not able to control the flow, and backflow may have occurred.

PSV could not control
pressure at Junction X
A Warning message in AFT
xStream

Full Message text is:
PSV could not control flow at Junction
X

This warning alerts users that the Pressure Sustaining Valve at junction X
was not able to control the flow, and
backflow may have occurred.

Temperature is below
the saturation line for
the following. . .
A Warning message in AFT
xStream
Full Message text is:
Temperature is below the saturation
line for the following:

The solution indicates that the temperature and pressure conditions at
the specified pipe are such that one or
more gas components has reached
saturation conditions. This warning
only occurs with Chempak fluids,
NIST REFPROP fluids, or ASME
Steam selected on the Fluid panel.
When temperature falls below saturation, xStream's solution accuracy
will be decreased, as xStream always
assumes the fluid is superheated and
will attempt to extrapolate gas properties below the saturation line.
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Transient choking
occured at Junction X.
The set point could not
be met.

final two values. Additional time data
points should be entered at Junction X
to avoid extrapolation.
This extrapolation behavior can be
changed in the User Options window
on the Tools menu.

A Warning message in AFT
xStream
Full Message text is:
Transient choking exists at junction X.
The specified flow or pressure could
not be met.

This warning tells the user that choked
conditions exist at a junction with a
specified pressure or flow rate, specifically that those choked conditions
existed during the transient simulation. In this situation, xStream will
limit the flow at the pipe to the choked
flow rate regardless of the userdefined conditions.

Transient data was extrapolated at Junction X
A Warning message in AFT
xStream
Full Message text is:
Transient data was extrapolated at
Junction X.

The transient data at Junction X did
not have time data that covered the
entire time frame of the simulation.
Any transient data after the final time
data point was extrapolated using the

Transient temperature
was below fluid minimum temperature
A Warning message in AFT
xStream
Full Message text is:
Transient temperature was below fluid
minimum temperature at X seconds.
Results after this time may not be
valid.

This warning informs the user that the
temperature went below the minimum
temperature in the fluid database during the transient simulation. xStream
will extrapolate below the minimum
temperature and assume the fluid
remains in the gas phase. In some
cases the minimum temperature for
the fluid database represents saturation conditions, in which case
xStream will be extrapolating below
the saturation line.
Results from the MOC Transient after
the transient temperature reaches the
minimum temperature should be
treated with caution.
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Unique Solution Not
Possible Relief Valve
Cycles
A Warning message in AFT
xStream

l

Automatic Sectioning is
enabled, but flow increases substantially during the transient.

l

Check Valve closed at Junction
X

l

Flow is negative through Junction X. Loss factors may be in
error

l

Junction X exceeded maximum
event messages

l

Junction X is downstream of a
choking point, stagnation/static
properties cannot be calculated

l

Maximum transient pipe Mach
number lower than estimate

l

Maximum transient pipe Mach
number at least 0.2 higher than
steady...

l

Pipe X length is shorter than
the elevation change (between
Junction Y and Z)

l

These results are from running
the simulation in MOC Steady
mode. This is a troubleshooting
mode, see "MOC Steady
Panel" help topic for more
details

l

Transient data did not extend to
Stop Time at Junction X

l

Transient temperature was
within 10 deg. F of minimum
temperature

l

Transient temperature was
within 10 deg. F of saturation
temperature.

Full Message text is:
Relief Valve cycles, unique solution is
not possible.

This warning is generated by the AFT
Arrow Steady Solution, and means the
relief valve will not operate in its open
or closed state during steady state.
When the relief valve is closed in
steady state, the pressure exceeds its
set pressure, so it opens. When the
relief valve is open in steady state, the
pressure falls below its blowdown pressure, so it closes.

Cautions
A Caution message in AFT xStream is
of less importance than a full warning.
While some Caution messages may
be left unresolved without affecting
model results, they should never be
ignored by the user.

CAUTIONS
l

Assigned Flow at Junction X
has a constant flow rate during
the transient...
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Assigned Flow at Junction X has a constant
flow rate during the transient...
A Caution message in AFT
xStream.
Full message text is:
Assigned Flow at Junction X has a constant flow rate during the transient.
During a transient the flow usually
changes. This may not be an appropriate use of the junction.

An Assigned Flow junction fixes the
flow at a boundary. When a transient
occurs in the system, it is common to
see all flows affected by that transient.
This caution is a reminder that an
assigned flow may not be the appropriate junction to model a transient
boundary condition. In general it is better to use Assigned Pressure or Tank
junctions at boundaries.

Automatic Sectioning is
enabled, but flow
increases substantially
during the transient
A Caution message in AFT xStream
Full Message text is:
Automatic Sectioning is enabled, but
flow increases substantially during the
transient.

This is a cautionary notice that the
user enabled Automatic Sectioning to
allow xStream to section the system to
minimize the Steady-State Conservation Error. However, Automatic
Sectioning is performed based on the
steady-state flow, meaning conservation error will increase if the system flow increases. When this caution
is presented, the user should not
assume that conservation error was
minimized throughout the simulation.

Check Valve closed at
Junction X
A Caution message in AFT xStream
Full Message is:
Check Valve closed at Junction X.

This is a cautionary notice that a
check valve closed during the AFT
Arrow Steady Solution.

Flow through Junction
X is negative. Loss
factors may be in error.
A Caution message in AFT xStream
Full Message text is:
Flow through Junction X is negative.
Loss factors may be in error.

This caution alerts users to flow
through junctions in the opposite
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direction from the connecting pipes reference directions. Any loss information specified for junctions may be in
error because it was defined assuming flow in the other direction.

Junction X exceeded
maximum event messages
A Caution message in AFT xStream
Full Message is:
Junction X exceeded maximum event
messages.

Event messages are generated each
time a transient event occurs at a junction. A limit is set of how many event
messages can be shown for a junction
to limit how much data is displayed in
the output. This limit was reached, and
some events have happened with no
event message displayed. The maximum event messages setting can be
changed in the Output Control window
on the Format & Action tab.

Junction X is downstream of a choking
point, stagnation/static
properties cannot be calculated
A Warning message in AFT xStream
Full Message is:

Junction X is downstream of a shock,
static/stagnation properties cannot be
calculated at junction.

This warning will only be generated by
pressure type junctions (e.g.,
Assigned Pressure, Tank). When
sonic choking occurs at a pressure
type of junction, there is no way to calculate a velocity downstream of the
choke point. This means that it is not
possible to determine static conditions
if you have specified stagnation at the
junction, and vice versa. All other results for the model should be accurate
except for the static/stagnation pressure, temperature, and enthalpy at the
junction.

Maximum transient pipe
Mach number lower than
estimate
A Caution message in AFT xStream
Full Message text is:
The maximum transient pipe Mach
Number X was significantly lower than
the estimate Y. Lowering the estimated maximum pipe Mach number
may increase accuracy. The estimate
must be set above the simulation maximum pipe Mach Number, a value of at
least Z is recommended

This is a cautionary notice that the
maximum transient Mach number in
the pipes remained significantly below
the Estimated Maximum Pipe Mach
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Number During Transient, which is
defined in the Sectioning panel.
Decreasing the estimated maximum
Mach number may increase the accuracy and improve the run time. Note
that if the estimated maximum Mach
number is less than the maximum
Mach number encountered during the
simulation, the solution will become
unstable, so the estimated maximum
Mach number should not be defined to
be less than the recommended value
given in the caution.

Maximum transient pipe
Mach number at least 0.2
higher than steady...
A Caution message in AFT xStream

further in the Transient Result Accuracy topic.
It is recommended to run the model
again with more sections to determine
what effect the Mach number difference has on accuracy.

Pipe X length is shorter
than the elevation
change (between Junction Y and Z)
A Caution message in AFT xStream
Full Message text is:
Pipe X length shorter than the elevation change (between Junction Y and
Junction Z).

Full Message text is:
The maximum transient pipe Mach
number is at least X higher than the
steady pipe mach number at the same
location. If sectioning was determined
from MOC steady results, the accuracy of the transient simulation may not
be sufficient for higher flow periods.

This is a cautionary notice that there
was a large change in Mach number
between the steady state and transient results. The sectioning for the
model is chosen based on the steady
state results, and will therefore produce the highest accuracy results for
cases where the velocity is similar to
the steady state velocity. The inaccuracy due to sectioning is discussed

This caution alerts users to a possible
inconsistency in their input. When this
caution is shown, a pipe is defined
with a length that is shorter than the
elevation change between its connecting junctions. In this situation,
pressure loss along the pipe due to friction is calculated using the pipe length
the user has defined while static head
loss is determined using the elevation
change the user has defined.

These results are from
running the simulation
in MOC Steady mode
A Caution message in AFT xStream
Full Message text is:
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These results are from running the simulation in MOC Steady mode. This is a
troubleshooting mode, see "MOC
Steady Panel" help topic for more
details.

Transient temperature
within 10 deg. F of minimum temperature
A Caution message in AFT xStream

This is a cautionary notice that the
model was run in the MOC Steady simulation mode, meaning that the model
was run with no user-defined transients applied. See the MOC Steady
Solution panel topic for more information.

Transient data did not
extend to Stop Time at
Junction X
A Caution message in AFT xStream
Full Message text is:
Transient data did not extend to Stop
Time at Junction X. Final data point
was used.

This caution means the transient data
at Junction X did not have time data
that covered the entire time frame of
the simulation. The junction was
assumed to be at the final data value
after the final time data point.
This extrapolation behavior can be
changed in the User Options window
on the Tools menu.

Full Message text is:
Transient temperature was within 10
deg. F of minimum temperature at X
seconds.

This is a cautionary notice that the temperature at some point in the system
approached the minimum temperature
for the fluid in the database during the
transient simulation. This means that
some properties may be extrapolated
beyond the range of the available
data. In some cases this may also
mean that the saturation conditions
were reached. The user should review
the results to verify that saturation conditions were never reached.

Transient Temperature
within 10 deg. F of Saturation Temperature
A Caution message in AFT xStream
Full Message text is:
Transient temperature was within 10
deg. F of saturation temperature at X
seconds.

This is a cautionary notice that the temperature at some point in the system
approached saturation conditions
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during the transient simulation. It does
not necessarily mean condensation
occurred or the results cannot be trusted. However, the user should review
the results to verify that saturation conditions were never reached.

Index 485
Make Initial Flow Rate Guesses
for Pipes
499

Troubleshooting
This section discusses methods of
troubleshooting models that are having difficulty converging. Topics
include discussions of common
issues, ideas to simplify overly complex models, and methods for adapting the solution methodology through
either tolerance or flow relaxation.
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The below topics discuss several common model configurations that can
cause xStream model run times to be
longer than expected. Select a topic
below for information on why each configuration increases the run time, and
suggestions on how each configuration can be avoided.
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If one of the below configurations is
detected by xStream and the run time
is relatively long, xStream will present
a message to the user showing which
of the below configurations may be
applicable.
Note that the configurations listed
here as causing long run times may
not be inaccurate for the system being
modeled. However, they are all likely
inefficient modeling choices for transient analysis - especially for preliminary iterations.
The configurations discussed below
are not meant to capture every possible model configuration which can
cause long model run times in
xStream. Many other factors can also
cause long run times. Following the
suggestions listed below may help
reduce run time in any model, though
it may not be practical to implement
the listed suggestions for all models.

Related Topics
Minimizing Run Time
Transient Result Accuracy
Transient Sensitivity Analysis Tutorial
Related Blogs
Analyzing Transients Faster - a
Hacker's Guide to Pipe Sectioning
You Should Combine Your Pipes
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The model has both very
long and very short
pipes
A model with both long and short
pipes requires a larger number of pipe
sections in order to perform calculations. The more pipe sections in a
model, the more computations the
solver needs to perform, which results
in a longer run time.

How are short and long pipe
lengths contributing to long
run times?
To run a transient simulation, AFT
xStream sections pipes to apply the
Method of Characteristics. In any system there will be a single controlling
pipe. The controlling pipe is the pipe
with the fewest sections - by default,
10. AFT xStream uses the length of a
section in the controlling pipe to divide
all pipes in the model into sections and
determine a uniform time step for the
transient simulation.
When a model has both very long and
very short pipes, the short pipes
determine the controlling pipe length,
and the long pipes must be divided
into many sections to properly apply
the Method of Characteristics. The run
time is proportional to the square of
the number of sections, meaning
many sections in a model will often
cause extremely long run times.
Consider a model that consists of two
pipes: a very short pipe, such as 1
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meter, and a very long pipe, such as
10,000 meters. The 1 meter pipe will
be the controlling pipe with 10 sections, and the 10,000 meter pipe must
be broken into 100,000 sections. The
model thus requires 100,010 sections
in order to perform the calculations,
which results in a long run time.
Increasing the short pipe’s length artificially from 1 to 10 meters decreases
the number of sections required by a
factor of 10, reducing run time by a
factor of 100. While the length
increase may also increase the error
in the short pipe, experience shows
that the error is usually negligible in a
liquid transient context.

What can the user do?
Several different approaches are available to reduce run time. These
approaches can work in parallel, and it
is up to the engineer to make appropriate judgments as to which is best
for the model.
Consider modeling fittings and
losses in pipes and combining multiple short pipes. In the Pipe Properties window, use the Fittings &
Losses tab to add in fittings to the pipe
instead of using junctions on the workspace. This is useful to account for
pressure losses without modeling
large numbers of elbows or similar fittings. For example, a user can add
valves and bends to a pipe, and the
solver will still apply the losses directly
to the pipe during the calculations. By
removing these junctions and combining pipes in the workspace, many

short pipes between these fittings are
eliminated. Reducing and combing
short pipes reduces the number of sections in the model and the overall run
time.
Consider adding artificial length to
short pipes. Adding length to short
pipes increases the length of the controlling pipe, which results in fewer sections for the other pipes in the model.
Reducing the overall number of sections in the model improves run time.
Using pipe lengths that are common
multiples, such as 5 feet, 10 feet, 15
feet, etc. provides improved sectioning since short pipes can be perfectly divided into longer pipes.

Related Topics
Transient Result Accuracy
Transient Sensitivity Analysis Tutorial
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Related Blogs
Analyzing Transients Faster - a
Hacker's Guide to Pipe Sectioning

The model has many
pipes that can be combined
Users often model losses in
AFT xStream using junctions with no
transient behavior, such as a bend,
static valve, or orifice, between two
pipes of identical diameter. While this
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may help show where these losses
are occurring in the overall pipe system, it can result in extra pipes which
can have a detrimental effect on pipe
sectioning and run time. Combining
pipes and modeling the losses within
the pipe itself can improve sectioning
and run time while maintaining accuracy.

How are pipes that can be
combined contributing to
long run times?
To run a transient simulation, AFT
xStream sections pipes to apply the
Method of Characteristics. In any system there will be a single controlling
pipe. The controlling pipe is the pipe
with the fewest sections - by default,
10. AFT xStream uses the length of a
section in the controlling pipe to divide
all pipes in the model into sections and
determine a uniform time step for the
transient simulation.
Each pipe in a model must be sectioned individually, meaning section
count must increase with pipe count.
The run time is proportional to the
square of the number of sections,
meaning many sections in a model will
often cause extremely long run times.
Reducing the number of pipes in a
model is often an effective way to
reduce run time.
Consider a model that includes a
pipeline that is 100 meters long, and
has 9 bends in it. If those 9 bends are
modeled as unique junctions, the
pipeline must be modeled as 10

individual pipes. Each pipe has 10 sections by default, meaning the pipeline
will have 100 sections. If the pipeline
is modeled as a single pipe, and the 9
bends are modeled as additional pipe
friction using the Fittings & Losses tab
in the Pipe Properties window, the
number of sections in the pipeline
could be reduced by a factor of 10, in
turn reducing the run time by a factor
of 100.

What can the user do?
The Fittings & Losses tab in the Pipe
Properties window can be used to add
losses directly to pipes to replace individual junctions on the workspace.
This process can be done manually,
or automatically using the Join Selected Pipes/Jcts tool in AFT xStream.
Select the pipes to be combined and
the junctions between those pipes on
the Workspace, and choose the Join
Selected Pipes/Jcts from the Edit
menu. This option will combine the
selected pipes into one pipe, add the
losses from the junctions into the Fittings & Losses tab.

Related Topics
Transient Result Accuracy
Transient Sensitivity Analysis Tutorial
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48

Index 489

Related Blogs
Analyzing Transients Faster - a
Hacker's Guide to Pipe Sectioning
You Should Combine Your Pipes

The model has an unusually short pipe
A model with a very short pipe
requires a larger number of pipe sections in order to perform calculations.
The more pipe sections in a model,
the more computations there are that
need to be performed, which results in
a longer run time.

How are pipe lengths contributing to long run times?
To run a transient simulation, AFT
xStream sections pipes to apply the
Method of Characteristics. In any system there will be a single controlling
pipe. The controlling pipe is the pipe
with the fewest sections - by default,
10. AFT xStream uses the length of a
section in the controlling pipe to divide
all pipes in the model into sections and
determine a uniform time step for the
transient simulation.
When the controlling pipe is unusually
short, the other pipes in the model
must be divided into many sections to
apply the Method of Characteristics.
The run time is proportional to the
square of the number of sections,

meaning many sections in a model will
often cause extremely long run times.
Consider a model that has one 0.05 ft
long pipe and 100 pipes that are each
10 ft long. Each 10 ft pipe would
require 200 sections, requiring 20,000
sections overall. Modeling the very
short pipe as 0.1 ft would reduce the
number of sections by a factor of 2,
which would potentially decrease the
run time by a factor of 4. Alternatively
if the very short pipe is not considered
in the sectioning by combining the
pipes, then the controlling pipe length
would become 10 ft. With one section
in each pipe this would decrease the
number of sections from 20,000 to
100, decreasing the run time by a
factor of 40,000.

What can the user do?
There are several different
approaches to reduce run time. These
approaches can work in parallel, and it
is up to the engineer to make appropriate judgments as to which
approach is best for the model.
Consider modeling fittings and
losses in pipes and combining multiple short pipes. In the Pipe Properties window, use the Fittings &
Losses tab to add in fittings to the pipe
instead of using junctions on the workspace. This is useful to account for
pressure losses without modeling
large numbers of elbows or similar fittings. For example, a user can add
valves and bends to a pipe, and the
solver will still apply the losses directly
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to the pipe during the calculations. By
removing these junctions and combining pipes in the workspace, many
short pipes between these fittings are
eliminated. Reducing and combing
short pipes reduces the number of sections in the model and the overall run
time.

calculations. The more calculations
that need to be performed, the longer
the run time.

Consider adding artificial length to
short pipes. Adding length to short
pipes increases the length of the controlling pipe, which results in fewer sections for the other pipes in the model.
Reducing the overall number of sections in the model improves run time.
Using pipe lengths that are common
multiples, such as 5 feet, 10 feet, 15
feet, etc. provides improved sectioning since short pipes can be perfectly divided into longer pipes.

xStream sections pipe to apply the
Method of Characteristics solution
method. The Method of Characteristics requires a uniform time
step to be used for all pipes in the
model, which is determined during the
sectioning process using the section
length and the sonic velocity in the
gas. On average the sonic velocity is
typically on the magnitude of 103, producing a time step on the magnitude
of 10-3.

Related Topics
Transient Result Accuracy
Transient Sensitivity Analysis Tutorial
Related Blogs
Analyzing Transients Faster - a
Hacker's Guide to Pipe Sectioning

The simulation has a
large number of time
steps
A model with a large number of time
steps will require a large number of

45
48

How are the time steps contributing to long run times?

A time step of 0.001 seconds means
that a transient simulation of 1 minute
will have 60,000 total time steps. Similarly, a transient simulation of 1 hour
will have 3.6 million time steps. Run
time is roughly proportional to the number of time steps, and models with
large numbers of time steps will generally have long run times. In addition,
models with higher wave velocity may
require shorter time steps, increasing
the number of time steps required.

What can the user do?
There are several different
approaches to reduce run time when
the number of time steps is larger than
expected.
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Consider reducing the simulation
duration. The simulation duration is
defined on the Simulation Duration
panel. For a simple system, the full
effect of the transient response occurs
over twice the communication time,
where the communication time is the
time it takes a pressure wave to travel
the length of the system and back
(length of system / wave velocity).
Determining the communication time
can become more complex for systems with branching paths or major
reflection points in the path. However,
limiting the simulation duration to 2
times the communication time may be
a good starting point. If multiple transient events occur the simulation duration should be extended to end after
the transient response has completed
for the last transient event.

length of the time step is determined
by the length of the computational stations. If the minimum number of stations per pipe is large, then shorter
sections and shorter time steps will be
required. Note that decreasing the
number of sections will decrease the
accuracy of the solution. A sensitivity
analysis is recommended to determine the effect of decreasing the number of sections on accuracy, see the
Transient Sensitivity Analysis Tutorial.

In addition, for a piping network
attached to a very long pipe it may not
be necessary to include the length of
the very long pipe in the communication time calculation. Use your
engineering judgement on whether
the reflections from the pipeline will be
important to consider.

Related Blogs

Consider lengthening the controlling pipe. The controlling pipe
length is used to determine the time
step for the simulation, setting the time
step equal to the section length
divided by twice the sonic velocity. Artificially lengthening the controlling pipe
means the time step for the simulation
can be longer, and fewer time steps
are required for the simulation.
Consider decreasing the Minimum
Number of Sections per Pipe. The

Related Topics
Transient Result Accuracy
Transient Sensitivity Analysis Tutorial
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Analyzing Transients Faster - a
Hacker's Guide to Pipe Sectioning

Transient Solver Errors
A transient solver error will be shown
during the transient solution if xStream
encounters a calculation error which
would invalidate the calculation results
for the rest of the transient. Transient
solver errors halt the transient solution
and must be resolved for the full simulation to be run.
The below topics offer descriptions of
the more common solver errors and
tips for common resolutions. Reach
out to AFT Support for further assistance.
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TRANSIENT SOLVER
ERRORS

General error occurred
during the transient calculations
A Transient Solver Error in AFT
xStream

An iteration error for junctions such as
the branch junction can occur if the
flow or pressure iterations at that point
exceed the maximum iterations. It is
recommended to generate a Transient
Debug File to get more information on
the solution leading up to the iteration
error. It may also help to increase the
minimum number of sections defined
on the Sectioning panel.
Contact AFT Support for additional
help if needed.

Full Message text is:
Error occurred while running Transient
Solver. General error occurred during
the transient calculations.

This solver error can be caused by
any number of discrepancies. It is
recommended to generate a Transient
Debug File to get more information on
the solution leading up to the iteration
error. It may also help to increase the
minimum number of sections defined
on the Sectioning panel.
Contact AFT Support for additional
help if needed.

Junction iteration problem
A Transient Solver Error in AFT
xStream
Full Message text is:
Error occurred while running Transient
Solver. [Junction] iteration problem.

Possible supersonic
flow detected at the connection of Junction X
and Pipe Y
A Transient Solver Error in AFT
xStream
Full Message text is:
Possible supersonic flow detected at
the connection of Junction X and Pipe
Y. Modeling of supersonic conditions
is not supported and the solver was
halted.

xStream assumes that the flow is one
dimensional and does not become
supersonic during the transient. In reality there are situations that could
cause supersonic flow to develop
behind a shockwave. In addition there
could be multidimensional shocks in a
real system which are not captured in
a one-dimensional solution. xStream
will halt the transient if the calculated
Mach number exceeds one to prevent
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inaccurate results from being displayed to the user.
If this error message is shown for a
system that should not experience
supersonic flow it is recommended to
verify the model inputs are correct,
consider adjusting the junction transient events, and potentially increase
the minimum number of sections per
pipe. Supersonic flow is more likely to
occur when there is a high pressure differential across a junction during the
steady state, when a transient event
occurs rapidly, and/or when the section length is relatively large in a pipe.
The configuration which most commonly causes this transient solver
error is a valve with a large pressure
differential across it that opens rapidly
in the transient.

explanation of how the allowable mismatch values are applied and the transient solver initialization process
please reference the discussion in the
Transient Solver Initialization panel
topic.
xStream prints a summary of the comparison between the AFT Arrow
Steady and Resolved solutions in the
Solution Progress window, which can
be used to determine what parameters were violated. For example,
see Figure 1 below which shows a
model that met the velocity criteria, but
did not meet the applied temperature
criteria.

User Specified AFT
Arrow to Resolved allowable mismatch was
exceeded
A Transient Solver Error in AFT
xStream

Figure 1: The bottom of the Solution Progress window provides additional information on the results of the artificial
transient resolution period

Full Message text is:
Error occurred while running Transient
Solver. A user specified AFT Arrow to
Resolved allowable mismatch was
exceeded.

This solver error indicates that one of
the allowable mismatch values
defined in the Transient Solver Initialization panel was exceeded. For an

To resolve a mismatch between the
AFT Arrow Steady and Resolved solutions it is recommended to re-evaluate
the initial conditions selected for the
model to remove inconsistent inputs.
For instance, in the model used for Figure 1 there was an inlet tank defined at
300 deg. F. Pipe P1 connected to the
inlet tank was defined to use
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convective heat transfer with the atmospheric temperature set at 70 deg. F.
There was no flow in the pipe initially,
so the pipe was fixed at the atmospheric temperature (70 deg. F) for
the AFT Arrow Steady solution. During
the artificial transient resolution process the pipe temperature was
allowed to vary and increased to about
300 deg. F due to the tank temperature, creating a mismatch
between the AFT Arrow Steady and
Resolved solution temperatures in the
pipe.
The error message in the example
model was resolved by using the Temperature Override for Zero Flow option
in the Pipe Properties window to set
the pipe's temperature equal to the
tank temperature during the AFT
Arrow Steady solution.

Rather, the identified items are settings that have frequently been incorrectly applied by other users. This is
not an exhaustive list of troubleshooting items, though the most common
issues are all included.
Data in the Model Diagnostics is organized by the Data Source, which is the
window where that setting/input is
defined. Any item that may negatively
impact the model will be highlighted
based on its potential to affect the
model, as shown in the Potential
Impact column. For pipe and junction
diagnostic items, the pipe(s)/junction
(s) that were identified will be listed
below the diagnostic item. For an
example, see Figure 1 below. The Diagnostic window indicates that multiple
pipes have unusual pipe dimensions,
and should be reviewed.

Diagnostics Window
The Model Diagnostics Window is
intended to help users check on a number of settings that may have been
changed during the model-building
process and that may affect the model
results.
The Model Diagnostics window can be
accessed from the Tools menu.
When the Model Diagnostics Window
is opened all input will be checked,
and the results will be displayed in a
tabular format. Items of note will be
highlighted based on the impact each
identified item may have on the results. It should be noted that not all
items identified by this window will
have a negative impact on results.

Figure 1: Example of the Model Diagnostics window. For this example, potential issues have been flagged in the pipe
dimensions.
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Related Blogs
AFT Responds to 2020 Customer Survey Feedback

Use the Model Data Window
The Model Data window is a powerful
tool for reviewing and documenting
model inputs, along with finding input
errors in a model.
Look at the model in Figure 1. If an
input error in one of the pipes was suspected, the task of looking for the error
in each individual pipe input window
would be tedious.
Now look at the Model Data window
for the pipes in Figure 2. Here it is
much easier to scan down columns of
data looking for input errors. In this
case, one of the pipe lengths was accidentally entered in miles rather than
feet.

Figure 1: Workspace layout of a pipe system with an input error in one of the pipes
(error not shown).
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Transfer Results to Initial Guesses
AFT xStream’s iterative steady-state
solver takes initial guesses (also
called initial conditions) and applies
the principles of mass and momentum
balance to improve the guesses. This
is called iteration. It continues to refine
the solutions until agreement with the
governing equations is obtained.
After a converged steady-state
answer is obtained, you can choose to
take these results and use them as the
initial guesses for a subsequent run.
Using those results as initial guesses
can lead to faster convergence in subsequent steady-state runs, as the
solver can start at or very close to the
actual solution.
Note: This will not increase the
speed of the transient solution progress.
Figure 2: Model Data window display for
the model in Figure 1. From this perspective it is much easier to see that one
of the pipes (#2) has length data entered
in miles rather than feet. This is not automatically an input error, as AFT xStream
accepts pipe input with mixed engineering units. However, more frequently
than not the user intends to use consistent units, so this probably is an error.

Related Blogs
Having model convergence problems? Start here!

This feature is called Transfer Results
to Initial Guess, and it is on the Output
window, Edit menu and toolbar.

Poor Compressor Curve
Fits
The Compressor/Fan Properties window allows curve fits of compressor/fan data up to fourth order.
Depending on the data points entered,
compressor/fan curves fits similar to
the orange or blue curves in Figure 1
below are possible.
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AFT xStream can only work with the
data the user inputs, and will use flow
rates on the orange curve past the
inflection point around 80 as acceptable operating points, which can lead
to unusual results or non-convergence. Users should always
ensure that their compressor/fan
curves cross the flow rate axis as
shown in the blue curve in Figure 1.
AFT xStream will attempt to warn the
user when a model containing a poor
compressor/fan curve fit is run. The
user can choose to run the model with
this curve fit anyways, but they should
take care that the compressor/fan is
operating in a region of the curve fit
that matches physical expectations,
such as the area to the left of the inflection point on the orange curve.

Figure 1: A good compressor/fan performance curve fit in blue and a poor

compressor/fan performance curve fit in
orange. All compressor/fan curve fits
should include sufficient data such that
the curve crosses the zero pressure rise
axis as shown in the blue curve.

Troubleshooting Resistance Curves
Common issues with resistance
curves include curves where losses
do not increase with flow, and curves
with a non-zero loss at zero flow. Figure 1 below shows examples of
curves with potential issues compared
to a correctly defined curve.

Figure 1: Example resistance curves
showing correct and incorrect curve
types. The incorrect curves either have
non-zero loss at zero flow, or have losses
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which do not increase with flow. The correct curve has zero loss with zero flow
and has losses which increase with flow.

or other parameters. An input error
(like incorrect diameter) may be easier
to see by looking at its effect on the
results.

These common issues create two
potential problems in a model.
First, if the system sees a constant
pressure drop even at low flowrates,
AFT xStream's iterative solver can
encounter difficulty converging on a
solution since the system flow and
pressure drop are no longer dependent on each other.
Second, real equipment in a system
will typically cause a higher pressure
drop at larger flowrates, and will not
provide any loss to the system at zero
flow. Users should capture a single
known pressure loss data point by
defining a curve which passes through
two points: the known pressure drop
at the tested flowrate and zero pressure drop at zero flow. The topic on
Resistance Curves gives more information on defining this type of curve.

Lower the Flow Rate
Relaxation
The AFT Arrow Steady Solution Panel
allows users to change multiple parameters, including the numerical relaxation parameter for both flow rate and
pressure.
By default, an automatic relaxation is
selected, and the relaxation will be
enabled when AFT xStream detects
the AFT Arrow Solution is getting
stuck.
The user can also set this relaxation to
a fixed value which is then applied for
every iteration. Values of 0.5 or 1.0
are recommended for pressure relaxation, while values of 0.05 or 0.1 are
recommended for flow rate relaxation.

Related Topics
Resistance Curve Loss
Model
General Component

Related Blogs
196
233

Use the Output Window
Sort Feature
If a model runs but the results look
incorrect, use the Sort feature on the
toolbar in the Output Window to look
for extremes in velocity, pressure drop

Having model convergence problems? Start here!

Try Absolute Tolerance
Most models converge reliably with relative tolerances, which is the default in
AFT xStream’s AFT Arrow Steady
Solution panel. However, some models converge better with absolute
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tolerance. This situation usually
means there is at least one element of
the model that is close to the real
answer in absolute terms but does not
lock in on a relative (percentage)
basis, likely due to a small-magnitude
value for pressure or flow.
If a model will not converge with relative tolerance, try changing to absolute tolerance. Even better, try the
option to converge on either absolute
or relative, which will offer the most
flexibility.

Related Blogs
Having model convergence problems? Start here!

Make Initial Flow Rate
Guesses for Pipes
As an iterative solver, AFT xStream
needs initial guesses to start the AFT
Arrow Steady Solution process.
xStream will make default initial
guesses automatically. On occasion
the AFT xStream guesses are far
away from reality. For some models
providing an initial guess for all the
pipe flow rates in the system can help
the model converge for the steady
state.
User-defined initial guesses can be as
simple as selecting all the pipes and
initializing all of them to 1 lbm/sec,
even though some operate at 0.1
lbm/sec and others at 10 lbm/sec.

Note that initial guesses that are too
far from the final solution can also interfere further with convergence.

Related Topics
Optional Input for Pipes

178

Change Boundary Conditions
Changing the boundary pressures or
flow rates can provide insight into
what is giving the model trouble.
For example, obtaining convergence
only within a certain range of flowrates
could indicate an issue with curve fit
data being unrealistic outside of that
range of flowrates.

Turn Off Parts of the
Model
Using the Special Conditions feature,
users can turn off elements in your
model and in effect shutdown entire
sections. If the model runs when certain sections are closed, this could
indicate a problem with one of the components in the closed section.

Break a Large Model Into
Submodels
AFT xStream provides convenient features for deleting parts of your model
and merging parts back in. A section
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of your model can be quickly deleted
by selecting it on the Workspace and
choosing Delete from the Edit menu. If
the section is instead Cut, it can be
Pasted into a new model of its own for
testing or holding. At a later time the
removed sections can be added back
in to the current model by using the
Merge feature on the File menu.
The advantage of breaking your
model into sub-models is that you can
investigate the convergence characteristics of each part of your model
independently. If you can get each
sub-model to converge, you should be
able to get the original model to converge also. If one of your sub-models
will not converge, it is doubtful your original model will converge either.

Use an AFT Standard
Fluid
AFT xStream offers multiple fluid databases for users to choose from in the
Fluids panel of the Analysis Setup window. Each database has benefits and
drawbacks.
If the model is defined using the
ASME Steam, Chempak, or
NIST REFPROP databases and is
experiencing convergence problems,
the user should simplify the model by
choosing a fluid from the AFT Standard fluid database. The fluid models
used for this database are simplified
from those in the other databases, and
often allow AFT xStream to find a solution more easily.

Once the user has a model that runs
well using an AFT Standard fluid, they
can return to the more complex fluid
databases.
It should also be noted that users are
strongly encouraged to only use
AFT Standard fluids in their AFT
xStream model. The increased accuracy of other models is almost always
outweighed by the increased run time
associated with the more complex fluids.

Related Topics
Fluid Panel

71

Run the MOC Steady
Solution
AFT xStream has three different Simulation Modes: AFT Arrow Steady,
MOC Steady, and MOC Transient. By
default, only the AFT Arrow Steady
and MOC Transient solutions are available. The user can access the MOC
Steady Simulation Mode by enabling
Advanced Options in the Analysis
Setup window.
The MOC Steady Solution is what
xStream uses to move between the
AFT Arrow Steady solution and the
start of the MOC Transient Solution.
Stopping the simulation after the
MOC Steady Solution is obtained can
help the user understand how the AFT
Arrow Steady Solution is adjusted
before the transient simulation starts.
Occasionally, issues can arise during
this process which need to be
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addressed prior to a successful
MOC Transient simulation.

properties. In this situation, it can be
helpful to limit property calculations to
saturation conditions and not allow
xStream to extrapolate properties.

Related Topics

The user can limit properties to saturation conditions in the Advanced
Transient Parameters panel of the
Analysis Setup window after checking
the Show Advanced Options box in
the lower left corner of the window.

AFT Arrow Steady Solution
Group
97
Transient Solver Initialization Panel
91

Simplify Event Transients
On occasion, the transient events
defined for an AFT xStream model
can lead to issues in the transient simulation. The user can use Special
Conditions to ignore individual transients, re-run the simulation, and
check to see if the issue persists. This
troubleshooting tactic can be especially useful when dealing with check
valves or control valves in the model.

Limit Properties to Saturation Conditions
AFT xStream is a single-phase tool,
operating under the assumption that
the fluid is always in the gas/vapor
phase. When saturation is reached,
xStream will attempt to extrapolate
gas properties past the saturation conditions. In some situations, this
approach is successful, and the transient simulation can proceed.
However, in other situations, the MOC
Transient solution will fail as it
attempts to extrapolate gas

This setting can also be useful outside
of troubleshooting situations. When
limited amounts of transient condensation is seen, it is unlikely that a
full phase change will occur, meaning
the temperature and pressure will be
constant at the saturation conditions.
Thus, in some situations, it may be
more accurate to limit properties to saturation conditions if the system only
briefly reaches saturation during a transient simulation.

Related Topics
Advanced Transient Parameters Panel
Fluid Panel
Engineering Assumptions

130
71
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Enable Transient Debug
Files
AFT xStream has the ability to write
out Debug files containing useful
information about events that happen
during a transient simulation. xStream
will write out information about the
MOC Steady Solution process and
information about any errors it
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encounters during a transient simulation.
The user can enable transient debug
files in the Advanced Transient Parameters panel of the Analysis Setup
window after checking the Show
Advanced Options box in the lower left
corner of the window.
Once the user has checked the Create
Transient Debug File option, xStream
will save a Transient Debug file each
time a scenario is run in an xStream
model. The user can view the information written to investigate the issue
themselves, or work with AFT's support team to resolve the issue. In the
event that a user requests support
from AFT but cannot send a model
file, the AFT Support team will likely
ask the user to generate this file.

Index 503

Technical Support
Options

Technical Support
This section focuses on the technical
support options for AFT Products. Topics include descriptions of the various
support options, contact information
for the AFT Support team, and links to
external sites to assist with installation
issues related to AFT xStream.

Contents
Technical Support Options
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Contacting AFT

504

Information on Software Installation
504
Chempak Database Installation 504
Updated Fluids Library

505

Special File Control Features

506

Converting Models from Earlier
Versions
507

Related Blogs
Having model convergence problems? Start here!

Support, Upgrade and Maintenance (SUM)
This primary level of support is for
assistance with specific features
within the software, or resolving
issues with a model such as difficult to
converge models. We are limited in
our ability to interpret model results,
and cannot recommend specific
changes in a system.
One full year of SUM is provided with
the purchase of a full license. Leases
have SUM coverage during the period
of the lease. Further support after the
first year requires SUM renewal.
For technical support questions falling
in this category, contact AFT.

Flow Expert Package (FEP)
The FEP is a higher level of consulting
assistance for a particular project.
This service will assign a qualified
AFT engineer to assist in not only modeling your system, but also with providing operational suggestions and
interpretation of results.
The intention of this service is to
provide assistance to active users of
AFT software and address questions
on the appropriate use of the software
for specific system requirements.
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Please visit our website at:
https://www.aft.com/products/aft-flowexpert-package for more information
on our FEP services.

Flow Modeling Consulting
Services
AFT's sister company, Purple Mountain Technology Group (PMTG),
provides comprehensive consulting
services utilizing experienced consulting engineers and AFT tools.
PMTG offers a solution to a wide variety of system analysis by building and
investigating the models and providing
direction on system changes and
appropriate operation. Visit PMTG on
the web: https://www.pmtechgroup.com/, or call at (719) 6879145 for more information.

Information on Software
Installation
For information on Local and Server
installations of AFT software, please
visit our website at https://www.aft.com/support/installation.
For answers to frequently asked licensing questions, please visit our eLicense or USB Key FAQ pages.

Chempak Database
Installation
AFT xStream does not include the
Chempak Database by default. The
Chempak Database is a separate
product that must be downloaded and
installed as an addition to AFT
xStream.

Contacting AFT
Database File Location
l

Telephone - (719) 686-1000

l

Fax - (719) 686-1001

l

Online - https://www.aft.com/
download the latest maintenance releases, find out what
is happening at AFT, and get all
the latest information.

l

E-mail Support - support@aft.com

l

Mail - 2955 Professional Place
(Suite 301), Colorado Springs,
CO 80904, USA

The Chempak Database is installed in
C:\AFT Products\Chempak Data\ by
default. If both AFT xStream and
Chempak Database are installed to
their default locations, no further configuration is necessary. However, if
AFT xStream or the Chempak Database are not installed in a default location, AFT xStream will need to know
where to look for the Chempak Database. This is specified in the control.aft file, located in the same folder
as xStream.exe. If the files cannot be
found the following message is displayed:
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Upgrading Chempak Database Version
If you had Chempak installed with
other AFT products, you may receive
a message that the library is outdated.
Figure 1: Error message when Chempak
data cannot be found in default location

Control.aft can be edited with a text
editor, and by default looks like:

Figure 3: Outdated Chempak data

Figure 2: Default control.aft file

If the Chempak Database was
installed to a location other than the
default, the line "ChempakDataPath =
" will need to be edited to include the
directory it was installed to. For
example: "ChempakDataPath = C:\My
AFT Files\Chempak Data"

To fix this issue, download the newest
version of the Chempak Database
from the AFT website. Be sure to
install to the same location as the existing Chempak Database, and double
check the control.aft file if necessary.

Updated Fluids Library
If the data in a shared fluid library is
changed outside of the model you are
opening, the following informational
message will appear when opening
the file.
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Special File Control
Features
What Is the Control.aft File?

Figure 1: Update Fluids dialog window
which appears if the fluid properties for
the model have changed since it was last
opened

This message is shown because the
model is defined with a custom fluid in
the fluid library and the custom fluid
was modified outside of this model. If
the fluid was changed in error, then
choose the option the "Keep using the
fluids defined in the scenario" or cancel loading the model and change the
fluid. If the changes were intended
then update the fluid data used in the
model using the "Change to Base
Scenario and update..." option.

Conrol.aft is read as AFT xStream
begins to load and instructs AFT
xStream where certain key files and
copy protection tokens are located.
Typically there is little need to change
the settings, however this file can be
used to override the internal defaults
and customize your working environment.
Control.aft is typically located in the
application folder. However, on networks, it may be necessary to locate it
in the Windows\System folder of each
client. If AFT xStream finds the file in
the Windows\System folder it will use
it and ignore any file in the application
folder.
Control.aft can be edited using any
text-based editor. Notepad, supplied
as part of the Windows installation, is
a good choice. Be careful to avoid
changing any of the headings or key
words. If these are changed AFT
xStream will not find the important
data.

Specifying Where Chempak
is Located
Before AFT xStream can use the
Chempak Fluid Database it needs to
know where both the data is located.
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These paths are specified in the control.aft file.
When Chempak is installed the setup
procedure automatically updates any
control.aft file specified with the path
to the data.
You can manually edit the file by opening it in Notepad (or any text editor)
and adding the following line to the
[SEARCH PATHS] section (replace
C:\AFT Products\Chempak Data with
the path information based on your
system):
ChempakDataPath = C:\AFT Products\Chempak Data
This will instruct AFT xStream to look
in the C:\AFT Products\Chempak
Data directory for the data.
Also see Chempak Data Location.

Converting Models from
Earlier Versions
Models from earlier version of AFT
xStream can be used with this version.
In most cases, the model file can be
opened in the newer version and automatically converted to the updated
format. It is considered good practice
to do a complete check on the model
to ensure the conversion process was
complete and accurate. In some
cases, especially with older models,
the automatic conversion is not successful. If this occurs, please contact
our support team with a copy of the
model file.

Other files such as libraries (previously databases) or preference files
can also be converted.
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Examples Overview
ExamplPipe- DescripFluid
e
s
tions
An in depth
discussion
of model
building in
Tank
AFT
Blow- Nitro2
xStream.
down gen
Models a
Beginner
simple valve
opening during a tank
blowdown.
A compressor is
passing natural gas
through a
heat
exchanger
before being
used in the
combustion
baskets of a
Gas Turturbine sysbine
Meth11
tem. This
Fuel Sys- ane
example
tem
evaluates
the effect
the sudden
closure of
one of the 3
control
valves has
on the temperature of
the system.

High
Pressure
Steam Steam
Fluid
Property
Models

High
Pressure
Steam
Steam Forces

The effect of
the Minimum Number of
Sections per
Pipe parameter is also
shown.
Two turbines in a
high pressure steam
system are
simultaneously
valved shut
as a bypass
line valve is
opened.
This model
demonstrates
12
factors to
know to evaluate which
fluid database to use
in your system, as well
as demonstrating how
to construct
a model in
the isometric drawing mode.
14

Two turbines in a
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Frequency
Analysis
- PFA

Methane

5

high pressure steam
system are
simultaneously
valved shut.
This model
demonstrates the
transient
forces of the
steam within
the system
as well as
the effect
that the transient duration has on
these
forces. Finally, this
example
shows how
to export the
force file
once the
forces are
obtained.
A frequency
analysis is
performed
on a system
with a positive displacement
compressor
to determine
the acoustical frequencies for

the existing
piping configuration
using the
Pulsation
Frequency
Analysis
(PFA) module.
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Tank Blowdown
Example (English Units)

Tank Blowdown Example
Summary
This chapterexample will give you the
big picture of AFT xStream's layout
and structure. To accomplish this purpose, a model with two pipes and
three junctions will be built to capture
the system effects when a valve is
opened.
A number of other example model discussions are included on the AFT help
site. It can be opened from the Help
Menu by choosing "Show Examples"
and selecting "English Units....".

Topics covered
l

Model building basics

l

Entering pipe and junction data

l

Entering transient data

l

Graphing output results

Required knowledge
No prior knowledge is required for this
example.
This example assumes the user has
not used AFT xStream previously. It

begins with the most basic elements
of laying out the pipes and junctions
and solving the transient system via
the Method of Characteristics (MOC).

Model file
The file listed below contains a completed version of this example and can
be located in the Examples folder as
part of the AFT xStream installation.
This file can also be downloaded from
the AFT xStream help site from the
Tank Blowdown Example page:
l

US - Tank Blowdown.xtr

This example is also provided in metric units under the Metric Units file
name, Metric - Tank Blowdown.xtr.
This example will require you to build
the model from scratch to help familiarize yourself with the steps required
to build a complete model in AFT
xStream. Therefore, use this example
model file as a reference only.

Problem statement
This problem evaluates the initial
design for a tank that undergoes a
blowdown. Nitrogen flows out of a supply tank into a 2 inch line as a part of
the blowdown. The flow is controlled
by opening and closing a valve in the 2
inch line.
This model will simulate opening a
valve in 0.1 seconds. The valve will
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remain open for the remainder of the
simulation.
Graph the pressure and temperature
of the tank to observe how both parameters change with time. Also, graph
the Mach number, temperature, and
velocity at the discharge of the second
pipe to understand how the flow properties change as the blowdown progresses.

can also "Subscribe to Receive Notifications" of when product maintenance releases are available,
receive the AFT newsletter, etc. Finally, you can open available learning
resources such as examples.

Step 1. Start AFT xStream
ØTo start AFT xStream, click Start
on the Windows taskbar and open
AFT xStream. (This refers to the standard menu items created by setup. You
may have chosen to specify a different
menu item).
After AFT xStream starts, the Startup
window, as shown in Figure 2Figure 4,
appears. This window provides you
with several options before you start
building a model: You can open a
model that was recently worked on,
browse to a different xStream file, or
browse to the xStream Example files.
If you have a license for the xStream
PFA add-on module, it can be activated here. The Unit System can also
be specified to use US Only, Metric
Only, Both with US Defaults, or Both
with Metric Defaults. They can be set
as the user default at this time as well.
You can also set the working fluid to
AFT Standard Air or another recently
used AFT fluid. You can click the link
to "Check for Latest Release" to go to
the AFT website to see if you have the
latest release of AFT xStream. You

Figure 1: Startup window with Modeling
Preferences expanded

Some of the actions available from the
AFT xStream Startup window are:
l

Open a previous model,
browse to a model, or browse
to an Example

l

Activate an Add-on Module

l

Select "AFT Standard "Air" " or
a recently used fluid to be the
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Working Fluid
l

l

Review or modify Modeling
Preferences
l

Select a Unit System

l

Filter units to include
Common Only or Common Plus Selected
Industries

l

Choose a Grid Style

l

Select a Default Pipe
Material

Access Resources, such as
Quick Start Guides, Help Files,
and Video Tutorials

If this is the first time that you have
started AFT xStream, Modeling Preferences will be expanded in the middle
section of the Startup Window, as
shown by Figure 1. If this is not the
first time that you have started AFT
xStream, the Startup Window will
appear with Modeling Preferences Collapsed, as shown in Figure 2.
When collapsed, you can view your
current Modeling Preferences at the
bottom of Start a New Model. To further review or adjust your preferences,
click the "Modify >>" button (Figure 2).

Figure 2: AFT xStream Startup window

With Modeling Preference expanded,
as in Figure 1, select "Both with US
Defaults" under Unit System. Select
"Common Only" under Filter to show
only commonly used units, instead of
"All Units."
You can "Show Sample Units" to see
which units will be included based on
your selections, as shown in Figure 3.
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Figure 4: AFT xStream Startup window

Click "Start Building Model".

Figure 3: "Show Sample Units" with "Common Only" selected

The Workspace window is initially the
active window, as seen in Figure 5Figure 6. The five tabs in the AFT
xStream window represent the five
Primary Windows. Each Primary Window contains its own toolbar that is displayed directly beneath the Primary
Window tabs.
AFT xStream supports dual monitor
usage. You can click and drag any of
the five primary window tabs off of the
main xStream window. Once you drag
one of the primary windows off of the
xStream window, you can move it anywhere you like on your screen, including onto a second monitor in a dual
monitor configuration. To add the

Index 514
primary window back to the main
xStream primary tab window bar,
simply click the "X" button in the upper
right of the primary window.
To ensure that your results are the
same as those presented in this documentation, this example should be
run using all default AFT xStream settings, unless you are specifically
instructed to do otherwise.
The Workspace window
The Workspace window is the primary
interface for building your model. This
window has three main areas: the
Toolbox, the Quick Access Panel, and
the Workspace itself. The Toolbox is
the bundle of tools on the far left. The
Quick Access Panel is displayed on
the far right. It is possible to collapse
the Quick Access Panel by clicking on
the thumbtack pin in the upper right of
the Quick Access Panel in order to
allow for greater Workspace area. The
Workspace takes up the rest of the
window.

Figure 5: The Workspace window is
where the model is built. The Status Bar
shows the model status.

You will build your pipe flow model on
the Workspace using the Toolbox
tools. The Pipe Drawing tool, on the
upper left, is used to draw new pipes
on the Workspace. The Annotation
tool allows you to create annotations
and auxiliary graphics.
Below the two drawing tools are icons
that represent the different types of
junctions available in AFT xStream.
Junctions are components that connect pipes and also influence the pressure or flow behavior of the pipe
system. The junction icons can be
dragged from the Toolbox and
dropped onto the Workspace.
When you pass your mouse pointer
over any of the Toolbox tools, a tooltip
identifies the junction's function.
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Unpinning the Quick Access Panel

I. Place the Tank junction
By default, the Quick Access Panel is
pinned to the Workspace window so
that it is constantly displayed. The
Quick Access Panel can be unpinned
so it is only displayed when the mouse
is hovered over the tab displayed on
the right edge of the Workspace window. You can unpin the Quick Access
Panel by clicking on the pin icon displayed in the top right corner of the
Quick Access Panel (Figure 5).

ØTo start, click and drag a Tank
junction from the Toolbox and drop
it on the Workspace. Figure 7 shows
the Workspace with one Tank.
Objects and ID numbers
Items placed on the Workspace are
called objects. All objects are derived
directly or indirectly from the Toolbox.
AFT xStream uses three types of
objects: pipes, junctions and annotations.
All pipe and junction objects on the
Workspace have an associated ID
number. For junctions, this number is,
by default, placed directly above the
junction and prefixed with the letter
"J". Pipe ID numbers are prefixed with
the letter "P". You can optionally
choose to display either or both the ID
number and the name of a pipe or junction. You also can drag the ID number/name text to a different location to
improve visibility.

Figure 6: The Workspace window is
where the model is built

Step 2. Lay out the model
To lay out the tank blowdown model,
you will place a Tank junction, a Valve
junction, and an Assigned Pressure
junction on the Workspace. Then you
will connect the junctions with pipes.

The Tank you have created on the
Workspace will take on the default ID
number of one. You can change this to
any desired number greater than zero,
but less than 100,000.
Editing on the Workspace
Once on the Workspace, junctions
can be moved to new locations and
edited using the features on the Edit
menu. Cutting, copying, and pasting
are all supported. Undo is available for
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most formatting and arrangement
actions on the Workspace.

Figure 8. The Valve will be assigned
the default number "J2".

Note: The relative location of
objects in AFT xStream is not
important. Distances and
heights are defined through
dialog boxes. The relative locations on the Workspace
establish the connectivity of
the objects, but have no bearing on the actual length or
elevation relationships.

Figure 8: Tank Blowdown model with
Valve placed

III. Place an Assigned Pressure junction

Figure 7: Tank junction placed

II. Place the Valve junction
ØTo add a Valve junction, click and
drag a valve from the Toolbox and
place it on the Workspace as shown in

ØTo add an Assigned Pressure
junction, click and drag an Assigned
Pressure junction from the Toolbox
and place it on the Workspace as
shown in Figure 9. The Assigned Pressure junction will be assigned the
default number "J3".
ØBefore continuing, save the work
you have done so far. Choose Save
As... from the File menu and enter a
file name (Tank Blowdown, perhaps)
and AFT xStream will append the ".xtr"
extension to the file name.
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A. Place the other junctions
Drag a Valve and an Assigned Pressure junction from the Toolbox and
drop them on the Workspace so that
your model appears similar to Figure
9.
If the icons do not line up exactly, the
calculations will not be affected. You
can align the icons by using the Align
feature selected from the Arrange
menu.
Note: The relative location of
objects in AFT xStream is not
important. Distances and
heights are defined through
Property window dialog
boxes. The relative locations
on the Workspace establish
the connectivity of the objects
but have no bearing on the
actual length or elevation relationships.

Figure 9: All junctions placed

Before continuing, save the work
you have done so far with "Save As"
from the File menu. Choose "Save As"
from the File menu and enter a file
name (Tank Blowdown, perhaps) and
AFT xStream will append the ".xtr"
extension to the file name.

IV. Draw a pipe between J1
and J2
Now that you have all of the junctions,
you need to connect them with pipes.
ØTo create a pipe, click the Pipe
Drawing Tool icon on the Toolbox.
The pointer will change to a crosshair
when you move it over the Workspace. Draw a pipe above the junctions by clicking and dragging the
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mouse, similar to that shown in Figure
10.
The pipe object on the Workspace has
an ID number (P1) that is shown near
the center of the pipe.

Figure 11: First pipe partially connected

Figure 10: First pipe drawn

ØTo place the pipe between J1 and
J2, use the mouse to grab the pipe in
the center and drag it so that the left
endpoint falls within the J1 Tank icon,
then drop it there (see Figure 11).
Next, grab the right endpoint of the
pipe and stretch the pipe, dragging it
until the endpoint terminates within the
J2 Valve icon (see Figure 12).

Figure 12: First pipe fully connected

Reference positive flow direction
Located on the pipe is an arrow that
indicates the reference positive flow
direction for the pipe. AFT xStream
assigns a flow direction corresponding
to the direction in which the pipe is
drawn. You can reverse the reference
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positive flow direction by choosing
Reverse Direction from the Arrange
menu or selecting the Reverse Pipe
Direction button on the Workspace
Toolbar.
The reference positive flow direction
indicates which direction is considered
positive. If the reference positive direction is the opposite of that obtained
by the Solver, the output will show the
flow rate as a negative number.

output once a solution has
been completed. You can
lock all the objects by choosing Select All from the Edit
menu, then selecting Lock
Object from the Arrange
menu. The Lock Object button on the Workspace Toolbar will appear depressed
indicating it is in an enabled
state, and will remain so as
long as any selected object is
locked.

V. Add the remaining pipe
A faster way to add a pipe is to draw it
directly between the desired junctions.
ØActivate the Pipe Drawing Tool
again. Position the cursor on the J2
Valve, then press and hold the left
mouse button. Stretch the pipe across
to the J3 Assigned Pressure junction,
then release the mouse button. All
objects in the model should now be
graphically connected as they are in
Figure 13.
Save the model by selecting "Save" in
the File menu, by clicking the "Save"
icon on the Toolbar, or by entering
Ctrl+S.

Figure 13: All pipes and junctions placed

Note: It is generally desirable to
lock your objects to the Workspace once they have been
placed. This prevents accidental movement and disruption of the connections.
Locking also helps prevent
accidental deletion of your

There is an arrow on each pipe that
indicates the reference positive flow
direction for the pipe. AFT xStream
assigns a flow direction corresponding
to the direction in which the pipe is
drawn.

Reference positive flow direction

You can reverse the reference positive flow direction by choosing
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"Reverse Direction" from the Arrange
menu or selecting the Reverse Pipe
Direction button on the Workspace
Toolbar.
The reference positive flow direction is
used for reference purposes only and
need not be the actual flow direction. If
the reference positive flow direction is
the opposite of that obtained by the
solver, the output will show the flow
rate as a negative number. However,
when used with compressors and certain other junction types the pipes
must be in the appropriate forward
flow direction because that is how AFT
xStream determines which side is suction and which is discharge.
Note: Some users find it desirable
to lock objects to the Workspace once they have been
placed. This prevents accidental movement and disruption of the connections.
Locking also helps prevent
accidental deletion of your
output once a solution has
been reached. You can lock
all the objects by choosing
"Select All" from the Edit
menu, then selecting "Lock
Object" from the Arrange
menu. The Lock Object button on the Workspace Toolbar will appear depressed
indicating it is in an enabled
state, and will remain so as
long as any selected object is
locked.

B. Define the model components

Step 3. Define the model
components
The model must have all pipes and
junctions defined in order for it to run.
This step encompasses the proper
input data and connectivity for all
pipes and junctions.
Object status
Each pipe and junction has an object
status. The object status tells you
whether the object is defined according to AFT xStream's requirements.
To see the status of the objects in your
model, click the light bulb icon on the
Workspace Toolbar (alternatively, you
could choose "Show Object Status"
from the View menu). Each time you
click the light bulb, "Show Object
Status" is toggled on or off.
When "Show Object Status" is on, the
ID numbers for all undefined pipes
and junctions are displayed in red on
the Workspace. Objects that are completely defined have their ID numbers
displayed in black. (These colors are
configurable through User Options
from the Tools menu.)
Because you have not yet defined the
pipes and junctions in this model, all
the objects' ID numbers will change to
red when you turn on "Show Object
Status."
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Showing undefined objects
Another useful feature is the List
Undefined Objects window (Figure
14). This can be opened from the View
menu by clicking on "List Undefined
Objects", or by clicking the List
Undefined Objects icon on the Workspace toolbar
. All objects with
incomplete information are listed.
Click on an undefined pipe or junction
to display the property data that is
missing. Click the close button on the
bottom right to stop showing this window.

Figure 14: The List Undefined Objects window lets you see the undefined properties
for each undefined object

I. Enter data for the Tank J1
As shown in Figure 13, the J1 junction
is a Tank junction.
ØTo define the first tank, open the
J1 Tank Properties window (See Figure 15) by double-clicking on the J1
icon. Choose the Finite Tank Model,
then enter an Elevation of 0 feet. You
can assign any unit of length found in
the adjacent drop down list.
To define the first tank, open the J1
Tank Properties window (Figure 15)
by double-clicking on the J1 junction
Note: You can also open an
object's Properties window
by selecting the object (clicking on it) and then either
pressing the Enter key or
clicking the Open Pipe/Junction Window icon on the
Workspace Toolbar.
ØEnter a Pressure of 600 psia, a
Temperature of 300 deg. F, and a
Volume of 300 ft3. Also set the Initial
Conditions to Known and the Thermodynamic Process to Adiabatic.
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Note: You can specify default units
for many parameters (such
as meters for length) in the
User Options window,
accessed from the Tools
menu under Preferred Units.
Enter the following properties into
the J1 Tank Properties window:
1.

Enter 0 feet for Elevation

2.

Set the Tank Model to "Finite"

3.

Set 600 psia for Pressure

4.

Set the Temperature to 300
deg. F

5.

Set the Volume to 300 feet3

6.

Set the Initial Conditions to
"Known"

7.

Set the Thermodynamic Process to "Adiabatic"

Note: You can specify default units
for many parameters (such
as feet for length) in the User
Options window, accessed
from the Tools menu under
Preferred Units.
The highlight feature displays all the
required information in the Properties
window in light blue. The highlight feature is on by default. You can toggle
the highlight off and on by double-clicking the top part of the window or by
pressing the F2 key. The highlight feature can also be turned on or off in the
User Options window, or accessed
from the View menu by selecting the
"Highlight in Pipe and Jct Windows"
option.
By default, the junction's name is the
junction type. The name can be

updated by entering it in the Name
field at the top of the window. In Figure
15, the name of Tank J1 is "Supply
Tank." The name can be displayed on
the Workspace, Visual Report, or in
the Output.
Most junction types can be entered
into a custom Junction Library allowing the junction to be used multiple
times or shared between users. To
select a junction from the custom library, choose the desired junction from
the Library List in the junction's Properties window. The current junction
will get the properties from the library
component.
The "Copy Data From Jct..." list will
show all the junctions of the same type
in the model. This will copy desired
parameters from an existing junction
in the model to the current junction.
The Tank Model tab is the tab that
appears first when the Tank junction is
opened and contains all of the inputs
required to define the Tank in steadystate. While the Tank Model tab is specific to the Tank junction, the first tab
opened for any junction will contain all
inputs required for that junction to be
defined.
The Optional tab allows you to enter
different types of optional data. You
can select whether the junction number, name, or both are displayed on
the Workspace. Some junction types
also allow you to provide a guess for
initial pressure as well as other junction specific data. The junction icon
graphic can be changed, as can the
size of the icon. Design factors can be
entered for most junctions, which are
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applied to the pressure loss calculations for the junction in order to
give additional safety margin to the
model.
Each junction has a tab for notes,
allowing you to enter text describing
the junction or documenting any
assumptions.
The highlight feature displays all the
required information in the Properties
window in light blue. The highlight feature is on by default. You can toggle
the highlight off and on by double-clicking anywhere in the window or by
pressing the F2 key. The highlight feature can also be turned on or off in the
User Options window, or accessed
from the View menu by selecting the
"Highlight in Pipe and Jct Windows"
option.
The Status tab will state whether all
required input data is present for a
given junction. If not, it will list all
inputs that are incomplete.
ØClick OK. If "Show Object Status" is
turned on, you should see the J1
ID number turn black again, telling you
that J1 is now completely defined.

Figure 15: Properties window for Tank J1

The "Copy Data From Jct..." list will
show all the junctions of the same type
in the model. This will copy desired
parameters from an existing junction
in the model to the current junction.
Using the tabs in the Properties
windows
The information in the Properties windows is grouped into several categories and placed on separate tabs.
Click the tab to bring its information forward. Figure 15 is an example of a
Tank's Properties window.
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The Tank Model tab is the tab that
appears first when the Tank junction is
opened and contains all of the inputs
required to define the Tank in steadystate. While the Tank Model tab is specific to the Tank junction, the first tab
opened for any junction will contain all
inputs required for that junction to be
defined.

The Status tab will state whether all
required input data is present for a
given junction. If not, it will list all
inputs that are incomplete.

The Optional tab allows you to enter
different types of optional data. You
can select whether the junction number, name, or both are displayed on
the Workspace. Some junction types
also allow you to provide a guess for
initial pressure as well as other junction specific data. The junction icon
graphic can be changed, as can the
size of the icon. Design factors can be
entered for most junctions, which are
applied to the pressure loss calculations for the junction in order to
give additional safety margin to the
model.

The Inspection feature

ØClick OK. If "Show Object Status" is
turned on, you should see the J1
ID number turn black again, telling you
that J1 is now completely defined.

You can check the input parameters
for J1 quickly, in read-only fashion, by
using the Inspection feature. Position
the cursor on the Tank J1 junction and
hold down the right mouse button. An
information box appears, as shown in
Figure 16.
Inspecting is a faster way of examining the input (and output, if output results are available) than opening the
Properties window.

Each junction has a tab for notes,
allowing you to enter text describing
the junction or documenting any
assumptions.
The highlight feature displays all the
required information in the Properties
window in light blue. The highlight feature is on by default. You can toggle
the highlight off and on by double-clicking anywhere in the window or by
pressing the F2 key. The highlight feature can also be turned on or off in the
User Options window, or accessed
from the View menu by selecting the
"Highlight in Pipe and Jct Windows"
option.

Figure 16: Inspect junction properties
from the Workspace by clicking and holding the right mouse button
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II. Define Valve J2Enter Valve
data
The J2 Junction is a Valve junction.
This junction will be the initiator of the
transient.
Double-click the J2 junction icon to
open the Valve Properties window
(Figure 17).
1.

Verify the Elevation is 0 feet

Note: This value by default will be
equal to the last elevation
used.
2.

Choose the loss model as Cv
and enter a Cv value of 60. This
typically represents the valve's
Cv during steady-state.

3.

Enter an Xt of 0.7

4.

Click the Optional tab and click
the radio button labeled
"Closed" under Special Condition. This will set the steady
state Cv equal to 0.

Figure 17: Input data for Valve junction J2

5.

Click the Transient tab and
select "Time" under "Initiation
of Transient" to indicate that the
valve closure will be initiated at
the time you specify, then enter
the following Cv vs. Time data
(Figure 18).

Time
(seconds)
0
0.1
240

Cv

Xt

0
60
60

0.7
0.7
0.7

The first data point of the table
must match the steady-state
value of the junction. In this
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case, the valve is closed in the
initial steady-state due to the
Special Condition specified in
Step 4. Therefore, the initial
transient data point automatically populates the valve
as being closed (Cv of zero
means the valve is closed). The
valve then fully opens over a
period of 0.1 seconds. It
remains in this position for the
rest of the simulation.

6.

Click the OK button. There
should now be a "T" symbol
next to the Valve junction in the
Workspace, indicating that transient data is entered for the
junction. The Valve junction in
the Workspace will additionally
have a red "X" next to it indicating that the junction contains
a special condition.

ØOpen the J2 Valve Properties window (see Figure 19) and enter an elevation of 0 feet.
ØChoose the loss model as Cv and
enter a Cv value of 60. This typically
represents the valve's Cv during
steady-state. When the valve is closed
during the steady state then opens during the transient (as is the case for this
model), the loss model represents the
valve's loss at the end of the transient.
Enter an Xt of 0.7.
ØClick on the Optional tab and,
under Special Condition, select
Closed. This indicates the valve will be
closed in the steady state.
ØClick the Transient tab and enter
the data below for Cv(See Figure 20).

Figure 18: Transient input data for
Valve junction J2

Time
(seconds)

Cv

Xt

0

0

0.7

0.1

60

0.7

240

60

0.7

The first data point (Cv = 0) must
match the steady-state value. The transient data represents the valve initially
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closed. The valve then opens over a
period of 0.1 seconds and stays open.
Note: The initial transient data point
is Cv = 0 because we set the
Special Condition as Closed
under the Optional Tab. Had
we selected none for the special condition, the first data
point would have to be Cv =
60.
The J2 Valve is the element which
causes the transient in this model. The
purpose of the model will be to understand how the conditions within the
supply tank and discharge pipe
change after the valve opens.
When transient data is entered for a
junction, an "XT" symbol is shown next
to the junction number on the Workspace.

Figure 19: Input data for Valve junction J2

Index 528
3.

Enter a Stagnation Pressure of
14.7 psia

4.

Verify the Temperature radio
button is selected and enter a
value of 70 deg. F

5.

Click the OK button. The
Assigned Pressure junction
should be fully defined.

Figure 20: Transient input data for Valve
junction J2

III. Define Assigned Pressure
J3Enter Assigned Pressure
data
The J3 Junction is an Assigned Pressure junction.
Double-click the J3 junction icon to
open the Assigned Pressure Properties window (Figure 21).
1.

Verify the Elevation is 0 feet

2.

Verify the Stagnation radio button is selected for "Boundary
Specification"

Figure 21: Input data for Assigned Pressure junction J3

ØOpen the J3 Assigned Pressure
Properties window (see Figure 22)
and enter an Elevation of 0 feet.
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ØEnter a Stagnation Pressure of
14.7 psia and a Stagnation Temperature of 70 F.
ØSave the model again before proceeding.

step is to define all the pipes. Doubleclick the pipe object on the Workspace.
ØFirst, open the Pipe Properties
window for Pipe P1. The Pipe Model
tab opens by default (Figure 23). For
Pipe P1, enter a length of 20 feet, and
select the Material as Steel - ANSI,
nominal 2 inch size, STD (schedule
40) (see Figure 23).
1.

In the Pipe Material field,
choose "Steel - ANSI"

2.

In the Size field, select "2 inch"

3.

In the Type field, select "STD
(schedule 40)"

4.

Specify the Length as 20 feet

5.

For the Friction Model field,
verify "Standard" is selected

Figure 22: Enter the data for Assigned
Pressure J3 in the Assigned Pressure
Properties window

IV. Define Pipe P1Enter pipe
data for P1
Data for pipes and junctions can be
entered in any order. In this example,
the junctions were done first. The next

Figure 23: Properties window for Pipe P1
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The Pipe Properties window

you can click the Jump button to jump
to any other part of your model.

The Pipe Properties window offers
control over all important flow system
parameters that are related to pipes.

Click OK to finish defining P1.

The Inspect feature also works within
the Pipe Properties window. To
inspect a connected junction, position
the mouse pointer on the connected
junction's ID number and hold down
the right mouse button. This is helpful
when you want to quickly check the
properties of connecting objects. (You
can also use this feature in junction
Properties windows for checking connected pipe properties.)

V. Define Pipe P2Enter pipe
data for P2

The Inspect feature can be accessed
not only from pipes and junctions located on the Workspace, but also from
within the Properties window of each
pipe (and certain junctions). This is
helpful when you want to quickly
check the properties of objects that
connect to a pipe or junction whose
Properties window you already have
open.
To inspect a junction connected to a
given pipe, position the mouse cursor
on the connected junction's ID number
in that pipe's Properties window (located at the top right of the Pipe Properties window) and hold down the right
mouse button. This process can be
repeated for any junctions that state
the upstream and downstream pipe in
the junction's Properties window by
holding the right mouse button on the
pipe's ID number.
By double-clicking the connected junction number, you can jump directly to
the junction's Properties window, or

Similar to Pipe P1, enter the following
data for pipe P2:
1.

In the Pipe Material field, select
"Steel - ANSI"

2.

In the Size field, verify "2 inch"
is selected

3.

In the Type field, verify "STD
(schedule 40)" is selected

4.

Specify the Length as 1500 feet

5.

For the Friction Model field,
verify "Standard" is selected

6.

Click OK to finish defining P2

ØOpen the Pipe Properties window
for Pipe P2. Enter a length of 1500
feet, and select the Material as Steel ANSI, nominal 2 inch size, STD
(schedule 40).
Check if all the pipes and junctions
are defined by clicking on the List
Undefined Objects button. If all data is
entered, no items should appear in the
Undefined Objects window. If items
are present, open the corresponding
Properties windows for the incomplete
items from the workspace. The Status
tab on each Properties window will
indicate what information is missing.
Check if all the pipes and junctions are
defined by clicking on the List
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Undefined Objects button. If all data is
entered, no items should appear in the
Undefined Objects window. If items
are present, open the corresponding
Properties windows for the incomplete
items from the workspace. The Status
tab on each Properties window will
indicate what information is missing.

C. Review model data

data section and the bottom is the
Junction data section. Each section is
collapsible using the button at the top
left of the section. Further, each section can be resized.
The Model Data window allows
access to all Properties windows by
double-clicking on any input parameter column in the row of the pipe or
junction you want to access.

ØSave the model. It is also a good
idea to review the input using the
Model Data window.
Save the model. It is also a good idea
to review the input using the Model
Data window.
Reviewing input in the Model Data
window
The Model Data window is shown in
Figure 24. To change to this window,
you can select it from the Window
menu, you can click on the Model
Data tab, or you can press Ctrl+M.
The Model Data window gives you a
text based perspective of your model.
Selections can be copied to the clipboard and transferred into other Windows programs, exported into Excel,
saved to a formatted file, printed to an
Adobe™ PDF, or printed out for
review. Figure 25 shows an expanded
view of the Transient Data tab from
Figure 24. Here all transient input data
for the model is shown.
Data is displayed in three general
areas. The top is called the General
data section, the middle is the Pipe

Figure 24: The Model Data window displays all input in text form

Index 532
checkmark. After defining all groups,
thus completing the Analysis Setup,
the Model Status light in the lower
right corner of the Workspace turns
from red to green.
The Analysis Setup window can also
be opened by clicking on the Model
Status Light on the Status Bar at the
bottom right corner of the AFT
xStream window (Figure 5).

Figure 25: The Transient data tab in the
Model Data window displays transient
input data

Step 4. Specify Analysis
Setup
ØNext, click Analysis Setup on the
Main Toolbar to open the Analysis
Setup window (see Figure 26). The
Analysis Setup window contains six or
more groups depending on which modules you may be using. Each group
has one or more items. A fully defined
group has every item within it defined
with all required inputs. Complete
every group to run the Solver. A group
or item that needs more information
will have a red exclamation point to
the left of the group or item name.
After completing a group, the group
icon shows a green circle with a

Figure 26: The Analysis Setup window
tracks the defined and undefined model
input

A. Specify the Modules
group
Under the Modules group, click on the
Modules item to open the Modules
panel, shown in Figure 26. Here you
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can enable and disable the Pulsation
Frequency Analysis add-on module.
By default, the model will have all modules disabled. Therefore, make no
changes to this panel for this example.

B. Specify the Fluid Properties group
ØSelect the Fluid item to open the
Fluid panel (Figure 27).
This panel allows you to specify the
fluid used in the model.
You can select a fluid from the standard AFT xStream fluid library (AFT
Standard), or select ASME Steam
Tables. Additionally, you can select
multiple fluids and/or create mixtures
using the included NIST REFPROP library or optional add-on Chempak library, or create custom fluids. Custom
fluids are created by opening the
Library Manager from the Library
menu or by clicking the Edit Fluid List
button in the Fluid panel and clicking
"Add New Fluid...". Users can also add
their own custom fluids to the AFT
Standard library.
ØSelect the AFT Standard fluid
option, then choose "Nitrogen (GN2)"
from the list and click the "Add to
Model" button.

Figure 27: The Fluid panel is where you
specify the fluid

C. Inspect the Pipes and
Junctions group
The Pipes and Junctions group in the
Analysis Setup window contains the
Pipes and Junctions panel, which is
used to show the status of the pipes
and junctions on the workspace. This
item is incomplete if there are any
undefined pipes/junctions on the Workspace, or if there are no pipes/junctions on the Workspace. In this
example the objects in the Workspace
are fully defined, so this item is
marked as complete.
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Running models in steady-state
After fully specifying the pipes and
junctions, sufficient information exists
to run the model in steady-state. You
can run the model in steady-state by
selecting the Simulation Mode/Duration panel from the Transient Control
group and then choosing "AFT
Arrow™ Steady" for the Time Simulation. If you do this, the other inputs
on the Simulation Mode/Duration
panel and the Pipe Sectioning and Output panel will no longer be required,
and the model can be run.
In general, it is a good idea to always
run your model in steady-state before
running the full transient analysis to
make sure the model is giving reasonable results. However, in this case
the model has no flow in the steady
state, and a steady state run is trivial.

D. Specify the Pipe Sectioning and Output group
The next panel is the Pipe Sectioning
and Output panel in the corresponding
group. The Pipe Sectioning and Output panel divides pipes into computation sections in a manner which is
consistent with the Method of Characteristics (MOC).
To satisfy the MOC, the following
equation must be satisfied:

where Δt is the time step, Δx is the section length, and c is the sonic velocity.
ØEnter "1" for the Minimum Number of Sections Per Pipe
The Minimum Number of Sections Per
Pipe determines the section length by
taking the quotient of the shortest
pipe's length and the Minimum Number of Sections. Increasing the number of sections in a model will always
have a positive correlation to the
model accuracy as the error inherent
to the Method of Characteristics
decreases when the step size is made
smaller. However, the run time of the
model increases quadratically as well,
since each added section to the
shortest pipe increases the number of
calculations for each time step. This
increase in run time is exacerbated
when there is a large disparity
between the minimum pipe length and
the length of the longest pipe, such as
exists in this model. The Minimum
Number of Sections Per Pipe for this
example will be set to 1 for expediency, but note that it would be wise to
use more computational sections if
you are running an AFT xStream
model for real projects. The number of
sections used will impact both the
accuracy and the run time - a larger
number of sections will increase the
result accuracy, but will also quadratically increase the run time for the
model. The Minimum Number of Sections will be defined as 1 in this
example for expediency, though this
may result in a lower accuracy than
when using more sections. The error
in the results due to this sectioning
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choice will be explored further in a
later step.
ØDefine the Estimated Maximum
Pipe Temperature During Transient
as 1700 deg. F.
The Estimated Maximum Pipe Temperature During Transient is used to
calculate the maximum sonic velocity.
Since all pipes in the network must be
solved together, the time step must be
the same for each pipe. However, the
sonic velocity will not be equivalent for
all of the pipes. Therefore, the sonic
velocity at the specified maximum temperature is used to find a uniform time
step for the system. Without a uniform
time step, the MOC could fail. Choosing a maximum temperature that is
much higher or much lower than the
maximum temperature calculated during the run can result in additional
uncertainty in the MOC solution., as is
discussed in the Pipe Sectioning Introduction to Method of Characteristics help topic. It is generally
recommended to choose a conservatively high temperature for the
model initially. The results of the initial
run can then be used to refine the
Estimated Maximum Temperature During Transient for subsequent runs.
The Sectioning Summary underneath
the inputs will be partially filled in. Certain properties, such as total steps and
total pipe computations, need the Simulation Mode/Duration panel completed to be defined.

Figure 28: The Sectioning panel in the
Analysis Setup window is used to calculate the time step of the model

E. Specify the Transient Control group
The Transient Control group has two
items, the Simulation Mode/Duration
panel and the Transient Solver Initialization panel. The Simulation
Mode/Duration panel allows you to
choose the simulation type, and to specify the time that the simulation starts
and stops.
The Transient Solver Initialization
panel contains advanced settings
related to the resolving artificial transients in the model, and typically
should not be changed.
ØSelect the Simulation Mode/Duration panel (Figure 29). Enter 0
seconds for Start Time and 240 for
Stop Time.
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ØClick OK to accept the current
settings. The last Analysis Setup
panel should be completed. The
model is ready to be solved.

Note the run time may take 5-10
minutes for this model, depending on
your computer's speed.

Figure 29: The Simulation Mode/Duration
panel is used to specify the simulation
type and the time span for the transient

ØSave the model.

Figure 30: The Solution Progress window
displays the state of the simulation

Step 5. Run the solver
The two solvers
ØChoose "Run Model..."from the
Analysis menu or click the "Run
Model" button on the Main Toolbar.
During execution, the Solution Progress window displays the state of the
simulation (Figure 32Figure 30). You
can use this window to pause or cancel the solver's activity.

AFT xStream has two solvers. The
first is called the AFT Arrow™ Steady
Solver, which as its name suggests,
obtains a steady-state solution to the
pipe network. The second solver is
called the Transient Solver and solves
the gas transient equations.
The AFT Arrow™ Steady solver and
Transient solver use different sectioning methods, which causes small
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discrepancies between the converged
AFT Arrow™ Steady solution and the
first time step of the transient solution.
To allow artificial waves caused by
these discrepancies to die out, AFT
xStream runs the Transient solver for
a period of time before the transient
simulation begins. Once the artificial
transients have died out AFT xStream
checks the solution with resolved artificial transients against the AFT
Arrow™ Steady solution. If the mismatch between the beginning and end
of the artificial transient resolution process is sufficiently small AFT xStream
proceeds with the transient simulation.
See the chart in Figure 31 as a visual
representation of the process
described above.

Figure 32: The Solution Progress window
displays the state of the simulation

The transient output file
Figure 31: Illustration of the Transient
Solver Initialization process with artificial
transient resolution

ØWhen the solution is obtained,
click the Output buttonWhen the
solution is obtained, click the Output
button to display the text-based Output window. The information in the Output window can be reviewed visually
on the screen, saved to a file, exported to a spreadsheet-ready format,
copied to the clipboard, or printed.

When the Transient Solver runs, the
transient output data is written to a file.
This file is given the same name as
the model itself with a number appended to the name, and with an ".out"
extension appended to the end. For all
transient data processing, graphing,
etc., the data is extracted from this file.
The number is appended because
AFT xStream allows the user to build
different scenarios all within this
model. Each scenario will have its own
output file; therefore, the files need to
be distinguishable from each other.
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The output file will remain on disk until
the user erases it or the model input is
modified. This means that if you were
to close your model right now and then
reopen it, you could proceed directly
to the output window for data review
without re-running your model.

Step 6. Review the Output
window
Click Output after the solver is finished. The Output window (Figure 33)
is similar in structure to the Model
Data window. Three areas are shown,
and you can minimize or enlarge each
section by clicking the arrow next to
the General, Pipes, and All Junctions
tabs. The items displayed in the tabs
can be customized with the Output
Control window from the Tools dropdown menu.
The General section will open by
default to the Warnings tab if any
Warnings or Cautions were
encountered during the simulation.
This model should generate a Caution
that the Maximum Transient Pipe
Mach Number is at least 0.2 higher
than the steady pipe Mach number,
which occurs since there is no flow in
the system at steady state. When this
Caution is present, the effect of pipe
sectioning on results can be significant. The impact of pipe sectioning
will be addressed in greater detail later
in Step 10.
The Output window allows you to
review both the steady-state and transient results. The Pipes tab, All

Junctions tab, and any specific junction tabs in the Junction section (such
as Branch, Tank, Valve, etc.) show the
steady-state results. A summary of the
maximum and minimum transient results for each pipe is given on the Transient Max/Min tab in the Pipe section
and is the active tab displayed in Figure 33.You can review the solutions
for each time step (i.e., a time history)
for which data was written to file. Also,
a summary of the maximum and minimum transient results for each computing station is given on the Transient
Max/Min tab in the pipe area. These
two data sets are located on the Transient Output tab and Transient
Max/Min tab in the pipe area of the
Output window (see Figure 34 and Figure 35). Note that in order to display all
pipe stations as shown in Figure 34,
the model will need to be set to save
data for all stations. By default,
xStream saves all data points. This
can be changed in the Pipe Sectioning
and Output panel.
Click on the Event Messages By Time
tab (See Figure 37). There should be
messages indicating that Valve J2
experienced a near instantaneous
choking that dissipated after about
0.06 seconds while Assigned Pressure J3 experienced choking after
2.52 seconds that lasted until approximately T=116.5 seconds. Choking is
an important phenomenon to pay
attention to as it indicates that the fluid
has reached sonic velocity. This has
significant implications for the MOC
calculation method as will be discussed later.
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Figure 35: The Output window displays
the values of steady-state parameters in
the pipes tab

You can also review the solutions for
each time step (i.e., a time history) for
which data was written to file on the
Transient Output tab in the Pipe section (Figure 36). Moving the slider
along the bottom will change the time
step shown in the table.

Figure 33: The Output window displays
steady and transient output in text form

Figure 34: The Output window displays
transient data from each time step

Figure 36: The Output window displays
transient data for each time step in the
Transient Output tab

The Event Messages By Time tab in
the General section (Figure 37) allows
you to review changes of states at
junctions, such as the onset of choking or the initiation of transient events.
This is important in gas transients as
sonic choking changes the computational method used by the solver.
Therefore, knowing where choked
flow occurs can provide important
insights about how the final results
were tabulated.
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Figure 38: The Output Control window
lets you customize the output

Figure 37: The Output window displays
event messages about system behavior
in the Event Messages by Time tab

The Output Control window can be
accessed from either the Tools menu
or from the Output window Toolbar
(Figure 38). The Output Control window allows you to select the specific
output parameters you want to display
in the Output window. You also can
choose the units. If you do not change
any of the Output Control settings, the
default Output Control parameters are
assigned.

Units for each column in the Output
window can also be changed by
double-clicking the column header.
This will open a window in which you
can select the units you prefer (Figure
39). These changes are extended to
the Output Control parameter data
that is set.

Figure 39: The Change Units window is
opened from the Output window tabs by
double-clicking the column header

A. Modify the output format
Go to the Transient Max/Min tab in the
Output window. If you selected the
default AFT xStream Output Control,
the Max. Mass Flowrate and Min.
Mass Flowrate should have units of
lbm/sec (pounds mass per second).
ØSelect Output Control from the
Tools menu or the main Toolbar.
Open the Pipe Transient results
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section. On the right side of the Pipe
Transient results section is the list of
currently selected output parameters
(see Figure 40). Click and change the
units by clicking the arrow beside the
units, and then selecting lbm/hr
(pounds mass per hour) from the drop
down list.

units once again if you prefer. These
changes are extended to the Output
Control parameter data you have previously set.

ØClick OK to display changes to
the current results. You should see
both the Max. Mass Flowrate and Min.
Mass Flowrate in units of lbm/hr.
Ø Select Output Control from the
Tools menu one more time. Open the
Transients Results section. The
Reorder scroll bar on the far right
allows you to reorder parameters in
the list. You may also reorder parameters by dragging and dropping the
icon just to the left of each parameter
within the list of currently selected
parameters.
ØSelect the Temperature Static
parameter and use the Reorder scroll
bar to move it up to the top of the parameter list.
ØClick OK to display the changes
to the current results. You will see in
the Transient Max/Min table that the
first column now contains Temperature Static. The Output Control
window allows you to obtain the parameters, units and order you prefer in
your output. This flexibility will help
you work with AFT xStream in the way
that is most meaningful to you, reducing the possibility of errors.
ØLastly, double-click the column
header Max. Mass Flowrate in the
Transient Max/Min tab. This will open
a window in which you can change the

Figure 40: The Output Control window
allows for the modification of Parameters
shown, Units, and the Order of Results
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B. Graph the results

Step 7. View the Graph Results
For transient analysis, the Graph Results window will usually be more helpful than the Output window because of
the more voluminous data.
ØOpen the Graph Results window
by choosing it from the Windows
menu, clicking the Graph Results tab,
by clicking "Graph Results" from the
Solution Progress window after running the model, or by pressing Ctrl+G.

"Quick and Simple" graph, or an
"Advanced" graph (Figure 41). You
can create a graph by following the
prompts on the Graph Guide, or by
manually specifying the graphing parameters on the Graph Control tab on
the Quick Access Panel, or from the
"Select Graph Parameters" icon located in the top left corner of the Graph
Results Toolbar. For the remainder of
this Quick Start Guide, the Graph
Guide will be hidden, but keep in mind
you can use it whenever you would
like assistance in creating a graph.
Figure 42 shows the Graph Results
window with the Graph Control tab
selected on the Quick Access Panel.

The Graph Parameters menu will automatically be displayed in the Quick
Access Panel on the far right of the
Graph Results window, and is where
you can specify which graphs to generate. On the Transient Pipe tab under
Select Pipe Stations, expand P2 pipe
stations and double-click, or click
(Add button) the outlet station. This
pipe computing station correlates to
the pipe discharge for the Blowdown
Tank system. Select the Graph Parameter as Temperature Static and set
the units to deg F. Add the Parameters
Velocity and Mach Number (See Figure 43).
AFT xStream's Graph Guide feature,
accessed by clicking on the "What
Would You Like to Do?" button located
at the top right of the Graph Results
window, provides assistance by guiding you through the creation of a

Figure 41: The Graph Guide
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on the Quick Access Panel (this
tab is automatically selected when
the Graph Results window is
opened). Because we are interested
in seeing how the pressures and flows
in specific pipe sections respond over
time, ensure that the Transient Pipe
tab is selected in the Parameters/Formatting area on the Quick
Access Panel. Alternatively, you can
open the Select Graph Parameters
window by clicking on the corresponding icon on the Graph Results
Toolbar (Figure 42).

Figure 42: The Graph Results window and
Quick Access Panel Graph Control tab is
where various system parameters (both
steady-state and transient) can be
graphed

AFT xStream gives you the ability to
create "stacked graphs". These are
graphs that are vertically aligned with
each other that use the same x-axis
but with different parameters on the yaxis of each graph. This feature is helpful when you want to look at how different parameters vary with time at a
given position without having to create
separate graphs.
In this example, you will create
stacked graphs of the Temperature
Static, Velocity, and Mach number at
the exit of pipe P2 to see how these
parameters change as the blowdown
proceeds.
Access the graphing parameters
by opening the Graph Control tab

Under "Select Pipe Stations" on
the Transient Pipe tab, expand the
P2 pipe stations and double-click
on Outlet, which is the pipe computing station at the discharge of the
blowdown pipe. Alternatively, you can
click on the right arrow button after
selecting the pipe station you want to
graph to add it to the "Graph These
Pipes/Stations" list.
Verify "seconds" is selected for
the Time Units and "All Times" is
selected for the Time Frame.
In the Parameters definition area,
select "Temperature Static" and
under "Units" select "deg. F" in the
dropdown box to graph the static temperature in deg. F at the pipe discharge over time.
In order to add the stacked graphs
under the static temperature graph
showing the velocity and Mach
number at the outlet of pipe P2,
click the "Add" button twice, which
is the green "+" icon next to "Select
Parameter". Two new rows will appear
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under the Parameter definition area
(Figure 43).
Choose "Velocity" in the first new
parameter row and select units of
"feet/s". Choose "Mach Number" for
the second row.
Figure 43 shows the input in the Parameters/Formatting area on the Quick
Access Panel.

size to 14 for all three graphs. Drag
the legend to the bottom right corner
of the graph
To format each axis font size, rightclick on each axis title and use the
scroll bar to decrease the size until
the font size on each axis appears as
you want it.
Figure 44 shows the stacked graphs
detailing the static temperature, velocity, and the Mach number at Pipe P2
outlet over the course of 240 seconds.
Here you can see that the maximum
temperature at the discharge is about
1400 deg. F. Also note that the maximum temperature in Figure 44 does
not approach the value indicated in
the Transient Max/Min tab. This is
because the Transient Pipe graph
shows only the outlet station (station
75), while the maximum temperature
in pipe 2 is reached at station 65.
Note: The axis titles in the stacked
graphs in Figure 44 have
been modified for clarity.

Figure 43: The Graph Control tab on the
Quick Access Panel allows you to specify
the graph parameters you want to graph
in the Parameters/Formatting area

Click Generate at the bottom of the
Quick Access Panel to create the
static temperature, velocity, and Mach
number graphs at the pipe discharge
over the duration of the simulation.
To format the legend font size,
right-click on each legend and use
the scroll bar to decrease the font

ØClick the Generate button. The
graph shows the temperature, velocity, and Mach number at the exit for
Pipe 2 (Figure 44).
You can use the other buttons in the
Graph Results window to change the
graph appearance and to save and
import data for cross-plotting. The
Graph Results window can be printed,
saved to file, copied to the clipboard,
or printed to an Adobe PDF file. The
graph's x-y data can also be exported
to a file or copied to the clipboard.
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Note that the graph guide, located at
the top right of the Graph Results window and represented with the What
Would You Like to Do? icon, can
guide you through the development of
your graph. This feature can be hidden by clicking on the icon.

seen on the Event Messages tab in
the Output window, and continues for
the next 115 seconds. Also note that
the temperature, velocity and Mach
number all rise sharply shortly after
the valve opens, with the Mach number rapidly reaching one. After the initial rise, the temperature and velocity
both decay while the Mach number
remains at one. The velocity drops
because sonic velocity has a positive
correlation with temperature, so as the
temperature decays, the velocity
required for choked flow also
decreases. It is good to keep in mind
this correlation between temperature
and sonic velocity. This relationship is
important to understand when looking
at systems that encounter choking.
For the purpose of this analysis, it is
also helpful to look at the temperature
and pressure of the tank over time.
Create a new graph tab by clicking
the "New Tab" button which is the
green plus icon located on the bottom
right, immediately below the graph
area (Figure 42).

Figure 44: The Graph Results window
offers full-featured plot generation. The
static temperature, velocity, and Mach
number of Pipe P2 outlet are shown.

Further review
Further review of the graph results in
Figure 44 shows that sonic choking
occurs after several seconds as was

Open the "Transient Jct" tab on the
Graph Control tab of the Quick Access
Panel (Figure 45). Add the J1 (Supply
Tank) Junction.
Verify "seconds" is selected in the
Time Units section and "All Times"
is selected in the Time Frame section to graph the Tank Temperature
and Pressure Stagnation over the
entire simulation duration.
Click the "Add" button to add a new
row under the Parameter definition
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area.
Select "Tank Temperature Stagnation" and specify the units as deg.
F. For the second row, select "Tank
Pressure Stagnation" and specify the
units as psia.
Click Generate at the bottom of the
Quick Access Panel to display the
graph. These graphs show the tank
pressure and temperature initially
decrease quickly, then decrease more
slowly as time progresses. This
change in slope is due to a decreasing
pressure gradient between the tank
and the atmosphere as the tank is
emptied, which slows the mass flow
rate out of the tank (Figure 46).
ØIn the Quick Access Panel, open
the Transient Jct Tab. Under Select
Junctions, add J1 (Supply Tank).
Select the Graph Parameters as Tank
Pressure Stagnation and Tank Temperature Stagnation (see Figure 45).
Set the units to psia and deg. F. Click
the Generate button. This will show
the temperature and pressure in the
supply tank (Figure 46).
Note: AFT xStream assumes all
pipes are adiabatic (perfectly
insulated). Over a 240
second run time this assumption may not be accurate.
Consider this when evaluating simulation results over
longer times.

Figure 45: Graph Parameters window for
the Transient Junction graph
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Lastly, we will animate the profile of
the Blowdown Tank system to show
the wave caused by opening the
valve. In the Quick Access Panel,
open the Profile tab. Under Plot Single
Path, select Pipe 1 and Pipe 2. After
ensuring your length is feet, select the
option to Animate Using Output and
ensure the Animation Time Units are
set to seconds. Add Parameters until
you have 4, then set them to Pressure
Static, Temperature Static, Velocity,
and Density Static. Set the units to
psia, Deg. F, feet/sec, and lbm/ft3,
respectively (see Figure 47).
ØClick the Generate button. This
will show an animated profile of the
pipe system over the specified time
frame (see Figure 48).

Figure 46: The Transient Junction graph
shows how variables within a junction
change over time. The temperature and
pressure of Tank J1 over time are plotted.

This junction graph could be used to
determine when certain conditions
within the tank were met. For instance,
suppose there was a need to know
when the tank pressure dropped
below 300 psia. The junction graph
would indicate the tank pressure
would reach such a point around 75
seconds after beginning of the tank
blowdown. Also note that the rate of
decrease in the tank pressure decays
at later time points as the pressure
gradient driving flow out of the tank
becomes smaller as time progresses.

Figure 47: Profile Graph Parameters window
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considered to happen instantaneously.

Step 8. View the Visual
Report

C. View the Visual Report
The Visual Report allows you to show
text output alongside the model
schematic. This is useful to quickly
show pertinent information in relation
to location in the model. The Visual
Report can also animate the transient
pipe results in a color animation overlaid on the model.
Figure 48: The Profile Graph show
the Maximum and Minimum values of all
parameters shown in the Graph over the
specified time Frame. It can also be set to
animate the values so that the behavior
within the system as a whole can be
observed. The blue line correlates to minimum values, the bright red line shows
maximum value, and the dark red line
shows the value at the current timestep.

Take note of the pressure wave that is
created at the valve just after animation is started. This wave travels to
the Assigned Pressure junction before
reflecting back towards the valve. The
amount of time it takes this wave to
travel to the reflection point and back
is called the communication time. It
should be noted when creating your
transient that any event that occurs
over a shorter length of time than the
communication time of the system is

ØChange to the Visual Report window by choosing it from the Window
menu, clicking the Visual Report tab or
by pressing Ctrl+I. The Visual Report
window allows you to integrate your
text results with the graphic layout of
your pipe network. The Visual Report
Control window should open automatically when accessing the Visual
Report window for the first time. The
Visual Report Control window can
also be opened from the Visual Report
Toolbar or the Tools menu. Note that
the parameters present in Visual
Report Control are determined by the
parameters selected in Output Control.
ØSelect "Max Temperature Static"
and "Min Temperature Static" in the
Pipe Transient Output area of the
Visual Report Window as shown in
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Figure 49. Click the Show button. This
will generate the Visual Report window graphic seen in Figure 50.
It is common for the text in the
Visual Report window to overlap when
first generated. You can change this
by selecting smaller fonts or by dragging the text to a new area to increase
clarity. You can also use the Visual
Report Control window to display units
in a legend to increase the clarity of
the display. These adjustments have
already been done in Figure 50. This
window can be printed or copied to the
clipboard for import into other Windows graphics programs, saved to a
file, or printed to an Adobe PDF file.

Figure 49: The Visual Report Control window selects content for the Visual Report
window

It is common for the text in the
Visual Report window to overlap when
first generated. You can change this
by dragging the text to a new area to
increase clarity. You can also use the
Visual Report Control window to display units in a legend to increase the
clarity of the display. These adjustments have been made in Figure 50.
This window can be printed or copied
to the clipboard for import into other
Windows graphics programs, saved to
a file, or printed to an Adobe PDF file.
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In the “Convective Heat Transfer”
scenario update pipes P1 and P2.
Open the Pipe Properties window for
each pipe and enter the following on
the Heat Transfer tab (Fig):

Figure 50: The Visual Report integrates
results with model layout

D. Examine the Effect of Heat
Transfer
By default AFT xStream models all
pipes as adiabatic at the internal surface, meaning no heat is transferred
from the fluid to the pipe walls or surroundings. Modeling the pipes as adiabatic is reasonable when the pipes are
well insulated and the temperature difference between the fluid and the
atmosphere is relatively low.
However, for cases such as the tank
blowdown modeled in this example
heat transfer from the fluid to the pipe
walls and environment has a large
impact on results.
To see the impact of convective heat
transfer on the results create a child
scenario named “Convective Heat
Transfer.”

1.

Heat Transfer Model = Convective Heat Transfer

2.

External Convection Coefficient Correlation = Free-Horizontal (Churchill-Chu)

3.

Ambient Temperature = 70
deg. F

After updating each of the pipes open
the Analysis Setup window and go to
the Pipe Sectioning and Output panel.
Change the Estimated Maximum Pipe
Fluid Temperature During Transient to
350 deg. F and click OK to accept the
changes.
ØRun the model and go to the Output window.
In the Transient Max/Min tab shown in
Figure 51 it can be seen that the maximum temperature in pipe P2 is only
228 deg. F as opposed to 1613 deg. F
which was calculated with adiabatic
heat transfer.
Go to the Graph results window and
recreate the pipe P2 outlet graph from
Figure 44 as is shown below in Figure
52.
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Step 9. Examine the effect of
sectioning

Figure 51: Transient Max/Min temperature
output with convective heat transfer modelled

Figure 52: Temperature, velocity, and
Mach number for the discharge of Pipe P2
with convective heat transfer

E. Examine the Effect of Sectioning
In AFT xStream, sectioning plays an
important role in model accuracy. Due
to how the MOC operates, accuracy
increases with the number of sections
you have in the model. To illustrate
this, the model was re-run with a Minimum Number of Sections Per Pipe of
6. Comparing Figure 46 to Figure 55,
values such as the tank temperature
and pressure for Tank J1 remain similar with the increase in the number of
sections. However, values such as the
maximum temperature reached in
Pipe 2 (Figure 33 and Figure 53),
changed substantially. This value
increased from 1613 deg. F to 2097
deg. F. This change in the maximum
temperature indicates that the difference in sectioning has significant
implications if your interest is in the
conditions in the blowdown pipe. It
should be noted that changing the Minimum Number of Sections Per Pipe
from one to six caused the computation time of the model to increase
from 5-6 minutes to 3.5 hours. Therefore, it is of critical importance to balance accuracy and computation time
when using AFT xStream. This idea is
discussed in more detail here.
Due to the long run time, it was not
sensible to ask you to run the 6 section scenario as a part of this example.
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If you are interested, you may want to
run this scenario overnight.

Figure 53: Transient Min/Max window for
modified sectioning

Figure 55: Temperature and pressure
stagnation for Tank J1 with 6 sections
minimum per pipe

Figure 54: Temperature, velocity, and
Mach number for the discharge of Pipe P2
with 6 sections minimum per pipe
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Figure 56: Profile Graph for Tank Blowdown system with 6 Sections Minimum
Per Pipe where the blue line represents
the minimum value, the bright red line represents the maximum value and the dark
red line represents the value at the current time step

Conclusion
You have now used AFT xStream's
five Primary Windows to build and analyze a simple gas transient model.
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l

Indicating the importance of the
Estimated Maximum Temperature During Transient

l

Creating animated profile
graphs

Gas Turbine Fuel System Example

Gas Turbine Fuel System
Example

Required knowledge

Summary

This example assumes the user has
already worked through the Beginner:
Tank Blowdown example, or has a
level of knowledge consistent with that
topic.

A compressor feeding natural gas to
combustion baskets in a Turbine Fuel
System has one of its 3 control valves
close instantaneously. The effect of
this transient event on the temperature, pressure, and velocity of the
system is observed.
This example looks at an instantaneous valve closure in front of the
combustion baskets in a natural gas
fuel system. The objective is to determine the maximum fluid temperature
reached during the transient.

Topics covered
This example will cover the following
topics:
l

Modeling a valve closure as a
transient event

l

Modeling a heat exchanger

l

Using the Scenario Manager in
AFT xStream

This example assumes that the user
has some familiarity with AFT xStream
such as placing junctions, connecting
pipes, entering pipe and junction properties, and entering transient data.
Refer to the Tank Blowdown Example
in Chapter 2 for more information on
these topics.

Model file
The file listed below contains a completed version of this example and can
be located in the Examples folder as
part of the AFT xStream installation.
This file can also be downloaded from
the AFT xStream help site from the
Gas Turbine Fuel Example page:
l

US - Gas Turbine Fuel System.xtr

Problem statement
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The objective of this example is to evaluate the maximum temperature that
the natural gas in a turbine fuel system
will reach if one of three control valves
were to instantaneously shut. The natural gas is preheated by a heat
exchanger before passing through the
three control valves, with each feeding
a separate combustion basket.
As the design engineer, you are also
responsible for evaluating the sensitivity of the results to the Minimum
Number of Sections Per Pipe parameter.

Step 1. Start AFT xStream
Open AFT xStream. Click "Start Building Model".

Figure 1: Layout of gas turbine fuel system

B. Enter the pipe and junction data

Step 2. Build the model

A. Place the pipes and junctions
The first step is to define the pipes and
junctions. In the Workspace window,
assemble the model as shown in Figure 1.

The system is in place but now the
input data for the pipes and junctions
needs to be entered. Enter the following data in each Pipe and Junction
Properties window.
All Pipes are Stainless Steel - ANSI,
Schedule 10S, and have standard
roughness. The rest of the pipe information is as follows:
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Pipe #
1
2
3
4
5
6
7
8
9
10
11

Size
(inches)
8
8
8
5
5
8
5
5
8
5
5

Length
(feet)
75
25
5
5
5
5
5
5
5
5
5

Pipe #

Size
(inches)

Length
(feet)

1

8

75

2

8

25

3

8

5

4

5

5

5

5

5

6

8

5

7

5

5

8

5

5

9

8

5

10

5

5

11

5

5

Because several of the pipes are the
same, you can use the Global Pipe
Editing tool to speed up the process of
entering the data. The Global Pipe
Editing tool allows you to apply

changes to multiple pipes at the same
time. Select Global Pipe Edit either
from the Edit Menu, or by selecting the
"Global Edit" dropdown on the toolbar
and selecting the "Global Pipe Edit"
option. This will open the Global Pipe
Edit window. Select pipes P4, P5, P7,
P8, P10, and P11 from the list of pipes
as shown in Figure 2.

Figure 2: Global Pipe Edit window

After selecting the pipes, click the
"Select Pipe Data" button. This will
open a template Pipe Properties window for entering the data to be applied
to all of the selected pipes. Fill out the
data for the selected pipes. When you
have entered all of the data for the
pipes, close the Pipe Properties
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window by selecting OK. The Global
Pipe Edit window will now display a list
of all of the parameters that may be
applied to the selected pipes. The
parameters are categorized as they
are displayed on the tabs in the Pipe
Properties window. For this example,
you want all of the parameters for all of
the selected pipes to be updated to
the specified values. This can be
accomplished by selecting the "All"
button above the list of parameters.
The Global Pipe Edit window should
now appear as shown in Figure 3.

Apply the changes to the selected
pipes by clicking the "Apply Selections" button. AFT xStream will notify
you that the changes have been completed. Select OK. At this point, all of
the changes have been applied but
not saved. If you wish to cancel all of
the changes you just implemented,
you may do so by clicking Cancel on
the Global Pipe Edit window. Save the
applied changes by clicking OK.
Notes: The "Guide >>" button in
the Global Edit windows may
be used as a reminder of the
required steps for the global
edit process if needed.
J1 - Assigned Flow
1.

Name = PD Compressor

2.

Elevation = 0 feet

3.

Mass Flow Rate = 90000
lbm/hr

4.

Temperature = 70 deg. F

J2 - Heat Exchanger
In the Loss Model tab enter the following:
1.

Name = Natural Gas Heater

2.

Elevation = 0 feet

3.

K = 6.6

In the Thermal Data tab enter the following:
Figure 3: Global Pipe Edit window with all
pipe parameters selected for updating

Steady Heat Rate = 3535200 Btu/hr
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J3 - Valve
1.

Elevation = 0 feet

2.

Cv = 10000

3.

Xt = 0.3

J4 and J7 - Tee
Elevation = 0 feet
J5 - Valve
1.

Name = Diffusion Gas FCV

2.

Elevation = 0 feet

3.

Cv = 95

4.

Xt = 0.7

J6, J9 and J12 - Assigned Pressure
Because all of the Assigned Pressures have similar input data, the
Global Junction Edit tool could be
used to input the data for all of the junctions at the same time. The Global
Junction Edit tool works in much the
same way as the Global Pipe Edit tool.
Another tool that can be used to speed
up data entry for items with the same
input data is the Copy Data From Junction tool. Enter the data for Assigned
Pressure junction J6, as listed below,
by double clicking the junction icon on
the Workspace.
1.

J6 Name = Combustion Basket
#1

2.

Elevation = 0 feet

3.

Stagnation Pressure = 15.5
atm

4.

Temperature = 140 deg. F

Click OK to close the junction J6 Properties window. Open the junction J9
Properties window. Near the top of the
Properties window is a drop-down box
labeled "Copy Data From Jct". This
box lists all of the Assigned Pressure
junctions on the Workspace. Select
junction J6 from the list. This will open
the Copy Data From Junction window,
which shows a list of all of the parameters for junction J6, and their values. By checking the box beside a
parameter, the current junction will
copy the parameter value from J6. In
this case, you want all of the parameters for J9 to be the same as J6
except for the name. Select the All button at the top of the list to select all of
the parameters, then uncheck the
name parameter, as shown in Figure
4.
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3.

Cv = 195

4.

Xt = 0.7

J10 - Branch
Elevation = 0 feet
J11 - Valve
1.

Name = Premix Gas FCV #2

2.

Elevation = 0 feet

3.

Cv = 195

4.

Xt = 0.7

5. On the Transient tab, enter the following data:

Time (seconds)
0
0.01
2
1.
Figure 4: The Copy Data From Junction
window

a.

Name = PD Compressor

b.

Elevation = 0 feet

c.

Mass Flow Rate =
90,000 lbm/hr
Note: Be advised that
the unit for
mass flow is
not the default
as it is lbm/hr
as opposed to
lbm/s.

d.

J8 - Valve
Name = Premix Gas FCV #1

2.

Elevation = 0 feet

Xt
0.7
0.7
0.7

Assigned Flow J1

After clicking the OK button in the
Copy Data From Junction window, all
of the junction J9 parameters are
updated to the selected J6 parameter
values. Set the name of junction J9 to
"Combustion Basket #2" and click OK.
Repeat this process for J12, giving
junction J12 the name "Combustion
Basket #3".

1.

Cv
195
0
0

2.

Temperature = 70 deg.
F

Heat Exchanger J2
a.

Name = Natural Gas
Heater
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b.

Elevation =0 feet

c.

K = 6.6

d.

Steady Heat Rate
=3,535,200 Btu/hr
Note: Be advised that
the unit for heat
rate is not the
default as it is
Btu/hr as
opposed to
Btu/s.

3.

4.

5.

Valve J3
a.

Elevation = 0 feet

b.

Cv = 10,000

c.

Xt = 0.3

Valve J5
a.

Name = Diffusion Gas
FCV

b.

Elevation = 0 feet

c.

Cv = 95

d.

Xt = 0.7

8.

Cv

Xt

0

195

0.7

0.01

0

0.7

2

0

0.7

Assigned Pressures J6, J9, J12
a.

J6 Name = Combustion
Basket #1

b.

J9 Name = Combustion
Basket #2

c.

J12 Name = Combustion Basket #3

d.

Elevation = 0 feet

e.

Stagnation Pressure =
15.5 atm

f.

Temperature = 140 deg
F.

Junctions J4, J7, J10
a.

Elevation = 0 feet

Valve J8
a.

6.

7.

Time
(seconds)

Name = Premix Gas
FCV #1

b.

Elevation = 0 feet

c.

Cv = 195

d.

Xt = 0.7

Valve J11
a. Name = Premix Gas FCV
#2
b.

Elevation = 0 feet

c.

Cv = 195

d.

Xt = 0.7

e.

Click on the Transient
Tab and enter the following data

C. Check if the pipe and junction data is complete
ØOpen the List Undefined Objects
window from the View Menu or the
Workspace Toolbar
to verify if all
pipes and junctions are specified. If
not, the incomplete pipes or junctions
will be listed. If undefined objects are
present, go back to the incomplete
pipes or junctions and enter the missing data.
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Step 3. Specify Analysis
Setup

value. This will be discussed
in Steps 8 and 9.

A. Specify the Fluid panel
ØOpen the Analysis Setup window
by clicking Analysis Setup on the
Main Toolbar. Under the "AFT Standard" fluid option, select "Methane"
from the list and click the "Add to
Model" button. Click OK.
Note: Methane is used to model
natural gas in order to minimize the run time. If you
need to model a real natural
gas mixture, then instead of
using the AFT Standard fluid
library, it would be better to
use the NIST REFPROP library or the optional Chempak
add-on.

B. Specify the Pipe Sectioning and Output panel
ØOpen the Pipe Sectioning and
Output panel. Set the Minimum Number of Sections Per Pipe to 8 sections
and the Estimated Maximum Pipe
Temperature During Transient to 140
deg. F.
Note: If following along in the completed model file, the Estimated Maximum Pipe
Temperature During Transient will have a different

Figure 5: Sectioning panel for Turbine
Fuel System

C. Specify the Simulation
Mode/Duration panel
ØOpen the Simulation Mode/Duration panel from the Transient Control group. Enter the Stop Time as 2
seconds. Verify the Time Simulation is
set to Transient. Click the OK button.

Step 4. Create scenarios to
model different sectioning
setups

A. Create scenarios
In this model, the following three types
of Sectioning cases for the system are
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to be evaluated:
1.

8 Sections Minimum per Pipe

2.

4 Sections Minimum per Pipe

3.

2 Sections Minimum per Pipe

To evaluate the three cases, we will
utilize the Scenario Manager to create
three scenarios for the three cases.
The Scenario Manager is a powerful
tool for managing variations of a
model, referred to as scenarios. The
Scenario Manager allows you to:
l

Create, name, and organize
scenarios

l

Select the scenario to appear in
the Workspace (the current
scenario)

l

Delete, copy, and rename scenarios

l

Duplicate scenarios and save
them as separate models

l

Review the source of a scenario's properties

l

Pass changes from a scenario
to its children

You will create three scenarios to
model these cases. Scenarios are created using the Scenario Manager from
the Tools menu or the Scenario Manager on the Quick Access Panel. The
Quick Access Panel, located on the
right side of the Workspace area, contains the Scenario Manager on the
Scenario tab. A scenario tree displays
all model scenarios.

Click the "Create Child" button on
the Scenario Manager on the Quick
Access Panel. Name the child "8 Sections Minimum Per Pipe". A new scenario will appear below the Base
Scenario in the scenario tree. Select
the Base Scenario, create another
child, and call it "4 Sections Minimum
Per Pipe". Finally, select the Base
Scenario again and create a third child
called "2 Sections Minimum Per Pipe"
(see Figure 6). Note that the new child
scenario is loaded when it is created
using the Scenario Manager on the
Quick Access Panel.
Open the Scenario Manager on the
Quick Access Panel. Create a child
scenario by either right-clicking on the
Base Scenario and then selecting
Create Child, or by first selecting the
Base Scenario on the Scenario Manager on the Quick Access Panel and
then selecting the Create Child icon
.Enter the name "8 Sections Minimum Per Pipe" in the Create Child
Scenario window, and select the
OK button. The new "8 Sections Minimum Per Pipe" scenario should now
appear in the Scenario Manager on
the Quick Access Panel below the
Base Scenario. Select the Base Scenario. Create another child and call it "4
Sections Minimum Per Pipe". Finally,
create one more child and call it "2
Sections Minimum Per Pipe". The
Child Scenarios should now be displayed as shown in Figure 6.
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does not need to be modified.
4 Sections Minimum Per Pipe
Double-click the "4 Sections Minimum
Per Pipe" scenario in the scenario tree
of the Scenario Manager on the Quick
Access Panel. This will load the "4
Sections Minimum Per Pipe" scenario
onto the Workspace as the current
scenario. The currently loaded scenario is indicated in the scenario tree
with a green circle with a checkmark
(Figure 6).
Since the "8 Sections Minimum Per
Pipe" scenario has the same setup as
the Base Scenario, we do not need to
modify it. Select the "4 Sections Minimum Per Pipe" scenario by doubleclicking the name in the Scenario Manager.

Figure 6: The Scenario Manager on the
Quick Access Panel displays the scenario
tree which allows you to create scenarios
and keep them organized within the same
model file

ØOpen the Analysis Setup window
from the Main Toolbar. Click on the
Pipe Sectioning and Output panel and
change the Minimum Number of Sections Per Pipe to 4 then click OK. The
required input for this scenario is now
complete.
2 Sections Minimum Per Pipe

B. Set up scenarios
Child scenarios "inherit" data from
their ancestor scenarios. As long as
the data has not been modified in a
child scenario, data parameters in the
child scenario will have the same
value as their parent. Since the Base
Scenario already has been setup with
8 Minimum Sections Per Pipe, the "8
Sections Minimum Per Pipe" child

Double-click the "2 Sections Minimum
Per Pipe" scenario from the scenario
tree in the Scenario Manager on the
Quick Access Panel. This will load the
"2 Sections Minimum Per Pipe" scenario onto the Workspace as the current scenario. This step can also be
accomplished by opening the Scenario Manager from the Tools menu,
selecting the "2 Sections Minimum Per
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Pipe" scenario and clicking the "Load
As Current Scenario" button.
Open the Analysis Setup window
from the Main Toolbar. Open the Pipe
Sectioning and Output panel and
change the Minimum Number of Sections Per Pipe to 2 then click OK. The
required input for this scenario is now
complete.
ØOpen the Child Scenario "2 Sections Minimum per Pipe". Open the
Analysis Setup window from the Main
Toolbar. Open the Pipe Sectioning
and Output panel and change the Minimum Number of Sections Per Pipe to
2 then click OK.

Step 5. Run the first scenario
ØDouble-click the "2 Sections Minimum Per Pipe" scenario in the
Scenario Manager. Select "Run
Model" on the toolbar. AFT xStream
will prompt you to save, then will open
the Solution Progress window. This
model is estimated to run in approximately one minute, but the run time is
dependent on the speed of your computer.

Step 6. Review the results
ØClick the Output button. This will
take you to the Output window, which
will display any warnings if they exist.
There should be a warning indicating

that the maximum transient pipe temperature was higher than the estimate
as well as a caution that the maximum
transient pipe mach number was significantly lower than the estimate (see
Figure 7). The Estimated Maximum
Pipe Temperature During Transient is
critical to the calculation of transient
conditions due to its necessity in the
Method of Characteristics. A review
on how the MOC handles sectioning
and tabulation can be found here.
The Estimated Maximum Pipe Temperature During Transient is used to
calculate the sonic velocity of the fluid,
which is then used to create the upper
boundary of the characteristic grid. If
the maximum temperature during the
transient exceeds the specified Estimated Maximum Pipe Temperature During Transient and the flow is sonic, the
Method of Characteristics may have to
extrapolate data, which can lead to
instability and will stop the transient
solver. In this model, sonic velocity
was not reached when the temperature was higher than the estimated maximum. However, to ensure
that this model can handle sonic flow,
we will re-run the model with a higher
Estimated Maximum Pipe Temperature During Transient.
The Maximum Transient Pipe Mach
Number error indicates that error
could be introduced through having a
Mach Number substantially lower than
the Maximum Transient Pipe Mach
Number used for the calculation (in
this case, the xStream default value of
one). This caution will be ignored in
this example for simplicity.
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Figure 7: The maximum transient pipe
temperature exceeds estimated maximum
temperature warning indicates that the
model is at risk of instability if changes
are made

number was significantly lower than
the estimate. Disregard this error as
discussed previously. Select the Transient Max/Min tab (Figure 8). Here we
can see that the maximum temperature in the inlet lines (P5, P8, &
P11) to the combustion baskets is
163.6 deg. F and occurs in the inlet
line to combustion basket 1.

Step 7. Adjust the Pipe Sectioning panel
ØDouble-click "Base Scenario" in
the Scenario Manager. Open the Analysis Setup window from the Main Toolbar and select the Pipe Sectioning and
Output panel. Change the Estimated
Maximum Pipe Temperature During
Transient to 180 deg. F. Click OK.

Figure 8: Transient Max/Min tab in the Output window

Note: It is essential that this change
is made in the Base Scenario
so all scenarios are updated.

Step 9. Graph the results
Step 8. Re-run the model
and review results

A. Review Output window
ØDouble-click the "8 Sections Minimum Per Pipe" scenario. Select
"Run Model" from the Analysis menu,
then proceed to the Output window.
There should be a caution indicating
that the maximum transient pipe mach

B. Graph the results
Go to the Graph Results window by
clicking on the Graph Results tab or
pressing Ctrl+G on the keyboard.
Create a graph that shows the temperature over time at the entrance to
Combustion Basket #1 using the following steps:
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1.

From the Graph Control tab on
the Quick Access Panel, select
the Transient Pipe tab as
shown in Figure 10

2.

Select Pipe P5 and add the outlet station

3.

Verify that the time units are set
to seconds

4.

In the Parameters definition
area, select "Temperature
Static" and specify "deg. F" in
the dropdown box under "Units"

5.

Click the Generate button

The results (see Figure 9Figure 11)
show a maximum temperature of
162.9 deg. F at the entrance to combustion basket #1. Note this temperature is lower than the temperature
shown on the Transient Max/min tab
because this graph is showing the outlet of pipe P5,while the maximum temperature in pipe P5 occurs at the inlet
of the pipe. The maximum temperature for the outlet of P5 occurs at
about 0.6 seconds before returning to
the previous steady state temperature
of 140 deg. F after the flow has normalized.

Figure 9: Inlet to combustion basket #1
Temperature Static vs Time

To easily recreate this graph in the
other scenarios or in the future, it can
be added into the Graph List Manager
on the Quick Access Panel. After generating the graph, click the "Add
Graph to List" icon
on the Graph
Results Toolbar (or simply right-click
the graph itself and choose "Add
Graph to List"). Give the graph a
name, such as "Combustion Basket
#1 Temperature vs Time", then click
OK. The graph will be added to the currently selected folder in the Graph List
Manager. Note that graphs added to
the Graph List Manager are not permanently saved until the model is
saved again. Also be aware that only
the graph templates are saved as
opposed to the graph data.
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Step 10. Animate the results

C. Animate the results
We will create a graph that models the
temperature, pressure, and velocity
along the flow path between the positive displacement compressor and
Combustion Basket #1. To do this:

Figure 10: Graph Parameters for Combustion Basket #1 Inlet Pipe

AFT xStream can animate output
along pipeline paths in your model in
the Graph Results window. This feature can help you understand how
your system will respond when a transient event occurs. You can also animate multiple graphs at the same time.
Here, you will animate the temperature static, pressure static, and
velocity along the flow path between
the positive displacement compressor
and Combustion Basket #1 in order to
gain an understanding of how these
hydraulic parameters respond as the
control valve closes. To animate these
parameters:
1.

Create a new graph tab by clicking the "New Tab" button

2.

Select the Profile tab under the
Graph Control tab in the Quick
Access Panel. Alternatively,
you can access the Select
Graph Parameters window by
clicking on the "Select Graph
Parameters" icon located at the
top left of the Graph Results
window.

3.

Select pipes 1, 2, 3, 4, and 5

Figure 11: Combustion Basket #1 Temperature vs Time Graph
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4.

Select the option to Animate
Using Output.

5.

Ensure that the animation time
used is seconds.

6.

Select Temperature Static as a
parameter.

7.

Add Pressure Static and Velocity Parameters to the Parameters Window.

8.

Click Generate.

9.

Add two additional parameters
in the Parameters definition
area. Specify the three parameters as "Temperature
Static", "Pressure Static", and
"Velocity"

10.

Verify the Length Units are feet

11.

Next to Animate Using, select
"Output", and verify "seconds"
is selected next to Animation
Time Units (see the following
paragraph for an explanation
about this option)

12.

Verify the temperature units are
"deg. F", the pressure units are
"psia", and velocity units are
"feet/sec"

13.

Check the Mx and Mn boxes
next to the graph parameters to
plot the maximum and minimum values on the graph (see
Figure 12)

To use the "Animate Using: Output"
option for animation, which is done
here, all pipe stations need to be
saved in the Pipe Sectioning and Output panel (this was already verified in
Step 5. If All is not selected, "Output"
will be grayed out).

Figure 12: Graph Parameters for combustion basket #1 profile

Click the Generate button. Additional
animation control features appear on
the Graph Results window (Figure
13). Press the Play button and watch
the temperature, pressure, and velocity responses move between the maximum and minimum values. This
animation can also be recorded to a
file. Click the "Add Graph to List" icon
and give it a name, such as "Combustion Basket #1 Profile".
Note: Figure 13 has had the axes
titles and scales modified to
increase clarity.
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not immediately seen by the combustion baskets downstream, however, as the gas velocity throughout
the system drops immediately following the valve closure. Instead, the
heightened temperature moves slowly
downstream until the gas wave is
reflected at the positive displacement
compressor and passes through the
heat exchanger going the opposite direction. This causes the local gas velocity to rise and causes the
temperature wave to move downstream towards the combustion baskets more quickly. This wave
eventually reaches combustion basket
#1 at T= 0.5 seconds, at which point
the inlet to the combustion basket
reaches its maximum temperature.

Figure 13: Flow to combustion basket #1
profile animation

To view the animated profile
follow this link:
https://bit.ly/3NbaokZ
You should generate a graph that
looks like the one shown in Figure 10.
Playing the animation reveals that the
highest temperature in the system is
observed at the J2 heat exchanger. It
should also be noted that the rise to
this maximum temperature occurs
when the pressure wave from the
valve closing passes through this junction. This heightened temperature is
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Click the "Add Graph to List" icon and
give it a name such as "Combustion
Basket #1 Profile". Click OK to add the
Graph to the Graph List.
Note:Figure 13 has had the axes
titles modified to increase
clarity.

Figure 15: Combustion Basket #1 Profile

Figure 14: Graph Parameters for Combustion Basket #1 Profile

Note: You can make similar graphs
for combustion basket #2. To
do so, change the pipe used
in the temperature vs time
graph to pipe 8, and change
the pipes in the animated profile graph to 1, 2, 3, 6, 7, and
8. This would generate similar graphs to the ones seen
in Figure 9 and Figure 13.
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Step 11. Run the other scenarios and graph the results
Using the Scenario Manager, load the
other two scenarios and run them.
Create the same graphs you created
for Steps 1011 and 12 for each of the
scenarios by double-clicking on the
graph names in the Graph List Manager. This will reveal that the general
behavior of the graph is the same for
all 3 scenarios, but that the maximum
temperature rises as the section count
is increased.

The difference between the three sectioning counts is summarized in Table
2. For these cases the maximum temperatures differ by 4.7 degrees.

Table 2: Summary of the maximum Static
Temperature for the three sectioning
counts

Scenario
8 Sections
4 Sections
2 Sections

Max Transient
Temperature (deg.
F)
173.2
170.2
168.5

The numerical maximum temperature
can be found in the Output window of
each scenario and is summarized in
Table 1. For these cases the maximum temperatures differ by 4.7
degrees.

Use of transient conditions within a
valve junction allowed us to model the
effects of an unexpected valve closure
in a system. While this example was
focused on temperature, it also
showed that values such as pressure
and velocity can be tracked by
AFT xStream.

Table 1: Summary of maximum Static
Temperature for the three cases

Additionally, this example identifies
the Estimated Maximum Temperature
During Transient as a critical variable
in the tabulation of the transient results. This value sets the boundary for
the characteristic grid the Method of
Characteristics uses. If sonic choking
occurs at a temperature higher than
the estimated maximum, the model
may not converge. As such, this value
should be conservatively high on early
runs of a model and then refined once
the temperature that the transient
approaches is known.

Case

Max Transient
Temperature
(deg F)

8 Sections

173.2

4 Sections

170.2

2 Sections

168.5

Conclusion
The overall maximum temperature
can be found in the General section of
the Output window of each scenario.
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High Pressure Steam Fluid Property Models
Example

High Pressure Steam Fluid Property Models
Example

This example assumes the user has
already worked through the Beginner:
Tank Blowdown example, or has a
level of knowledge consistent with that
topic.
This example assumes that the user
has some familiarity with AFT xStream
such as placing junctions, connecting
pipes, entering pipe and junction properties, and entering transient data.
Refer to the Tank Blowdown Example
in Chapter 2 for more information on
these topics.

Summary
Model file
This example evaluates two turbines
in a high pressure steam system that
are simultaneously valved off as a
bypass line valve is opened. The
focus will be the transient behavior in
the bypass line in response to simultaneous transient events. Whether
or not condensation occurs will also
be evaluated through the use of different Fluid Property Models.

The file listed below contains a completed version of this example and can
be located in the Examples folder as
part of the AFT xStream installation.
This file can also be downloaded from
the AFT xStream help site from the
High Pressure Steam - Fluid Property
Models Example page:
l

US - High Pressure Steam Fluid Property Models.xtr

Topics covered
l

Using the isometric grid to create a model

Problem statement

l

Creating systems with multiple
transients

l

Evaluating the selection of a
fluid property model

In this problem, the inlet valves to two
steam turbines in a high pressure
steam system are closed simultaneously while the bypass line is
valved open. Evaluate the maximum
pressure at the turbine inlet. Additionally, quantify the mass flow rate
through the bypass valve throughout
the transient. Lastly, perform an analysis on whether two-phase flow

Required knowledge
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occurs in the bypass line by conducting a sensitivity analysis on the
fluid property model utilized.

1.

From the Arrange menu, select
the option to Show Grid

2.

Open the Arrange menu again,
go to Pipe Drawing Mode, and
select Isometric

Step 1. Start AFT xStream

3.

Place the junctions as shown in
Figure 1

4.

Click the Pipe Drawing Tool
and draw the pipes in the
model as shown. When drawing segmented pipes such as
P5, a red dashed preview line
will show how the pipe will be
drawn on the isometric grid. As
you are drawing a pipe, you
can change the preview line by
clicking any arrow key on your
keyboard or scrolling the scroll
wheel on your mouse.

5.

Use the Rotate Icons buttons
on the Workspace Toolbar, or
right-click on the junction and
select the Auto-rotate option to
automatically align the junction
with the connected pipes.
Alternatively, Customize Icon
can be selected from the rightclick menu to manually choose
an icon/orientation.

6.

The grid can be shown or
turned off in the Arrange menu,
as shown in Figure 2

Open AFT xStream. Click "Start Building Model".
To ensure that your results are the
same as those presented in this documentation, this example should be
run using all default AFT xStream settings, unless you are specifically
instructed to do otherwise.

Step 2. Build the model

A. Place the pipes and junctions
The next step is to define the pipes
and junctions.
Isometric Drawing Mode
The previous example models were
drawn using the default Pipe Drawing
Mode, 2D Freeform. AFT xStream has
two additional available drawing
modes, 2D Orthogonal and Isometric.
In this model, the isometric mode is
used to visually interpret pipe layout
and provide a better understanding of
the system when analyzing calculated
forces.

Note: You can hold the "Alt" key
while adjusting a pipe by the
endpoint to add an additional
segment. This can be used
with the arrow key or mouse
scroll wheel to change
between different preview
line options.
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B. Enter the pipe and junction data
The system is in place but now the
input data for the pipes and junctions
needs to be entered. Double-click
each pipe or junction and enter the following data in the Pipe or Junction
Properties window.
All pipe materials are User Specified
in this model (see Figure 3). Use the
Absolute Roughness of Steel (0.0018
in) as the Friction Model, along with
the following data:
Figure 1: The isometric layout with the
grid shown

Figure 2: The isometric layout with the
grid turned off

Note: The pipes below are user
defined as they utilize nonstandard pipe sizes.

Pipe #

Inner Diameter
(inches)

Length
(feet)

1

13.25

100

2

12

60

3

12

45

4

12

15

5

12

15

6

6

6

7

4

6

8

6

10

9

6

5

10

6

20
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Pipe #

Inner Diameter
(inches)

Length
(feet)

11

19.25

20

12

19.25

5

Pipe #
1
2
3
4
5
6
7
8
9
10
11
12

Inner Diameter
(inches)
13.25
12
12
12
12
6
4
6
6
6
19.25
19.25

Length
(feet)
100
60
45
15
15
6
6
10
5
20
20
5

Figure 3: User Specified Pipe Properties
window

J1 - Assigned Pressure
1.

Name = High Pressure Steam
Inlet

2.

Elevation = 0 feet

3.

Static Pressure = 2425 psia

4.

Static Temperature = 1060
deg. F

J2 - Area Change
1.

Elevation = 0 feet

2.

Type = "Conical Transition"

3.

Angle (µ) = 45 Degrees

J3, J4, and J7 - Branch
Elevation = 0 feet
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J5 and J6 - Assigned Flow

1.

Elevation = 5 feet

2.

Cv = 3000

1.

J5 Name = Turbine 1

3.

Xt = 0.7

2.

J6 Name = Turbine 2

4.

3.

Elevation = 0 feet

4.

Mass Flow Rate = 504000
lbm/hr

On the Optional tab, under Special Condition, select the radio
button for Closed.

5.

5.

Static Temperature =1060 deg.
F

On the Transient tab, enter the
following data

6.

On the Transient tab of both J5
and J6, enter the following
data:

Time
(seconds)
0
0.25
5

Mass
Flow
(
lbm/hr)
504000
0
0

Static
Temperature
(deg. F)
1060
1060
1060

Time
(seconds)
0
2
5

Cv

Xt

0
3000
3000

0.7
0.7
0.7

J13 - Assigned Pressure
1.

Name = Steam Bypass Outlet

2.

Elevation = 0 feet

3.

Static Pressure = 435 psia

4.

Static Temperature = 660 deg.
F

1.

Assigned Pressure J1

J8 - Dead End
Elevation = 0 feet
J9 - Bend
Elevation = 0 feet
Type = Standard Elbow (knee,
threaded)
J10 and J12 - Bend

2.

a.

Name = High Pressure
Steam Inlet

b.

Elevation = 0 feet

c.

Static Pressure = 2425
psia

d.

Temperature = 1060
deg. F

Area Change J2
a.

Type = Conical Transition

b.

Angle = 45 degrees

Elevation = 5 feet
Type = Standard Elbow (knee,
threaded)

3.

J11 - Valve

4.

Branch J3,J4,J7
a.

Elevation = 0 feet

Assigned Flowrate J5,J6
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a.

J5 Name = Turbine 1

b.

J6 Name = Turbine 2

c.

Elevation = 0 feet

d.

Mass Flowrate = 504000
lbm/hr
Note: Ensure that
you change the
unit in the Mass
Flowrate from
lbm/s to lbm/hr,
as lbm/hr is not
the default unit.

e.
5.

Dead End J8
a.

6.

7.

8.

Temperature =1060
deg. F
Elevation = 0 feet

9.

Time
(seconds)

Cv

Xt

0

0

0.7

2

3000

0.7

5

3000

0.7

Assigned Pressure J13
a.

Name = Steam Bypass
Outlet

b.

Elevation = 0 feet

c.

Static Pressure = 435
psia

d.

Static Temperature =
660 deg. F

Bend J9
a.

Elevation = 0 feet

b.

Type = Standard Elbow
(knee, threaded)

Bend J10, J12
a.

Elevation = 5 feet

b.

Type = Standard Elbow
(knee, threaded)

Valve J11

C. Check if the pipes and
junctions are specified
ØClick the List Undefined Objects
button to see if the model is fully
defined. If it is not, the undefined pipes
and junctions window will show a list
of incomplete items. If undefined
objects are present, go back to the
incomplete pipes or junctions and
enter the missing data.

a.

Cv = 3000

b.

Xt = 0.7

c.

Elevation = 5 feet

d.

In the optional tab, set
the special condition to
closed

Step 3. Specify Analysis
Setup

Click on the Transient
Tab and enter the following data

A. Specify Fluid panel

e.

ØOpen the Analysis Setup window
from the Main Toolbar and open the

Index 578
Fluid panel. Under the "AFT Standard"
fluid option, choose "Steam" from the
list and click the "Add to Model" button. Click OK.

B. Specify the Pipe Sectioning and Output panel
ØOpen the Pipe Sectioning and
Output panel. Specify the Minimum
Number of Sections Per Pipe as 1 and
the Estimated Maximum Pipe Temperature During Transient to 1100
deg. F.

ØOpen the Simulation Mode/Duration panel from the Transient Control group from the Analysis Setup
window. Enter the Stop Time as 5
seconds. Click the OK button.

Step 4. Run the model
ØSelect "Run Model" from the Main
Toolbar. The model has an estimated
run time of 5 minutes, but the run time
is dependent on the speed of your PC.

Step 5. Graph the results

A. Graph the transient pressures at the turbines
ØGo to the Graph Results window.
The first graph we make will show the
Static Pressure at the entrance to the
steam turbines.

Figure 4: Sectioning panel for High Pressure Steam System

C. Specify the Simulation
Mode/Duration panel

1.

From the Graph Control tab on
the Quick Access Panel, select
the Transient Pipe tab

2.

Select the pipe P5 outlet station

3.

Ensure that time units are set to
seconds

4.

In the Parameters definition
area, select "Pressure Static"
and specify "psia" in the dropdown box under Units

5.

Click Generate

This will generate the graph shown in
Figure 6. The pressure variation is difficult to see using the default y-axis
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scale so we will adjust the scale using
the following steps:
1.

Right-click the y-axis

2.

Uncheck the Auto Scale box

3.

Set the Minimum to 2200 psia,
the Maximum to 2600 psia, and
Major Val to 100 (see Figure 7)

The graph should now match Figure 8.
When the model contains multiple transient events, transient pipe graphs
allow the user to see the cumulative
impact of the events on system pressure. Note that the first peak contains
an oscillation, which is attributable to
the opening of the bypass valve.

Figure 6: Static pressure at steam turbine
2 entrance

Figure 7: Axis Modification Window
opened by right-clicking the y-axis
Figure 5: Graph Parameters for Inlet Pressure to Turbines
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Figure 8: Static pressure at steam turbine
2 entrance with modified y-axis

B. Create a profile of the
bypass line temperature and
pressure
We also will animate the profile of the
bypass line temperature and pressure
in order to determine whether condensation occurs.
1.

Click the "New Tab" button to
create a new graph.

2.

From the Graph Control tab on
the Quick Access Panel, select
the Profile tab (Figure 9)

3.

Select pipes 6, 8, 9, and 10

4.

Verify the Length unit is set to
feet

5.

Next to Animate Using, verify
"Output" is selected, and verify
"seconds" are the selected
Animation Time Units

6.

Add a second parameter in the
parameters definition area,
then specify one parameter to
be "Pressure Static" and the
other to be "Temperature
Static"

7.

Change the Pressure Static
units to "psig" and the Temperature Static units to "deg. F"

8.

Click the Generate button

9.

Click the Play button to review
the graph

Note: If you wish to adjust the
speed of the transient in the
profile, you can use the
Speed Slider in the upper
right-hand corner of the
Graph Results window to
speed up or slow down the
animation.
Figure 10 is useful to determine
whether or not condensation occurs in
the system, as well as understanding
the cause of condensation. Condensation can occur by a rise in pressure, a
decrease in temperature, or a combination of both. Saturation line data
was added for AFT Standard fluids in
AFT xStream 2. In this model the temperatures stay well above the saturation line at all times, showing that
the steam is not close to condensing.
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It should be noted that the saturation
data is limited to predicting the presence of saturation conditions as
opposed to modeling the behavior of
the multi-phase mixture.

Figure 9: Graph Parameters for bypass
line profile

Figure 10: Bypass line animation profile
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To view the animated profile, follow this link: https://bit.ly/38Xiz5F

C. Graph the mass flow rate
and pressure drop through
the bypass valve

graphs when multiple transient events
occur in order to fully understand the
interactions between them.
Note: Figure 12 has modified axes
titles and its legend removed
for clarity.

Lastly, we shall create a graph to
show the mass flow rate and the pressure drop through the bypass valve to
gain insight into how the flow develops
in the bypass line.
1.

Click the "New Tab"button to
add a new graph tab

2.

From the Graph Control tab on
the Quick Access Panel, select
the Transient Jct tab

3.

In the Select Junctions section,
select J11 and click the ">"
arrow

4.

Add a second parameter in the
Select Parameters section.
Specify the parameters as
"Mass Flow Rate Inlet" and
"Pressure Drop Stagnation
Total".

5.

Set the units for Mass Flow
Rate Inlet to "lbm/hr" and Pressure Drop Stagnation Total to
"psid"

6.

Click Generate

As shown in Figure 12, the flow rate
increases and the pressure drop
decreases as the valve opens over
time. While the observed trends for
mass flow rate and pressure drop are
typical for a valve that is opening, it is
still worthwhile to make Transient Jct

Figure 11: Bypass valve mass flow and
pressure drop Parameters
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libraries. Similar results to the
AFT Standard Fluid run were obtained
for both the bypass valve and the turbine pressure vs time graph, so these
results are not shown below. Nevertheless, it is sensible to run your system using different fluid property
models as they have been known to
impact results. The temperature profile for the bypass line showed more
significant differences, as is shown
below comparing the results using
NIST REFPROP to the AFT Standard
fluid library. ASME Steam and
Chempak gave nearly identical results
to NIST, and therefore are not shown.

Figure 12: Bypass valve mass flow rate
and pressure drop transient

Note that the minimum temperature
reached at J11 is 56 degrees Fahrenheit higher in the AFT Standard fluid
library run compared to the
NIST REFPROP run.
Note: The axes of the below graphs
were modified for clarity.

Step 6. Results of Other
Libraries and Discussion

Step 7. Evaluate the effects
of changing fluid property
models

A. Review the results of
other libraries
In addition to the AFT Standard fluid
library, the model built in this example
was run using the Chempak,
NIST REFPROP, and ASME Steam

Index 584
before having to commit to Transient
runs, which are more time consuming.
This also can inform the types of variables that need to be considered during refined runs (i.e. if the AFT
Arrow™ steady state runs are close to
the saturation temperature, condensation is a phenomenon that
should be monitored in subsequent
runs).
Step 2: Complete a transient run
using an AFT Standard fluid with
minimal sectioning

Figure 13: Bypass line profile obtained
using NIST REFPROP

B. Advice for preliminary
runs
Obtaining final results from AFT
xStream will require multiple iterations. To effectively work through
those iterations, we recommend the
iterative process begins with the following steps:
Step 1: Run the steady-state model
It is recommended that the first runs
are completed using a simplified version of your model in the AFT Arrow™
Steady-State Solver with each fluid
property model before considering
transient conditions. This will allow for
larger issues in the model to be caught

You should then run your simplified
model in the Transient Solver using an
AFT Standard fluid with minimal sectioning. This is not always possible,
such as when mixtures are present,
but this step should always be attempted if allowable. This will allow for larger issues to be caught before
committing to extended run times.
Only after you are satisfied with the
model should you attempt increasing
the number of sections.

C. Selection of fluid property
model for final runs
A number of factors must be taken into
consideration while selecting the fluid
property model for an AFT xStream
model. If there are no mixtures, and
the compound is present in the
AFT Standard library, it is recommended that the AFT Standard library
be the first library used. AFT Standard
has the shortest run times of the four
libraries and is an excellent choice for
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early runs focused on troubleshooting
the model. However, if there is a need
to model mixtures, and simplifying the
system is not possible, initial runs
should be conducted with
NIST REFPROP or Chempak.
NIST REFPROP and Chempak both
have greater accuracy than
AFT Standard and can represent mixtures. However, both have slower run
times than AFT Standard. Chempak
runs faster than NIST REFPROP with
comparable accuracy. However,
Chempak is an optional add-on while
the NIST REFPROP library comes
standard with AFT xStream.
Lastly, ASME Steam provides a wellestablished, trustworthy source of
steam data. ASME Steam has the
longest run times of the four, and it is
recommended that a high processing
power computer paired with ample
time be used to run your analysis if
this library is selected. If either of
those elements is unavailable, it is
recommended that one of the three
other libraries be used, with the added
note that NIST REFPROP is the most
similar in accuracy to ASME steam.
Table 1 summarizes this example's
run time with the four different fluid
property models. The run times will be
affected by the specifications of your
computer as well as the memory available.
Table 1 shows data for runs conducted on the computers at AFT as of
publication. Additionally, Table 2
provides a library compatibility chart to
assist with fluid property model selection.

It should be noted that if a tremendous
amount of accuracy is needed, appropriate library selection will not be sufficient to give a high accuracy model.
The single parameter that will have
the greatest effect on accuracy is the
Minimum Number of Sections per
Pipe in the Sectioning panel.
Ultimately, appropriate sectioning
remains the single most important
factor in creating a high accuracy
model and should be weighed just as
heavily as the fluid library when setting
the parameters your transient gas system uses.
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Table 1: Comparison of High Pressure
Steam System run times

High Pressure Steam System Run
Times
Fluid Property
Run Time
Model
AFT Standard - 1
1 - 2 minutes
Section
Chempak - 1 Sec8 - 10
tion
minutes
NIST REFPROP 0.9 - 1.4
1 Section
hours
AFT Standard - 10
1.6 - 2 hours
Sections
ASME Steam - 1
3.9 - 4 hours
Section
High Pressure Steam System Run Times

Fluid
Library
AFT
Standard
NIST
REFPROP
Chempak
ASME
Steam

Model Requirements
User
ComSpeMixplex
cified
tures
SysFlutems*
ids
P

P

P

P

P

P

Model Requirements

Fluid Property Model

Run Time

AFT Standard
- 1 Section

1 - 2 minutes

Chempak - 1
Section

8 - 10 minutes

NIST
REFPROP - 1
Section

0.9 - 1.4 hours

AFT Standard
- 10 Sections

1.6 - 2 hours

ASME Steam
- 1 Section

Table 2: Compatibility chart for fluid property model selection for final runs

Fluid
Library

Mixtures

AFT
Standard

Complex
Systems*

User
Specified
Fluids

P

P

NIST
REFPROP

P

P

Chempak

P

P

3.9 - 4 hours
ASME
Steam
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* Evaluating the complexity of a system is most easily done in early runs
of the model. It is suggested that all
early runs should be run with a version
of AFT Standard if they can, and the
run time recorded. This run time
should inform your decision on which
fluid library is needed to run the more
thorough runs when high accuracy results are needed. As seen from Table
1, the run times can vary wildly
between the 4 libraries, so make sure
you evaluate your time constraints
and accuracy needs when weighing
this decision. Factors that can impact
the run time include the ratio in the
length of the smallest pipe to the
largest pipe, presence of mixtures,
usage of Junctions containing resistance curves, and the presence of
sonic choking. See the Reducing Run
Time section for more information.

Conclusions
The mass flow rate through the
bypass line was modeled and the
cumulative effect of multiple transient
events was observed.
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High Pressure Steam Forces Example

High Pressure Steam Forces Example
Summary
Two turbines in a high pressure steam
system are simultaneously valved off,
which causes the system to experience transient forces. This example
describes how to determine the imbalanced transient force data for the piping system during the steam flow
transient. It also evaluates the effect of
varying the time to close the valves on
force magnitude. Lastly, this example
shows how to export the force results
to a force file to use in piping stress
software.

Topics covered
l

Calculating the forces associated with a transient event

l

Using the Scenario Comparison Tool to compare scenarios

l

Exporting force sets to
CAESAR II®

Required knowledge

This example assumes the user has
already worked through the Beginner:
Tank Blowdown example, or has a
level of knowledge consistent with that
topic.
This example assumes that the user
has some familiarity with AFT xStream
such as placing junctions, connecting
pipes, entering pipe and junction properties, and entering transient data.
Refer to the Tank Blowdown Example
in Chapter 2 for more information on
these topics.

Model file
This example uses the following file,
which is installed in the Examples
folder as part of the AFT xStream
installation. This file can also be downloaded from the High Pressure Steam
- Forces Example topic on the Product
Help Site:
l

US - High Pressure Steam Forces Quick Start.xtr

Problem statement
The inlet valves to two steam turbines
are shut simultaneously in a high pressure steam system. As the design
engineer, you are tasked with completing a piping stress analysis and
need to capture the magnitude of the
forces caused by the aforementioned
steam transient. Additionally, determine how the valve closure time impacts
the forces. Lastly, export the force
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data to CAESAR II® to check for compliance with standards.

4.

Click the pipe tool and draw the
pipes in the model as shown

5.

Use the Rotate Icons button, or
right click on the junction and
select Auto-rotate Icon to align
the junction with the connected
pipes. Alternatively, the Customize Icon option can be selected from the right-click menu to
manually choose an icon/orientation.

6.

The grid can be shown or
turned off in the Arrange menu,
as shown in Figure 2

Step 1. Start AFT xStream
Open AFT xStream. Click the Start
Building Model button.

Step 2. Open model file
For this example, we will be starting
from a pre-built model file for which
setup been partially completed to save
time. From either the Startup window
or the File menu, browse to the model
file name shown above. The Workspace should appear as shown in Figure 2.

Note: You can hold the "Alt" key
while adjusting a pipe by the
endpoint to add an additional
segment . This can be used
with the arrow key or mouse
scroll wheel to change
between different preview
line options.

Step 3. Build the model

A. Place the pipes and junctions
This example will be created in the isometric view in order to get a greater
feel for the pipe layout.
1.

From the Arrange menu, select
the option to Show Grid

2.

Open the Arrange menu again
and select the Isometric option
under Pipe Drawing Mode

3.

Place the junctions as shown in
Figure 1

Figure 1: Model layout with grid
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Pipe

Internal Diameter
(inches)

Length
(feet)

3

10.6

13

4

10.6

13

5

10.6

33

6

10.6

43

7

10.6

6.5

8

10.6

5

9

8.1

20

10

10.6

5

11

8.1

20

12

6.5

50

13

6.5

10

14

6.5

10

Figure 2: Model layout without Grid

B. Enter the pipe data
The system is in place, but now the
input data for the pipes and junctions
needs to be entered. Double-click
each pipe or junction and enter the following data in the Pipe or Junction
Properties windows.

C. Enter the junction data
1.

All pipes in the model are User Specified and utilize a User Specified Friction Model with an Absolute
Roughness of 0.002 in.
Internal Diameter
(inches)

Length
(feet)

1

13.2

13

2

13.2

40

Pipe

2.

3.

Assigned Pressure J1
a.

Name = High Pressure
Steam Inlet

b.

Elevation = 0 feet

c.

Static Pressure = 2420
psia

d.

Static Temperature =
1060 deg.F

Bend J2, J4
a.

Elevation = 0 feet

b.

Type = Standard Elbow
(knee, threaded)

Area Change J3
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a.

Elevation = 0 feet

b.

Type = "Conical Transition"

c.

Angle = 45 degrees

Bend J5, J7, J13
a.

Elevation = 13 feet

b.

Type = Standard Elbow
(knee, threaded)

Branch J6
a.

6.
7.

8.

Elevation = 13 feet

Branch J8
a.

Mass
FloStatic
w
Time
TemRa(secoperte (
nds)
ature
lb(deg. F)
m
/sec)

Elevation = 6.5 feet

0

140

1060

0.1

0

1060

1

0

1060

Bend J9, J11
a.

Elevation = 6.5 feet

b.

Type = Standard Elbow
(knee, threaded)

Assigned Flow J10, J12
a.

J10 Name = Turbine #1

b.

J12 Name = Turbine #2

c.

Elevation = 6.5 feet

d.

Mass Flow Rate = 140
lbm/sec (to each turbine)

e.

Temperature = 1060
deg. F

f.

On the Transient tab
enter the following data
for both Assigned Flow
junctions:

Figure 3: Transient data for Assigned
Flow junctions J10 and J12
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9.

10.

Bend J14
a.

Elevation = 23 feet

b.

Type = Standard Elbow
(knee, threaded)

the Estimated Maximum Pipe Temperature During Transient as 1100
degrees F.

Dead End J15
a.

Name = Bypass Valve

b.

Elevation = 23 feet

D. Check if the pipes and
junctions are specified
ØClick the List Undefined Objects
button to see if the model is fully
defined. If it is not, the undefined pipes
and junctions window will show a list
of incomplete items. If undefined
objects are present, go back to the
incomplete pipes or junctions and
enter the missing data.

Figure 4: Sectioning panel for high pressure steam system in the Analysis Setup
window

Step 4. Specify Fluid
ØSelect Fluid from the Analysis
menu to open the Fluid panel in the
Analysis Setup window. For this
example, select the AFT Standard
fluid option, then choose "Steam" from
the list and click the "Add to Model"
button.

Step 5. Specify the Pipe Sectioning and Output panel
ØOpen the Pipe Sectioning and
Output panel in the Analysis Setup
window. Define the Minimum Number
of Sections Per Pipe as 1 section and

Step 6. Specify the Simulation Mode/Duration panel
ØOpen the Simulation Mode/Duration panel from the Transient Control group. Enter the Stop Time as 1
second. Click OK to close the Analysis
Setup window.

Step 7. Specify Force Sets
We will first add one Force Set from
the Workspace.
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ØOn the Workspace, right-click on
pipe P2 and from the right-click menu
select "Create a Force Set with Selected Pipe." Select the Use Pipe Information radio button and uncheck the
"Include Appended Text" option (Figure 5). Click Create. This will open the
Force Definitions panel of the Analysis
Setup window. The Force Definitions
panel should appear as shown in Figure 6.
AFT xStream can only determine axial
forces down a pipe in the direction
defined as forward by the force set
definition. As such, AFT xStream has
no knowledge of the three-dimensional orientation of a given force set.
For example, a vertical pipe and a horizontal pipe that both have the same
force magnitude would be indistinguishable in AFT xStream. The
force set definition informs the sign of
the force, with a positive value indicating a force pushing from the start location to the end location, and a
negative value indicating the converse.
If a more robust view of the 3D orientation of the pipes is required, directional information can be entered
using the optional Force Unit Vector
columns. The Force Unit Vectors do
not impact AFT xStream's calculations, but may be useful to export
the output to piping stress analysis
software as discussed in Step 13
Note: Only single pipes can be
added as a "Difference" force
set type from the Workspace.
Also note that difference

forces should strictly be used
between two 90 degree angle
pipe fittings.

Figure 5: Adding force set from Workspace using the right-click menu
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Figure 6: High Pressure Steam System
Force input in the Analysis Setup window
Figure 7: Completed Forces panel in the
Analysis Setup window

The remaining force sets will be
defined inside the Force Definitions
panel.
ØDefine a force set by clicking
"New", selecting the Force Type (in
this example, we will be using "Difference"), entering a name, and defining the starting and ending locations of
the force set. Set up the force sets as
shown in Figure 7. Click OK to exit the
Analysis Setup window.

Step 8. Add child scenarios
using Scenario Manager

A. Create scenarios
In this model, we will evaluate three different valve closure durations for the
system:
1.

0.1 Second Valve Closure

2.

0.25 Second Valve Closure

3.

0.5 Second Valve Closure

We will create three child scenarios to
model the three cases.
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ØGo to the Scenario Manager on
the Quick Access Panel. Create a
child scenario by either right-clicking
on the Base Scenario and then selecting Create Child, or by first selecting
the Base Scenario on the Scenario
Manager on the Quick Access Panel
and then selecting the Create Child
icon
. Enter the name "0.1
Second Valve Closure" in the Create
Child Scenario window, and click OK.
The new "0.1 Second Valve Closure"
scenario should now appear in the
Scenario Manager on the Quick
Access Panel below the Base Scenario.

definitions as the base scenario, we
do not need to modify it. We will set up
the remaining scenarios using the following steps:
1.

Open the "0.25 Second Valve
Closure" scenario by doubleclicking the name in the Scenario Manager

2.

Open the Assigned Flow Properties window for Assigned
Flow J10 and open the Transient tab. Enter the following
data:

Time
(seconds)

ØRight-click the Base Scenario in
the Quick Access Panel. Create
another child and call it "0.25 Second
Valve Closure". Finally, create one
more child and call it "0.5 Second
Valve Closure". The child scenarios
should now be displayed as shown in
Figure 8.

0
0.25
1

Mass
Flow
(
lbm
/sec)
140
0
0

Mass
Time
Flow
(second(
s)
lbm
/sec)
Figure 8: Completed Scenario Manager
for High Pressure Steam - Forces

B. Define the child scenarios
Since the "0.1 Second Valve Closure"
scenario uses the same transient

3.

Static
Temperature
(deg. F)
1060
1060
1060

Static
Temperature
(deg. F)

0

140

1060

0.25

0

1060

1

0

1060

Enter the same Transient Data
for Assigned Flow J12
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4.

Open the Child Scenario "0.5
Second Valve Closure" from
the Scenario Manager

5.

Open the Assigned Flow Properties window for Assigned
Flow J10 and open the Transient tab. Enter the following
data:

Time
(seconds)

0
0.5
1

Mass
Flow
(
lbm
/sec)
140
0
0

Mass
Time
Flow
(second(
s)
lbm
/sec)

6.

Static
Temperature
(deg. F)
1060
1060
1060

Static
Temperature
(deg. F)

0

140

1060

0.5

0

1060

1

0

1060

Enter the same Transient Data
for Assigned Flow J12

Step 9. Compare child scenarios using the Scenario
Comparison Tool

The three scenarios created should be
identical except for the different transient data. To confirm the scenarios
are otherwise identical, we will use the
Scenario Comparison Tool.
1.

Load the "0.1 Second Valve
Closure" scenario from the
Scenario Manager

2.

In the Tools menu, select the
Scenario Comparison Tool

3.

In the Scenario Comparison Selection window (Figure 9),
select "Siblings"

4.

Click "Show Comparison"

5.

In the Scenario Comparison
Grid, set the "Item" and "Parameter" sliders to show "Differences". Also set the
"Highlight Unique Values"
slider to "Yes".

The Scenario Comparison Tool will
run a comparison of all Pipe and Junction Properties as well as the General
Properties used in each scenario and
highlight any differences in the Scenario Comparison Grid. In this model,
the only highlighted differences should
be for the "First Transient Data" parameter for junctions J10 and J12 (Figure 10). Note that each column in the
Scenario Comparison Grid is highlighted in a different color. This indicates that each scenario possesses a
unique value for the given parameters.
Click close to exit the Scenario Comparison Tool.
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the Scenario Manager. Ensure that
all force sets are set to be applied in
the Force Definitions panel of the Analysis Setup window as shown in Figure
7. Select "Run Model" from the Analysis menu. This will open the Solution
Progress window. This model has an
estimated run time of 1 minute, but the
run time is dependent on the speed of
your computer.

Step 11. View the results
Figure 9: Scenario Comparison Tool Selection window

A. Open the Forces tab
ØIn the Output window, click on
the Forces tab. This will show the
maximum force observed in the
defined force sets, as well as provide
information about how the force segments were defined.

Figure 10: Scenario Comparison Grid of
the 3 scenarios

Step 10. Run the first scenario
ØDouble-click the "0.1 Second
Valve Closure" child scenario in

Figure 11: Forces tab in the Output window for the "0.1 Second Valve Closure"
scenario

B. Graph the force results
ØOpen the Graph Results window.
We will create a graph that shows the
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transient forces over time for the force
sets. To do so, perform the following
steps:
1.

Select the Forces tab on the
Graph Control tab on the Quick
Access Panel, as shown in Figure 12.

2.

Select "All" force sets to be
graphed.

3.

Verify the Force Units Primary
Y is set to "lbf."

4.

Verify that Time Units is set to
"seconds."

5.

Verify that the Time Frame is
set to "All times."

6.

Click Generate.

This should generate the graph shown
in Figure 13.
Add the graph to the Graph List Manager by right-clicking the graph results
window and selecting "Add Graph To
List...". Name the graph "Force Sets"
and click OK.

Figure 12: Graph parameters for force
sets

Figure 13: Graph for forces of the "0.1
Second Valve Closure" scenario

Note that at t = 0 seconds, there are
no force imbalances for any of the
force sets. This is expected since the
sum of forces across a piping run
between two elbows equals zero in a
steady state system. If a Point or Exit
type force set were used instead of a
Difference type force set, then a nonzero force may be encountered during
the steady state.
Additionally, some traditional methods
of analyzing force sets will not yield
the same results as AFT xStream
since they may not include friction or
momentum effects in their force balances. Traditional methods can yield
significantly different results and indicate incorrect, non-zero forces during
steady state conditions.
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There are two important points to be
observed here:
1.

AFT xStream calculates transient fluid forces. This does not
include piping, component, or
fluid weight, or any other forces
external to the piping. A comprehensive analysis of pipe
loading must separately
include these items.

2.

Ignoring friction and
momentum force balance components will result in force
imbalances that do not exist.

Step 12. Run the other child
scenarios
ØRun the other two child scenarios
and load the Forces tab and the
"Force Sets" graph list item for each.
The results are seen below in Figures
5.11-1414-17.

Figure 15: Graph for forces of the "0.25
Second Valve Closure" scenario

Figure 16: Forces tab in the Output window for the "0.5 Second Valve Closure"
scenario
Figure 14: Forces tab in the Output window for "0.25 Second Valve Closure"
scenario
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was not significant in the system built
within this example. However, the results for altering each of these three
parameters are shown in Figures
5.15-1718-20 so that you may see the
impact of changing these three parameters. Note that in Figure 19,
ASME Steam, Chempak, and NIST
REFPROP are superimposed on each
other, indicating no meaningful difference for this case.
If you wish to learn more about the
effect of altering these 3 factors with
regards to force, the click here to go to
the Transient Sensitivity Analysis
Tutorial.

Figure 17: Graph for forces of the "0.5
Second Valve Closure" scenario

These figures show that the maximum
force magnitude increases as the
valve closes faster. Typically, the
more rapidly a change occurs, the
more severe the resulting forces are.
Therefore, a utility of AFT xStream
would be to evaluate the correlation
between transient event duration
(e.g., valve closing time) and the resultant force magnitudes.
Factors affecting the timing and
magnitude of forces
Pipe sectioning, the selection of fluid
property model, and specification of
Maximum Pipe Mach Number During
Transient can have a significant effect
on the accuracy of the forces calculated by AFT xStream. This effect
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Figure 18: Effect of sectioning on High
Pressure Steam - Forces model. All runs
use the AFT Standard fluid library and a
Maximum Pipe Mach Number During Transient of 1.

Figure 19: Effect of fluid property model
on High Pressure Steam - Forces model.
All runs use a Minimum Number of Sections Per Pipe of 1 and an Estimated Maximum Pipe Mach Number During
Transient of 1.
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Figure 21: Export CAESAR II® Force File
window

Figure 20: Effect of Maximum Pipe Mach
Number During Transient on High Pressure Steam - Forces model. All runs use
the AFT Standard fluid library.

Step 13. Export
CAESAR II Force file
ØOpen the Output window, and
click on the File menu. Select
"Export Force File..." and choose
"CAESAR II® Force File." This will
open the export file window shown in
Figure 21.

The force sets to include in the force
file may be individually selected, along
with how frequently data points are
saved. The number of data points that
will be in the file is also displayed for
the given setting. This number should
not exceed the maximum number of
data points allowed for the relevant piping stress software, which in the case
of CAESAR II® is 2500.
If unit vector information has been
entered in the Force Definitions panel,
the Export Unit Vector option can be
used to include this information in the
exported file. Similar methods to those
described above can be used to
export force files to ROHR2®,
TRIFLEX®, and AutoPIPE®.

603

Quick Start Guide

Conclusion
We created a force model to calculate
the forces experienced as a result of
two simultaneous closures in a steam
header. We also identified how the
length of the transient can have a significant impact on the forces a system
experiences. Finally, we discussed
how to export these forces into a force
file to be used in pipe stress analysis
software.
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Frequency Analysis PFA Example

AFT xStream Add-on
Module - PFA Example

This example assumes that the user
has some familiarity with AFT xStream
such as placing junctions, connecting
pipes, entering pipe and junction properties, and entering transient data.
Refer to the Tank Blowdown Example
in Chapter 2 for more information on
these topics.

Model file
Summary
A frequency analysis is performed on
a system with a positive displacement
compressor to determine the acoustical frequencies that need to be evaluated for the existing piping
configuration.

The file listed below contains a completed version of this example and can
be located in the Examples folder as
part of the AFT xStream installation.
This file can also be downloaded from
the AFT xStream help site from the
Frequency Analysis - PFA Example
page:
l

Topics covered
l

Using the PFA module to
identify natural acoustic frequencies

l

Defining valid sectioning and
simulation duration settings for
pulsation analysis

l

Checking API-618 compliance

Required knowledge
This example assumes the user has
already worked through the Beginner:
Tank Blowdown example, or has a
level of knowledge consistent with that
topic.

US - Frequency Analysis
PFA.xtr

Problem statement
A system's positive displacement compressor has known pulsation issues in
a section of piping with a closed valve.
This issue is caused by the system's
natural frequency resonating with certain PD compressor frequencies, resulting in severe pressure oscillations
at the closed valve. A forcing function
will be placed on the PD compressor
to determine the natural acoustic frequencies, which will then be used to
find the worst-case frequencies for the
system.
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Step 1. Start AFT xStream
Open AFT xStream. Click the Start
Building Model button.
From the Startup window under the
"Activate Modules" section in the center panel, select the PFA (Pulsation
Frequency Analysis) option to activate
the PFA module. If AFT xStream is
already running, choose Activate Modules from the Tools menu, then check
the box next to PFA to activate the
module on the Modules panel.

Step 2. Build the model

Figure 1: Layout of frequency analysis
model

A. Place the pipes and junctions

B. Enter the pipe and junction data

The next step is to define the pipes
and junctions. In the Workspace window, assemble the model as shown in
Figure 1.

The system is in place but now we
need to enter the input data for the
pipes and junctions. Enter the following data:
All Pipes are Steel - ANSI, STD
(schedule 40), and have standard
roughness. The rest of the pipe information is as follows:

Pipe #
1
2
3
4
5

Length
(feet)
25
25
25
250
10

Size
(inches)
10
10
10
16
6
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Pipe #

Length
(feet)

Size
(inches)

1

25

10

2

25

10

3

25

10

4

250

16

5

10

6

J1 - Assigned Flow
1.

Name = PD Compressor

2.

Elevation = 12 feet

3.

Mass Flow Rate = 100 lbm/s

4.

Temperature = 100 deg. F

J2 - Valve

1.

2.

3.

Assigned Flow J1

5.

6.

Elevation = 12 feet

2.

Cv = 446

3.

Xt = 0.8

a.

Elevation = 12 feet

b.

Name = PD Compressor

c.

Mass Flow Rate =100
lbm/s

Elevation = 12 feet

d.

Temperature = 100 deg.
F

J4 - Valve

Valve J2
a.

Elevation =12 feet

b.

Cv = 446

c.

Xt = 0.8

J3 - Branch

1.

Elevation = 0 feet

2.

Cv = 1570

3.

Xt = 0.6

J5 - Assigned Pressure

Branch J3
a.

4.

1.

Elevation = 12 feet

Valve J4
a.

Elevation = 0 feet

b.

Cv = 1570

c.

Xt = 0.6

Assigned Pressure J5
a.

Elevation = 0 feet

b.

Stagnation Pressure = 0
psig

c.

Temperature = 100 deg
F

Dead End J6
a.

Elevation = 12 feet

b.

Name = Closed Valve

1.

Elevation = 0 feet

2.

Stagnation Pressure = 0 psig

3.

Temperature = 100 deg. F

J6 - Dead End
1.

Name = Closed Valve

2.

Elevation = 12 feet

C. Check if the pipe and junction data is complete
ØTurn on List Undefined Objects
from the Main Toolbar to verify if all
data is entered. If it is not, the
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undefined pipes and junctions window
will show a list of incomplete items. If
there are undefined objects, go back
to the incomplete pipes or junctions
and enter the missing data.

Step 3. Specify Analysis
Setup

A. Specify the Fluid panel
ØOpen the Analysis Setup window
and select the Fluid panel under the
Fluid Properties group. Under the
"AFT Standard" fluid option, choose
"Methane" from the list and click the
"Add to Model" button. Click OK.

B. Specify the Pipe Sectioning and Output panel
ØOpen the Pipe Sectioning and
Output panel in the Pipe Sectioning
and Output group. Define the Minimum Number of Sections per Pipe as
8 sections and the Estimated Maximum Pipe Temperature During Transient as 150 deg. F.

C. Specify the Simulation
Mode/Duration panel
ØOpen the Simulation Mode/Duration panel in the Transient Control
group. Enter the Stop Time as 2
seconds.

D. Specify the Pulse Setup
panel
ØOpen the Pulse Setup panel from
the Pulsation Setup group. The Pulse
Setup panel is used to specify the location and magnitude of the pulse
applied to the system, as well as the
parameters required to generate the
forcing function for frequency analysis.
Define the Pulsation inputs as follows
(Figure 2):
1.

Check that junction J1 is selected for the pulse to be applied
at. Note that the pulse may only
be applied at Assigned Flow or
Compressor junctions.

2.

For Magnitude, ensure that
Automatic (Twice Steady-State
Flow) is selected.

3.

Under Frequency Analysis,
define the Cutoff Frequency as
200 Hz and verify that the Minimum Number of Frequency
Samples is set to the default
value of 1000.

4.

Leave the Evaluate with API618 option unchecked. This
option will be used in a later
step once the acoustic frequencies have been determined.
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Checking the Pulsation Summary for
this example, the Minimum Sections
Required for Cutoff are 2, and the Minimum Simulation Duration Required
for Min. Samples is 0.80 seconds.
Both of these requirements are satisfied by the current model settings.
The "Update For Me" button can be
used to automatically change the minimum number of sections and/or the
minimum simulation duration if they
are insufficient. Click OK to exit the
Analysis Setup window.

Step 4. Run the model

Figure 2: Pulse Setup panel in the Analysis Setup window with all pulsation settings defined

Now that all of the pulsation inputs are
defined, look at the Pulsation Summary at the bottom of the window. The
defined Cutoff Frequency and the Minimum Number of Frequency Samples
will affect the number of sections and
the simulation duration that are
required to run the analysis. If the number of sections is insufficient, then the
time step will be too large to capture
the specified Cutoff Frequency. Similarly, if the simulation duration is too
small, then the number of time steps
will not accommodate the Minimum
Number of Frequency Samples.

ØSelect "Run Model" from the Main
Toolbar. This will open the Solution
Progress window. This model has an
estimated run time of 5 minutes, but
the run time is dependent on the
speed of your PC.

Step 5. Review the frequency results
ØOpen the Graph Results window.
The first step will be to generate a plot
of the pressure in each of the pipes to
ensure that the simulation duration
was long enough for the response to
stabilize. Create the pressure graph
as follows:
1.

Select the Transient Pipe tab in
the Graph Control tab in the
Quick Access Panel

2.

Add the inlet and outlet station
for each of the pipes
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Under Select Parameter
choose "Pressure Static" and
verify "psia" are the selected
units
Click Generate

The pressure graph should appear as
shown in Figure 3. Note that there is a
small perturbation in the pressure
when the pulse is applied to the system, though the pressure results completely stabilize by the end of the run.
If the pressure results were still changing at the end of the run, the model
should be re-run with a longer simulation duration.

Next, graph the acoustic frequency
response as follows:
1.

Click the "New Tab" button

2.

Select the Frequency tab in the
Graph Parameter section of the
Quick Access Panel (Figure 4)

3.

Add the inlet and outlet station
for each of the pipes

4.

Verify that the pressure units
are set to psia

5.

Click Generate

Figure 4: Graph Parameters section for
the frequency analysis

Identify excitation frequencies to
study

Figure 3: Pressure Static in each of the
pipes for the frequency analysis

From the graph in Figure 5, there are
several frequencies that produce a
large pressure response. Points on
the plot with a large response magnitude are easily identified by finding
local maxima on the graph. These
maxima are the acoustic natural frequencies that are potentially the most
damaging when excited by a positive
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displacement compressor. These frequencies can also be caused by equipment that contributes large pressure
drops, such as control valves.
Two natural frequencies are identified
for the system based on the peaks in
the graph at roughly 28 Hz and 57 Hz.
Note that the number of sections used
for the analysis may affect the location
of the peaks, so it is prudent to run the
analysis with more sections to reduce
uncertainty in the results. It is also
recommended to analyze frequencies
near identified peaks (for example,
analyzing 55 and 59 Hz for the peak at
57 Hz) to account for potential shifting
of the frequency peaks that can result
from the assumptions made for the frequency analysis in AFT xStream.

Figure 5: Acoustical frequency graph for
the positive displacement compressor
system

Step 6. Determine the pressure response for API-618
The identified excitation frequencies
can now be used to determine the
pressure response in the system
caused by the pulsation at the compressor. The pressure response can
then be evaluated for compliance with
API-618.
To determine the pressure response
of the excitation frequencies, complete the following steps:
1.

In the Scenario Manager, rightclick on the base scenario and
choose "Create Child". Name
the child scenario "28 Hz".

2.

Open the Analysis Setup window and go to the Pulse Setup
panel.

3.

Check the box to "Evaluate with
API-618 and enter the Speed
as 750 rpm and the Number of
Heads as 2.

4.

Enter the Time Until Steady
State Pulsation as 0.25
seconds. The method to find
this value is discussed later in
the example. Click OK to close
Analysis Setup.

5.

Open the Assigned Flow Properties window for junction J1.
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6.

In the Transient tab, clear the
pulse transient data by clicking
Edit Table under the transient
table and choosing Clear All
Data.

7.

Check the box next to Periodic
Flow. Define the Frequency as
28 1/s and the Flow Amplitude
as 10 lbm/sec (Figure 6).

8.

Click OK to close the Properties window.

The model is now updated to represent the pulsation at the positive displacement compressor that will excite
the system. Run the model, then navigate to the Output window. This scenario will run faster than the base
scenario (about 2 minutes).
In the Output window there is now a
warning stating that the maximum
pressure limit for API-618 was
exceeded as is shown in Figure 7.
When the API-618 evaluation is performed the Pulsation Summary tab is
shown in the Output window with additional information on where pressure
limit violations occurred, and what
inputs were used to calculate the API618 pressure limits for the scenario
(Figure 8).

Figure 7: Warning showing that the API618 pressure limits have been exceeded
at multiple locations

Figure 6: Assigned Flow Properties window with Periodic Flow transient applied

Figure 8: Pulsation Summary tab listing
the pipes with the largest pressure violations
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In the Graph Results window, generate a graph of the static pressure following the same process used to
create Figure 3. However, only include
the pipe P1 inlet and outlet station.
The resulting graph is shown in Figure
9. These pressure results can be used
to check for compliance with standards such as API-618.
The pressure results for the compressor outlet (Pipe P1 inlet) can also
be used to determine the Time Until
Steady State Pulsation, which is one
of the inputs needed to accurately evaluate API-618. The Time Until Steady
State Pulsation is the time at which the
pressure oscillations have a consistent amplitude. In Figure 9 below
the wave heights appear to become
consistent at about 0.25 seconds.
Note for this example the value of 0.25
seconds was given in advance to
expedite the process, but normally the
user would need to run the model
once with the "Time Until Steady..."
set to 0, then determine the time input
and re-run the model with the correct
value.
For comparison, this model can also
be run at one of the frequencies which
gave a lower amplitude, such as 14
Hz. At 14 Hz, a lower amplitude pressure response is produced, as can be
seen in Figure 10.
Note: The pulsation observed in
this model represents a pure
sine wave. Real systems
might have a different forcing
function.

Figure 9: Pressure Static response at 29
Hz frequency
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Figure 10: Pressure Static response at 14
Hz frequency

Conclusion
The PFA add-on module for AFT
xStream can be used to apply a pressure pulse to the system in order to
identify acoustic frequencies which
may result in damage. These frequencies can be used in further pulsation analysis to determine if pulsation
mitigation is required, and what mitigation would be effective.
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Index

A
Activate Modules 255

ASME Steam Tables
library See Fluid libraries,
ASME Steam Tables library
Assigned Flow

Add Component to Library 255

Specifications Window 246

AFT Arrow Steady Solver 536,
584

Assigned Flow junction See Junctions, Assigned Flow

AFT Standard library See Fluid
libraries, AFT Standard library

Assigned Pressure

Align 256, 517
Analysis Setup 253

Specifications Window 246
Assigned Pressure
junction See Junctions,
Assigned Pressure

Analysis Setup window 532,
561, 563-564
Animation
Graph 567-568, 580
Speed adjustment 580
Annotation Tool See Toolbox,
Annotation tool
API 618 604, 612
Area Change
Specifications window 246
Area Change junction See Junctions, Area Change
Arrange menu 517

B
Bend
Specifications Window 246
Bounded by known flow rates 58
Branch
Specifications Window 246
Branch junction See Junctions,
Branch
C
Change Units window 540
Chempak library See Fluid libraries, Chempak library
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Clear Initial Guesses 252
Compressor/Fan
Specifications Window 246
Compressor/Fans
Specifications Window 246

Defining objects
List Undefined Objects window 521, 560, 577, 592,
606
Design Factors 178

Condensation 580, 584

Disable Pipes Snapping to Isometric Grid 257

Control Valve

Display on Workspace 178

Specifications Window 246

Duplicate Special 251

Conventions 57
Converting models and
libraries 507
Copy Data From Jct... 522-523
Custom Libraries 370, 373-374,
383
Cutoff Frequency 85, 365
D
Dead End

E
Edit menu 515
Estimated Maximum Temperature During
Transient See Pipe Sectioning panel, Estimated
Maximum Temperature
During Transient
Export force files See Forces,
Exporting force files
Export Model Data 249

Specifications Window 246
Dead End junction See Junctions, Dead End
Defining force sets See Forces,
Force sets, Definition

F
Fittings & Losses 255
Flip Vertex 257
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Fluid libraries
AFT Standard library 533,
561, 578, 584, 607
ASME Steam Tables
library 533, 585
Chempak library 533, 585
Effect of 583, 600

G
General Component
Specifications Window 246
Graph Animations See Animation, Graph
Graph Control tab 542
Forces 598

NIST REFPROP library 533,
585

Profile tab 567, 580

Selection 584, 586

Transient Jct tab 545, 582

Fluid Library 255
Fluid panel 533, 561, 577, 607

Transient Pipe tab 543, 566,
578

Fluid Property Viewers 255

Graph List Manager 566, 571,
598

Forces

Graph Results window 542

Exporting force files 602

Graph Guide 542

Force sets 592

Modifying axes of graphs 579

Definition 593-594
Direction 593
Force Unit Vectors 593
Methodology 598
Forces panel 602

H
Heat Exchanger
Specifications Window 246
Heat Exchanger
junction See Junctions,
Heat Exchanger
Highlight feature 522-524
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I
ID numbers 515, 520

Tee 558
Valve 525, 558-559, 576, 606

Import Graph Data 249
Initial Flow Guess 178
Inspection feature 524, 530

K
Keep Network eLicense Checked
Out 255

Insulation 164

L

Insulation Library 255
Integration Query 254
Isometric See Pipe Drawing
Mode, Isometric
J
Jump button 530

Libraries 370, 383
List Undefined Objects
window See Defining
objects, List Undefined
Objects window
Load Background Picture 250
Lock Object 258, 520

Junction library 255, 522
M

Junctions 246, 514
Area Change 575
Assigned Flow 557, 576, 606
Assigned Pressure 528, 558,
575-576, 606
Branch 559, 575-576, 606
Dead End 576, 606
Heat Exchanger 557
Tank 515, 521, 523

Make Selected Pipes and Jcts
Orthogonal 257
Merge 249
Method of Characteristics 534,
564
Minimum Number of Frequency
Samples 85, 365
Minimum Number of Sections
Per Pipe See Pipe Sectioning panel, Minimum
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Number of Sections Per
Pipe
Mixtures 533, 584-585
Model building process 584
Model Data window 531
N
Network Libraries 371
NIST REFPROP
library See Fluid libraries,
NIST REFPROP library
O
Objects 515
Open Pipe/Jct Window 521
Orifice
Specifications Window 246
Output Control window 538, 540
Output file See Transient output
file
Output window 537-538, 564,
571
Event Messages By Time 539
Forces tab 597, 599
Transient Max/Min tab 565

P
Parallel Pipes 179
PFA Module 604
Excitation frequencies 609610
Pipe Drawing Mode 257
2D Freeform 573
2D Orthogonal 573
Isometric 573, 589
Adding segments 573
Pipe Drawing Tool See Toolbox,
Pipe Drawing Tool
Pipe Line Size and Color 178
Pipe Material Library 255
Pipe Properties window 529-530
Pipe Sectioning panel 534, 561,
565, 578, 592, 607
Estimated Maximum Pipe
Mach Number During
Transient
Effect of 600
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Estimated Maximum Temperature During Transient 535, 561, 578,
592, 607

Pulsation Summary 608
Q
Quick Access Panel 514, 562

Effect of 564
Graph List Manager 566
Minimum Number of Sections
Per Pipe 534, 561, 578,
592, 607
Effect of 551, 600

Pinning 515
R

Pipe Segments 258

Reference Positive flow
direction See Reverse Pipe
Direction

Preferred Units 522

Reset Label Locations 257

Properties windows

Reverse Direction 258

Sectioning Summary 535

Notes tab 523-524

Reverse Pipe Direction 519

Optional tab 522, 524-525,
576

Rotate Icon 256

Status tab 523-524, 530-531
Transient tab
Specification 525, 559,
576, 595-596, 611
Pulsation Frequency
Analysis 253
Pulsation panel 607
Cutoff Frequency 607
Minimum Number of Frequency Samples 607

Rotate Selection 256
Rotating Icons 573, 589
Run Model 253, 536, 564-565,
578, 597, 608, 611
S
Satisfying Connectivity Requirements 152
Scale/Flip Workspace 257
Scenario Comparison Tool 596
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Scenario Manager 562, 565, 571,
594-595, 610
Screen

Startup window 511
Modeling Preferences 512
Status Bar 514, 532

Specifications Window 246
T

Select All 520
Select Flow Path 251
Select Graph Parameters 543

Tank
Specifications Window 246

Select Special 251

Tank junction See Junctions,
Tank

Selecting a fluid
library See Fluid libraries,
Selection

Tee junction See Junctions, Tee

Set Pipe and Junction Locations
to Parent 257

Tee/Wye
Specifications Window 246
Time Simulation 253

Show Grid 257, 573, 589
Toolbars 532
Show Object Status 153, 520,
523-524
Simulation Mode/Duration
panel 534-535, 561, 578,
592, 607
Snap to Grid 257

Toolbox 514-515
Annotation tool 514
Pipe Drawing Tool 514, 517,
519

Solution Progress window 536

Transfer Results to Initial
Guesses 252

Sonic choking 545, 571

Transient Control group 535

Sort Table By 256

Transient event
specification See Properties windows, Transient
tab, Specification

Special Conditions 186
Stacked Graphs 543
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Transient Jct tab See Graph Control tab, Transient Jct tab
Transient output file 537
Transient Pipe tab See Graph
Control tab, Transient Pipe
tab
Transient Solver 536, 584
U
Undefined objects list See Defining objects, List Undefined
Objects window
Undefined Objects Window 152
Unique solution 58
Use Status Feature 152
User Options 520
V
Valve
Specifications Window 246
Valve junction See Junctions,
Valve
Venturi
Specifications Window 246
Visual Report Control 548
Visual Report window 548

W
Workspace window 514-515,
555

